
03/28/2023

Automation
Anywhere IQ Bot



    Automation Anywhere - Contents 

Contents

IQ Bot — заметки о выпуске.....................................................................................................6
Рекомендации по обновлению................................................................................................. 6
IQ Bot version compatibility matrix.............................................................................................8
Матрица сравнения функций IQ Bot.......................................................................................13
IQ Bot operating system compatibility.......................................................................................23
IQ Bot database compatibility matrix........................................................................................ 24
Required database information for IQ Bot installation................................................................ 26
IQ Bot hardware and software requirements.............................................................................27

Hardware and software requirements for IQ Bot with Extensions...................................... 29
IQ Bot Version 11.3.5.7 — заметки о выпуске......................................................................... 32
IQ Bot Version 11.3.5.6 — заметки о выпуске......................................................................... 33
IQ Bot Version 11.3.5.5 — заметки о выпуске......................................................................... 34
IQ Bot Version 11.3.5.4 — заметки о выпуске......................................................................... 36
IQ Bot Version 11.3.5.3 — заметки о выпуске......................................................................... 39
IQ Bot Version 11.3.5.2 — заметки о выпуске......................................................................... 44
IQ Bot Version 11.3.5.1 — заметки о выпуске......................................................................... 46
IQ Bot Version 11.3.5 — заметки о выпуске............................................................................48
IQ Bot Version 11.3.4.3 — заметки о выпуске......................................................................... 52
IQ Bot Version 11.3.4.2 — заметки о выпуске......................................................................... 53
IQ Bot Version 11.3.4.1 — заметки о выпуске......................................................................... 54
Version 11.3.4 Release Notes for IQ Bot...................................................................................55
Version 11.3.3.1 Release Notes for IQ Bot................................................................................ 61
Version 11.3.3 Release Notes for IQ Bot...................................................................................63
Version 6.5.2 — заметки о выпуске........................................................................................ 68
Version 6.5 — заметки о выпуске........................................................................................... 73

IQ Bot architecture overview....................................................................................................78
IQ Bot 11.x architecture diagram............................................................................................. 78
Protocol specifications.............................................................................................................. 78
IQ Bot 11.x: Ports and services................................................................................................79
Учетные данные..................................................................................................................... 81
Scalability performance planning...............................................................................................81
IQ Bot 11.x: High Availability and Disaster Recovery overview....................................................83

IQ Bot 11.x: HA cluster configuration overview............................................................... 85
IQ Bot 11.x disaster Recovery deployment model............................................................ 87

Операции................................................................................................................................91
Log files in IQ Bot.........................................................................................................92
Enabling tracing in logs..................................................................................................94
Monitoring and alerts..................................................................................................... 95
Monitoring services........................................................................................................ 95
Database backup recommendation..................................................................................96

Installing IQ Bot........................................................................................................................97
IQ Bot 11.x: IQ Bot installation prerequisites............................................................................ 99

IQ Bot 11.x: IQ Bot prerequisite steps.......................................................................... 100
IQ Bot 11.x: IQ Bot service configuration......................................................................101
IQ Bot 11.x: IQ Bot Windows services.......................................................................... 102
IQ Bot 11.x: RabbitMQ v3.8.18 and Erlang/OTP upgrade................................................103
Installation limitations...................................................................................................104
Prerequisites for installing  in Cluster mode...................................................................104
IQ Bot 11.x: Prerequisites for installing IQ Bot in Express mode......................................105

© 2023 Automation Anywhere. All rights reserved.    ii



    Automation Anywhere - Contents 

IQ Bot 11.x: Installing IQ Bot in Express mode....................................................................... 106
IQ Bot 11.x: Установка IQ Bot в пользовательском режиме.................................................. 108

IQ Bot Custom installation............................................................................................113
IQ Bot 11.x: Installing IQ Bot in Cluster mode........................................................................ 113

IQ Bot 11.x: Make a Shared Folder Accessible...............................................................115
IQ Bot 11.x: Installing IQ Bot in Cluster mode on machines with IQ Bot preinstalled...................116
IQ Bot 11.x: Installing IQ Bot in Cluster mode on Amazon EC2................................................ 117
IQ Bot post installation configuration...................................................................................... 118

IQ Bot 11.x: Registering IQ Bot with the Control Room..................................................118
IQ Bot 11.x: Use Microsoft Azure Computer Vision OCR engine.......................................121
Use ABBYY FineReader Engine Распознавание текста (OCR) engine in IQ Bot 11.x..........123
IQ Bot 11.x: Use Google Vision API OCR engine............................................................126
IQ Bot 11.x: Использование модуля Распознавание текста (OCR) Tegaki API................129
Databases created during IQ Bot installation................................................................. 130
IQ Bot 11.x: Create a self-signed certificate with Subject Alternative Name......................131
IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS.....................................................132
Контрольный список после установки........................................................................ 138

IQ Bot post installation validation........................................................................................... 140
User roles and permissions...........................................................................................140
Learn whether a profile is local or roaming................................................................... 147
IQ Bot 11.x: Health Check API response if RabbitMQ v3.8.18 fails to start....................... 147
IQ Bot 11.x: Set up log file automatic rollover...............................................................148
Reinstalling HTTPS SSL certificate on expiry.................................................................. 150

IQ Bot upgrade and uninstallation.......................................................................................... 151
Uninstalling IQ Bot 11.x............................................................................................... 152
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS............. 152
Upgrading and downgrading IQ Bot 11.x.......................................................................153

Использование IQ Bot........................................................................................................... 155
Learning instance...................................................................................................................158

Search for a learning instance...................................................................................... 159
Refresh data in Learning Instance details page..............................................................159

IQ Bot 11.x: Создать экземпляр для обучения......................................................................160
Custom Domain in IQ Bot............................................................................................ 162
IQ Bot 11.x: Selecting an Распознавание текста (OCR) engine......................................164
Classification criteria in IQ Bot......................................................................................166
IQ Bot 11.x: Edit a learning instance............................................................................ 167
IQ Bot 11.x: Delete a learning Instance........................................................................ 169

Staging environment.............................................................................................................. 169
Create and edit a бот.................................................................................................. 170
Start training in Designer............................................................................................. 170
IQ Bot 11.x: Move a learning instance to Production......................................................199
Боты........................................................................................................................... 199
Информационная панель............................................................................................ 202

Production environment..........................................................................................................205
Upload documents to a learning instance...................................................................... 205
Upload multiple folder files to a learning instance.......................................................... 206
Download a document from a learning instance............................................................ 207
Read a successfully digitized document using TaskBot....................................................208
IQ Bot Validation queue............................................................................................... 209
Validator window..........................................................................................................210
IQ Bot 11.x: Adding custom logic to improve automatic extraction in production...............214
Prevent automatic copying of documents to Staging...................................................... 218

Migration Utility......................................................................................................................219
Keep learning instance document classifier version during IQ Bot upgrade.................................219
IQ Bot 11.x: List of languages in IQ Bot.................................................................................219

© 2023 Automation Anywhere. All rights reserved.    iii



    Automation Anywhere - Contents 

Стандартные формы for custom extraction............................................................................ 226
Import domains for fixed format documents..................................................................227
Create learning instance using fixed format documents.................................................. 228
Process fixed format documents in production............................................................... 229
Using Валидатор for fixed format documents processing................................................229

IQ Bot database encryption....................................................................................................230
IQ Bot Microsoft Windows authentication................................................................................ 231
IQ Bot audit log in Control Room........................................................................................... 231

Upgrading IQ Bot.................................................................................................................... 233
IQ Bot upgrade options..........................................................................................................233
Upgrading system to IQ Bot Version 11.3.5.7.......................................................................... 235
Upgrading system to IQ Bot Version 11.3.5.6.......................................................................... 236
Upgrading system to IQ Bot Version 11.3.5.5.......................................................................... 237
Upgrading system to IQ Bot Version 11.3.5.x.......................................................................... 238
Upgrading system to IQ Bot Version 11.3.5.............................................................................240
Upgrading system to IQ Bot 11.x........................................................................................... 242
Upgrade from IQ Bot Version 11.3.4 to Version 11.3.4.x patch................................................. 243

Uninstall IQ Bot Version 11.3.4.x patch......................................................................... 244
Upgrade IQ Bot Version 6.5 or earlier to IQ Bot Version 11.3.4................................................ 244
Upgrading IQ Bot to Version 11.3.3.x..................................................................................... 246
Upgrading system from IQ Bot Version 5.3.x or IQ Bot 6.0.x to Version 6.5............................... 248
Upgrading system from IQ Bot 5.3.x to 6.0.x.......................................................................... 249
Upgrading system from IQ Bot 5.1.x to 5.2.x.......................................................................... 250
Upgrading system from IQ Bot 5.0.x to 5.1.x.......................................................................... 250
Using Migration Utility to import and export learning instances................................................. 251

Export a learning Instance........................................................................................... 252
Import a learning instance........................................................................................... 252
Варианты импорта...................................................................................................... 254

Export or Import learning instances within IQ Bot 5.2 installation............................................. 257
Export/Import learning instances within IQ Bot 5.3.x, and later versions................................... 258

Troubleshooting IQ Bot...........................................................................................................260
Large IQBA files failing import................................................................................................260
Installation error in output path configuration screen............................................................... 260
No learning instance for command in Enterprise Client.............................................................260
Learning instance classification issue on restarting AWS instance.............................................. 260
IQ Bot does not load after restarting AWS instance................................................................. 260
Error message displays indefinitely..........................................................................................260
IQ Bot installation fails to run in RabbitMQ cluster mode..........................................................261
IQ Bot HTTPS SSL certificate expiry........................................................................................261
Automation Anywhere Control Room login error...................................................................... 261
Connect ECONNREFUSED error during login............................................................................ 261
Unable to install IQ Bot in express mode................................................................................ 261
Uninstall error........................................................................................................................ 261
Unable to view learning instance listing.................................................................................. 262
Your connection is not private error........................................................................................262
Stalled Classifier.....................................................................................................................262
Unresponsive Designer while drawing a User-Defined Region (UDR)..........................................262
Installer unable to create platform database tables..................................................................262
Classification stalls while training documents........................................................................... 262
Export process hangs.............................................................................................................262
Documents not classified after migrating learning instances......................................................262
Installer error 1334................................................................................................................263
Access Denied message......................................................................................................... 263
Installation fails while installing RabbitMQ............................................................................... 263

© 2023 Automation Anywhere. All rights reserved.    iv



    Automation Anywhere - Contents 

Cannot upgrade to IQ Bot 6.0 on Control Room 11.3...............................................................263
IQ Bot services not getting uninstalled....................................................................................263
Output folder path change from local to shared drive.............................................................. 263
Windows authentication with services in local system is not working.........................................263
Database encryption errors.....................................................................................................264
SIRs not getting generated consistently.................................................................................. 264
IQ Bot installation FAQs......................................................................................................... 264
IQ Bot user FAQs.................................................................................................................. 264
IQ Bot classifier FAQs............................................................................................................ 264
IQ Bot validator FAQs............................................................................................................ 264

IQ Bot Community Edition quick start guide..........................................................................265
Начните с IQ Bot..................................................................................................................265
Register to use the Community Edition................................................................................... 265
Creating a learning instance in Community Edition...................................................................265

Custom domain............................................................................................................266
Train your learning instance................................................................................................... 266
Export data to a CSV file....................................................................................................... 267
IQ Bot 11.x: Set learning instance to production..................................................................... 268
Use IQ Bot in RPA.................................................................................................................268

Using Upload Document action..................................................................................... 268
Upload multiple files to IQ Bot using Loop action...........................................................269
Использование action «Загрузить все документы»...................................................... 270

FAQs for Community Edition...................................................................................................271
Index........................................................................................................................................276

© 2023 Automation Anywhere. All rights reserved.    v



    Automation Anywhere - IQ Bot — заметки о выпуске

IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
Follow the links in the table to view the release note updates for the respective release.

Major Releases Minor Releases

Version 11.3.5 Version 11.3.5.7

Version 11.3.5.6

Version 11.3.5.5

Version 11.3.5.4

Version 11.3.5.3

Version 11.3.5.2

Version 11.3.5.1

Version 11.3.4 Version 11.3.4.3

Version 11.3.4.2

Version 11.3.4.1

Version 11.3.3 Version 11.3.3.1

Version 6.5 Version 6.5.2

Related concepts
IQ Bot operating system compatibility on page 23
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix on page 24
The table provides information about the databases that are compatible with the different IQ Bot releases.
IQ Bot hardware and software requirements on page 27
Make a note of the following hardware and software requirements before installing IQ Bot.
Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
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Upgrading to IQ Bot Version 11.3.5

Upgrading system to IQ Bot Version 11.3.5 on page 240

Important:  IQ Bot Version 11.3.5 is compatible with Control Room Version 11.3.4.3 and above only.

Upgrading to IQ Bot Version 11.3.5.7
If you are using any of the earlier IQ Bot versions (11.3.5.3, 11.3.4.3, and so on), ensure that you first
upgrade to IQ Bot Version 11.3.5.6 before upgrading to Version 11.3.5.7
Upgrading system to IQ Bot Version 11.3.5.7 on page 235
Upgrading to IQ Bot Version 11.3.5.6
If you are using any of the earlier IQ Bot versions (11.3.5.3, 11.3.4.3, and so on), ensure that you first
upgrade to IQ Bot Version 11.3.5.5 before upgrading to Version 11.3.5.6
Upgrading system to IQ Bot Version 11.3.5.6 on page 236
Upgrading to IQ Bot Version 11.3.5.5
Upgrade the system to IQ Bot Version 11.3.5.5 for enhancements and bug fixes.
Upgrading system to IQ Bot Version 11.3.5.5 on page 237
Upgrading to IQ Bot Version 11.3.5.x
Upgrading system to IQ Bot Version 11.3.5.x on page 238
• IQ Bot Version 11.3.5.4 is compatible only with Control Room Version 11.3.4.4
• IQ Bot Version 11.3.5.3 is compatible only with Control Room Version 11.3.4.4.
• To import learning instance backups on an IQ Bot Version 11.3.5.2 environment, the backup (.iqba)

file must be exported from an IQ Bot Version 11.3.5.2 environment only. Therefore, you must also
upgrade your source IQ Bot environment to Version 11.3.5.2. This requirement is due to changes made
in database schemas and version information in the backup (.iqba) files.

Upgrading to IQ Bot Version 11.3.4

Install IQ Bot Version 11.3.4 using installation checklist provided in the installer zip file.
Upgrading to IQ Bot Version 11.3.4.x
Upgrade from IQ Bot Version 11.3.4 to Version 11.3.4.x patch on page 243

Upgrading to IQ Bot Version 11.3.3

• For IQ Bot Version 11.3.3, users must upgrade to  version 3.7.17.
• When upgrading to IQ Bot Version 11.3.3, all group information gets stored in a new table

ContentClassification, and all data gets automatically upgraded/transferred to this table during the
installation process.

• If your machine version is older than SQL Server Native Client 2012, a dialog box appears, giving you the
option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER). Then complete
the installation process.
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• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. Select that prior version of IQ Bot from a drop-down list to keep the classifier version for the
existing learning instances.

Note:  См. раздел Keep learning instance document classifier version during IQ Bot upgrade on page 219.

• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5 is used.

• If upgrading from IQ Bot Version 5.3.1.x and you have a learning instance that relies on 5.3.1.x group
check box or linked table functionality, clear that learning instance's validation queue before upgrading
to IQ Bot Version 6.5 to avoid field name conflicts.
• IQ Bot Version 5.3.1.x uses "_", a non-unique delimiter (Gender_ID_Female and

Patient_Table_Services).
• IQ Bot Version 6.5 uses unique delimiters "->" for group check box (for example, "Gender_ID-

>Female") and ":" for linked tables (for example, "Patient_Table:Services"), which can make it easier
to process in RPA.

Note:  См. раздел Export/Import learning instances within IQ Bot 5.3.x, and later versions on page 258.

• For security protection, the SQL server database is encrypted starting from IQ Bot Version 6.5. The
added protection can increase the database size by up to 4x. This is due to the encryption obfuscation.

• When upgrading IQ Bot Version 5.3.x to Version 6.5 and above, the installer encrypts data related to
files in the database.

Note:  См. раздел IQ Bot database encryption on page 230.

•
11.3.1.1 Upgrading to IQ Bot Version 11.3.3.1

Install IQ Bot Version 11.3.3.1 using the installation checklist provided in the installer zip file.
• Upgrading to IQ Bot Version 11.3.3.x

When upgrading IQ Bot, the group numbers under learning instances can change due to data migration
to Version 11.3.3.x. To see the mapping between the old groups in Version 6.0.x and new groups in
Version 11.3.3.x, user would need to go through the installation-helper.log file, in C:\Users\Public
\Documents\Automation Anywhere IQBot Platform\Logs folder.

Note:  The upgrade changes the group number only, and not the data.

Related concepts
IQ Bot — заметки о выпуске on page 6
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
Related reference
Version 6.5 — заметки о выпуске on page 73
These release notes contain changed features, fixed features, and security fixes introduced in IQ Bot
Version 6.5.x.

IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
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IQ Bot versions and Control Room compatibility matrix

See the following table to verify which IQ Bot version is compatible with specific Automation Anywhere
Enterprise 11.x.

IQ Bot
versions Control Room versions Enterprise Client versions Примечания

Version
11.3.5.7 Version 11.3.5.8 Version 11.3.5.8 --

Version
11.3.5.6

Version 11.3.5.8
Version 11.3.5.5
Version 11.3.5.4
Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.7
Version 11.3.4.6
Version 11.3.4.5
Version 11.3.4.4

Version 11.3.5.8
Version 11.3.5.7
Version 11.3.5.6
Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.8
Version 11.3.4.7
Version 11.3.4

Version 11.3.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1 and later

--

11.3.5.5 Version
11.3.5.5

Version 11.3.5.5
Version 11.3.5.4
Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.7
Version 11.3.4.6
Version 11.3.4.5
Version 11.3.4.4

Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.8
Version 11.3.4.7
Version 11.3.4

Version 11.3.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--
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IQ Bot
versions Control Room versions Enterprise Client versions Примечания

Version
11.3.5.4

Version 11.3.5.5
Version 11.3.5.4
Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.7
Version 11.3.4.6
Version 11.3.4.5
Version 11.3.4.4

Version 11.3.5.3
Version 11.3.5

Version 11.3.4.8
Version 11.3.4.7
Version 11.3.4

Version 11.3.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

For Control Room
Version 11.3.4.4,

addignite.security.disable=true

Version
11.3.5.3

Version 11.3.5.5
Version 11.3.5.4
Version 11.3.5.3
Version 11.3.5.2
Version 11.3.4.7
Version 11.3.4.6
Version 11.3.4.5
Version 11.3.4.4

Version 11.3.5.3
Version 11.3.5

Version 11.3.4.8
Version 11.3.4.7
Version 11.3.4

Version 11.3.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

For Control Room
Version 11.3.4.4,

addignite.security.disable=true

Version
11.3.5.2

Version 11.3.5.1
Version 11.3.5

Version 11.3.4.3

Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--

Version
11.3.5.1

Version 11.3.5.1
Version 11.3.5

Version 11.3.4.3

Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--

Version
11.3.5

Version 11.3.5
Version 11.3.4.3

Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--
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IQ Bot
versions Control Room versions Enterprise Client versions Примечания

Version
11.3.4.3

Version 11.3.5.1
Version 11.3.5
Version 11.3.4
Version 11.3.3

Version 11.3.2

Version 11.3.1.1
Version 11.3.1.11

Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.14
Version 11.3.1.1

Version
11.3.4.2

Version 11.3.5.1
Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.11
Version 11.3.1.1

Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--

Version
11.3.4.1

Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--

Version
11.3.4

Version 11.3.5.1
Version 11.3.5
Version 11.3.4

Version 11.3.3.6
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

Version 11.3.1.13
Version 11.3.4

Version 11.3.3.6
Version 11.3.3
Version 11.3.2

Version 11.3.1.1

--
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IQ Bot
versions Control Room versions Enterprise Client versions Примечания

Version
11.3.3.1

Version 11.3.5
Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.11
Version 11.3.1.1

Version 11.3.3
Version 11.3.2

Version 11.3.1.1

• For Control
Room Version
11.3.5, Version

11.3.4 and
Version

11.3.3, add
ignite.tls.disable=true

• For Control
Room Version
11.3.2, add

ignite.security.disable=true

See the Create
or update

cluster.properties
file section below.

Version 6.5

Version 11.3.5.1 (compatible
with IQ Bot Version 6.5.2)

Version 11.3.5 (also compatible
with IQ Bot Version 6.5.2)

Version 11.3.4
Version 11.3.3
Version 11.3.2

Version 11.3.1.11
Version 11.3.1.1

Version 11.3.1.1

• For Control
Room, Version

11.3.5.1,
Version 11.3.5,
Version 11.3.4,

and Version
11.3.3, add

ignite.security.disable=true
ignite.tls.disable=true

• For Control
Room Version
11.3.2, add

ignite.security.disable=true

See the Create
or update

cluster.properties
file section below.

Version
6.0.1

Version 11.3.3
Version 11.3.2

Version 11.3.1.1
Version 11.3.1.1

• For Control
Room Version
11.3.3, add

ignite.security.disable=trueignite.tls.disable=true
• For Control

Room Version
11.3.2, add

ignite.security.disable=true

See the Create
or update

cluster.properties
file section below.

Version 6.0 Version 11.3.1.1 Version 11.3.1.1 -
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IQ Bot
versions Control Room versions Enterprise Client versions Примечания

5.3.1.x
(Unofficial
Release)

10.5.5 - -

5.3.0 10.5.5 - -

5.2.x 10.5.5 - -

5.1.x
10.5.2
10.5.5

- -

5,0 10,4 - -

Create or update cluster.properties file

Based on the compatibility information in the table, update your cluster.properties file for the listed
parameters.
1. Locate the file in your Control Room directory (for example, C:\Program Files\Automation

 Anywhere\Enterprise\config\).
If the file does not exist in your Control Room directory:
a. Create a file with the filename cluster.properties.
b. Add the property options to the file as mentioned in the Notes column of the table.

2. Save the cluster.properties file.
3. Restart the following services:

a. Automation Anywhere Control Room Caching
b. Automation Anywhere Control Room Messaging
c. Automation Anywhere Control Room Service

Related concepts
IQ Bot — заметки о выпуске on page 6
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
Related reference
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

Матрица сравнения функций IQ Bot
Compare features between different product releases.

Прим.:  There are no feature changes to the IQ Bot feature comparison matrix from Version 11.3.5.5
onwards.
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Custom
Encryption
key

Да Да Нет Нет Нет Нет Нет Нет Нет Нет Нет Нет Нет

Pre-built
domains

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

User
confidence
threshold

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Learning
instance
creation/
editing

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Document
image pre-
processing

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Document
image
classification

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Document
image OCR

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Бот
creation/
editing

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Delete a
Бот

Да Yes Да Yes Да Нет Нет Нет Нет Нет Нет Нет Нет

Designer/
Preview/
Test

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Production
toggle

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Валидатор Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Default
validations
for a group

Да Нет Нет Нет Нет Нет Нет Нет Нет Нет Нет Нет Нет

CSV output
files

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

Learning
instance
import/
export

Да Yes Да Yes Да Да Да Да Да Да Да Да Да
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Learning
Instance
tab
enhancements

Да Yes Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет

Ease-
of-use
features

Да Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Web-based
UI

Да Yes Да Yes Да Да Да Да Да Да Да Нет Нет

Domain
import/
export

Да Yes Да Yes Да Да Да Да Да Да Да Нет Нет

Import
custom
domain in
any order

Да Yes Да Yes Нет Нет Нет Нет Нет Нет Нет Нет Нет

Hover
over text
segment to
view OCR

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

Re-size
mapped
box in
Designer

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

Delete
mapped
box in
Designer

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

Populate
text in End
of table/
section
indicator

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Single click
to extract
text in the

Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Валидатор
enhancements
• Hide

optional
form
fields

• Hide
successful
form
fields

Да Yes Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет

Access
specific
documents
in
Валидатор
using URLs

Да Yes Да Yes Да Нет Нет Нет Нет Нет Нет Нет Нет

Document
group
description

Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет

Search for
documents
in the
Validator
UI

Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет Нет Нет

See
extraction
results
action
displays
list of all
training
documents
in an
alpha-
numeric
sequence

Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет

InstallShield
patch
installer
has
simplified
the
upgrade/
downgrade
process for
IQ Bot

Да Yes Да Yes Да Да Да Да Нет Нет Нет Нет Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

IQ Bot
Installer
enhancements:
pre-
installation
check

Да Yes Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет

Extraction/
validation
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Original IQ
Bot text
segmentation /
document
classifier
from IQ
Bot Version
5.3.0 / 6.0

Да Yes Да Yes Да Да Да Да Да Да Да Нет Да

New IQ
Bot text
segmentation /
document
classifier
from IQ
Bot Version
5.3.1 / 6.5

Да Yes Да Yes Да Да Да Да Да Да Нет Да Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Option
to select
classifier
version of
existing
learning
instances
during
IQ Bot
upgrade:
• Version

1 (IQ
Bot
5.3.0 or
before /
6.0)

• Version
2 (IQ
Bot
5.3.1 /
Version
6.5
Beta

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Enhanced
compatibility
with
ABBYY
FineReader
Engine
12.2 Plugin

Да Yes Yes Yes Да Да Да Да Да Да Нет Да Нет

Automated
installation
of ABBYY
FineReader
Engine
12.2 Plugin

Да Yes Yes Yes Да Да Да Да Да Да Нет Нет Нет

Validator
auto-
correction

Да Yes Yes Yes Да Да Да Да Да Да Нет Да Нет

Checkbox
extraction

Да Yes Yes Yes Да Да Да Да Да Да Нет Да Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Advanced
extraction:
Repeated
tables /
sections;
linking
tables /
sections;
map some
header-less
columns

Да Yes Да Yes Да Да Да Да Да Да Нет Да Нет

Alternative
to stop
extraction
at End of
table/
section
indicator

Да Yes Да Yes Да Да Да Да Да Да Нет Да Нет

Select text
segments
that
enclose
or are
enclosed
by other
text
segments

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

Option
to select
default
training
document

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

Formula
validation

Да Yes Да Yes Да Да Да Да Да Да Нет Да Да

List
validation
in UI

Да Yes Да Yes Да Да Да Да Да Да Да Да Да

List
validation
via
external
file

Нет No Нет No Нет Нет Нет Нет Нет Нет Нет Да Да

Microsoft
Azure
Computer
Vision API
(OCR)

Да Yes Yes Yes Да Да Да Да Да Нет Нет Нет Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Add user
logic in the
Designer

Да Yes Yes Yes Да Да Да Да Да Нет Нет Нет Нет

View and
test all
documents
in the
Designer
> See
extraction
results

Да Yes Yes Yes Да Да Да Да Да Нет Нет Нет Нет

IQ Bot
extensions

Да Yes Yes Yes Да Да Да Да Нет Нет Нет Нет Нет

Import
standard
form
domains

Нет No No No Нет Нет Нет Да Нет Нет Нет Нет Нет

(Beta)
Enabled
data
capture
and OCR
using
Google
Vision
API API
for Asian
languages

No No No Нет Нет Да Нет Нет Нет Нет Нет Нет

(GA)
Enabled
data
capture
and OCR
using
Google
Vision
API API
for Asian
languages

Да Yes Yes Yes Да Да Нет Нет Нет Нет Нет Нет Нет

© 2023 Automation Anywhere. All rights reserved.     20



    Automation Anywhere - IQ Bot — заметки о выпуске

IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

(Beta)
Enabled
data
capture
and OCR
using
Tegaki API
Распознавание
текста
(OCR)
engine
for Asian
languages

Да Yes Yes Yes Да Да Нет Нет Нет Нет Нет Нет Нет

Magnetic
ink
character
recognition
(MICR)
extraction

Да Yes Yes Yes Да Да Да Нет Нет Нет Нет Нет Нет

Option to
turn off
PDFBox
as OCR
engine

Да Yes Yes Yes Да Да Да Нет Нет Нет Нет Нет Нет

Enterprise
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Access IQ
Bot without
device
license
(without
Bot Creator
or Bot
Runner
license)

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Access
IQ Bot as
Валидатор
users
without Bot
Creator or
Bot Runner
license

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Database
encryption

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

Roles-
based
access
(RBAC)
for new
learning
instances

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

RBAC
enhancements
(role
assignment
from UI)

Да Yes Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет

Журналы
аудита

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Аутентификация
Windows

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Azure PaaS
Database
Service

Да Yes Да No Да Да Да Да Да Да Нет Нет Нет

Counter for
number of
uploaded
pages in
production

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

Limit
number of
groups in
production

Да Yes Да Да Нет Нет Нет Нет Нет Нет Нет Нет Нет

API access Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет

Access IQ
Bot without
sysadmin
role that
includes
support for
Amazon
Relational
Database
Service
(RDS) out
of the box

Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет

ИнтернационализацияДа Yes Да Yes Да Да Да Да Да Да Нет Нет Нет
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IQ Bot
initial
features

Version
11.3.5.5

Version
11.3.5.4

Version
11.3.5.3

Version
11.3.5.2

Version
11.3.5.1

Version
11.3.5

Version
11.3.4

Version
11.3.3 /
Version
11.3.3.1

Version
6.5.2

Version
6.5

Version
6.0.x

Version
5.3.1.x

Version
5.3.0

UI
Localization:
Chinese
Simplified,
Chinese
Traditional,
French,
German,
Japanese,
Korean,
and
Spanish

Да Yes Да Yes Да Да Да Да Да Да Нет Нет Нет

UI
Localization:
Italian and
Portuguese

Да Yes Да Yes Да Да Да Да Да Нет Нет Нет Нет

Migrate
learning
instances
as other
learning
instances
are being
edited

Да Yes Да Yes Да Да Да Да Нет Нет Нет Нет Нет

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.

IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.

Note:  There are no changes to the IQ Bot operating system from Version 11.3.5.5 onwards.

Версия IQ Bot Microsoft
Windows Server
2019 Data Center

Microsoft
Windows Server
2016 Data Center

Microsoft
Windows Server
2012 R2 Standard

Microsoft
Windows 10 Pro/
Enterprise

11.3.5.5 Version
11.3.5.5

Да Да Да Да

IQ Bot Version
11.3.5.4

Да Да Да Нет
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Версия IQ Bot Microsoft
Windows Server
2019 Data Center

Microsoft
Windows Server
2016 Data Center

Microsoft
Windows Server
2012 R2 Standard

Microsoft
Windows 10 Pro/
Enterprise

IQ Bot Version
11.3.5.3

Да Да Нет Нет

IQ Bot Version
11.3.5.2

Да Да Да Нет

IQ Bot Version
11.3.5.1

Да Да Да Нет

IQ Bot Version
11.3.5

Да Да Да Нет

IQ Bot Version
11.3.4

Да Да Да Нет

Version 11.3.3 /
Version 11.3.3.1

Нет Да Да Нет

IQ Bot Version
6.5.2

Нет Да Да Нет

IQ Bot Version 6.5 Нет Да Да Нет

IQ Bot Version
6.0.1

Нет Да Да Нет

IQ Bot Version 6.0 Нет Да Да Нет

IQ Bot Version
5.3.1

Нет Да Да Да

IQ Bot Version 5.3 Нет Да Да Да

IQ Bot Version
5.2.1

Нет Нет Да Да

IQ Bot Version 5.2 Нет Нет Да Да

IQ Bot Version
5.1.1

Нет Нет Да Да

IQ Bot Version 5.1 Нет Нет Да Да

Note:  The open source software (OSS) disclosure for IQ Bot is stored in the Installation folder with
the filename: IQ Bot (version) OSS Disclosures.html.

<Installation folder>\Automation Anywhere IQ Bot \IQ Bot (version) OSS
 Disclosures.html

IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.

Note:
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There are no changes to the IQ Bot database compatibility matrix from Version 11.3.5.5 onwards.

Версия
IQ Bot

Microsoft
SQL
Server 2012

Microsoft
SQL
Server 2014

Microsoft
SQL
Server 2016

Microsoft
SQL
Server 2017

Microsoft
SQL
Server 2019

Amazon
Relational
Database
Service
(Amazon
RDS)

Microsoft
SQL Azure
(RTM)

11.3.5.5 Version
11.3.5.5

Да Да Да Да Да Да Да

IQ Bot
Version
11.3.5.4

Да Да Да Да Да Да Да

IQ Bot
Version
11.3.5.3

Да Да Да Да Да Да Да

IQ Bot
Version
11.3.5.2

Да Да Да Да Да Да Нет

IQ Bot
Version
11.3.5.1

Да Да Да Да Да Нет Да

IQ Bot
Version
11.3.5

Да Да Да Да Да Нет Да

IQ Bot
Version
11.3.4

Да Да Да Да Да Да Да

IQ Bot
Version
11.3.3 /
Version
11.3.3.1

Да Да Да Да Нет Да Да

IQ Bot
Version
6.5.2

Да Да Да Да Нет Да Да

IQ Bot
Version
6.5

Да Да Да Да Нет Да Да

IQ Bot
Version
6.0.x

Да Да Да Да Нет Нет Нет
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Версия
IQ Bot

Microsoft
SQL
Server 2012

Microsoft
SQL
Server 2014

Microsoft
SQL
Server 2016

Microsoft
SQL
Server 2017

Microsoft
SQL
Server 2019

Amazon
Relational
Database
Service
(Amazon
RDS)

Microsoft
SQL Azure
(RTM)

IQ Bot
Version
5.3.1.x

Да Да Да Да Нет Нет Нет

IQ Bot
Version
5.3.0

Да Да Да Да Нет Нет Нет

IQ Bot
Version
5.2.x

Да Да Да Да Нет Нет Нет

IQ Bot
Version
5.1.x

Да Да Да Да Нет Нет Нет

IQ Bot
Version
5.0.0

Да Да Да Да Нет Нет Нет

Note:  See IQ Bot hardware and software requirements on page 27 for Database performance
requirements.

Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.

Microsoft SQL Server and Amazon RDS databases

Required information Описание

Database (SQL Server) authentication Provide credentials for a Microsoft SQL Server
user who has permission to connect to the
database.

Database names • AliasData
• ClassifierData
• Configurations
• FileManager
• MLData

Database port Default: 1433
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Microsoft SQL Server and Amazon RDS databases

Required information Описание

Service credentials Provide the user with the following permissions:
• CONNECT SQL
• CREATE ANY DATABASE
• VIEW ANY DATABASE

База данных Microsoft Azure

Required information Описание

Database (SQL Server) authentication Created when database was created.

Database names • FileManager
• Classifier
• Configurations
• MLData
• AliasData

Database port Default: 1433

Database role Database access requires the dbmanager role.

Related concepts
IQ Bot hardware and software requirements on page 27
Make a note of the following hardware and software requirements before installing IQ Bot.

IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.

Important:  Install IQ Bot on a dedicated server, and install Control Room on a separate server.
To know more, see What is the limitation of installing both Control Room and IQbot in a same server (A-People
login required)

Требования к аппаратному обеспечению

IQ Bot Recommendation

Application server optimum requirements • 32 GB RAM
• 8 Octa Core Processor
• 500 GB hard disk space1

• Ensure C: drive has 100 GB plus free hard
disk space.
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Database server optimum requirements

Сервер Recommendation

IQ Bot application server • 32 GB RAM
• 8 Core Processor
• 500 GB hard disk space

For all IQ Bot-related database servers • 16 GB RAM
• 8 Core Processor
• 500 GB hard disk space

Note:  If hosting IQ Bot databases along
with other application databases, ensure
the hardware resources are increased
proportionately.

Microsoft Azure SQL Database: production
environment

• vCore model (recommended)
• DTU model (Premium tier recommended)

Amazon RDS: production environment db.t3.2xlarge or db.t3.xlarge

Software requirements

The following software is required for IQ Bot installation:

Software Сведения

Database Management System See IQ Bot database compatibility matrix on page
24 for a list of compatible versions.

Automation Anywhere Control Room See IQ Bot version compatibility matrix on page
8 for a list of compatible versions.

Supported web browsers • Google Chrome
• Microsoft Internet Explorer (Version 11.3.3

onward)

Important:  When using Internet
Explorer11, you might need to Display
intranet sites in Compatible View in the
Compatibility View Settings window.
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Software Сведения

Зависимости Automation Anywhere IQ Bot is dependent on
the following software, which are automatically
installed during the installation process:
• RabbitMQ v3.10.8
• Erlang/OTP v25.1 (13.1)
• NodeJS v14.20.0
• Python3.11.1 (64 bit)
• Microsoft .NET Framework v4.7.2. The system

prompts for a restart to complete the update.
• Microsoft Visual C++ Redistributable 2017

x64 package
• Microsoft SQL Server 2012 Native Client -

QFE

This is installed automatically by the installer. A
system restart is required.

Note:  In a cluster environment, all
dependencies will get installed on each machine
where IQ Bot is installed.

Related reference
Hardware and software requirements for IQ Bot with Extensions on page 29
The following diagram provides the deployment architecture for IQ Bot with Extensions.

Hardware and software requirements for IQ Bot with Extensions
The following diagram provides the deployment architecture for IQ Bot with Extensions.
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This page mentions the minimum requirements for installing Control Room node. See Automation 360 On-
Premises prerequisites

See the minimum hardware and software requirements for IQ Bot node with Extensions below:

Supported operating systems for IQ Bot node with Extensions

Microsoft Windows Server 2016 Standard / Data Center

Microsoft Windows Server 2012 R2 Standard / Data Center

Microsoft Windows 10 Pro/Enterprise

Software Сведения

Database Management System Microsoft SQL Server 2012, 2014, 2016, 2017
(Express or Standard or Enterprise or later).
Microsoft SQL Azure (RTM) 12.0.2000.8
(optional).

Automation Anywhere Control Room See IQ Bot version compatibility matrix on page
8 for a list of compatible versions.

Веб-браузеры The Google Chrome and Internet Explorer 11
web browsers are supported.

Зависимости IQ Bot is dependent on the following software,
which is automatically installed during the
installation process:
• Microsoft .NET Framework v4.7.2. The system

prompts for a restart to complete the update.
• Erlang v22.0
• RabbitMQ v3.8.18 v3.7.17
• NodeJS v10.16.3
• Microsoft SQL Server 2012 Native Client -

QFE
• Python 3.5.4 (32 bit)

Note:  This is installed automatically by the
installer and requires a system restart.

Note:  For IQ Bot extensions feature to work, the custom extraction services needs to be running on
an engine node. We recommend that this engine node be part of a different machine instead of the one
that has the IQ Bot node. The configuration of the machine running the engine node (as described in the
figure) depends on the requirements of the custom extraction service built for the specific fixed format
documents.

Related concepts
IQ Bot hardware and software requirements on page 27
Make a note of the following hardware and software requirements before installing IQ Bot.
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IQ Bot Version 11.3.5.7 — заметки о выпуске
Review the changed features, fixed features, and known limitations in Version 11.3.5.7 for IQ Bot. There
are no security fixes in this release.

Изменения

IQ Bot now uses the latest version of Python (3.11.1) for custom logic validation. To use the latest
version, you must upgrade from cx_Oracle 8.3 to python-oracledb. See Upgrading from cx_Oracle 8.3
to python-oracledb.

As of the latest build in IQ Bot, the Automation Anywhere Cognitive MLScheduler Service is
removed.

Исправления

The security vulnerability related to an unquoted service path that contained whitespace has
been fixed. Previously, the Windows host referred to an installed service that used an unquoted
service path which contained whitespace in the Automation Anywhere Cognitive Console: D:
\Program Files (x86)\Automation Anywhere IQ Bot\Portal\node modules
\winser\bin\nssm64.exe.
Service Cloud case ID: 01880370

You no longer see duplicate group entries when you import the IQ Bot archive (IQBA) file.
Service Cloud case ID: 00746545, 00827208, 00836859, 01824946

IQ Bot no longer shows any duplicate fields in the Валидатор. Previously, there was a mismatch
in the field IDs between the source and target machine for the Custom Domain which caused
duplicate fields in the Валидатор.
Service Cloud case ID: 01822954

While exporting learning instances from one environment to another, IQ Bot now updates the
visionBotId in the exported data.You can edit bots in the destination environment without any
errors.
Service Cloud case ID: 00832744

An unexpected error that occurred due to large unnamed RabbitMQ message queues has been
fixed and you can now navigate to the Learning Instance page without any issue.
Service Cloud case ID: 00833174, 00830141

IQ Bot Classifier now classifies documents perfectly with all aliases. Previously, IQ Bot Classifier
threw an System.OutOfMemoryException error while processing aliases with spaces which
caused a large amount of search loop for each field of the document.
Service Cloud case ID: 01765562
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When you enable the Never Create New Group option, the document moves to the validation
queue instead to the new group. Previously, even though you selected Never Create New Group,
the document still moved to a new group.
Service Cloud case ID: 01275259

The IQ Bot application now loads successfully and all transactions on the Learning Instances are
successful. Previously, the Bot application was not loading if you had more than 8000 groups and a
large amount of group data.
Service Cloud case ID: 01758636

Известные ограничения

For non-English languages such as Japanese, Chinese, and Korean, you cannot create a learning
instance if the file name contains more than 104 characters.

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
Матрица сравнения функций IQ Bot
Compare features between different product releases.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.

IQ Bot Version 11.3.5.6 — заметки о выпуске
The Version 11.3.5.6 release includes the fix for Apache Log4j2 vulnerability. There are no new features,
changed features, fixed features, or known limitations in this release.
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Security fix

This release addresses the exposure to the Apache Log4j CVE-2021-45105, CVE-2021-45046,
CVE-2021-44228, and CVE-2021-44832 vulnerabilities.

Important:  We have updated IQ Bot Version 11.3.5.6 to include the fix for the Apache Log4j2
component vulnerability. The Apache Log4j2 library in this release is updated to version 2.17.1.
For the Log4j2 vulnerability, as an additional, in-depth defense measure, IQ Bot Version 11.3.5.6 includes
the parameter (-Dlog4j2.formatMsgNoLookups=true) for all the applicable Windows services. There
will be no impact to IQ Bot 11.3.5.x users who have already implemented this parameter change.
IQ Bot Version 11.3.5.6 is compatible with the latest Control Room 11.3.5.x version, which addresses the
exposure to the Apache Log4j. Additionally, this IQ Bot version is also compatible with all the Control Room
versions that were compatible with Version 11.3.5.5.
For additional information on the parameter change, see Automation Anywhere Enterprise 11.x | Update
regarding CVE-2021-44228 related to 0-day in the Apache Log4j2 Java library (A-People login required).
Подробнее см. в разделе FAQs related to Automation Anywhere Releases regarding zero-day vulnerabilities
(CVE-2021-44228, CVE-2021-45046) (A-People login required).

Review the disclaimer document included in the IQ Bot Version 11.3.5.6 build for more information.

IQ Bot Version 11.3.5.5 — заметки о выпуске
Review the new features, changed features, and fixed features in Version 11.3.5.5 of Automation
Anywhere IQ Bot. There are no security fixes in this release.

Новые функции

Default validations for a group
When editing a learning instance, you can now use the Select the default validations group
drop-down menu to select an available group. The custom logic and validations for the selected
group will apply to all new group documents in production.
IQ Bot 11.x: Edit a learning instance

Измененные функции

Change in encryption protocol support (Service Cloud case ID: 00687856, 00707964)
IQ Bot now supports only TLS 1.2 and higher.

Python library upgrade (Service Cloud case ID: 00760960, 00812130)
IQ Bot now uses Python version 3.9.5 for data extraction.

Node.JS upgrade (Service Cloud case ID: 00737129, 00764459, 00791511)
IQ Bot now uses Node.JS version 10.24.1.
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RabbitMQ upgrade (Service Cloud case ID: 00771128, 00812131, 00795363)
IQ Bot now uses RabbitMQ version 3.8.16.

Исправленные функции

ID обращения к облачному
сервису

Описание

00668412, 00644948,
00717414

When you upload a document to a learning instance in production,
IQ Bot now runs without failures caused by deadlocks.

00702139 When you are loading the dashboard, editing a learning instance,
or extracting results to a CSV, the page no longer freezes.

-- You can now successfully add fields to a learning instance that is
on a cluster and click Save. Previously, an error caused the Edit
learning instance page to be stuck on the Updating instance
 and uploading documents screen.

00651057 IQ Bot can now connect to Control Room Ignite cache without any
errors. This fixes the issue that previously caused IQ Bot to not
display all learning instances.

-- You can now access IQ Bot after a fresh installation without
issues. Previously, there was a communication issue between IQ
Bot and Control Room.

00784016 The Upload API now supports requests that contain /gateway in
the request path.

00728523 When you add a field to a learning instance, the change is now
reflected in all the existing боты for that learning instance.

00795424, 00723586 When you move a learning instance between environments,
unclassified data is no longer exported.

Известные ограничения

Sometimes, the PDFBox is unable detect PDF (Portable Document Format) documents accurately.
We recommend that you first convert the documents into PDF using Adobe Acrobat before
uploading it to IQ Bot.

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.

© 2023 Automation Anywhere. All rights reserved.     35



    Automation Anywhere - IQ Bot — заметки о выпуске

Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.

IQ Bot Version 11.3.5.4 — заметки о выпуске
Дата выпуска:03 марта 2021 г.

Изучите информацию об измененных функциях, исправленных функциях и известных ограничениях
в Automation Anywhere IQ Bot Version 11.3.5.4. В этом выпуске нет новых функций или исправлений в
системе безопасности.

Измененные функции

Последовательная обработка документов (ID обращения к облачному сервису:
00662968, 00665331)
Используйте параметр Посмотреть результаты извлечения в IQ Bot, чтобы открыть
запрос в новой вкладке браузера, где отображается номер в очереди. Это число уменьшается
по мере обработки предыдущих запросов в очереди.

Поддержка нидерландского языка (ID обращения к облачному сервису: 00694020)
IQ Bot теперь поддерживает нидерландский язык с ABBYY FineReader Engine.

Усовершенствование утилиты миграции
Когда вы теперь экспортируете файл архива IQ Bot (.iqba), экспортируется только один
документ, связанный с каждым доступным (групповым) обучением бот. Это значительно
уменьшает размер файлов .iqba для экспорта.

Усовершенствование Валидатор:возобновление сеанса
Теперь каждый раз, когда вы вносите изменения в Валидатор, IQ Bot сохраняет ваши данные
в локальном хранилище. Если сеанс прервется, вы сможете возобновить его и продолжить
работу с тем же документом после повторного входа. Эти данные сохраняются до тех пор,
пока все документы не будут либо сохранены, либо отмечены как недействительные.

© 2023 Automation Anywhere. All rights reserved.     36



    Automation Anywhere - IQ Bot — заметки о выпуске

Исправленные функции

ID обращения к облачному
сервису

Описание

-- Если вы выбрали какое-либо поле на экране Валидатор, выбор
этого поля больше не отменяется при щелчке или выборе
области, определяемой системой (SIR).

00636899, 00683451 При создании обучаемого экземпляра с помощью
пользовательского домена имена полей теперь отображаются
правильно, независимо от языка пользовательского домена.

00657928, 00679540 Экспортированные файлы архивов IQ Bot (.iqba) больше не
содержат записей, у которых classificationID = -1.

00658245, 00459301,
00677204, 00532325

Пользовательская логика Python теперь отображает
результаты извлечения в окне Designer без ошибок.

00408482 Теперь вы можете успешно экспортировать пользовательский
домен, созданный с помощью корейского или другого
азиатского языка.

00687535, 00666456,
00686297

Теперь службы машинного обучения IQ Bot правильно
устанавливаются при установке IQ Bot.

00679790, 00648013,
00670191

Теперь вы можете переносить, экспортировать, импортировать
или загружать файлы резервных копий экземпляров обучения
IQ Bot (.iqba) размером до 1 ГБ. Это применимо к обучаемым
экземплярам, содержащим до 100 групп по 10 МБ каждая.

00668412 Документы, которые вы загружаете в производственную
среду, теперь эффективно передаются в Валидатор. Ранее
документы иногда не отправлялись в Валидатор из-за
взаимоблокировок, возникавших в системе.

Известные ограничения

(ID обращения к облачному сервису: 00715124)
Когда вы загружаете в обучаемый экземпляр документы промежуточной или
производственной среды, в папке C:\Windows\Temp создаются временные файлы, и с
течением времени размер папки может увеличиваться. Поэтому вручную удаляйте файлы из
этой папки, так как это может привести к тому, что IQ Bot перестанет отвечать.

Иногда обучаемый экземпляр может не появиться в Enterprise Client.
Обходное решение. Удалите Enterprise Client и выполните повторную установку.

Если работающий параллельно пользователь удаляет бот, IQ Bot не ограничивает действия
другого работающего параллельно пользователя по перемещению бот в промежуточную или
производственную среду.
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Иногда после новой установки IQ Bot не может подключиться к Control Room, и при входе
в IQ Bot отображается следующее сообщение об ошибке: «Ошибка при подключении к
Control Room. Повторите попытку входа».
Обходное решение.
1. Отмените регистрацию IQ Bot в Enterprise Control Room.
2. Перезапустите службы IQ Bot.
3. Повторно зарегистрируйте IQ Bot в Enterprise Control Room.

Если вы попытаетесь обработать документ PDF с помощью pdfboxOCR, то SIR будут
неправильно размещены на флажках.
Обходное решение. Отключите параметр pdfboxOCR при создании обучаемого
экземпляра.

Если в Валидатор метка поля перекрывается с SIR флажка, то область SIR флажка не может
быть выбрана.
Обходное решение. Нарисуйте поверх SIR флажка вместо того, чтобы выбирать
идентифицированное поле SIR.

(ID обращения к облачному сервису: 00634155) Если размер файла IQBA превышает 2 ГБ
или если ваши обучаемые экземпляры содержат более 200 групп по 10 МБ каждая, миграция
может завершиться сбоем.
Обходное решение. См. раздел Migration of learning instance is not getting completed if the IQBA is
more than 2GB (A-People login required).

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.
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IQ Bot Version 11.3.5.3 — заметки о выпуске
Изучите информацию об измененных функциях, исправленных функциях и известных ограничениях
в Automation Anywhere IQ Bot Version 11.3.5.3. В этом выпуске нет новых функций или исправлений в
системе безопасности.

Измененные функции

View confidence level of extracted fields (Service Cloud case ID: 00648941)
You can now view the confidence level of the fields extracted using the Tesseract OCR and Tegaki
API OCR engines in IQ Bot. This information is available in a JSON file in the following output
directory: C:\Users\Public\Documents\Automation Anywhere IQBot Platform
\Output\<Learning Instance>\.
IQ Bot 11.x: Improve output quality using OCR confidence

Automatically detect check box
IQ Bot can now automatically detect check boxes and radio buttons in a document. You can enable
this feature when creating a learning instance.
• With this feature enabled, during training, if you select check box from the data type drop-

down list and then you select the field value, only the check box segments are displayed.
• This feature does not work when the PDFBox option is enabled.

IQ Bot 11.x: Создать экземпляр для обучения | IQ Bot 11.x: Disable PDFBox option

Tegaki API OCR improvements
IQ Bot now uses enhanced Tegaki API OCR segmentation to improve accuracy in the following
scenarios:
• Multiple fields are merged into a single SIR
• Segmentation on empty spaces
• Overlapping SIRs
• Incorrectly located SIRs
• Partial or incorrectly captured values from SIRs

IQ Bot 11.x: Использование модуля Распознавание текста (OCR) Tegaki API

Custom encryption key (Service Cloud case ID: 00656823)
During a new installation of IQ Bot, you can now specify a custom encryption key.
IQ Bot 11.x: Установка IQ Bot в пользовательском режиме

Performance improvement (Service Cloud case ID: 00629302)
IQ Bot now takes significantly less time to create a бот for groups containing only production
documents.
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Timeout limit for extracting data from tables (Service Cloud case ID: 00674110, 00662968,
00679587)
Data extraction from a table sometimes stops working indefinitely if the training is not done
correctly. To avoid such a scenario, the timeout limit for table data extraction is set to 30 minutes.
After the timeout (30 minutes), the document is moved to Валидатор with empty table rows,
where you can manually add the data.

Исправленные функции

ID обращения к облачному
сервису

Описание

00653929 With segmentation improvements, you can now train Korean
language documents using the Tegaki API OCR engine without any
system-identified region (SIR) errors.
IQ Bot 11.x: Использование модуля Распознавание текста (OCR)
Tegaki API

00430923, 00618234,
00636422, 00662137,
00478986, 00414921

All uploaded documents are now rendered correctly, irrespective
of their content orientation while uploading, which enables you
to train them without encountering any issues. Previously, when
you created a learning instance, documents that did not have the
correct content orientation (they were upside down or tilted) could
not be trained.

00639117 Numeric format in the Polish language is now accepted in Designer
and Валидатор.
IQ Bot 11.x Designer validation patterns

00590165 Fixed an issue that caused the following error: Cannot read
property 'startPx' of undefined. You can now see the
extraction results and save your documents without any errors.
IQ Bot 11.x: Preview extracted data

00500914 The TesseractLog.log file is now available in the following
directory: C:\Users\Public\Public Documents
\Automation Anywhere IQBot Platform\Logs\Engine\

The log level is set to error by default. You can change this
setting in the CognitiveServiceConfiguration.json file.

00445378 You can now create and edit learning instances even if the role
name consists of Unicode characters in Chinese, Japanese, and
Korean languages.

00459301, 00677204,
00532325

Пользовательская логика Python теперь отображает
результаты извлечения в окне Designer без ошибок.

00619139 When you now run a бот and try to edit it while it is still running,
the following correct message is displayed: Staging Documents
for this Vision bot is in progress. Please try
after some time. Previously, the following incorrect message
was displayed: Learning instance not found
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ID обращения к облачному
сервису

Описание

00668625 When you upload documents containing digital signatures to
learning instances, Designer now displays the correct success or
error message.

-- When you now select Hide successful fields, successful table
fields are accurately hidden.

00663790 Performance is now improved for the projects listing page.

00672470, 00650232,
00542411, 00605607,
00595731

After validating the fields of production documents, you can now
use the Save current document option to save all the validated
document, without any error messages.

-- Fixed an issue that caused a higher API response time when more
than 20 users tried to access IQ Bot.
You must add the ignite.security.disable=true property
in the cluster.properties file.
Create or update cluster.properties file

00672702 You can now export and import backup (.iqba) files successfully
even if the data entered in the Валидатор contains spaces or tabs.

00669197, 00681599 Node.js is now upgraded to version v10.22.1 to fix a security
vulnerability.

00662968 Sometimes, when you click See Extraction Results and the
preview fails, IQ Bot now correctly displays the following error
message after a timeout of 2 minutes: Error occurred while
extracting the document. Please re-check the
training/document. Previously, when the preview failed, the
page kept loading indefinitely.

00644948 When you now upload a document in production, deadlocks no
longer occur in the system and documents are correctly sent to
the Валидатор.

Известные ограничения

In a cluster setup, sometimes after training, when you click See Extraction Results, the preview
page does not load and the system displays an Internal Server Error message.

IQ Bot Version 11.3.5.3 is a full installer and not a patch release. Therefore, to import learning
instance backups to Version 11.3.5.3, the backup (.iqba) file must be exported only from Version
11.3.5.3.

Processing time for bulk documents (4000 approximately) takes longer than before because IQ Bot
now fixes the orientation of documents first before processing them.
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When the value entered for GroupDocumentThreshold in the settings.txt file is zero (0) or
negative, the Threshold to create new groups field does not display the default value of 10 in
the Learning Instances > Summary page.
The settings.txt file is available in C:\Program Files (x86)\Automation Anywhere
 IQ Bot\Configurations folder.

If you create a learning instance with Checkbox auto-detection enabled, check box SIRs cannot
be selected.
Обходное решение. Нарисуйте поверх SIR флажка вместо того, чтобы выбирать
идентифицированное поле SIR.

When you install IQ Bot with a custom key, documents might not be classified if they are used with
Microsoft Azure or Google Vision API.

Sometimes, when you train a бот and verify the extracted data, and then if you retrain that бот and
view the extraction results again, the preview might fail but the cached extraction results are still
displayed.

When you upload a document to production immediately after deleting a бот it was associated
with, extraction results are not displayed.
Обходное решение. Use one of the following options:
• Select the Disable cache option in the Network tab.
• Ensure you wait at least 3 minutes between deleting the бот and uploading the document.
• Empty the cache and reload the page.

Sometimes, if a бот is not trained correctly and the preview fails, IQ Bot does not display an error
and the page keeps loading.

When two users try to access a бот for a learning instance at the same time, IQ Bot redirects
the user to the learning instances listing page and displays an error message there instead of the
learning instance details page.

When a user with a custom role with all permission except View learning instance from the
same role and Launch Validator clicks Save and go to next group, IQ Bot displays an
Access Denied error. However, the group information is saved.

In the Designer, if a segment drawn over a field maps less than 50% of the total area of that field,
the field value is displayed in the Designer.

If you are using Internet Explorer, you cannot save a document or mark it as invalid in the learning
instances validator screen.
Обходное решение. Use the Google Chrome browser to access the learning instances validator
screen.

Sometimes, IQ Bot does not display an error when you enter a date in an invalid format in the
Валидатор.
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When IQ Bot is installed with Microsoft SQL Azure (RTM) database, and if the IQ Bot application
and database servers are in different sub-networks, the Healthcheck API returns NOT_OK for
the alias service due to network latency.
Обходное решение.
1. Open the C:\Program Files (x86)\Automation Anywhere IQ Bot\Services

\Application.yaml file.
2. Update the following attributes to increase the healthcheck timeout period to 10000 from the

current 5000:
connect-timeout: 1000

read-timeout: 10000

During a new installation, IQ Bot does not restrict a user from including spaces in the custom
encryption key.

When you export a learning instance, the status is not displayed on the Migration page until you
manually refresh the page data.

When table fields are validated in the Валидатор, the user is navigated to the associated page for
that field but the SIRs are sometimes not displayed.
Обходное решение. Navigate to the page by entering the page number in the pagination bar.

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.
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IQ Bot Version 11.3.5.2 — заметки о выпуске
Review the new features, changed features, fixed features, and known limitations in Version 11.3.5.2 of
Automation Anywhere IQ Bot. There are no security fixes in this release.

Новые функции

Control creation of groups
Use the New groups creation setting section in the Learning Instance > Edit page to limit
creating groups when uploading training documents to IQ Bot. Use the Threshold to create new
groups value and Never create new groups check box to define the parameters.

Боты

Измененные функции

Search by filename in Валидатор
(ID обращения к облачному сервису: 00372981)
Use the Search by filename field in the Validator screen to search a document in IQ Bot.

Валидатор enhancements

Import custom domains from the staging to the production server in any order
(ID обращения к облачному сервису: 00472445)
You can now edit and update an existing custom domain multiple times and import them to the
production server multiple times, in any order, before importing the learning instances. After
importing the learning instances, the system classifies all documents in the production server
correctly, allowing successful processing of documents.
Custom Domain in IQ Bot

Исправленные функции

ID обращения к облачному
сервису

Описание

00551886 Unicode issue with table validation for Asian languages is now
resolved.

-- A validation error message along with the corrected field is now
displayed in the output (.csv) file for documents validated using
ValidatorURL.

00605607 When you click Save current document in the validator
screen, the document is now saved without any errors and the
corresponding .csv file is created in the output folder.
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ID обращения к облачному
сервису

Описание

00376179 The Automation Anywhere Cognitive Project is now created
without any errors even when you use the IQ Bot batch files to
install or uninstall.

00702139 IQ Bot no longer becomes unresponsive when you edit an existing
learning instance.

Известные ограничения

To import learning instance backups on an IQ Bot Version 11.3.5.2 environment, the backup (.iqba)
file must be exported from an IQ Bot Version 11.3.5.2 environment only. Therefore, you must also
upgrade your source IQ Bot environment to Version 11.3.5.2. This requirement is due to changes
made in database schemas and version information in the backup (.iqba) files.

When you click the Save and go to next group option, the available groups or the learning
instances are sometimes not displayed.

(ID обращения к облачному сервису: 00565803)
If the time spent in validating different groups varies substantially, the Y-axis (depicting time) in
the Validation chart sometimes does not display data accurately. You can hover over the bar for
individual groups to view the time spent in validating that group.

When the value entered for GroupDocumentThreshold in the settings file is zero or negative,
the Threshold to create new groups field does not display the default value of 10 in the
Learning Instances > Summary page.

Due to some enhancements in IQ Bot Version 11.3.5.2, Microsoft Azure (RTM) Database is not
compatible with this version.

(ID обращения к облачному сервису: 00753319)
If you are running IQ Bot using a service account credential where the password contains a space,
the IQ Bot logs will not update.

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
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Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.

IQ Bot Version 11.3.5.1 — заметки о выпуске
Review the new features, changed features, fixed features, and known limitations in Version 11.3.5.1 of
Automation Anywhere IQ Bot. There are no security fixes in this release.

Новые функции

Delete бот option in IQ Bot Designer (Service Cloud case ID: 00096258, 00595526)
Users with Edit бот permission can view and use the Delete bot option in the Designer. After a
бот is deleted from the system, it will not be displayed in the Learning Instance or Bots listing
pages.
IQ Bot removes all document details from staging, and all unprocessed production documents are
moved to the Валидатор.

Прим.:  The Migration Utility > Import/Export functionality is not affected in any way by the
Delete бот feature.

Delete a bot

Alert for successful or pending document validations
Document validation status is now displayed on the Learning instances page. A green icon is
used for all successful document validations, and a red icon shows any pending validations.

Измененные функции

Extract data from a table that spans across multiple pages (Service Cloud case ID:
00572574, 00341694)
IQ Bot can now extract data successfully from an entire table that spans across multiple pages and
that has a table header only on the first page.
IQ Bot 11.x: Map a table

Валидатор enhancements (Service Cloud case ID: 00470258)
You can now hide the Skip to next file and Mark as Invalid options using configuration settings.
The options are currently enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00552830 You can now use the unique validation link to access documents
without any errors.

00574815 Documents are now correctly classified irrespective of the
document type.

00371795 When you use table extraction from a document with multiple
tables, the data from the specified table is now extracted correctly.

00538480 The Options method is now disabled for HTTP requests.

00538480 Cross origin resource sharing is now restricted in IQ Bot.

00551886 Unicode issue with table validation for Asian languages is now
resolved.

00421067 The activities time stamp is now captured correctly in the Control
Room Audit Logs tab.

Известные ограничения

If you create a learning instance and click Learning instances > Edit, a blank page is displayed.
Обходное решение. Clear your browser cache and try to edit the learning instances.

If you log in to the Control Room as an IQ Bot administrator, a 502 system error is displayed
when you click the IQ Bot tab in the navigation bar.

In Internet Explorer, you cannot save a document or mark it as invalid in the learning instances
validator screen.
Обходное решение. Use the Google Chrome browser to access the learning instances validator
screen.

If you remove a бот (Delete a bot) associated with the document from the staging environment,
you must create a group before uploading this document to the production environment. However,
after deleting the бот from the staging environment, you cannot create or edit the group when you
upload the same document to the production environment.

(ID обращения к облачному сервису: 00605607)
When you draw a box to select text in the Validator and try to save the document, it is sometimes
not saved, and the corresponding .csv file is not created in the output folder.

(ID обращения к облачному сервису: 00737991)
When you are creating a learning instance and training your document, the IQ Bot system cannot
extract data from tables with the same Header Name and Column Value.
Обходное решение. Try combining Header Name or Column Value with the adjacent
column. Additionally, you can provide a Python postprocessing script to separate the values during
extraction.
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Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.

IQ Bot Version 11.3.5 — заметки о выпуске
Review the new features, changed features, fixed features, and known limitations in Version 11.3.5 for
Automation Anywhere IQ Bot. There are no security fixes in this release.

Новые функции

Select an Распознавание текста (OCR) engine when creating a new learning instance
You can now select different Распознавание текста (OCR) engines directly from the UI based on
your requirements for data extraction from specific document types when creating a new learning
instance. You do not have to stop and restart IQ Bot services for implementing the engine change.
A new OCR Engine column is available in the My learning instance page that shows the
different Распознавание текста (OCR) engines used to create each learning instance. You can use
this information when deciding on document processing and to track the different Распознавание
текста (OCR) engines at a glance, after importing the learning instances.
IQ Bot 11.x: Selecting an Распознавание текста (OCR) engine

Pre-installation check
The IQ Bot installer now checks for dependent software and required ports before starting the
installation process. The installer displays any software that is running an incompatible version and
dependent ports that are being used by other services.
The installer also provides you the option to run the pre-installation check again and continue the
installation process.
IQ Bot 11.x: Installing IQ Bot in Express mode | IQ Bot Custom installation
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(Beta) Enable data capture and Распознавание текста (OCR) extraction for Asian
languages using Tegaki API Распознавание текста (OCR) engine
Use the Beta version of the Tegaki API Распознавание текста (OCR) engine with IQ Bot to improve
the accuracy of the Распознавание текста (OCR) (optical character recognition) results for training
documents in Asian languages, particularly in Japanese and Korean. Tegaki API files are installed
on your machine automatically during IQ Bot installation. However, you have to use your private
license keys to use this engine.
IQ Bot 11.x: Использование модуля Распознавание текста (OCR) Tegaki API

Измененные функции

Enable or disable PDFBox option
You can enable or disable the My PDF documents do not have images check box directly in the
UI when creating a learning instance. Previously, users had to configure the Settings.txt file.
IQ Bot 11.x: Disable PDFBox option

Use Google Vision API GA version
Besides providing better accuracy for Asian languages, Google Vision API can now be used for all
languages supported by this Распознавание текста (OCR) engine.
IQ Bot 11.x: Use Google Vision API OCR engine

Support for ABBYY FineReader Engine versions 12.2 and 12.3
When you install IQ Bot Version 11.3.5, ABBYY FineReader Engine version 12.3 is installed as
the default version. However, the product supports all learning instances created using ABBYY
FineReader Engine versions 12.2 and 12.3.
Use ABBYY FineReader Engine Распознавание текста (OCR) engine in IQ Bot 11.x

Role-based access control (RBAC) enhancements
IQ Bot now allows more granular access control over various learning instance actions to different
groups of users. Users can achieve this by allocating or deallocating custom roles to learning
instances. A new permission Assign Roles is introduced in Control Room Version 11.3.4.3 to
enable this action.
Define access to learning instances using custom roles
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Валидатор enhancements
Some of the Валидатор enhancements are as follows:
• You can now hide the Skip to next file and Mark as Invalid options using configuration

settings. The options are currently enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

• You can now hide the Hide successful fields and Hide optional fields options using
configuration settings. The options are enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

Прим.:  Selecting the Hide successful fields and Hide optional fields check boxes hides
all the valid fields and reduces the display of a large number of fields, thus making correction
easier. However, if there is an invalid field, it continues to be displayed because the invalid field
requires correction.

• Clicking in any column field expands the column width to accommodate the text entry. The
Валидатор shows the value of the field that is being validated, in the document.

• Draw an area around single or multiple values in the document image to automatically populate
a field in the Валидатор. This function is similar to the Designer.
Text segment

Исправленные функции

ID обращения к облачному
сервису

Описание

00474578 During the migration of learning instances between different
environments, the group description for each learning instance
is now carried over successfully, and users can easily identify the
group details and document type in a specific classification group.

-- When a user changes permission for a specific role in the Control
Room, the IQ Bot page is now automatically refreshed and
implements the permission update.

00451917 If import with append for a modified learning instance fails, IQ Bot
now shows an appropriate error message, and learning instance
migration works as expected with the append option.

00440868 IQ Bot classifies documents as expected even when the aliasName
length exceeds 75 characters.

A CSV file is now generated with the right content on the
validation page for large documents.

00492446 Learning instances with 100 and more fields now load faster, so
users can train or validate them without delay.

00481720 The Service account user password can now include special
characters. The service account will not be locked and all the IQ
Bot services will start successfully after an installation, irrespective
of whether the password has special characters.
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ID обращения к облачному
сервису

Описание

00348696 After login, when you change the UI display language to Japanese,
the UI translations in the selected language display correctly. The
translations did not display accurately in IQ Bot Version 6.5.

-- After any node is removed from a cluster, the cookies are no
longer stored in the environment variable. This enables a clean re-
installation.

00248270 The Learning Instance details page loads as expected.
Previously, there was a delay in loading the page.

-- When you create learning instances with permissions for the role
View the learning instances having the same role, you
can now see learning instances created by your user role only.
Previously, you were able to see learning instances created by
other users as well.

-- The learning instance details page now correctly shows all
data for a бот and the available options. Previously, the system
displayed the following message: No current groups in
this instance.

00339407 Draw box functionality for field labels now ensures that the
selected value is treated as an entire word rather than distinct
characters. You can now select multiple system identified regions
(SIRs) or a specific part of a single SIR from a field label, which
enables accurate data extraction in the IQ Bot Designer.

00599162 You can now download archive (.iqba) files for successfully
processed documents using an API client without any errors even
if the archived learning instances contain spaces in their names.

Известные ограничения

You have to manually refresh the Learning Instances page in IQ Bot to apply and update any
permission changes made in the Control Room.

When uploaded file names have spaces in them, any attempt to delete or archive learning instances
using the delete or archive API end points fails, showing an error message.

After installing IQ Bot, when you try to log in, the web page shows an "Access token
expected in the 'X-Authorization' header" message instead of the dashboard.

Прим.:  Restart the Automation Anywhere Control Room Reverse Proxy service to resolve this
issue.

In the IQ Bot installer, the scroll bar for the pre-check screen that shows a list of all ports, services,
and software dependencies for the installation is not displayed.

Прим.:  This is a limitation of the InstallShield tool.

Sometimes, when editing a бот, when you click Test Run, the custom logic script fails to run and
no error message is displayed.
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(ID обращения к облачному сервису: 00605607)
When you draw a box to select text in the Validator and try to save the document, it is sometimes
not saved, and the corresponding .csv file is not created in the output folder.

Понятия, связанные с данным
IQ Bot — заметки о выпуске
This document for IQ Bot describes new capabilities, changed and migrated features, fixed features,
technical updates, and known limitations for each version.
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.

IQ Bot Version 11.3.4.3 — заметки о выпуске
The Version 11.3.4.3 release includes the fix for Apache Log4j2 vulnerability. There are no new features,
changed features, fixed features, or known limitations in this release.

Security fix

This release addresses the exposure to the Apache Log4j CVE-2021-45105, CVE-2021-45046,
CVE-2021-44228, and CVE-2021-44832 vulnerabilities.

Important:  We have updated IQ Bot Version 11.3.4.3 to include the fix for the Apache Log4j2
component vulnerability. The Apache Log4j2 library in this release is updated to version 2.17.1.
For the Log4j2 vulnerability, as an additional, in-depth defense measure, IQ Bot Version 11.3.4.3 includes
the parameter (-Dlog4j2.formatMsgNoLookups=true) for all the applicable Windows services. There
will be no impact to IQ Bot 11.3.4.x users who have already implemented this parameter change.
IQ Bot Version 11.3.4.3 is compatible with the latest Control Room 11.3.4.x version, which addresses the
exposure to the Apache Log4j. For more information on IQ Bot and Control Room version compatibility, see
IQ Bot version compatibility matrix

For additional information on the parameter change, see Automation Anywhere Enterprise 11.x | Update
regarding CVE-2021-44228 related to 0-day in the Apache Log4j2 Java library (A-People login required).
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Подробнее см. в разделе FAQs related to Automation Anywhere Releases regarding zero-day vulnerabilities
(CVE-2021-44228, CVE-2021-45046) (A-People login required).

Review the disclaimer document included in the IQ Bot Version 11.3.4.3 build for more information.
Понятия, связанные с данным
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Задачи, связанные с данной
Upgrading system to IQ Bot 11.x
As enhancements and bug fixes are provided with Version 11.3.4.3, use this topic to review the upgrade
instructions.
Ссылки, связанные с данной
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.

IQ Bot Version 11.3.4.2 — заметки о выпуске
Review the changed features, fixed features, and known limitations for IQ Bot Version 11.3.4.2 patch
release. В этом выпуске нет новых функций или исправлений в системе безопасности.

Измененные функции

Performance improvements
Further performance improvements are introduced in this release for handling concurrent users and
page load time over IQ Bot Version 11.3.4.1 patch release.

Исправленные функции

You can now access a particular document in the Валидатор using the Validator URL API.

Известные ограничения

If you have installed the IQ Bot Version 11.3.4.1 patch, you must uninstall it before installing the
Version 11.3.4.2 patch.
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After installing or uninstalling any IQ Bot Version 11.3.4.x patch, the desktop shortcut will not work.
Follow the prerequisite steps provided in the upgrade topic: Upgrade from IQ Bot Version 11.3.4 to
Version 11.3.4.x patch.

The auto-correction and auto-suggestion features, which are part of the MLScheduler service, use
system resources extensively and cause the system to slow down or stop responding.

Задачи, связанные с данной
Upgrade from IQ Bot Version 11.3.4 to Version 11.3.4.x patch
Install an IQ Bot Version 11.3.4.x patch on your IQ Bot Version 11.3.4 system.

IQ Bot Version 11.3.4.1 — заметки о выпуске
The release notes describes new capabilities and changed features for IQ Bot Version 11.3.4.1.

Новые функции

IQ Bot Version 11.3.4.1 new features

Функция Описание

New IQ Bot patch installer Users can now install the updated patch files
using the new patch installation process.
Uninstalling the patch reverts IQ Bot to the base
version.
Пример. IQ Bot Version 11.3.4 is the base
version, and the patch updates IQ Bot to version
Version 11.3.4.1.
Upgrade from IQ Bot Version 11.3.4 to Version
11.3.4.1 patch release

Измененные функции

IQ Bot Version 11.3.4.1 changed features

Функция Описание

IQ Bot performance enhancement IQ Bot caches some static and semi-static
data from API calls for some time to improve
performance.
Data for these static API calls are stored
(cached) in the browser for short periods of
time. Subsequently, when API calls for that same
data are made within the caching time span, the
browser responds immediately with the cached
data.
Users should be able to see the latest refreshed
data within two minutes.
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Исправления в системе безопасности

There are no security fixes in this version.

Deprecated features

There are no deprecated features in this version.

Известные ограничения

During the Version 11.3.4.1 patch uninstallation process, the IQ Bot services are stopped and uninstalled.
After the process is complete, the services are reinstalled and restarted.
Понятия, связанные с данным
IQ Bot operating system compatibility
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix
The table provides information about the databases that are compatible with the different IQ Bot releases.
IQ Bot hardware and software requirements
Make a note of the following hardware and software requirements before installing IQ Bot.
Required database information for IQ Bot installation
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
Задачи, связанные с данной
Uninstall IQ Bot Version 11.3.4.x patch
Follow these steps to uninstall Version 11.3.4.x patch.
Ссылки, связанные с данной
Рекомендации по обновлению
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot
Compare features between different product releases.

Version 11.3.4 Release Notes for IQ Bot
The release notes for IQ Bot Version 11.3.4 describes new capabilities, changed features, fixed features
(resolved issues), security fixes, deprecated features, and known behavior or limitations.
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Новые функции

IQ Bot Version 11.3.4 new features

Функция Описание

(Beta) Enabled data capture and OCR
using Google Vision API for Asian
languages

Use the Beta version of the Google Vision API
with IQ Bot to improve the accuracy of the
optical character recognition (OCR) results
for training documents in Asian languages,
particularly in Japanese and Korean. Google
Vision API files are installed on your machine
automatically during IQ Bot installation.
IQ Bot 11.x: Use Google Vision API OCR engine on
page 126

Magnetic ink character recognition (MICR)
extraction

Use the MICR OCR feature with ABBYY
FineReader Engine v12.2 to extract MICR data
from financial checks.
IQ Bot 11.x: Extract data using magnetic ink
character recognition on page 196

Option to turn off PDFBox as OCR engine Users have the option to turn off the PDFBox
value to false to use the extraction functionality
of the selected OCR engine such as Tesseract4
OCR, ABBYY FineReader Engine, and Microsoft
Azure API. Disabling the PDFBox OCR optimizes
extraction from hybrid documents that have a
mix of images and digital values.
IQ Bot 11.x: Disable PDFBox option on page 197

Измененные функции

IQ Bot Version 11.3.4 changed features

Service Cloud ticket number Описание

Enterprise Control Room > Administration
> Settings IQ Bot

When a user tries to register IQ Bot with the
Control Room, the system now shows an error
message if you enter an incorrect URL.

UI auto-refresh in IQ Bot is disabled The system does not automatically refresh
(auto-refresh) the IQ Bot UI, unless the user
loads a screen or clicks Refresh to manually
refresh data on a page. This feature helps
reduce the response time for loading new data
or performing any action in IQ Bot.
Refresh data in Learning Instance details page on
page 159
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IQ Bot Version 11.3.4 changed features

Service Cloud ticket number Описание

- - Previously, the user had to select the certificate
from a provided list. Now, during the installation
process:
• The CA.crt is automatically created in the

<installation path>/Portal/keys
folder.

• The public certificate is added to the Java
keystore in <installation path>\JRE
\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\lib\security\cacerts.

- - No updates are required in the
cluster.properties file for IQ Bot Version
11.3.4 to work with earlier versions.
IQ Bot version compatibility matrix on page 8

Исправленные функции

IQ Bot Version 11.3.4 fixed features

Service Cloud ticket number Описание

- - After correcting the field values in the
Валидатор when a user saves the changes, the
Валидатор updates only the edited values. The
IQ Bot Dashboard now displays the correct
accuracy value for that learning instance.

- - After you correct a field value, the ML suggestion
works as expected and provides suggestions for
that field value in other documents as well. The
user is able to select the ML suggested value on
the first click.

- - The system now generates a valid response
for the AAE_IQ Bot Admin role when accessing
dashboard accuracy details for a specific project
ID.

00417631 / 00423076 Uploading a document with a long file name
does not return an empty learning instance
success folder anymore. Instead, the file name is
now visible and is successfully processed to the
success folder.

- - HTTP response header settings related to
security vulnerability are now fixed.
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IQ Bot Version 11.3.4 fixed features

Service Cloud ticket number Описание

- - A user can now successfully install a later version
of IQ Bot even if an existing Version 11.3.3 is
installed on their machine. The system does not
create duplicate data in the contentclassification
table. In case duplicate data is created, the
system displays an error message and rolls back
the installation. The user then has to manually
verify and remove the duplicate data from the
contentclassification table.

00358689 The user can no longer see the system-
created temporary files after the processing of
documents in the IQ Bot server.

Исправления в системе безопасности

Critical security fix: TLS 1.2 is required for
HTTPS connections to IQ Bot

To maintain security standards and promote the
safety of data, the earlier TLS 1.1 encryption
protocol is disabled in IQ Bot. Starting with Version
11.3.4, all inbound connections to IQ Bot must use
TLS 1.2.
Users must verify that their browsers are compliant
with TLS 1.2.

Deprecated features

There are no deprecated features listed for this version.

Известные ограничения

IQ Bot Version 11.3.4 known limitations

Service Cloud ticket number Описание

- - If the value of PDFBoxOCREnabled is set
to False in the settings.txt file, some
multilingual documents do not get classified.

00356534 IQ Bot does not support migration of learning
instances created using custom domains, unless
the custom domains were imported in the same
order, and the field IDs between the source and
target system match.
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IQ Bot Version 11.3.4 known limitations

Service Cloud ticket number Описание

- - With Google Vision API OCR, for accurate value
extraction, use training documents that are
single language only.
Пример. Documents cannot have a mix of
Japanese and English language fields. They must
be fully Japanese only.

- - The system is unable to generate CSV files with
the appropriate extraction results for documents
with more than 10 to 15 pages that are sent for
validation.

- - The Бот training page displays the бот ID in the
URL. If a user manually changes the бот ID in
the URL, the system creates a new бот with that
ID instead of showing an error message.

Note:  IQ Bot does not support manual
modification of the бот ID in the URL.

- - Sometimes the user is unable to edit or add new
fields to existing learning instances in a cluster
environment. The new field is not available in
the Designer for training, as it did not get added
to the learning instance. In such cases, reach
out to support.
This does not affect learning instances in the
standalone mode.

- - The Валидатор does not stop data extraction
at the end of a table/repeated section for the
first table, but continues on to extract data from
different fields in the following tables as well.
This leads to incorrect data extraction and the
result is shown in the See extraction results
screen for the first table.

Tip:  As a workaround, we recommend using
the Advanced table options setting in the
Валидатор and enabling the Stop extraction
at "End of table indicator" check box. This
stops the table extraction at the table footer.

- - When a user tries to install a newer version of IQ
Bot, the system uninstalls any existing previous
version of the product on the user machine. The
system then installs the newer version without
displaying any notification for the user.
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IQ Bot Version 11.3.4 known limitations

Service Cloud ticket number Описание

- - When a user with an AAE_IQ Bot Admin role
tries to create a learning instance with IQ Bot
extensions, the system displays a forbidden
access with admin role message.

Tip:  As a workaround, we recommend assigning
the user with the AAE_Basic role in addition to
the AAE_IQ Bot Admin role .

- - The image invoice document classification
is inconsistent. The system deletes such
documents from the temporary folder after an
upload, which leads to results showing that no
classification occurred.

- - If a user has configured a new output and log
path in the Settings file, the system fails to
update the change. This results in the audit logs
being unavailable at the new location.

- - The data validation error checklist in the system
is not working according to defined priority, thus
impacting validation results.

- - IQ Bot is unable to generate system identified
regions (SIRs) for PDF files with multiple formats
in different pages.

Tip:  As a workaround, we recommend turning
off the PDFBox option as an OCR engine. IQ Bot
11.x: Disable PDFBox option on page 197

- - In the Learning Instance details page when
a user deletes a learning instance, and then
navigates to the Bots tab and sets the same
learning instance to production, the system fails
to display an error message stating that the
learning instance cannot be found.

- - IQ Bot is unable to identify some check boxes, or
is extracting incorrect values from some of them
from the uploaded documents.

- - The IQ Bot classifier performance is inconsistent
for the same learning instances, and for learning
instances with the same domain and custom
fields.

Related concepts
IQ Bot hardware and software requirements on page 27
Make a note of the following hardware and software requirements before installing IQ Bot.
IQ Bot operating system compatibility on page 23
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Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix on page 24
The table provides information about the databases that are compatible with the different IQ Bot releases.
Required database information for IQ Bot installation on page 26
When you install IQ Bot, you are prompted to provide information specific to the database type you are
using. The following table summarizes the required information.
Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

Version 11.3.3.1 Release Notes for IQ Bot
This topic for IQ Bot Version 11.3.3.1 describes fixed features.

Note:  IQ Bot Version 11.3.3.1 is a full release that also has new, changed, and fixed features
from IQ Bot Version 11.3.3 General Availability release. See: Version 11.3.3 Release Notes for IQ Bot
on page 63.

Новые функции

There are no new features listed for IQ Bot in this version.

Измененные функции

The installation process for upgrading to IQ Bot Version 11.3.3.1 in the custom mode requires some
specific steps. Follow the installation checklist provided in the installer zip file. См. раздел Upgrading
IQ Bot to Version 11.3.3.x on page 246.

Fixed Features

The following fixed features are listed for IQ Bot in this version.

IQ Bot Version 11.3.3.1 Fixed Features

Service Cloud ticket number Описание

14380 IQ Bot installer runs without any interruption,
as the issue that ocurred during the installation
of Python dependencies has been resolved. The
required Python packages are now provided with
the intstaller.
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IQ Bot Version 11.3.3.1 Fixed Features

Service Cloud ticket number Описание

- - The installation continues despite inconsistent
data, which is logged in the installer-helper.log
file.

14445 Users are able to access IQ Bot without any
HTTP 431 error message.

Deprecated Features

There are no deprecated features listed for IQ Bot in this version.

Known Limitations

(ID обращения к облачному сервису: 00533813, 00564190, 00572649)
При загрузке векторных PDF-документов в новый обучаемый экземпляр несколько документов
определяются как неклассифицированные. Если же преобразовать документы из PDF в TIFF и
загрузить их, эти документы будут успешно обработаны.

Related concepts
IQ Bot operating system compatibility on page 23
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
IQ Bot database compatibility matrix on page 24
The table provides information about the databases that are compatible with the different IQ Bot releases.
IQ Bot hardware and software requirements on page 27
Make a note of the following hardware and software requirements before installing IQ Bot.
Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Related information
Version 6.5.2 — заметки о выпуске on page 68
This document for IQ Bot Version 6.5.2 describes new capabilities, changed features, fixed features
(resolved issues), security fixes, deprecated features, and known behavior or limitations.
Version 11.3.3 Release Notes for IQ Bot on page 63
This topic for IQ Bot Version 11.3.3 describes new capabilities, changed features, fixed features, security
fixes, deprecated features, and known behavior or limitations.
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Version 11.3.3 Release Notes for IQ Bot
This topic for IQ Bot Version 11.3.3 describes new capabilities, changed features, fixed features, security
fixes, deprecated features, and known behavior or limitations.

Important:  To better align the new release cycles for IQ Bot with the Control Room, the versioning
convention has been streamlined to be in sync. IQ Bot version 6.6 has been renamed to IQ Bot Version
11.3.3.

Note:  IQ Bot Version 11.3.3 is the first General Availability release that also has new,
changed, and fixed features from IQ Bot Version 6.5.2 Limited Availability release. See: Version
6.5.2 — заметки о выпуске on page 68.

Новые функции

IQ Bot Version 11.3.3 New Features

Функция Описание

Стандартные формы Create learning instances that leverage custom
extraction services to process complex, fixed-
format forms (also known as standard forms)
without requiring any training.
См. раздел Стандартные формы for custom
extraction on page 226.

Import standard form domains Import domains for standard form documents
to use Стандартные формы feature. These
domains become available for use from the drop-
down list, when creating a learning instance.
См. раздел Import domains for fixed format
documents on page 227.

Internet Explorer 11 support IQ Bot Version 11.3.3 now supports Internet
Explorer 11.

Important:  When using Internet Explorer11,
you might need to Display intranet sites in
Compatible View in the Compatibility View
Settings window.

IQ Bot patch installer The IQ Bot patch installer simplifies the upgrade
and downgrade process and supports modifying
the affected files only. For minor changes you
do not have to uninstall and reinstall the IQ Bot
solution package.

Note:  To revert to the original version, uninstall
the patch.
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Измененные функции

IQ Bot Version 11.3.3 Changed Features

Функция Описание

Check box data extraction enhancement The IQ Bot check box data extraction ML model
has been retrained to capture more variations for
check boxes.

RabbitMQ v3.8.18 and Erlang/OTP upgrade IQ Bot Version 11.3.3 has been updated with
RabbitMQ v3.8.18 3.7.17 and Erlang/OTP 22.0.

Note:  IQ Bot Version 11.3.3 is also backward
compatible with the earlier versions of RabbitMQ
v3.8.18. См. раздел IQ Bot 11.x: RabbitMQ
v3.8.18 and Erlang/OTP upgrade on page 103.

Migrate learning instances as other
learning instances are being edited

An administrative user can now migrate learning
instances, even while other learning instances
are being edited.

Microsoft Azure Computer Vision OCR
engine

This feature is now official, and no longer beta.
IQ Bot has native support for Microsoft Azure
Computer Vision OCR engine.
Пример. It can help handwriting, driver licenses,
and passport extraction.

Note:  Internet connectivity is required.

Use custom logic (Python scripts) to improve
extraction

The custom logic feature is now part of the
standard IQ Bot package from this release.
There's no separate configuration required to
enable the feature.
IQ Bot 11.x: Adding custom logic to improve
automatic extraction in production on page 214

Fixed Features

IQ Bot Version 11.3.3 Fixed Features

Zendesk/Support ticket/Service Cloud Описание

- CSS vulnerability is no longer found in Veracode
scan.

Customer service: 431 Learning instances load faster than before.

Customer service: 13467 After you edit a learning instance with a large
number of bots, clicking the Back to training
button loads the Designer window.
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IQ Bot Version 11.3.3 Fixed Features

Zendesk/Support ticket/Service Cloud Описание

- When you edit a learning instance in any
group with a large number of bots, the See
extraction results > Back to training action
works faster than before.

- Uploading training files to a learning instance
using API processes works as expected.

Customer service: 551 Multi-page document navigation and processing
does not stop, but completes as expected.

Customer service: 13847 Classifier successfully processes learning
instances even with more than 2100 groups.

Customer service: 534 When you click an empty validator field on
a multi-page document in the webpages
(Designer/See extraction results/Validator), the
cursor now remains on the given page instead of
jumping back to page 1.

Zendesk: 242261 In the Designer window, when you click the See
extraction result button, the extracted results
display faster than before.

Исправления в системе безопасности

There are no security fixes listed for this version.

Deprecated Features

There are no deprecated features for this version.

Known Limitations

Note:  In addition to the known limitations in the table below, IQ Bot Version 11.3.3 General Availability
release has the known limitations listed for IQ Bot Version 6.5.2 Limited Availability release.

См. раздел Version 6.5.2 — заметки о выпуске on page 68.

IQ Bot Version 11.3.3 Known Limitations

Zendesk/Support ticket/Service Cloud Описание

Zendesk: 221115 In select use cases , with unexpected diagonal
line marks on the page, document orientation
displays incorrectly in the Валидатор.
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IQ Bot Version 11.3.3 Known Limitations

Zendesk/Support ticket/Service Cloud Описание

- In production, during batch upload of files,
sometimes an express-http-proxy error can
occur due to which one or more files can be lost.
The environment shows high-compute usage
with database Microsoft Azure SQL service.

Zendesk: 240900 Importing a learning instance with an empty
hashkey for layoutTrainSet fails.

Internet Explorer 11 When using Internet Explorer 11, icons
disappear after a page refresh. A hard refresh
(Ctrl+F5) helps fix the issue.

Customer service: 422 and 526 With ABBYY FineReader Engine in IQ Bot,
the text segments / system identified regions
(SIRs) for some documents get offset or are not
generated, creating problems with mapping.
With ABBYY FineReader Engine, for some
documents, the SIRs are not generated as
expected.

- In production, the Валидатор is unable to make
auto-suggestions for Japanese unicode, requiring
a fix to a third party library.

Service Cloud: 00342272 Classifier worker keeps on creating duplicates
of the number classifier executors, using more
system resources (primarily CPU, and secondarily
RAM) than necessary, that slows down IQ Bot.

Service Cloud: 00331297 Documents are stuck in processing without
completing classification, and an error message
is displayed.

Customer Service: 146 Optical character recognition (OCR) accuracy can
impact light colored fonts.

- The red icon and red highlighted text boxes,
indicating a validation error for a field, can
disappear if the user clicks on the field but
moves to a different field without making any
corrections.

- The IQ Bot dashboard does not always show
accurate metrics (for example, number of
documents processed) for standard forms that
get processed.

© 2023 Automation Anywhere. All rights reserved.     66



    Automation Anywhere - IQ Bot — заметки о выпуске

IQ Bot Version 11.3.3 Known Limitations

Zendesk/Support ticket/Service Cloud Описание

- During IQ Bot uninstall process, the Finish
screen displays incorrect version information of
the third party components.

- Standard form
documents in IQ
Bot:

Learning instances,
created with a domain
for standard forms,
cannot be exported/
imported with IQ Bot.

- User is able to register IQ Bot in the Control
Room with an incorrect URL.

- During the processing of IQ Bot extensions, the
blue bounding boxes do not completely cover
the extracted text.

- In the Валидатор, when correcting errors for a
IQ Bot extensions document:
• user is unable to see the highlighted value in

the document.
• on selecting a bounding box on the

document, the value does not get extracted
to the field text box.

- The Microsoft Azure Computer Vision OCR
engine returns single characters for languages
such as Japanese. That can lead to unclassified
documents in IQ Bot, if domains or learning
instances in IQ Bot rely on field names to
be multi-character words instead of single
characters.

- In the Валидатор, a user has to select the ML
auto-suggested value twice to apply it to a field
on that document.

- User could see a Окноs Defender SmartScreen
message about unrecognized app at the
start of the IQ Bot installation process. To
resolve the issue, see Windows unrecognized
application message on page 101.

- While accessing the IQ Bot dashboard, a user
with IQ Bot administrator role could get a 403
 Forbidden Error message. To resolve this
issue, ensure the user also has the AAE_BASIC
role assigned in the Control Room.

- In Валидатор, the suggested value for a field
does not get selected from the drop-down.
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IQ Bot Version 11.3.3 Known Limitations

Zendesk/Support ticket/Service Cloud Описание

- When documents are getting classified, or a
learning instance is in edit mode, the Export
Status of that learning instance shows as
available in Migration utility page.

Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
Related information
Version 6.5.2 — заметки о выпуске on page 68
This document for IQ Bot Version 6.5.2 describes new capabilities, changed features, fixed features
(resolved issues), security fixes, deprecated features, and known behavior or limitations.

Version 6.5.2 — заметки о выпуске
This document for IQ Bot Version 6.5.2 describes new capabilities, changed features, fixed features
(resolved issues), security fixes, deprecated features, and known behavior or limitations.

Note:  IQ Bot Version 6.5.2 is a restricted release, and is not listed on the customer or partner portals. For
access, contact your Automation Anywhere representative.

Новые функции

IQ Bot Version 6.5.2 New Features

Функция Описание

Single click to extract text in the Validator In the Валидатор, users can click on any text
region to select the text instead of typing it.

API access New APIs have been added for:
• Return a list of filenames for validation status.
• Download a zip folder containing files.
• Delete specified files in the output folder.

Document group description A Description tab has been added for entering
a descriptive label or information, such as vendor
names, about the associated document group.

Microsoft Azure Computer Vision OCR engine1 IQ Bot now has native support for Microsoft
Azure Computer Vision OCR engine. Пример.
It can help handwriting, driver licenses, and
passport extraction.

Important:  Internet connectivity is required.
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IQ Bot Version 6.5.2 New Features

Функция Описание

Add user logic in the Designer In the Designer, under Logic, Python language
support has been added, so power users can
add custom code to:
• improve extraction and validation in

production
• skip Валидатор
• flag errors that could not be flagged before
• reduce post-processing of IQ Bot output

Internationalization and localization: Italian and
Portuguese

You can now select Italian and Portuguese to
show the UI in that language.

Note:  Any part of IQ Bot UI that is linked to
the database appears only in English. Language
support for these is upcoming in a future
release.

Note 1: This is a beta feature.

Измененные функции

IQ Bot Version 6.5.2 Changed Features

Функция Описание

Updated SDK modules The SDK has been updated to match Control
Room Version 11.3.x. This removes the need to
change the ignite.security flag.

Access IQ Bot without sysadmin role that includes
support for Amazon Relational Database Service
(RDS) out of the box

The sysadmin SQL database role requirement
has been removed from the IQ Bot installer. The
following privileges are checked instead:
• SQL connection
• database creation
• view any database

Installation with Microsoft Azure SQL requires
the following role: dbmanager

Localized text in UI updated The localized UI text has been updated for
Chinese Simplified, Chinese Traditional, French,
German, Italian, and Japanese.

View and test all documents in the Designer >
See extraction results

Users can select and test not some but any of
the uploaded documents in See extraction
results, to train more robust bots.
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IQ Bot Version 6.5.2 Changed Features

Функция Описание

Role-Based Access Control updates for IQ Bot
Version 6.5.2

All standard roles and permissions for IQ Bot
work as before with the exception of custom
roles. See Define access to learning instances using
custom roles on page 141 for more information.

Fixed Features

Note:  For future releases all fixed features will be tracked via external ticket system. For current and
previous releases, customers and partners filled out external tickets or worked with internal representatives
who helped file internal tickets on their behalf.

IQ Bot Version 6.5.2 Fixed Features

COG internal ticket number Описание

COG-15749 AND COG-15664 Reworked migration utility feature to better
support classifier versioning at the learning
instance level, which fixes the migration
overwrite option.

COG-17242
(Zendesk - 209799)

IQ Bot upgrade from v5.2 to v6.5 succeeds
despite large increase in SQLServer log volume.

COG-15745 AND COG-15767 In a cluster environment:
• No files are lost during document processing

in production environment.
• My total and My learning instance tiles on

dashboard displays are in sync when showing
the STP %.

• Documents sent to the Validator are
automatically validated and show the correct
STP %.

COG-15426 IQ Bot shows the correct бот numbers when
importing learning instances with the merged
option.

COG-17211 IQ Bot is able to import learning instances with
unclassified group.

COG-17178
(Zendesk 210705)

IQ Bot Version 6.5 performance is improved
when loading the learning instance page with a
large number of Bots.

COG-15355 Trying to access a learning instance created by
a different user role shows an error message
instead of a blank screen.
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IQ Bot Version 6.5.2 Fixed Features

COG internal ticket number Описание

COG-15864 AND COG-15883 IQ Bot Designer is responsive:
• the text segments display correctly.
• results are displayed when the See

extraction results button is clicked.

COG-16765 Japanese and Korean unicode character
corrections are getting stored correctly in the Bot
database.

COG-16086 The width of the field value input box is now the
same as the width of the field name input box.

COG-15417 If a user moves column fields from one table
to another table in Designer, the sequence
of selection of these fields will appear in See
extraction results view.

COG-17032 Even if a document is open for ~20 minutes in
the Валидатор, user is able to validate all the
errors and save the document.

COG-17348 Displays the correct Copyright year for all IQ Bot
DLLs.

COG-15669 IQ Bot can continue with pen sessions over a
period of few days without slowing down or
the need to restart services. The system can
continue to work and be responsive.

COG-17909 On a learning instance page, when navigating
through pages for listed groups, the pagination
is stable and works as expected.

COG-17908 When there are lot of groups in a learning
instance, navigating back to the Back to
training page does not take long.

COG-17108 IQ Bot is able to recognize the spaces in specific
content. Пример. "Logitech M100 Mouse" is
output correctly with the appropriate spaces in
between the words.

COG-17338 In the Валидатор page, user is able to scroll
through the entire document using the scroll bar.

COG-17721 In a non-cluster environment, My total and
My learning instance tiles on the IQ Bot
dashboard display the correct document
processed count and STP %.

COG-17515 IQ Bot does not display any error screen after
learning instance creation and before opening
the document in Designer.
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Deprecated Features

There are no deprecated features listed for IQ Bot in this version.

Known Limitations

IQ Bot Version 6.5.2 Known Limitations

JIRA/Zendesk ticket number Описание

Customer service: 13420 Text segments might not get generated for PDFs
with multiple file formats on different pages.

Tip:  A current workaround is to convert the
PDFs to TIFF files before uploading to IQ Bot.

CGNSRV-436 IQ Bot UI response can be slow due to multiple
users. The dashboard refresh can be slow due
to ~50+ learning instances or a large number of
groups per learning instance.

COG-18016 Users can experience longer file upload times for
files whose cumulative size is greater than 10MB,
when using the APIs.

CGNSRV-362, CGNSRV-457, CGNSRV-521,
COG-16030

Several customers have reported cases where
some tables, without headers, spanning
multiple pages could have skipped rows during
extraction.

CGNSRV-356, CGNSRV-368, CGNSRV-372,
COG-16891

Several customers have reported table extraction
skipping some required rows to be extracted.

CGNSRV-467 IQ Bot healthcheck can incorrectly return a
NOT OK message when learning instances are
loading.

COG-18977 While upgrading to a different IQ Botversion,
incorrect timestamp is inserted for the uploaded
documents. The previous version of files have
the local timestamp, and the new uploaded files
have the timestamp based on the time of the
machine (UTC).

COG-19485 If a new group is created in production, or if a
user uploads documents to IQ Bot in production,
and retroactively toggles the learning instance to
production, the download API feature does not
work for those documents.

Related concepts
IQ Bot operating system compatibility on page 23
Install IQ Bot as a local profile with administrator permissions. The table provides information about the
operating systems that are compatible with the different IQ Bot releases.
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Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

Version 6.5 — заметки о выпуске
These release notes contain changed features, fixed features, and security fixes introduced in IQ Bot
Version 6.5.x.

Новые функции

Extraction/Validation features
• Select document classifier version:

During upgrade, the installer detects if you have existing learning instances from a prior version of IQ
Bot. Select that prior version of IQ Bot from a drop-down list to keep the document classifier version for
the existing learning instances.
См. раздел Keep learning instance document classifier version during IQ Bot upgrade on page 219.

• Select between optical character recognition (OCR) engines:
Select between Tesseract4 or ABBYY FineReader Engine FineReader Engine v12.2 as IQ Bot's OCR
engine for each new learning instance, and still continue to leverage IQ Bot's native document
classification, autocorrection, and extraction capabilities. IQ Bot installation now automatically installs
ABBYY FineReader Engine FineReader Engine v12.2, and with an open runtime license. This means that
the license is pre-activated, and can be on as many IQ Bot servers you run, and works with or without
terminal server.

• Expanded language support:
Access text segmentation and OCR support for 190 languages including: Chinese Simplified, Chinese
Traditional, Japanese, Korean
См. раздел IQ Bot 11.x: List of languages in IQ Bot on page 219.

Enterprise features
• Access IQ Bot without device license ( without a Bot Creator or Bot Runner license):

Log in to IQ Bot without an assigned device license in the Automation Anywhere Enterprise Control
Room. The roles are custom or defined by the system. The user view of the UI depends on the
assigned role.
См. раздел Access IQ Bot without a Bot Creator or Bot Runner device license on page 146.

• Access IQ Bot Валидатор without a Bot Creator or Bot Runner license:
Log in to IQ Bot with a Валидатор role (defined in Control Room) without a Bot Creator or Bot
Runner license. This function supports and permits an unlimited number of Валидаторs in IQ Bot
simultaneously.
См. раздел Access IQ Bot Валидатор without a license on page 147.
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• Internationalization and localization:
At log in, select from a drop-down list of eight languages, that shows the IQ Bot UI in the selected
language. Choose from the following languages:
• Английский
• Упрощенный китайский
• Традиционный китайский
• Французский
• Немецкий
• Японский
• Корейский
• Испанский

Note:  Any part of IQ Bot UI that is linked to the database appears only in English. Language support
for these is upcoming in a future release.

• Database encryption:
IQ Bot document data stored in database tables and columns are encrypted for security of potentially
sensitive information. This does not yet apply to field value data that humans manually correct in the IQ
Bot validation queue. Database encryption occurs during the following tasks:
• Fresh install of IQ Bot
• Migration of a learning instance
• Upgrade of IQ Bot

См. раздел IQ Bot database encryption on page 230.

Note:  All APIs that use this data work as before.

• Role-Based Access Control for new learning instances:
Role-Based Access Control (RBAC) is configured through the Control Room, which enables or
restricts access to the IQ Bot learning instances, related features, and functionality that are based on
permissions defined in the user role. Create and assign custom roles to users. Without permissions for
the custom role, users get an error message when trying to log in to the system.
См. раздел Define access to learning instances using custom roles on page 141.

• Audit logs for IQ Bot:
The administrator sees action logs for all IQ Bot users in the Audit Logs tab of the Control Room.
Successful and unsuccessful actions are logged with reasons for failure logs.
См. раздел IQ Bot audit log in Control Room on page 231.

• Windows authentication:
The IQ Bot platform administrator is able to enable Windows authentication, during IQ Bot platform
installation, to connect SQL databases with Windows or dual authentication.
См. раздел IQ Bot Microsoft Windows authentication on page 231.

• Microsoft Azure SQL database service Platform as a Service (PaaS):
The IQ Bot platform administrator can enable Microsoft Azure SQL database service during IQ Bot
platform installation to use the SQL database services.

• Counter for number of pages uploaded:
In the IQ Bot UI, users can now view the number of pages uploaded in production to manually
compare with their license limit. Automatic comparison with their license limit is forthcoming in a future
release.
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Измененные функции

The following features were migrated from IQ Bot Version 5.3.1.x to Version 6.5:
Extraction/validation features
• Production field value autocorrection:

Fix field value errors in the IQ Bot Валидатор. As IQ Bot learns, it can autocorrect field value errors
for which it reaches 90% confidence. If users upload additional documents in production, IQ Bot can
autocorrect these errors, skip Validator, and count the documents as STP.
См. раздел Use Machine Learning to fix extraction errors on page 210.

• Check box extraction:
When a user maps check boxes or radio buttons, IQ Bot's artificial intelligence (AI) returns a Yes/No/
No check box found value for whether the check boxes have check marks. That applies to a single
check box, group of check boxes, and repeated sections of check boxes.
См. раздел Extract data from check box or check box groups on page 192.

• Improved text segmentation:
Improved text segmentation, such as, grouping and separation of related or unrelated text, provides
more accurate results to support OCR, document classification, and data extraction.
For example, the improvement helped increase STP (percent of documents processed successfully
without human intervention) by 9% on a sample dataset of 4,300 documents. The example increase
is based on comparing IQ Bot Version 6.5 with IQ Bot Version 6.0.1 on that sample dataset, and was
replicated for IQ Bot Version 6.5 versus IQ Bot Version 5.3.0.
См. раздел Text segment on page 186.

• Map table columns without mapping table headers:
In the IQ Bot Designer, map only one column header per table. If other column headers in the table do
not exist or have low quality text, users can map these columns without headers to extract the column
data.

• Repeated table/section extraction:
In the IQ Bot Designer, for a specific document with repeated tables/sections, users only have to map
the first table or section. Automatic extraction occurs for the repeated tables or sections with similar
structure or content in the remainder of the document. That automation can continue to production
documents.
См. раздел Map repeated tables and sections on page 191.

• Link tables/sections:
In the IQ Bot Designer, select one or more fields to link tables or sections. For example, link health
insurance claims data to services data.
That linking automatically continues to production documents, facilitating and eventually merging these
tables or sections in RPA.

• Choose a different training document for a group:
During document training, a user can look at unique document layouts available in a group, and choose
a different document from the default one chosen by IQ Bot Designer, that is more representative of
documents across that group.
См. раздел Choose training document for a group on page 172.
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• IQ Bot Designer and Валидатор formula validation:
Use formulas for selected fields to flag whether the formulas catch errors. For example, sum of column
item totals equals Invoice Total.
См. раздел IQ Bot 11.x: Formulas on page 180.

• Formula validation migrates during upgrade from Version 5.3.x to 6.5.x:
When upgrading from IQ Bot Version 5.3.x to 6.5.x, the formula validation also migrates, and this
prevent the task of re-adding the formula validation manually.

Ease-of-use features
• Resize box around a text segment:

In the Designer, resize a box around a mapped field value in any direction, without having to redraw
or reselect a box. In the Designer, Валидатор, and Preview mode, (See Extraction Results), hover over
any text segment to preview its OCR result.
См. раздел Resize mapping area on page 184.

• Preview OCR result for a text segment:
In the Designer, Валидатор, and Preview mode, (See Extraction Results), hover over any text
segment to preview its OCR result.

• Delete mapping in the Designer:
Delete mapping of field labels or field values, by selecting the X delete symbol next to the mapped label
or value.
См. раздел IQ Bot 11.x: Delete mapping in the Designer on page 194.

• Use blue-bound box to populate text in End of table/section indicator:
Select a blue-bounded box to populate the text value for the End of table/section indicator in the
IQ Bot Designer.
См. раздел Stop extraction at End of table/section indicator on page 189.

Fixed features
• End of table/section indicator:

Stop extraction at End of table/section indicator permits the end of table indicator to work in
additional cases.
См. раздел Stop extraction at End of table/section indicator on page 189.

• Migration utility
Option 1: triggers the functionality for Appends only new learning instance(s), if the learning
instance ID in the .iqba file (for example, from development environment) differs from the ID in the
target environment (for example, production environment). If a learning instance ID in the .iqba file is
the same as an ID in the target environment, that .iqba learning instance is not appended.
Option 2: triggers the functionality for Merges new groups and trainings (bots) in existing
learning instance(s).
См. раздел Using Migration Utility to import and export learning instances on page 251.

• Numeric format autocorrection:
For international languages, for example, French or German, if a numeric field has a comma misread
as a period (100000.00), then an international number pattern (999,00) can autocorrect the values
(100000,00).
For the English language, if a numeric field has a period misread as a comma (100000,00), then an
English number pattern (999.00) can autocorrect the values (100000.00).
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Technical updates
• Microsoft .NET framework updated from v4.6 to v4.7.2. The system prompts for a restart to complete

the update.
• SQL client updated from v11.0 to v2012. The system prompts for a restart to complete the update.
• NodeJS updated from v6.10.2 to v10.15.0. Minimum requirement is v8.0.0.
• JDBC driver updated from v4.2 to v7.2.

Известные ограничения

• Import/export of learning instances from IQ Bot Version 6.5 Beta to Version 6.5 is not supported just as
this is not supported for IQ Bot Version 5.2 to 5.3, and IQ Bot Version 6.0.1 to Version 6.5 and so on.
See IQ Bot upgrade options on page 233, which includes migration workarounds.

• When importing learning instances, the import option 3 (overwriting data) can create new groups
unexpectedly. Use the other import options instead.
См. раздел Import a learning instance on page 252.

• Database encryption:
• Performance and database size are impacted.
• Encryption for learning instance export is not supported for IQ Bot Version 6.5.

Related reference
Рекомендации по обновлению on page 6
To ensure successful upgrade to the newest IQ Bot version, review the considerations section before
starting the upgrade process.
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.
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IQ Bot architecture overview
Find the technical details for IQ Bot Version 6.5.
IQ Bot technical details are as follows:
• Развертывание
• Protocols
• Ports
• Encryption and credentials
• Sensitive user information

IQ Bot 11.x architecture diagram
This diagram shows the different components of IQ Bot architecture.
Use the IQ Bot, components, Designer and Валидатор for designing and validating боты, respectively. In
a typical scenario, IQ Bot portal and IQ Bot platform communicate through a network firewall and a load
balancer.

Various protocols are used to communicate between the different components. A database server, a file
storage server, and servers for IQ Bot are used. An organization has the flexibility of using a separate
server for the database or using the Control Room clusterdatabase. A firewall is between the external
components, web browser and Bot Runner, and the data center load balancer. Chrome is the supported
browser.

Protocol specifications
A standard set of regulations and requirements that allow two electronic items to connect to and exchange
information with one another.
The following table lists the protocols IQ Bot uses to enable various task.

Component Communication Протокол Примечания

Microsoft Azure Computer
Vision OCR engine

HTTPS Open port: 443

Google Vision API OCR engine TCP Open port: 443

Browser to Web server HTTPS, REST/JSON TLS typically terminates on a
firewall.

IQ BotLite command to Web
server

HTTP(S), REST/JSON TLS typically terminates on a
firewall.

Web server to Gateway HTTP(S), REST/JSON

Web server to Control Room HTTP(S), REST/JSON TLS typically terminates on a
firewall.

Gateway to Microservices HTTP(S), REST/JSON
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Component Communication Протокол Примечания

Gateway to Message queue HTTP Encrypted communication
will be mandatory in a future
release.

Control Room to Web server HTTP(S), REST/JSON TLS typically terminates on a
firewall.

Microservices to Control Room HTTP(S), REST/JSON Use of encryption is not
controlled by the Cognitive
team.

Microservices to database TCP Encrypted communication
will be mandatory in a future
release.

Related concepts
IQ Bot 11.x: Ports and services on page 79
Find out a list of port numbers for all services used for IQ Bot.

IQ Bot 11.x: Ports and services
Find out a list of port numbers for all services used for IQ Bot.

Important:  Configure to expose the following as inbound listening ports:
• 47100-47200 on IQ Bot server for IQ Bot-Control Room communication.
• 47100-47200 and 47500-47600 on Control Room server.

The following table displays port numbers for all services used in IQ Bot:

Service / Micro
service

Протокол Источник Целевой
объект

Port number Примечания

Web Server
(NodeJS) IQ Bot
Portal

HTTP/S Load Balancer IQ Bot
application
server

3000 Port 3000
needs to be
opened on
the Windows
Application
Server so
browser
sessions can
send requests
through the
Load Balancer.
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Service / Micro
service

Протокол Источник Целевой
объект

Port number Примечания

RabbitMQ
v3.8.18 Cluster
Server

HTTP/S Other IQ Bot
Applications
Server in same
cluster

IQ
BotApplication
Server (part of
cluster)

4369/25672 Needs to
be open on
each IQ Bot
Application
Server so
RabbitMQ
v3.8.18 can
work within a
cluster.

Automation
Anywhere
Control Room

HTTP/S Client web
browsers

IQ Bot
application
server

80 This port is
required to
handle Control
Room and IQ
Bot traffic, and
enable internet
communication.

Firewall/TLS HTTPS Load Balancer IQ Bot
application
server

443 Default HTTPS
TLS port.

Псевдоним HTTP/S - - 9997 Used internally
within server.

Приложение HTTP/S - - 9002 Used internally
within server.

RabbitMQ
v3.8.18

TCP/IP - - • 5672
• 5673

Used internally
within server.

Gateway HTTP/S Load Balancer IQ Bot
application
server

8100 Used internally
within server.

File Manager - - - 9996 Used internally
within server.

Microsoft SQL
Server

TCP/IP IQ Bot
application
server

Сервер SQL 1433 Used by micro
services.

Machine Learning - - - 9991 Used internally
within server.

Project - - - 9999 Used internally
within server.

Отчет - - - 9992 Used internally
within server.

Валидатор - - - 9995 Used internally
within server.

VisionБот
Manager

- - - 9998 Used internally
within server.
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Related concepts
Protocol specifications on page 78
A standard set of regulations and requirements that allow two electronic items to connect to and exchange
information with one another.

Учетные данные
IQ Bot does not store any user credentials as it relies on the Control Room authentication, which uses
AES256 encryption algorithm.

Scalability performance planning
To plan your deployment capacity and performance, understand the requirements, limits, and defaults that
determine the number of concurrent users, document processing rates, and infrastructure required.
The following information is to help you calculate your best deployment scenario.

Hardware and software requirements

IQ Bot hardware and software requirements on page 27

User Concurrency

IQ Bot Version 11.3.4.2 supports up to 20 concurrent users in a system .

Document processing performance benchmark

The objective of this test is to verify the maximum number of documents that can be processed in a span
of time by IQ Bot Version 11.3.4.2, when the configuration is scaled in a vertical and horizontal approach.
Test parameters

Параметр Значение

OCR engine Tesseract4 (Default)

Домен Счет-фактура

Тип документа TIFF (image)

Total documents processed 8604 (8K), 40416 (40K)

Pages per document One (Single page per document)

Special considerations

Параметр Значение

Number of fields mapped Six fields (3 form fields and 3 table fields)

Document resolution 300 DPI or more
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Параметр Значение

Document density Not dense

File processing benchmark results

Benchmark results for 40,000 documents The following tables represent the scaling
configuration and the time taken to process
approximately 40,000 documents. The total time
specified includes document upload, classification,
and extraction.

Note:  The processing times mentioned do not
include any post processing, pre processing, and no
additional custom logic.

Vertical scaling Processing time

1x8 (Single machine
with 8 cores)

57 hours and
40 minutes

1x16 (Single machine
with 16 cores)

29 hours and
20 minutes

1x32 (Single machine
with 32 cores)

31 hours and
10 minutes

Horizontal scaling Processing time

2x8 (Two machines
with 8 cores each)

34 часов

4x8 (4 machines
with 8 cores each)

14 hours and
40 minutes

8x8 (8 machines
with 8 cores each)

7 hours and 40 minutes

2x16 (Two machines
with 16 cores each)

15 hours and
50 minutes

4x16 (4 machines
with 16 cores each)

10 часов

Benchmark results for 8,000 documents The following tables represent the scaling
configuration and the time taken to process
approximately 8,000 documents. The total time
specified includes document upload, classification,
and extraction.

Note:  The processing times mentioned do not
include any post processing, pre processing, and no
additional custom logic.
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Конфигурация Processing time

1x8 (Single machine
with 8 cores)

16 hours and
20 minutes

IQ Bot 11.x: High Availability and Disaster Recovery overview
High availability (HA) provides a failover mechanism if an IQ Bot service or server fails. Disaster recovery
(DR) enables recovery across a geographically separated distance if a disaster causes an entire data center
to fail.
IQ Bot uses a minimum of 3 nodes and a maximum of 5 nodes in a cluster for high availability (HA).

IQ Bot HA and DR solution

In the context of IQ Bot, implementation of High Availability (HA) and Disaster Recovery (DR) reduces
downtime and maintains continuity of business (CoB) for your бот activities.
• High Availability (HA)—High availability is an architectural system design that attempts to safeguard

a system against certain failure scenarios. This means that even if parts of a system is failing, as a
whole it is still available and usable. High availability solutions typically protect against specific scenarios
such as: server failures, single component failures, dependency failures, variable load increases, and
networks splits where dependent on system components that become unreachable on a network.

• Disaster Recovery (DR)—Disaster recovery involves a set of policies and procedures to enable the
recovery or continuation of vital infrastructure and systems following a natural or human-induced
disaster. Disaster recovery addresses many different causes of failures in a system where high
availability typically accounts for a predictable few. Disaster recovery has a focus on re-establishing
services after an incident not just failover. Recovery of a system includes scenarios such as: restarting a
service or system, restoring configuration files or a database from backups.

To ensure HA and DR protection of your IQ Bot components, configure your existing HA and DR
infrastructure, load balancing, and failover systems to include IQ Bot servers and services. See your data
center administrator for your approved local HA and DR procedures.

Required HA and DR infrastructure elements

• Distributed Approach—In addition to clustering IQ Bot related data center components, we also
recommend that you deploy IQ Bot on multiple physical and, or virtual servers.

• Load balancing—Performed by a load balancer, this is the process of distributing application
or network traffic across multiple servers to protect service activities and allows workloads to be
distributed among multiple servers. This ensures бот activity continues on clustered servers.
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• Databases—Databases use their own built-in failover to protect the data. This ensures database data
recovery.
• Between the HA clusters, configure synchronous replication between the primary (active) and

secondary (passive) clustered MS SQL servers in the data center. This ensures consistency in the
event of a database node failure.
For the required HA synchronous replication, configure one of the following:
• Backup replica to Synchronous-Commit mode of SQL Server Always On availability groups
• SQL to Server Database Mirroring

• Between the DR sites, configure your database to provide asynchronous replication from the
primary (production) DR site to the secondary (recovery) DR site that is at a geographically
separated location from the primary DR site.

Sample scenario

Point all IQ Bot instances within the same cluster to the same database and repository files. This is
required to enable sharing data across multiple servers and ensuring data integrity is maintained across IQ
Bots servers within a cluster.

HA and DR deployment models

To ensure your IQ Bot is protected by HA and, or DR, configure your data centers according to the
deployment models described in:
• IQ Bot 11.x: High Availability deployment model on page 87
• IQ Bot 11.x disaster Recovery deployment model on page 87

HA implementation requirements

• Install IQ Bot on multiple servers.
• Access to IQ Bot is through a load balancer.
• Open a RabbitMQ v3.8.18 synchronization port between IQ Bot servers.
• Configure the Microsoft SQL Server in high availability mode.

Installation HA and DR configuration requirements

• The IQ Bot installer does not directly support cluster installation. To set up a cluster do the following:
• Run the installer on each application server node.
• Share the output folder using the access role Everyone.
• Post installation, execute the messagequeue_cluster_configuration.bat with appropriate

command line arguments.

• Configure IQ Bot in a high availability configuration.
• Open firewall ports: 4369 and 25672.
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• Install RabbitMQ v3.8.18 on every IQ Bot node in the cluster.
The first node where IQ Bot is installed becomes the primary RabbitMQ v3.8.18 node. The host name
of the primary node is used to configure the RabbitMQ v3.8.18 cluster.

• The load balancer is required to distribute a traffic to all IQ Bot server nodes.
• Configure Microsoft SQL Server for high availability. Use the Microsoft SQL Server Always On option.
• For RabbitMQ v3.8.18 specific installation, see your RabbitMQ v3.8.18 documentation.

HA and DR known limitations

• To discover the availability of IQ Bot instances, a load balancer periodically sends pings, attempts
connections, or sends requests to test the IQ Bot instances. These tests are called health checks.

• Health checks do not verify the availability of RabbitMQ v3.8.18 instances.

IQ Bot 11.x: HA cluster configuration overview
To support Automation Anywhere your data center, configure an HA cluster. Follow your company methods
and procedures for implementing your data center cluster.
HA clusters protect services and data in the event of a server or service failure. The following is a list of
processes associated with clusters.

Database replication Configure synchronous replication between the
primary site (active) and secondary site (passive)
MS SQL servers to ensure consistency in the event
of a database node failure.

Downtime The amount of downtime depends on the number
of restart attempts the administrator configures for
the primary server services, the number of failovers
allowed per number of hours, and the failback
configuration.

Failback After the primary server is returned to normal, fail
back the workload from the secondary servers to
the primary servers. The primary server becomes
the active server again.
Restoring operations to the primary system or site
after a failover or disaster recovery on a secondary
system or site.

Failover If one of the primary servers fails, the workload
of the failed server automatically shifts to the
secondary server in the cluster. This automatic
process is called failover. Failover ensures
continuous availability of applications and data.
When failover completes, the secondary server
becomes the active server.
When a (primary) system detects a fault or failure,
it automatically transfers control to a (secondary)
duplicate system. This applies to HA clusters, where
failover is from one server to another.

Graceful degradation Process allowing cluster dependencies to operate
gracefully on a degraded primary site.
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Redundancy HA clusters use redundancy to prevent single points
of failure (SPOF), such as a failed server or service.
HA clusters include primary (active) servers that
host services or databases and secondary (passive)
servers that host replicated copies of the services
and databases.

Replication The secondary servers have the same configuration
and software as the primary servers, they are a
duplicate (redundant copy) of the primary. Data is
replicated (copied) from the primary servers to the
secondary servers.

To support HA and DR for Automation Anywhere, configure the selected components in your data center
for HA.

Прим.:  In the context of clusters, though the terms server, host, and node each have specific meaning,
they are frequently used interchangeably.

Cluster A cluster is a set servers (nodes) that are connected
by physical cables and software. In an HA
environment, these clusters of servers are allowed
to be in the same physical data center.

Cluster group (role) Group of clustered services that failover together
and are dependent on each other.

Узел The cluster machine that is hosting the services.
Multiple servers The HA technique where operations are available

across multiple servers with workload managed by
a load balancer. This applies to IQ Bot instances.

Узел A generic term for a machine in a cluster.
Primary node The active node in the cluster. The machine where

the production activities run. This applies to the
database servers.

Secondary node The machine that is designated as the target in the
event of a failover. The secondary node is a passive
duplicate of the primary node. This applies to the
database servers.

Сервер The machine in the cluster installed with the server
operating system.

HA cluster technologies guard against three specific types of failures:

Application and service failures These affect application software and essential
services.

Site failures in multisite organizations This is caused by natural disasters, power outages,
or connectivity outages.

System and hardware failures This affects hardware components such as CPUs,
drives, memory, network adapters, and power
supplies.
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This ability to handle failure allows clusters to meet two requirements that are typical in most data center
environments:

Высокая доступность The ability to provide end users with access to a
service for a high percentage of time and reduces
unscheduled outages.

High reliability The ability to reduce the frequency of system
failure.

IQ Bot 11.x: High Availability deployment model
The High Availability (HA) deployment model provides failure tolerance for the IQ Bot servers, services,
and databases.
The following shows IQ Bot and data center components.

In this example, the IQ Bot servers and Microsoft SQL Servers have HA redundancy.
• Multiple users have access the IQ Bot cluster through their web browsers. The web browsers

communicate to the IQ Bot cluster through the load balancer.
• Multiple Bot Runner communicate to the IQ Bot cluster through the load balancer.
• The server message block (SMB) file share and the Microsoft SQL Server store data from the IQ Bot

cluster.
• Microsoft SQL Server uses redundancy through replication syncing to the clustered Microsoft SQL

Server.

Pros Maintains availability when server failures occur
within a single data center.

Cons Does not provide protection against data center
outage.

Use Cases Small to medium-size businesses that do not
require multi-site disaster recovery.

IQ Bot 11.x disaster Recovery deployment model
The Disaster Recovery (DR) deployment model uses high availability (HA) clusters distributed over a
geographic area.
Disaster Recovery (DR) is a method where the two High Availability (HA) data center configurations are
separated geographically. The extra benefit here from a single location HA configuration, is in the event of
a localized disaster, the physically removed data center resumes functions with minimum downtime.

In this example, all the servers have redundancy.
• Multiple users have access the IQ Bot cluster through their web browsers. The web browsers

communicate to the IQ Bot clusters through the load balancers.
• Multiple Bot Runner communicate to their IQ Bot cluster through the load balancer.
• The server message block (SMB) file share and the Microsoft SQL Server store data from their IQ Bot

cluster. Both servers are asynchronously replicated to the backup disaster recovery site.
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• Microsoft SQL Server uses redundancy through replication syncing to the clustered Microsoft SQL Server
on the primary disaster recovery site.

For disaster recovery in IQ Bot environment.
• Deploy a second IQ Bot HA cluster in an additional data center that is in a separate geographic location.
• In the event of a primary site failure, do the disaster recovery manually. See the IQ Bot 11.x: Disaster

recovery failover steps overview on page 90.

Note:  When a failover to a backup site occurs, it is possible that very recent changes made on the
primary site are lost.

Pros Provides business continuity when faced with data
center outage or loss.

Cons Increased operational burden.

IQ Bot 11.x: DR configuration requirements
When you configure your Disaster Recovery enabled data centers for IQ Bot, ensure the listed conditions
are met.

Disaster Recovery configuration requirements

• Asynchronous replication—Configure asynchronous, rather than synchronous replication, between
DR sites for all supporting services. This ensures off-site replication does not impact performance of the
primary site.

• AD domain—Ensure the same Active Directory domain is available to both the primary and backup
sites.

• Site domains—Ensure the backup site Control Room and device machines are members of the same
domain as the primary site Control Room and machines.

• Licenses—Assign floating licenses for users, so that they are able to log into devices on the backup
site.

• Backup site services—Shutdown the Control Room services at the backup site until they are needed.
• Site configurations—Ensure the machines at the primary site and backup site have the same

specification and configuration. This includes the Control Room, Bot Runner, associated devices, and
login credentials. This is required to ensure equal level of service during an outage.

Прим.:  Schedules are stored in UTC and therefore run at the same time regardless of the physical
location or time zone settings of the server.

Database Replication Details

The database replication configuration for disaster recovery is an extension of the high availability
configuration. This configuration requires the use of Always On availability groups.
• Configure the primary site replica in Synchronous-Commit mode.
• Configure the recovery site replica in Asynchronous-Commit mode. Asynchronous-Commit mode

ensures that the latency and reliability of the inter-datacenter does not impact the performance and
availability of the primary site.
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• Do not configure the recovery site replica to offer any database services until a recovery failover is
triggered.

Failure mode

With asynchronous replication there is the possibility that a transaction that occurs on the primary site
does not reach the recovery site replica before the failure occurs.

Прим.:  This possibility of loosing the most recent transactions applies to all DR automated application
solutions using asynchronous replication, not just Automation Anywhere solution.

Deployment requires strict consistency between distant geographical locations. Synchronous-Commit
configured between replicas with significant latency has a detrimental effect on all Control Room
operations.
To prevent work items being processed twice when a failure occurs, some work items awaiting delivery to
a device are placed into an error state. This ensures they can be manually reviewed and marked as ready
to be processed or complete as appropriate.

Disaster Recovery preparation
Describe the settings and configuration required to ensure recovery in the event of a failed site.
Prior to installing IQ Bot, prepare your Disaster Recovery sites.

Hardware failure protection Deploy multiple IQ Bot servers locally on each DR
site.

Data corruption protection Backups Perform regular on-site
full and daily backups
of database server,
the IQ Bot repository,
configuration and task
files.

DR sites Apply the same storage
configuration on
both the primary and
secondary DR sites.
Apply replication
methods to update
the secondary DR site
from the primary DR
site. Example content
describes using the
Windows feature,
Distributed File System
(DFS).

Environmental disaster protection Geographic
separation

Protect against a
geographical or
environmental disaster,
complete regular
backups of the
secondary DR site.
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Primary site The location where the
active cluster resides.

Recovery In the event of a
disaster, some events
could stop part way
through execution.
Retrieve task level
log files and other
intermediate files to
identify the state of
any pending processes.
Example content
describes using SQL
Server 2012 AlwaysOn
Availability Groups.
The process of shifting
the production activities
from a failed primary
site to the secondary
backup site. This applies
to DR sites, where
recovery is from one site
to another.

Recovery site The secondary
(redundant) site,
that is geographically
separated from the
primary DR site. This
secondary site is a
passive replication of
the primary site. It is
designated as the target
location in the event of
a disaster.

IQ Bot 11.x: Disaster recovery failover steps overview
Overview of failover steps for IQ Bot recovery after a disaster.
Complete the disaster recovery deployment on two geographically separated sites, where one site is
primary (active) and the other is a backup (passive) site. Disaster recovery is performed on remote backup
site.
The procedure is identical regardless of whether switching over from primary to secondary (recovery), or
secondary to primary.
If the failed IQ Bot nodes are still available:
1. Shut off all IQ Bot services at the primary site.
2. Failover all IQ Bot-related databases using the database tools.
3. Failover your Server Message Block (SMB) share using the appropriate tools to make the recovery site

SMB file share writable.
4. Start IQ Bot services at the recovery site.
5. Wait until the IQ Bot web interface is available.
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6. Login to the web interface as an administrator.
7. After the recovery site is operating as the primary site, configure a replacement secondary site. Using

the database tools, set replication from the recovery primary site to the replacement secondary site.

IQ Bot 11.x: Re-establish a duplicate DR site
After a secondary (backup) site is recovered as the primary (production) site, establish a new secondary
DR site.
The recovery site is up and running as the new production site.
The process of returning activity to a primary (active) production site, plus secondary (backup) site
depends on the state of the original primary site.
• If the old production environment becomes available again, complete the following to switch back to

the original DR primary site.
a) Restore/replicate the DR database and file system to the original production database and file

system respectively.
b) Bring up the new DR primary (production) IQ Bot.
c) Verify new DR primary (production) environment is working, as expected.
d) Stop the DR IQ Bot services on the DR recovery site.
e) Establish the replication between the new DR primary (production) and DR secondary (standby) IQ

Bot (DB and NAS).

• If the old DR primary production environment is rendered completely unusable due to the disaster, re-
establish a new secondary (standby) DR site. Complete the recovery DR steps to re-establish primary
and secondary DR sites.
a) Restore/replicate the database and file system data from DR environment to the new production

environment.

No additional steps are required. The DR primary and secondary sites are restored.
• The бот Activation utility does not need to be run again. Activation occurs when IQ Bot is first deployed

to the DR cluster sites only.
• For any subsequent disasters, only the database query needs to be run on DR secondary (standby)

IQ Bot database. This is required because the replication between DR primary (production) and DR
secondary (standby) overwrites DR secondary site Bot Runner data in DR secondary site database with
DR primary (production) Bot Runner data.

• Similarly, the mapping between DR primary and DR secondary Bot Runner is established. Use the same
mapping for all subsequent disasters or mock drills.

Операции
Find out about the important IQ Bot operations supported by IQ Bot.
IQ Bot provides information about the following:
• different logs generated for IQ Bot components and the location of logs,
• enabling tracing in the logs for the various components of IQ Bot,
• status of IQ Bot services using the healthcheck APIs, and
• recommended database maintenance plan.
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Related concepts
Log files in IQ Bot on page 92
Find out the different logs generated for IQ Bot components and the location of logs.
Enabling tracing in logs on page 94
Log files are generated by the system that store messages from various application and system
components. Different logs are generated for IQ Bot components for which you can enable tracing.
Monitoring services on page 95
Find the status of the IQ Bot services using the healthcheck.
Database backup recommendation on page 96
Find out the details about the recommended database maintenance plan.

Log files in IQ Bot
Find out the different logs generated for IQ Bot components and the location of logs.

Компоненты IQ Bot

Component Log File Related Feature or
Functionality

Location

Installer • IQBotSetupLog.log
• MSI****.log

%temp%

Gateway service Gateway.log Provides connectivity
to Control
Room(authorization,
roles, permissions, and
auditing)
Gateway for all inward
requests to other
micro-services

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Alias service Alias.log Serves different
domains, language,
fields or columns, and
their alias related APIs
Add, Import, or Export
domain

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Application service Application.log Serves handshake
for App registration,
updating on
configuration IN DB
and the V2 API's

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs
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Classifier service ClassifierWorker.logSupports RabbitMQ for
incoming classification
requests
For each request,
it spins a Classifier
Executor
It is not a API service,
but only takes
operation work through
RabbitMQ queue
(topic_classification)

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs
\Engine

File Manager service FileManager.log Serves different APIs
related to files

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Project service ProjectService.log Serves different APIs
related to project
(Learning Instance)
IQBA Migration

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Report service Reports.log Dashboard and Metrics %public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Validator service Validator.log Responsible for
activities (Visionbot)
after a production
document is processed

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

VisionBotEngine service VisionBotWorker.logSupports RabbitMQ
for incoming Visionbot
related requests
For each request, it
invokes VisionbotEngine
Executor

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs
\Engine

VisionBot Manager VisionbotService.logServes different APIs
related to Visionbot

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs

Machine Learning • MLTranslationService.log
• MLWebService.log

Responsible for
validator input
and output based
supervised learning
data

%public%
\Documents
\Automation
 Anywhere IQBot
 Platform\Logs
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Web Server (Node.js)
Gateway Client

ClientGateway.txt Front end server that
serves as a gateway for
all requests to IQBot
(e.g. from frontend,
visionbot command)

%public%\Documents
\Automation Anywhere
IQBot Platform\Logs

Other Automation Anywhere applications interacting with IQ Bot

Component Log File Related Feature
or Functionality

Location

Control Room • query-engine-
xxxx.log

• WebCR_xxxx.log
•aa_cr_elasticsearch_xxxx.log
• zoomdata_xxxx.log

%ProgramData%
\AutomationAnywhere

\Logs

Enterprise Client ClientServiceLog.log Provides essential
features to record,
modify, manage,

and run tasks

%public%
\Documents
\Automation

 Anywhere Client
 Files\LogFiles
\ServiceLogs

Third party applications interacting with IQ Bot

Component Log File Related Feature
or Functionality

Location

Сервер SQL • Приложение
• Окна

Start Menu >
 Event Viewer
 > Windows Logs

RabbitMQ rabbit@<hostname>.log Serves as a
message broker

%appdata%
\RabbitMQ

См. раздел IQ Bot 11.x: Set up log file automatic rollover on page 148.
Related concepts
Download a document from a learning instance on page 207
Once documents are uploaded to a learning instance, some files process successfully, while others fail.

Enabling tracing in logs
Log files are generated by the system that store messages from various application and system
components. Different logs are generated for IQ Bot components for which you can enable tracing.
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To enable tracing, open the log configuration file of the component. See Enabling tracing in logs (A-People
login required) on steps for enabling tracing.

Monitoring and alerts
Find out the status of the IQ Bot services using the Health Check APIs.
For more information about the status of the IQ Bot services using the Health Check APIs, see link in the
Related information section.
Related tasks
IQ Bot 11.x: Health Check API response if RabbitMQ v3.8.18 fails to start on page 147
Check the status of each IQ Bot service using the Health Check API if RabbitMQ v3.8.18 fails to start.

Monitoring services
Find the status of the IQ Bot services using the healthcheck.

Performing a Health Check

If needed, use the Healthcheck API to perform a detailed verification on the desired service. The request/
response details of the Healthcheck API are as follows:
REQUESTS
The following table lists the API requests sent for performing healthcheck of the different IQ Bot services:

Service Name URL-адрес

Alias http://<hostname/IP>:9997/
healthcheck

Application service http://<hostname/IP>:9002/
healthcheck

Project service http://<hostname/IP>:9999/
healthcheck

FileManager service http://<hostname/IP>:9996/
healthcheck

Visionbot http://<hostname/IP>:9998/
healthcheck

Validator service http://<hostname/IP>:9995/
healthcheck

Report service http://<hostname/IP>:9992/
healthcheck

Gateway service http://<hostname/IP>:8100/
healthcheck

Frontend or Console service http://<hostname/IP>:3000/
healthcheck

RabbitMQ <RabbitMQ installation directory>
\sbin\rabbitmqctl.bat status
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In the table listing, simply replace <hostname/IP> with the IQ Bot Host name or IP address to create the
Healthcheck API request using a web browser on the machine on which IQ Bot is installed.
For example, if your IQ Bot is accessible at http://localhost:3000, the FileManager Healthcheck can be
accessed using the URL http://localhost:9996/healthcheck.

Database backup recommendation
Find out the details about the recommended database maintenance plan.
The following database backup strategy is strongly recommended.
• Weekly: Full database backup
• Every 3 Days: Differential backups
• Daily: Incremental backups every 24 hours
• Hourly: Transaction log backup every hour
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Installing IQ Bot
This is the landing page for the collection of topics related to IQ Bot installation. For details on the
installation types and methods, see the topics below to install Automation Anywhere IQ Bot.

IQ Bot installation core tasks
Follow the installation task list to install IQ Bot:

Шаг 1. Предустановка Review and verify the requirements and options
before installing IQ Bot. This topic provides
you important information about the supported
operating systems, hardware and software
requirements, and the prerequisite steps you have
to complete even before you begin the installation
process.

IQ Bot 11.x: IQ Bot
installation prerequisites
on page 99

Verify the hardware,
software, and
configuration required
to install IQ Bot in your
environment. Follow the
pre-installation checklist
before installing IQ Bot.

Шаг 2. IQ Bot installation Install IQ Bot using any of the following installation
options:

IQ Bot 11.x: Installing IQ
Bot in Express mode on
page 106

Install IQ Bot in Express
mode with the default
settings.

IQ Bot Custom installation
on page 113

Пользовательский
режим используется
для установки IQ
Bot со сведениями о
конфигурации.

IQ Bot 11.x: Installing IQ
Bot in Cluster mode on
page 113

Install IQ Bot in Cluster
mode for improved
throughput.

IQ Bot 11.x: Installing
IQ Bot in Cluster mode
on machines with IQ Bot
preinstalled on page
116

If you have IQ Bot
already installed on
your machine, uninstall
IQ Bot, stop  service,
and clean the existing
RabbitMQ v3.8.18
cookies before installing
IQ Bot in Cluster mode.

IQ Bot 11.x: Installing IQ
Bot in Cluster mode on

Install IQ Bot in the
cluster mode on Amazon
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Amazon EC2 on page
117

Elastic Compute Cloud
(Amazon EC2).

Шаг 3. Пост-установка After downloading IQ Bot, register with the
Control Room and do the various configurations as
required. You would also go through the checklist
to ensure all services, databases, tables, and
configuration settings are in place.

IQ Bot post installation
configuration on page
118

After installing IQ
Bot complete the
configuration settings
to ensure registration
with Control Room,
confirm the creation of
all required databases,
create the appropriate
certificates, configure
the HTTP and HTTPS
settings, generate the
authorization token
for performing any
task, and verify the
completion of all tasks
in the post-installation
checklist.

Шаг 4. Валидация Create and register IQ Bot specific users in the
Control Room, and do other validation actions as
required.

IQ Bot post installation
validation on page
140

After installing IQ Bot
and completing the
post-installation tasks,
validate the installation
by creating IQ Bot
specific roles, accessing
the Валидатор without
a license, accessing
the product without
a device license,
and understanding
permissions for role-
based access control to
the learning instances.

IQ Bot upgrade and
uninstallation on page
151

Follow the upgrade and
uninstallation steps
for IQ Bot to ensure a
smooth and seamless
process.
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IQ Bot 11.x: IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot in your environment. Follow the
pre-installation checklist before installing IQ Bot.

Требования к аппаратному обеспечению

Important:  As a prerequisite step, open ports 4369 and 25672 and add inbound firewall rules to allow
traffic to these ports on each target machine. To add nodes to the cluster, sync the RabbitMQ v3.8.18
cookies to enable running any RabbitMQ v3.8.18 commands . If IQ Bot is already installed on the target
machine, clean up and remove the existing cookies.

IQ Bot hardware and software requirements on page
27

Make a note of the following hardware and software
requirements before installing IQ Bot.

IQ Bot version compatibility matrix on page 8 Before you install or upgrade, read the compatible
versions of IQ Bot with the Control Room.

IQ Bot operating system compatibility on page 23 Install IQ Bot as a local profile with administrator
permissions. The table provides information about
the operating systems that are compatible with the
different IQ Bot releases.

IQ Bot database compatibility matrix on page 24 The table provides information about the databases
that are compatible with the different IQ Bot
releases.

Prerequisite

IQ Bot 11.x: IQ Bot prerequisite steps on page 100 Complete the steps before you begin installing IQ
Bot.

IQ Bot 11.x: IQ Bot service configuration on page
101

In some IQ Bot deployments, the service account
can be different from the login account. As an
administrator, provide the service credentials during
installation.

IQ Bot 11.x: IQ Bot Windows services on page 102 IQ Bot Windows services are automatically installed
when running the installation and setup.

IQ Bot 11.x: RabbitMQ v3.8.18 and Erlang/OTP
upgrade on page 103

The IQ Bot Version 11.3.x installation package
includes the RabbitMQ v3.8.18 version 3.7.17 and
Erlang/OTP version 22.0.

Installation limitations on page 104 Learn about the installation limitations before
installing IQ Bot.

Prerequisites for installing in Cluster mode on page
104

Complete the prerequisites to set up  in cluster
mode.

IQ Bot 11.x: Prerequisites for installing IQ Bot in
Express mode on page 105

Complete the prerequisites to set up  in express
mode.

Related tasks
IQ Bot 11.x: Installing IQ Bot in Express mode on page 106
Install IQ Bot in Express mode with the default settings.
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IQ Bot 11.x: Установка IQ Bot в пользовательском режиме on page 108
Пользовательский режим используется для установки IQ Bot со сведениями о конфигурации.
IQ Bot 11.x: Installing IQ Bot in Cluster mode on machines with IQ Bot preinstalled on page 116
If you have IQ Bot already installed on your machine, uninstall IQ Bot, stop  service, and clean the existing
RabbitMQ v3.8.18 cookies before installing IQ Bot in Cluster mode.
IQ Bot 11.x: Installing IQ Bot in Cluster mode on Amazon EC2 on page 117
Install IQ Bot in the cluster mode on Amazon Elastic Compute Cloud (Amazon EC2).

IQ Bot 11.x: IQ Bot prerequisite steps
Complete the steps before you begin installing IQ Bot.
1. User needs to have SYSADMIN or following privileges for SQL database account as this is used during

installation to create database and run the BULK INSERT statement.

6.5.2 IQ Bot 6.5.2 onwards, the SYSADMIN role is not a mandatory requirement by the
installer. Instead, it verifies if the user has the following privileges:
• SQL connection (CONNECT SQL)
• Database creation (CREATE ANY DATABASE)
• View any database (VIEW ANY DATABASE)

Note:  Installation with Microsoft Azure SQL requires the dbmanager role.

Note:  Installation with AWS RDS requires a role with the above three privileges. These privileges are
already assigned to the db_owner role in RDS.

Grant permissions for a specific database user and see the permissions for that role using the
following TSQL query:
SELECT * FROM fn_my_permissions(NULL, 'SERVER').

2. First enable HTTPS, to configure IQ Bot with HTTPS. Keep the following HTTPS certificate files ready
for use:
• Control Room certificate in .crt format (Certificate Authority list bundle).
• Control Room certificate in .crt format (Server side public certificate).
• IQ Bot server certificate in .pfx and .crt format.

Important:  Install the .crt certificates for Control Room manually to their appropriate certificate
stores.

Note:  See IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS on page 132 for more information.

3. Keep the following ports open because they are used by IQ Bot services:
См. раздел IQ Bot 11.x: Ports and services on page 79.

• Application access port (configurable): 3000
• Database access port (configurable): 1433
• Internal application services ports (fixed): 8100, 9002, 9991, 9992, 9995, 9996, 9997, 9998, 9999
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• Inbound listening ports:
• 47100-47200 on IQ Bot server for IQ Bot-Control Room communication.
• 47100-47200 and 47500-47600 on Control Room server.

• RabbitMQ v3.8.18
•

6.5 Порт. 5672
•

11.3.3 Порт. 5673

4. When upgrading from IQ Bot Version 5.3.1.x, if you have learning instances that rely on the 5.3.1.x
check box or linked table functionality, clear the validation queue before upgrading to IQ Bot Version
6.5.x and above.

5. If your Сервер SQL version is older than SQL Server Native Client 2012, a dialog box appears, giving
you the option to upgrade. Open services.msc and stop the Сервер SQL (MSSQLSERVER) to do
the upgrade. Then continue with the installation process.

6. During the upgrade process, the installer will detect existing learning instances from a previous version
of IQ Bot. To retain the original classifier for those learning instances, select that earlier version of IQ
Bot from the drop-down list. This ensures consistency in the behavior of the learning instances with
that earlier version.

7. IQ Bot installer is case sensitive about the user account created for Сервер SQL or Окноs.

Important:  Use the username as it appears on the Microsoft SQL Server Management Studio under
Security > Logins. If it was created in upper case, then use upper case for the username to launch
the installer. Additionally, verify if the collation database property is set to case sensitive.

Windows unrecognized application message
The system might display a Windows Defender SmartScreen message about unrecognized applications at
the start of the installation process. The Administrator can either choose to continue with the installation
(by selecting Run anyway) or perform specific steps before installation to prevent the message from
appearing.
1. Click the Windows key to display the Start menu.
2. Enter gpedit.msc, and select the result (which can be Group Policy Editor or gpedit.msc).
3. Navigate to Computer Configuration > Administrative Templates > Windows Components >

File Explorer.
4. Double-click the policy Configure Windows Defender SmartScreen and set it to Disable.
5. Click OK to save the change.

IQ Bot 11.x: IQ Bot service configuration
In some IQ Bot deployments, the service account can be different from the login account. As an
administrator, provide the service credentials during installation.
IQ Bot Installer supports service credentials during Microsoft Windows or SQL server authentication. When
installing Services for IQ Bot, in the service installation window, the Local System Account check box is
selected by default. You can deselect this and provide a username and password.
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Прим.:
• Use Windows authentication with a valid system administration user in service configuration.
• Use Windows authentication with a local system for a system administration user.
• When using a remote SQL server to create a database, the combination of local system account for

service credentials and Windows authentication for SQL connection is not supported.
• The service account used for IQ Bot services must have full rights to the IQ Bot installation folder.

If you do not select the Local System Account checkbox, provide your user credentials to run the IQ Bot
Services.

Прим.:
• A valid system administrator user requires Окноs authentication with the Services user credentials.
• При вводе учетных данных пользователя убедитесь, что они связаны с доменом. For example:

example.com/testuser. User is unable to use this function without the domain.

See IQ Bot 11.x: Установка IQ Bot в пользовательском режиме to view the use of service credentials in IQ
Bot.

IQ Bot 11.x: IQ Bot Windows services
IQ Bot Windows services are automatically installed when running the installation and setup.
Make sure that the following Windows services are set when installing IQ Bot.

Имя службы Описание

Automation Anywhere Cognitive Alias IQ Bot service that manages domains, domain
dictionary, aliases, and languages supported in
the system.

Automation Anywhere Cognitive Application IQ Bot service that provides support for all
Control Room integration points and information
about IQ Bot application configuration.

Классификатор Automation Anywhere Cognitive IQ Bot service that provides support to classify
documents in a learning instance, into different
groups.

Automation Anywhere Cognitive Console IQ Bot user interface.

Прим.:  In contrast to other services, the
Automation Anywhere Cognitive Console service
runs on the local user account rather than the
domain or service account.

Automation Anywhere Cognitive File Manager IQ Bot service that manages documents in the
file management system.

Automation Anywhere Cognitive Gateway-2 IQ Bot Gateway for all the IQ Bot backend
services, handling authorization and validation of
request/response of APIs.

Automation Anywhere Cognitive MLScheduler
Service

IQ Botservice scheduler for ML Web Service.

© 2023 Automation Anywhere. All rights reserved.     102



    Automation Anywhere - Installing IQ Bot

Имя службы Описание

Automation Anywhere Cognitive MLWeb Service IQ Bot service that prepares models based on
user validation.

Automation Anywhere Cognitive Projects IQ Bot service managing learning instances.

Automation Anywhere Cognitive Report IQ Bot dashboard.

Automation Anywhere Cognitive Валидатор IQ Bot service to manage documents that go for
validation.

Automation Anywhere Cognitive Visionbot
Manager

IQ Bot service to manage vision bots in the
system.

Automation Anywhere Cognitive VisionbotEngine
Service

IQ Bot service to process document based on
different inputs provided.

Прим.:  All the services can be configured either in Local System or Domain account when IQ Bot is
installed in Custom mode. For IQ Bot installed in Express mode, all the services are run in Local System
account.

IQ Bot 11.x: RabbitMQ v3.8.18 and Erlang/OTP upgrade
The IQ Bot Version 11.3.x installation package includes the RabbitMQ v3.8.18 version 3.7.17 and Erlang/
OTP version 22.0.
For Automation 360 IQ Bot, ensure that you download the Microsoft Visual C++ Redistributable 2017 x64
version because it is required for the latest version of Erlang/OTP.
The following information explains different scenarios for upgrading RabbitMQ v3.8.18/Erlang/OTP:
• Fresh installation of IQ Bot Version 11.3.x:

For a fresh installation, you do not have to perform any additional steps, as RabbitMQ v3.8.18 Erlang/
OTP are included in the IQ Bot Version 11.3.x installation package. These get installed automatically on
the machine during the installation process.

• Upgrade from previous version of IQ Bot to Version 11.3.x:
Uninstall the earlier version of RabbitMQ v3.8.18 / Erlang/OTP.

• An earlier version of RabbitMQ v3.8.18/Erlang/OTP exists on the machine and the user
wants to upgrade to the latest versions:
You need to manually remove any older versions from the system using a batch utility file provided by
Automation Anywhere. Contact the Automation Anywhere Support team to get the utility. You can then
proceed with installing IQ Bot Version 11.3.x.

Related tasks
Uninstall previous version of RabbitMQ v3.8.18 / Erlang/OTP on page 104
When upgrading to IQ Bot Version 11.3.x, you need to uninstall the previous version of RabbitMQ v3.8.18 /
Erlang/OTP.
IQ Bot 11.x: Health Check API response if RabbitMQ v3.8.18 fails to start on page 147
Check the status of each IQ Bot service using the Health Check API if RabbitMQ v3.8.18 fails to start.
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Uninstall previous version of RabbitMQ v3.8.18 / Erlang/OTP
When upgrading to IQ Bot Version 11.3.x, you need to uninstall the previous version of RabbitMQ v3.8.18 /
Erlang/OTP.
Except for a fresh installation of IQ Bot Version 11.3.x, all upgrades to Version 11.3.x require you to
uninstall older RabbitMQ v3.8.18 Erlang/OTP instances.
Follow these steps to uninstall RabbitMQ v3.8.18 or Erlang/OTP:
1. Uninstall existing RabbitMQ v3.8.18 and Erlang/OTP from the Control Panel.
2. Run the Cleanup_Components.bat file as an administrator.
3. Restart your machine.
4. After running the scripts, verify that RabbitMQ v3.8.18 and Erlang/OTP are removed completely. If not,

uninstall them manually to delete any remaining files from the program files folder, and then repeat
Step 3.

Related concepts
IQ Bot 11.x: RabbitMQ v3.8.18 and Erlang/OTP upgrade on page 103
The IQ Bot Version 11.3.x installation package includes the RabbitMQ v3.8.18 version 3.7.17 and Erlang/
OTP version 22.0.
Related tasks
Upgrading IQ Bot to Version 11.3.3.x on page 246
This topic provides instructions on upgrading IQ Bot from Version 6.5.x and older, to Version 11.3.3.x.

Installation limitations
Learn about the installation limitations before installing IQ Bot.
Database encryption limitations
Installation time increases when encryption of the SQL database backup file is in progress, and also when
the database backup file size increases.
The encryption process of the SQL database might result in the creation of large transaction logs. Allocate
at least 3 to 4 times more disk space than the database backup file size.
IQ Bot has been tested for basic compatibility with Microsoft Azure databse with single database PaaS.
However, the functionality for the following scenarios was not fully verified:
• IQ Bot services configured in the Active Directory
• IQ Bot Портал secured with HTTPS
• IQ Bot operating in a Cluster mode
• Using Microsoft Windows authentication to connect to the database
• Microsoft Windows authentication with the local system works only if the NT Authority/System user has

system administration permissions.
• The combination of Local System Account for service credentials and Microsoft Windows authentication

for the SQL connection is not supported if you are using the remote SQL server to create databases.

Prerequisites for installing  in Cluster mode
Complete the prerequisites to set up  in cluster mode.
To set up a cluster, do the following:
1. Run the installer on each application server node.
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2. Share the output folder with the access role Everyone.
3. Run the messagequeue_cluster_configuration.bat post-installation with appropriate

command line arguments provided in the Cluster Configuration guide.
4. Set up  in High Availability mode when you set up IQ Bot in the High Availability mode as well.
5. Install RabbitMQ v3.8.18 with cluster configuration in a multi-node setup.
6. Configure the firewall to have ports 4369 and 25672 open.

The first node where IQ Bot is installed becomes the primary RabbitMQ v3.8.18 node. The host name
of the primary node is used to set up the RabbitMQ v3.8.18 cluster configuration.

7. Ensure you have a load balancer for a cluster setup to distribute traffic to all application server nodes.
8. Configure the SQL server in the High Availability setup.
9. Ensure the SQL server is set up in always on mode.

Related tasks
IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113
Install IQ Bot in Cluster mode for improved throughput.

IQ Bot 11.x: Prerequisites for installing IQ Bot in Express mode
Complete the prerequisites to set up  in express mode.
Complete the following steps before you begin installing IQ Bot in express mode.
1. Preinstall the Automation Anywhere Control Room Version 11.3.1 base plus either Version 11.3.1.1

or Version 11.3.1.2 patch on the target machine in express mode. This is required for communicating
with the Control Room using default settings.

2. Ensure that SQL Server Browser service is up and running before installing IQ Bot in express mode.
3. Start the SQL Server Browser service in any one of the following ways:

Option 1 a. Launch the SQL Server
Configuration Manager.

b. Go to SQL Server Services.
c. Start the SQL Server Browser

services.

Option 2 a. Launch the Task Manager.
b. Go to the Services tab.
c. Start the SQLBrowser services.

4. Use the Automation_Anywhere_IQ_BOT_<version_number>.exe file to install IQ Bot.
5. The setup wizard guides you through the installation process. During installation, any software

dependencies or missing prerequisites are installed.

Note:  When a file is uploaded to a fresh IQ Bot instance, the database administrator is unable to
extract any information about that file from the database as the data is encrypted.

6. Enable SQL authentication.
Enable the TCP protocol on the SQL server and listen to the local host at port 1433.

7. Set the SQL server instance name to AACRSQLEXPRESS.
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8. Create a user with sysadmin permissions for username aaadmin, and password aabots@123.
9.

6.5

If you install IQ Bot Version 6.5, with the Control Room, ensure you update the
cluster.properties file and set ignite.security.disable=true and
ignite.tls.disable=true. If you install IQ Bot Version 6.5.2, ensure you update the
cluster.properties file and set ignite.tls.disable=true.
a) Locate the file in your Control Room directory (for example, C:\Program Files\Automation

 Anywhere\Enterprise\config\). If the file does not exist in your Control Room directory,
then create it using a text editor:
1. Create a file with the filename, cluster.properties.

Note:  Ensure all file extensions are shown and your editor is opened with Administrator
rights.

2. For IQ Bot Version 6.5, add ignite.security.disable=true and
ignite.tls.disable=true.

3. For IQ Bot Version 6.5.2, add ignite.tls.disable=true.

b) Save the cluster.properties file.
c) Restart the following services:

• Automation Anywhere Control Room Service
• Automation Anywhere Control Room Caching
• Automation Anywhere Control Room Messaging

See IQ Bot 11.x: Installing IQ Bot in Express mode on page 106 for steps to install in Express mode.

IQ Bot 11.x: Installing IQ Bot in Express mode
Install IQ Bot in Express mode with the default settings.
Complete the prerequisites: IQ Bot 11.x: Prerequisites for installing IQ Bot in Express mode on page 105
1. Double-click the Automation_Anywhere_IQ_BOT_<version_number>.exe file.
2. In the IQ Bot Setup Wizard, click Yes, and then click Next.

Note:  The Control Room installation does not have to be in Express mode to install IQ Bot Version
6.5 in Express mode.

3. In the Prerequisites page, review the prerequisites and click Next.
4. In the License Agreement page, review the license agreement, accept the terms, and click Next.

IQ Bot runs a pre-installation check.
Появится экран предварительной установки с приложениями, не имеющими требуемой версии и
необходимых портов, вместе со службами, занимающими эти порты.
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5. If the pre-installation check is not successful, uninstall the mentioned software and free the required
ports.
a) Щелкните Повторить.
b) When the pre-installation check is successful, click Next.

Открывается страница Тип установки с настройками Экспресс и Пользовательский.

Note:  Во время экспресс-установки устанавливается IQ Bot на основе HTTP без поддержки
Active Directory.

6. Select Express and click Next.
7. After you click Next, the unable to proceed with installation message might appear if

one of the following conditions is not met.
a) If Control Room Version 11.3.1 base plus either Version 11.3.1.1 or Version 11.3.1.2 patch are not

pre-installed on the target machine in Express mode.
b) If the installer is unable to communicate with the Control Room or SQL Express.

If the error message appears, perform these steps:
a. Click Back to review or change the installation settings. Alternatively, exit the Setup Wizard and

click Cancel.
b. In the confirmation dialog box, click Yes to exit the Setup Wizard.

This rolls back all the changes.
c. Click No to resume.

8. In the Ready to install the program page, click Install.
The express installation begins and the system shows the Finished page after a few minutes to
indicate a successful installation.

9. For the Control Room, set the cluster.properties file as required based on the release version.
For more information about the associated cluster.properties file for each release version, see
IQ Bot version compatibility matrix on page 8.

IQ Bot is installed with the following default settings:
Security type: None (HTTP)
Web configuration: <web url:port>
Database configuration: <database url:port> (user: aaadmin ; Authentication: SQL)
Database password: aabots@123
Host Gateway: <gateway:port> (SSL Offloading: No)
Output path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform
\Output\
Logging Path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform\Logs
\
Logging path IQ Bot A360.21 onward: C:\Users\Public\Documents\Automation 360 IQBot
 Platform\Logs\
Installation path for IQ Bot Version 11.3.5: C:\Program Files (x86)\Automation Anywhere
 IQ Bot\
Installation path for Automation 360 IQ Bot:C:\Program Files (x86)\Automation Anywhere
 IQ Bot A2019\
Installation path IQ Bot A360.21 onward: C:\Program Files (x86)\Automation 360 IQ Bot\

IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118
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Register IQ Bot with Automation Anywhere Control Room.
Related tasks
IQ Bot 11.x: Установка IQ Bot в пользовательском режиме on page 108
Пользовательский режим используется для установки IQ Bot со сведениями о конфигурации.
IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113
Install IQ Bot in Cluster mode for improved throughput.
IQ Bot 11.x: Installing IQ Bot in Cluster mode on Amazon EC2 on page 117
Install IQ Bot in the cluster mode on Amazon Elastic Compute Cloud (Amazon EC2).

IQ Bot 11.x: Установка IQ Bot в пользовательском режиме
Пользовательский режим используется для установки IQ Bot со сведениями о конфигурации.
1. Run the Automation_Anywhere_IQ_BOT_<version_number>.exe installation file as an

administrator.
2. Для всех установок IQ Bot Version 6.5 и более поздних версий Microsoft SQL Server 2012 Native

Client — QFE устанавливается автоматически.
В первый раз после установки может потребоваться перезагрузка сервера. Перезапустите
процесс установки IQ Bot при необходимости.

3. В мастере настройки IQ Bot Automation Anywhere щелкните Далее.
a) Щелкните Далее в окне Предварительные условия.

4. Прочитайте лицензионное соглашение, примите условия и щелкните кнопку Далее.
IQ Bot выполняет проверку перед установкой.
Появится экран предварительной установки с приложениями, не имеющими требуемой версии и
необходимых портов, вместе со службами, занимающими эти порты.

5. Если проверка перед установкой не была успешной, удалите упомянутое программное
обеспечение и освободите необходимые порты.
a) Щелкните Повторить.
b) Когда проверка перед установкой пройдет успешно, щелкните кнопку Далее.

Открывается страница Тип установки с настройками Экспресс и Пользовательский.

Note:  Во время экспресс-установки устанавливается IQ Bot на основе HTTP без поддержки
Active Directory.

6. Выберите вариант Пользовательский и щелкните кнопку Далее.
7. В окне Конфигурация базы данных добавьте указанные ниже данные.

a) Имя хоста или IP. Введите имя хоста или IP-адрес.

Note:  Подчеркивание в имени хоста не допускается.

b) Порт. Введите номер порта.

Note:  Если на целевом компьютере локально установлена база данных Microsoft Windows
SQL Server Express, в качестве имени хоста автоматически подставляется localhost, а в
качестве порта — 1433.
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8.
11.3.5.3

В окне Настройка ключа шифрования выберите один из указанных ниже вариантов.
• По умолчанию, чтобы использовать автоматически сгенерированный предопределенный

ключ
• Custom if you want to use a custom key.

Ensure that the custom key is a 32-character, alphanumeric key, and does not contain any special
characters.

Вы можете выбрать этот вариант только во время новой установки IQ Bot. Этот вариант не
удастся изменить позднее.

Restriction:  If you upgrade from IQ Bot Version 11.3.5.3 installed using a custom key to Version
11.3.5.4, you might not be able to validate those documents in the Валидатор which were migrated
from Version 11.3.5.3.

For a cluster setup, ensure that you complete installing IQ Bot on the first node successfully before
you begin installing IQ Bot on the subsequent nodes.

9. Введите указанные ниже данные сервера базы данных на странице Конфигурация базы
данных и щелкните Далее.
Option Description

Вариант 1 Укажите свои учетные данные пользователя
Microsoft Windows SQL Server для входа на
сервер базы данных.

Вариант 2 Если установить флажок Использовать
аутентификацию Windows, не нужно
предоставлять учетные данные Microsoft
Windows для входа на сервер базы данных,
поскольку программа установки обнаруживает
их автоматически.

Сообщение об ошибке Не удалось подключиться к SQL-серверу с заданной
конфигурацией появляется при указанных ниже условиях.
• Неправильные имя сервера/IP-адрес и номер порта
• Неправильные учетные данные сервера базы данных
• Недостаточные права пользователя для подключения к базе данных

Note:
• При установке IQ Bot настройте учетные данные недавно размещенной базы данных в

Microsoft Azure SQL PaaS. Для проверки учетных данных и перехода к следующему экрану
может потребоваться до 300 секунд. Однако если локальная база данных для IQ Bot уже

© 2023 Automation Anywhere. All rights reserved.     109



    Automation Anywhere - Installing IQ Bot

перенесена на Microsoft Azure SQL PaaS перед установкой, задержки при настройке базы
данных не будет.

• IQ Bot не поддерживает логику повторных попыток для Microsoft Azure SQL PaaS. Избегайте
использовать IQ Bot во время запланированных мероприятий по техническому обслуживанию
в базе данных Microsoft Azure SQL.

• Если IQ Bot и экземпляр базы данных уже существуют, а IQ Bot устанавливается повторно,
IQ Bot получает экземпляр базы данных по умолчанию во время установки.

• Windows authentication with the local system works only if the NT Authority/System user has
system administrator permissions.

• Комбинация учетной записи Local System для служебных учетных данных и аутентификации
Microsoft Windows для подключения SQL не поддерживается, если для создания баз данных
вы используете удаленный SQL-сервер.

10. В окне Конфигурация служб установите флажок Локальная системная учетная запись и
щелкните кнопку Далее.
• Установите флажок Локальная системная учетная запись, чтобы службы запускались в

контексте локальной системной учетной записи.
• Если флажок Локальная системная учетная запись не установлен, укажите свои учетные

данные пользователя для запуска служб IQ Bot.
• Для действительного пользователя системного администратора требуется аутентификация

Windows с помощью учетных данных пользователя «Службы».
• При вводе учетных данных пользователя убедитесь, что они связаны с доменом. For

example: example.com/testuser. Пользователь не может воспользоваться этой
функцией без домена.

• In contrast to other services, the Automation Anywhere Cognitive Console service runs on the
local user account rather than the domain or service account.

11. В окне IQ BotКонфигурация портала введите указанные ниже данные и щелкните Далее.

Безопасность портала

Выберите тип безопасности: HTTPS или HTTP.

Выбрав HTTPS, убедитесь, что можете просмотреть, а затем выбрать
действительный файл сертификата PFX в поле Путь к сертификату.
IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS on page 132

Выбрав HTTP, перейдите к следующему шагу.
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Безопасность портала

Введите действительную парольную фразу сертификата в поле Парольная фраза
сертификата.

Конфигурация портала

Имя хоста или IP Введите имя хоста или IP-адрес IQ
Bot или используйте автоматически
заполняемое значение по умолчанию,
которое представляет собой полное
доменное имя (FQDN) компьютера, на
котором устанавливается IQ Bot.

Note:  По умолчанию автоматически
подставляется полное доменное имя
компьютера, на котором устанавливается
IQ Bot.

Порт Введите номер порта или используйте
автоматически заполняемое значение по
умолчанию — 3000.

12. В окне Конфигурация балансировщика нагрузки выполните указанные ниже действия.
a) Установите флажок Использовать то же, что и портал IQ Bot, чтобы использовать для

балансировщика нагрузки те же имя хоста и номер порта, которые были указаны ранее
в окне Конфигурация портала в IQ Bot. Этот флажок установлен по умолчанию. Этот
флажок следует оставить установленным при выполнении любого указанного ниже условия.
• IQ Bot устанавливается на одном компьютере.
• Конфигурацию балансировщика нагрузки планируется оставить такой же, как на

странице IQ Bot.

b) Если значения конфигурации балансировщика нагрузки отличаются от значений на
странице IQ Bot, снимите флажок Использовать то же, что и портал IQ Bot и введите
указанные ниже значения.
• Имя хоста балансировщика нагрузки: Введите имя хоста или IP-адрес.
• Порт балансировщика нагрузки. Введите номер порта.

c) При необходимости установите флажок Балансировщик нагрузки может
обрабатывать разгрузку SSL и щелкните Далее.

Note:  Если во время настройки балансировщика нагрузки задать режим безопасности
HTTPS в окне Конфигурация портала IQ Bot, разгрузка SSL по умолчанию отключена.
Чтобы включить разгрузку SSL для балансировщика нагрузки, выберите HTTP в окне
Конфигурация портала IQ Bot.

Ниже приведены некоторые дополнительные возможности настройки балансировщика
нагрузки.
• При установке IQ Bot в AWS, чтобы обеспечить доступ к серверу IQ Bot из внешнего

местоположения, замените имя шлюза именем, предоставляемым общедоступной
службой DNS.

• При повторной установке имя хоста балансировщика нагрузки и порт автоматически
определяются программой установки на основе данных предыдущей установки,
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сохраненных в файле Control Room. Изменяйте их при необходимости, поскольку это
полезно при установке нескольких экземпляров IQ Bot для масштабируемости (чтобы не
пришлось запоминать сведения для каждого экземпляра).

• При использовании HTTPS-сертификата в балансировщике нагрузки с псевдонимом,
который отличается от имени хоста машины (FQDN), введите псевдоним в качестве
имени хоста.

• Программа установки берет значение из окна ПорталКонфигурация в IQ Bot (с
предыдущей страницы), но показывает ранее полученные значения в отключенных
текстовых полях из окна Control Room.

13. В окне Папка назначения внесите необходимые изменения в папки назначения и щелкните
Далее.
• Путь установки. При необходимости выберите другой путь установки.

Путь установки по умолчанию: C:\Program Files(x86)\Automation Anywhere IQ Bot
 <номер версии>\

IQ Bot A360.21 и далее: C:\Program Files (x86)\Automation 360 IQ Bot\
• Путь вывода. Выберите путь вывода, где будут сохраняться выходные данные. Путем

вывода также может быть общий сетевой путь. Во время повторной установки Путь
вывода автоматически определяется программой установки (на основе данных предыдущей
установки, хранящихся в базе данных конфигурации IQ Bot). При необходимости измените
сведения.
Путь вывода по умолчанию: C:\Users\Public\Documents\Automation Anywhere IQ
 Bot Platform\Output\

14. В окне Готовность к установке программы проверьте и просмотрите настройки установки и
щелкните Установить, чтобы начать установку.
• При первой установке в процессе установки может появиться оповещение системы

безопасности Microsoft Windows Security с предложением разрешить программе установки
установить Erlang. При появлении такого запроса щелкните Разрешить доступ.

• Иногда окно Оповещение системы безопасности Windows не видно (оно может быть
скрыто за другими активными окнами). С помощью сочетания клавиш Alt + Tab убедитесь,
что окно Оповещение системы безопасности Windows не скрыто за другими видимыми
окнами.

15. Щелкните Разрешить доступ, чтобы завершить установку, а в окне Успешная установка
щелкните Готово.
На рабочем столе создается значок IQ Bot.
Если при запуске IQ Bot возникает ошибка, возможно, придется перезапустить службы Cognitive
Console Automation Anywhere Control Room Reverse Proxy и Automation Anywhere.

16. Для Control Room задайте файл cluster.properties нужным образом в зависимости от
версии выпуска..
For more information about the associated cluster.properties file for each release version, see
IQ Bot version compatibility matrix on page 8.

IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118
Register IQ Bot with the Control Room.
Related tasks
Контрольный список после установки on page 138
Verify if IQ Bot is installed, and ensure the IQ Bot services are running using the healthcheck APIs.
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IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS on page 132
This section describes single and multiple domain scenarios when installing IQ Bot and Control Room with
various server certificates.
Reinstalling HTTPS SSL certificate on expiry on page 150
Reinstall HTTPs SSL certificate when your HTTPS SSL certificate expires.
IQ Bot 11.x: Create a self-signed certificate with Subject Alternative Name on page 131
Create a self-signed certificate with Subject Alternative Name (SAN) when you want to use an SSL
certificate for multiple domains.
IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113
Install IQ Bot in Cluster mode for improved throughput.
Related reference
IQ Bot version compatibility matrix on page 8
Before you install or upgrade, read the compatible versions of IQ Bot with the Control Room.

IQ Bot Custom installation
Install IQ Bot in Custom mode to configure and install specific requirements, for example, connection to an
SQL database, load balancer details, and output folder definitions.
If you have not done so already, first review IQ Bot Architecture Guide and IQ Bot 11.x: IQ Bot installation
prerequisites and ensure you have the following available on Windows Server 2016 Standard / Data Center
or 2012 R2 Standard / Data Center:
• Браузер Google Chrome
• Microsoft SQL Server Express 2014 SP1
• Microsoft SQL Server Management Studio (SSMS)
• Automation Anywhere Control Room
• Automation Anywhere Enterprise Client
• IQ Bot installation file
• SSL certificate
• License file for IQ Bot

The Custom mode installation enables users to set up IQ Bot with the following process:

Шаг 1. Create a role See Create a role for information on creating a role.
Шаг 2. User roles and permissions Find out about the roles and associated permissions

required for each IQ Bot user to know the role you
need access to. Your permission to access specific
areas in IQ Bot are defined and depend on your
user role.

Шаг 3. IQ Bot 11.x: Установка IQ Bot в
пользовательском режиме

IQ Bot scales horizontally in Custom mode to
support improved throughput.

Шаг 4. IQ Bot 11.x: Registering IQ Bot with the
Control Room

IQ Bot can be accessed after registering it with
Control Room

IQ Bot 11.x: Installing IQ Bot in Cluster mode
Install IQ Bot in Cluster mode for improved throughput.
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IQ Bot supports clustering of up to five IQ Bot installations.
1. Install IQ Bot on the target machines in the custom mode. During installation, on the Load Balancer

Configuration screen, type in the load balancer host name and port.
2. Select the Load Balancer can handle SSL Offloading option, if the load balancer supports is to

enable SSL offloading.
3. Provide the shared output path on the Destination Folder screen.
4. During installation, use the same database server details on all the nodes.

After completing the installation, perform the following for each node to complete the process:
1. Get the host name of the primary node.

Note:  The primary node is the node where IQ Bot was first installed.

2. Using administrator permissions, open the command prompt.
3. Navigate to the <installation Directory\Configurations> folder.
4. Run messagequeue_cluster_configuration.bat and pass the host name of the primary node:

C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\Configurations> 
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messagequeue_cluster_configuration.bat Server1

Important:  In a cluster setup, if a temporary network issue occurs, the cluster breaks. To add the
nodes back into the cluster, you must manually execute commands in each of the participating nodes.
You also have to monitor the cluster status to know if it is healthy or broken. To avoid such issues, you
can configure the cluster to automatically recover (auto-recover) from temporary network issues. See this
article for information about how to enable auto-recovery: RabbitMQ Cluster Configuration with Auto-recovery
(A-People login required).

Related tasks
IQ Bot 11.x: Make a Shared Folder Accessible on page 115
IQ Bot 11.x: Installing IQ Bot in Cluster mode on Amazon EC2 on page 117
Install IQ Bot in the cluster mode on Amazon Elastic Compute Cloud (Amazon EC2).

IQ Bot 11.x: Make a Shared Folder Accessible

Follow the steps to make your shared folder accessible to IQ Bot.
1. Change log on of the application services with .\Administrator account on all cluster nodes.
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2. On primary (shared folder) node, change following settings:
a) Click Control Panel > Network and Internet > Network and Sharing Center > Advanced

Sharing Setting
b) Expand Private and click Network Discovery.
c) In Network Discovery:

1. Select Turn on Network Discovery.
2. Check the Turn on automatic setup of network connected devices checkbox.
3. Click File and Printer Sharing and then select the Turn on file and printer sharing

checkbox.

d) Expand Guest or Public and click Network Discovery.
e) In Network Discovery:

1. Select Turn on Network Discovery.
2. Click File and Printer Sharing and then select the Turn on file and printer sharing

checkbox.

Open "Local Group Policy Editor". Go to Local Computer Policy >> Windows Settings >> Security
Settings >> Local Policies >> Security Options. Find "Network access : Sharing and security
model for local accounts". Change it to "Guest only - local users authenticate as Guest".

f) Click Local Group Policy Editor.
g) Click Local Computer Policy > Windows Settings > Security Settings > Local Policies >

Security Options.
h) Find Network access : Sharing and security model for local accounts and change it to

Guest only - local users authenticate as Guest.
i) Execute this Powershell script:

Set-ItemProperty -Path "HKLM:\SYSTEM\CurrentControlSet\Services
\LanmanWorkstation\Parameters" -Name "AllowInsecureGuestAuth" -Type
 DWord -Value 1

You need to execute this Powershell script on every machine which is a part of the cluster.

IQ Bot 11.x: Installing IQ Bot in Cluster mode on machines
with IQ Bot preinstalled

If you have IQ Bot already installed on your machine, uninstall IQ Bot, stop  service, and clean the existing
RabbitMQ v3.8.18 cookies before installing IQ Bot in Cluster mode.
• Open ports 4369 and 25672 and add inbound firewall rules to allow traffic to these ports on each target

machine.
• To add nodes to the cluster, sync the RabbitMQ v3.8.18 cookies to enable running any RabbitMQ

v3.8.18 commands . If IQ Bot is already installed on the target machine, clean up and remove the
existing cookies.

Follow the clean up procedure before setting up a cluster:
1. Uninstall IQ Bot from Program and Features.
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2. Stop the RabbitMQ v3.8.18 service, by running the command: net stop RabbitMQ /yes.
3. Uninstall RabbitMQ v3.8.18 from %Programfiles%\RabbitMQ Server\uninstall.
4. Stop the epmd.exe and its descendants by running this command: Taskkill /IM epmd.exe /F.
5. Stop erl.exe and erlsrv.exe and its descendants by running the following commands:

a) Taskkill /IM erl.exe /F

b) Taskkill /IM erlsrv.exe /F

6. Uninstall Erlang from %Programfiles%\erl8.2\Uninstall.
7. Remove the following folders if they were not removed from the uninstall:

a) %Programfiles%\Rabbit MQ Server

b) %Programfiles%\erl8.2

8. Remove the following folders: %appdata%\RabbitMQ, %WINDIR%\.erlang.cookie,
%USERPROFILE%\.erlang.cookie.

Do the following after completing the installation steps:
• The load balancer details for the following are available:

name of the load balancer
порт
type of security used (For example, HTTP or HTTPS)

• Share a folder for configuring the output path.

Прим.:  The user installing IQ Bot requires appropriate access permissions.

IQ Bot 11.x: Installing IQ Bot in Cluster mode on Amazon EC2
Install IQ Bot in the cluster mode on Amazon Elastic Compute Cloud (Amazon EC2).
If you install IQ Bot in Cluster mode on Amazon EC2, make a note of the following.
• The name for the Amazon EC2 RabbitMQ v3.8.18cluster is in this format: rabbit@ip-XXX-XXX-XX-

XX.
• Connecting to a node works if both the nodes are in the same local network, but if you connect to a

cluster outside the local Amazon EC2 network, configure the host file of node 2.
• Add an entry in the host file where AA.AA.AAA.AAA is the public IP of node 1.

AA.AA.AAA.AAA
ip-XXX-XX-XX-XX

If all the IQ Bot instances in a cluster are not a part of the same domain, ensure that the following services
are running using the Administrator user login on each instance.
• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive File Manager

To run a service using the Administrator user login, do the following procedure.
1. Click Task Manager > Services > Open Services.
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2. Right-click the target service, for example, Automation Anywhere Cognitive Projects, and click
Properties.

3. In the Properties dialog box, select This account and enter the credentials for the administrator user.
4. Click OK and restart this service. Repeat these steps for the remaining services on this instance and all

the other IQ Bot instances in the cluster.

Related tasks
IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113
Install IQ Bot in Cluster mode for improved throughput.

IQ Bot post installation configuration
After installing IQ Bot complete the configuration settings to ensure registration with Control Room,
confirm the creation of all required databases, create the appropriate certificates, configure the HTTP and
HTTPS settings, generate the authorization token for performing any task, and verify the completion of all
tasks in the post-installation checklist.

Control Room installation Review the installation core tasks and topics for
installing Enterprise Control Room in a data center
on an on-premise server or a cloud service provider
server instance.

Related tasks
IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118
IQ Bot is integrated with Control Room for user management. Installation of the Enterprise Control Room
and Enterprise Client is not a prerequisite for installing IQ Bot. However, you are required to log in to the
Enterprise Control Room and register before using IQ Bot.
IQ Bot 11.x: Use Microsoft Azure Computer Vision OCR engine on page 121
IQ Bot automate some installation steps for Microsoft Azure Computer Vision OCR engine.
Use ABBYY FineReader Engine Распознавание текста (OCR) engine in IQ Bot 11.x on page 123
IQ Bot installation now automates the installation of ABBYY FineReader Engine (FRE) optical character
recognition (OCR) plug-in.
Databases created during IQ Bot installation on page 130
Learn which databases and tables are created after installing IQ Bot.
IQ Bot 11.x: Create a self-signed certificate with Subject Alternative Name on page 131
Create a self-signed certificate with Subject Alternative Name (SAN) when you want to use an SSL
certificate for multiple domains.
IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS on page 132
This section describes single and multiple domain scenarios when installing IQ Bot and Control Room with
various server certificates.
Контрольный список после установки on page 138
Verify if IQ Bot is installed, and ensure the IQ Bot services are running using the healthcheck APIs.

IQ Bot 11.x: Registering IQ Bot with the Control Room
IQ Bot is integrated with Control Room for user management. Installation of the Enterprise Control Room
and Enterprise Client is not a prerequisite for installing IQ Bot. However, you are required to log in to the
Enterprise Control Room and register before using IQ Bot.
Do the following before registering IQ Bot with Control Room:
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• Ensure the Control Room and IQ Bot are on the same subnet.
• Launch Control Room and create an admin user.
• Install the license for IQ Bot.

Note:  Install the IQ Bot-specific license.
See Installing a license.

IQ Bot can be accessed after registering it with Control Room. When installing IQ Bot, use the following
guidelines:

For Express installation: Control Room Version 11.3.1 base plus Version
11.3.1.1 or later patch must be installed in Express
mode before installing IQ Bot.

For Custom installation: Control Room Version 11.3.1 base plus Version
11.3.1.1 or later patch must be installed in Custom
mode before installing IQ Bot.

Note:  Make a note of the database credentials used for the Control Room installation. This is required for
IQ Bot installation if you are using the same database.

1. Log in to Control Room as an administrator.
If you already logged into Control Room in the same browser session, you are automatically logged in
to IQ Bot.

2. Click Administration > Settings > IQ Bot.
3. Click Edit in the IQ Bot section, and a text box appears.
4. Enter the correct IQ Bot URL for example, http(s)://IQBotURL/, and click Save changes.

If the application registration fails, try registering again.

Log in to IQ Bot.

Note:  IQ Bot supports Google Chrome.

Related tasks
IQ Bot 11.x: Resolving IQ Bot registration failure on page 120
Use the instructions in this topic if IQ Bot registration fails due to HTTPs URL issues.
Unregistering IQ Bot 11.x from the Control Room on page 119
You have to unregister IQ Bot from the Control Room if the IQ Bot URL changes because of installation or
uninstallation of IQ Bot, or when a load balancer is added.

Unregistering IQ Bot 11.x from the Control Room
You have to unregister IQ Bot from the Control Room if the IQ Bot URL changes because of installation or
uninstallation of IQ Bot, or when a load balancer is added.
After unregistering IQ Bot from the Automation Anywhere Control Room, restart the Automation Anywhere
Cognitive Console service.
1. Using the sysadmin role, run two separate SQL queries in different databases.
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2. Run the first SQL query in the Control Room database to delete the following data:
• DELETE FROM [CRDB-NEW].[dbo].[APP_USER] WHERE [type]='IQBOT'

• DELETE FROM [CRDB-NEW].[dbo].[USERS] WHERE user_type='APP'

• DELETE from dbo.ACTIVEMQ_ACKS

• DELETE from [CRDB-NEW].dbo.ACTIVEMQ_ACKS

• DELETE from dbo.ACTIVEMQ_MSGS

3. Run the second SQL query in the IQ Bot configuration database to delete the following data:
• DELETE FROM [Configurations].[dbo].[Configurations] where

 [key]='controlRoomVersion'

• DELETE FROM [Configurations].[dbo].[Configurations] where
 [key]='appRegistered'

• DELETE FROM [Configurations].[dbo].[Configurations] where
 [key]='controlRoomUrl'

• DELETE FROM [Configurations].[dbo].[Configurations] where [key]='appId'

You have unregistered successfully.
Related tasks
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.

IQ Bot 11.x: Resolving IQ Bot registration failure
Use the instructions in this topic if IQ Bot registration fails due to HTTPs URL issues.
1. Use Windows Services to restart the Control Room service.
2. Update the Control Room HTTPs URL by logging in to Control Room > Administration > Settings

> General.
3. Use Windows Services to restart the following services:

• Automation Anywhere Control Room Cognitive Console
• Automation Anywhere Control Room Reverse Proxy

4. Re-register IQ Bot with the HTTPs URL in the Control Room.
IQ Bot is registered successfully.

Related tasks
Unregistering IQ Bot 11.x from the Control Room on page 119
You have to unregister IQ Bot from the Control Room if the IQ Bot URL changes because of installation or
uninstallation of IQ Bot, or when a load balancer is added.
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IQ Bot 11.x: Use Microsoft Azure Computer Vision OCR engine
IQ Bot automate some installation steps for Microsoft Azure Computer Vision OCR engine.
• Microsoft Azure Computer Vision OCR engine is a cloud Распознавание текста (OCR) engine and is

available to all customers of IQ Bot.
• Data is not stored and is removed immediately.

For additional information on privacy for data retention see: Microsoft Azure Cognitive Services

See a list of allowed service URLs for using Microsoft Azure Computer Vision OCR engine in the example
section below.

Note:  When creating a learning instance, you can select any language from the IQ Bot's drop-down list.
During processing, the OCR engine tries to auto-detect the primary language and can override the user
selection. For example, you can specify English, but if you upload Spanish, the API would try to process
Spanish.

Microsoft Azure Computer Vision OCR engine provides approximately 18% STP and 80% accuracy with
data extraction.

Tip:  If IQ Bot is unable to extract data from low quality or handwritten documents, troubleshoot the
issue:
IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Follow the steps to configure the Settings.txt file and use Microsoft Azure Computer Vision OCR
engine.

Important:  Configuring the settings.txt file is not applicable to Automation 360 IQ Bot Cloud

1. Ensure your IQ Bot server has internet connectivity and external DNS resolution.
Check to enable communication for the API endpoint on default port = 443: default endpoint =
 https://aai-iq-bot-ocr.cognitiveservices.azure.com/.

Note:  To validate connectivity to the API endpoint and the server open a web browser on the server
and type in the complete URL for the API endpoint. If the browser returns a "404 error", then a
response from the API endpoint was received.

2. You can use your own Microsoft Azure Computer Vision OCR engine subscription or spell-check keys.
See IQ Bot 11.x: Use your own keys for Microsoft Azure Computer Vision OCR engine on page 122 for
more information.

3. From the C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\Configurations folder, open the Settings.txt file, and change the OCR engine value to
OCREngine=Tesseract4 or OCREngine=Abbyy to OCREngine=MicrosoftAzureAPI. Then save
the file.

4. Run the stopanduninstallallservices.bat file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot\Configurations.

Note:  After stopping the services, run installandstartallservices.bat file to install and start the
services.
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5. Create learning instances in IQ Bot, and use Microsoft Azure Computer Vision OCR engine for the text
segmentation and OCR engine for these learning instances.
At the same time, for these learning instances, you would continue to use the IQ Bot capabilities for
document classification, auto-mapped fields, cognitive extraction, and field value auto-correction.

List of service URLs used for Microsoft Azure Computer Vision OCR engine (optional)
Use the following allowed URLs if required:

Note:  All URLs point to a global service region in the US.

• https://aai-iq-bot-ocr.cognitiveservices.azure.com/
• https://aai-iq-bot-ocr-spellcheck.cognitiveservices.azure.com/

Note:  If IQ Bot is unable to process a document using Microsoft Azure Computer Vision OCR engine, see
IQ Bot unable to process the document with Microsoft Azure OCR (A-People login required) for troubleshooting
tips.

Related reference
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

IQ Bot 11.x: Use your own keys for Microsoft Azure Computer Vision OCR
engine
You can use your own Microsoft Azure Computer Vision OCR engine subscription or Spell Check keys.
Users can use a combination of their own Microsoft Azure Computer Vision OCR engine keys with
the Spell Check keys provided by Automation Anywhere. Using the provided Spell Check keys from
Automation Anywhere will send your data to the Automation Anywhere account. If you do not want
to send any data to the Automation Anywhere Microsoft Azure account, you would have to provide
your own Spell Check service keys, or turn it off by setting the value in the Settings.txt file to
EnableAutoCorrectSegmentText: false.
Follow the steps to use your own keys for Microsoft Azure Computer Vision OCR engine.
1. By default, IQ Bot's encrypted Microsoft Azure Computer Vision OCR engine subscription and

Spell Check keys are used. If you prefer to use your own Microsoft Azure Computer Vision OCR
engine subscription and, or Spell Check keys, go to C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurationsand folder Configurations >
AzureOCREngineSettings.json file, and specify your keys.
If both SubscriptionKey and SubscriptionClientKey are specified, then
SubscriptionClientKey is used:
• VisionSubscriptionKey
• VisionSubscriptionClientKey
• SpellCheckSubscriptionKey
• SpellCheckSubscriptionClientKey

2. Enter your keys correctly to ensure proper API calls as follows:
Before:

{
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  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "",
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

After:

{
  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "191234d5e7abc1f382123459d4399e33",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "336f8f6a503a4c30ba123456834d4abc",
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

3. Run the stopanduninstallallservices.bat file as an administrator. The default location
of the file is at C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations.

4. Run the installandstartallservices.bat file as an administrator. The default location
of the file is at C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations .
Log in or refresh your IQ Bot web page.

Use ABBYY FineReader Engine Распознавание текста (OCR)
engine in IQ Bot 11.x
IQ Bot installation now automates the installation of ABBYY FineReader Engine (FRE) optical character
recognition (OCR) plug-in.

Note:  IQ Bot supports ABBYY FineReader Engine version 12.2 and 12.3 for IQ Bot.

When installing IQ Bot, the system automatically installs an ABBYY FineReader Engine open run-time
license on your server.
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Use the following steps to manually install ABBYY FineReader Engine:
1. Download the OCR plug-in with IQ Bot.
2. Unzip the OCR plug-in folder in your downloads folder, and place that unzipped folder, at C:\Program

 Files (x86)\Automation Anywhere IQ Bot <version>.
3. Ensure the folder says \OCR Plugins\ABBYY SDK\12\. . . , and the unzipping does not create

OCR Plugins\OCR Plugins twice.
4. To use ABBYY FineReader Engine with IQ Bot you have the following options:

Параметры Описание

Set ABBYY FineReader Engine as your
default Распознавание текста (OCR)
engine

Configure the Settings.txt file.
Follow steps 5 and 6 to configure the
Settings.txt file.

Important:  Configuring the settings.txt
file is not applicable to Automation 360 IQ Bot
Cloud

Select ABBYY FineReader Engine
Распознавание текста (OCR) engine from
the UI

To select from the UI, see IQ Bot 11.x: Selecting
an Распознавание текста (OCR) engine on page
164.

5. Important:  Configuring the settings.txt file is not applicable to Automation 360 IQ Bot Cloud.
In Automation 360 IQ Bot Cloud, you can use the appConfigurations API to read and update the
OCR settings.
For help with using the API, contact the Support team. Open a support case (A-People login required)

To set ABBYY FineReader Engine as your default Распознавание текста (OCR) engine, from the C:
\Program Files (x86)\Automation Anywhere IQ Bot <version>\Configurations
folder, open the Settings.txt file, change OCREngine=Tesseract4 to OCREngine=Abbyy, and save
the file.

Important:  Troubleshoot classification issue in processing Chinese language documents:
All files are getting unclassified while processing Chinese language documents (A-People login required)

6. Next, run the stopanduninstallallservices.bat file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot\Configurations.

Note:  After stopping the services, run installandstartallservices.bat file to install and start the
services.

7. Create learning instances in IQ Bot, and use ABBYY FineReader Engine for the text segmentation
and Распознавание текста (OCR) engine for these learning instances. At the same time, for these
learning instances you still partner with the IQ Bot capabilities on document classification, auto-
mapped fields, cognitive extraction, and field value autocorrection.

Note:  If you install IQ Bot in a different folder besides C:\Program Files
 (x86)\Automation Anywhere IQ Bot <version>, find and open the Configurations >
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ABBYYOCREngineSettings.txt folder, and update the embedded EnginePath and LicensePath to
match the different folder.

Пример.

{
  "UseOpenRuntimeLicense": true,
  "EnginePath": "C:\\Program Files (x86)\\Automation Anywhere IQ Bot 6.5
 Beta\\OCR Plugins\\ABBYY SDK\\12\\FineReader Engine\\Bin",
  "DeveloperSN": "",
  "ProjectId": "",
  "LicensePath": "C:\\Program Files (x86)\\Automation Anywhere IQ Bot 6.5
 Beta\\Configurations\\Runtime.ABBYY.LocalLicense",
  "LicensePassword": ""
}

Note:  Sometimes, documents can fail to classify with ABBYY FineReader Engine as your default
Распознавание текста (OCR) engine. See recommended workaround for this issue.
Document uploads are moving to unclassified state while using Abbyy OCR engine (A-People login required)

Related reference
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

IQ Bot 11.x: Installation steps if ABBYY FineReader Engine remains installed
from a previous IQ Bot version
If ABBYY FineReader Engine remains installed from a previous IQ Bot version, use the IQ Bot ABBYY
FineReader Engine open run-time license.

1. Navigate to the IQ Bot installation directory > configuration folder, and open the
AbbyyOCREngineSettings.json file to update the following properties:
Change the EnginePath and paste the installed ABBYY FineReader Engine engine path. For example,
C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin. Ensure the path includes
separators as two backward slashes.

2. Go to the ABBYY FineReader Engine installation directory, open the Bin folder, and remove the
Protection.Developer.dll file.

3. From the C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations folder, open the Settings.txt file, modify or ensure OCREngine=ABBYY
FineReader Engine, and save the file.

4. Run the stopanduninstallallservices file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

5. Run the installandstartallservices file and log in, or refresh your IQ Bot web page.

IQ Bot 11.x: Use your own ABBYY FineReader Engine license
Follow the steps to use your own ABBYY FineReader Engine license.
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1. Navigate to the IQ Bot installation directory > configuration folder, and open
AbbyyOCREngineSettings.json to update the following properties:
• Change the EnginePath and paste the installed ABBYY FineReader Engine engine path. For

example, C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin. Ensure the
path includes separators as two backward slashes. Update the DeveloperSN property with the
license key.

• Update the ProjectId property with your license project ID.
• Update the UseOpenRuntimeLicense to false.

2. From the C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations folder, open the Settings.txt file to ensure or modify OCREngine=ABBYY
FineReader Engine, and save the file.

3. Run the stopanduninstallallservices file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

4. Run the installandstartallservices file and log in to or refresh your IQ Botweb page.

IQ Bot 11.x: Use Google Vision API OCR engine
Use the Google Vision API Распознавание текста (OCR) engine with IQ Bot to improve the accuracy of
the optical character recognition (Распознавание текста (OCR)) results for training documents in Asian
languages, particularly in Japanese and Korean.  Google Vision API Распознавание текста (OCR) engine in
IQ Bot supports all languages supported by the engine.
Verify that the default port 443 is available to enable communication for the API endpoint using TCP.

Note:  See a list of allowed service URLs for using Google Vision API in the example section below.

Google Vision API files are installed on your machine automatically during the IQ Bot installation and is
provided as a built-in plug-in, with a single-step installation, and is available for all users:
• It is a cloud Распознавание текста (OCR) engine.
• Google Vision API does not support documents with more than one language. Before using this feature,

ensure you want to primarily extract Japanese or Korean text only.
• Languages that are written right to left, rather than left to right, are not supported within IQ Bot for

document extraction. For example, Arabic, Aramaic, Azeri, Divehi, Fula, Hebrew, Kurdish, N'ko, Persian,
Rohingya, Syriac, and Urdu.
Prior to this release, the engine primarily supported data extraction for Japanese and Korean text only.
IQ Bot 11.x: List of languages in IQ Bot on page 219

• Data is not stored in Google Cloud and is removed immediately.
For additional information on privacy for data retention see: Google Data Usage

IQ Bot provides you with the license to use the Google Vision API Распознавание текста (OCR) engine.
You can also use your own license key.
IQ Bot 11.x: Use your own license keys for Google Vision API OCR engine on page 128
You have the following options for using this Распознавание текста (OCR) engine:
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Параметры Описание

Вариант 1. Set Google Vision API as your
default engine

Configure the Settings.txt file.

Restriction:  Configuring the settings.txt
file is not applicable to Automation 360 IQ Bot
Cloud

Вариант 2. Select Google Vision API engine
directly from the UI when creating a learning
instance

IQ Bot 11.x: Selecting an Распознавание текста
(OCR) engine on page 164

To set Google Vision API as your default Распознавание текста (OCR) engine, configure the
Settings.txt file as follows:

Restriction:  Configuring the settings.txt file is not applicable to Automation 360 IQ Bot Cloud

1. Запустите установщик IQ Bot.
2. Navigate to ..\Automation Anywhere IQ Bot\Configurations\Settings.txt, and modify

the following value: OCREngine=GoogleVisionAPI.
This will set Google Vision API Распознавание текста (OCR) engine as the default engine for your
environment.

3. The GoogleOCREngineSettings.json file is generated within the ..\Automation Anywhere
 IQ Bot\Configurations folder with default values as follows:
• Use the following with Google Vision API:

{
 "ADCJson": null,
  "EngineType": 2,
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Logs\\Engine\\Google",
  "EnableCustomParse": false,
  "DistanceThreshold": 15
 }

• Use the following with Google Vision API in IQ Bot Version 11.3.5 and later:

{
 "ADCJson": null,
  "EngineType": 2,
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Logs\\Engine\\Google",
  }

4. For Japanese and Korean language documents, update the field: "EnableCustomParse": true.

Note:  A service restart is not required after making the change.

List of service URLs used for Google Vision API (optional)
Use the following allowed URLs if required:
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Note:  All URLs point to a global service region in the US.

• API URL: https://vision.googleapis.com/
• Auth URL: https://accounts.google.com/o/oauth2/auth
• Token URL: https://oauth2.googleapis.com/token
• Auth Provider URL: https://www.googleapis.com/oauth2/v1/certs
• Client Auth URL: https://www.googleapis.com/robot/v1/metadata/x509

1. Создайте новый обучаемый экземпляр с использованием документа на одном из азиатских
языков, который вы хотите обучить.

2. Обучите документ и переведите обучаемый экземпляр в рабочий режим.
3. Отправьте файлы на азиатском языке и запустите бот.
4. Выполните загрузку и просмотрите точность результатов извлечения.

Related reference
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

IQ Bot 11.x: Use your own license keys for Google Vision API OCR engine
You can use your own keys for Google Vision API OCR engine subscription.
Users can use their own authentication of Google Vision API. They would need to create Google Cloud
Application Default Credentials (ADC) and copy the content from ADC JSON file to the "ADCJson" field in
GoogleVisionOCREngineSettings.json..

Note:  Use the link to create Google Cloud Application Default Credentials for Google Vision API: https://
cloud.google.com/docs/authentication/production.

Follow the steps to use your own keys for Google Vision API OCR engine.
1. By default, IQ Bot's encrypted Google Vision API subscription keys are used. If you prefer to use

your own Google Vision API subscription keys, go to C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations, and folder Configurations >
GoogleVisionOCREngineSettings.json file, and specify your keys.

2. IQ Bot provides you with an inbuilt license for Google Vision API, but you have the option to overwrite
this license if you would like to use your own. Copy the content from the ADC JSON file correctly to
ensure proper API calls as follows:

{
  "ADCJson": {
    "type": "service_account",
    "project_id": "dark-caldron",
    "private_key_id": "9e83979f61cff072d0e0e4f91bf837e6e29bbb",
    "private_key": "-----BEGIN PRIVATE KEY-----\nMIIEvgIBADANBg......----
END PRIVATE KEY-----\n",
    "client_email": "vision-test@dark-caldron.iam.gserviceaccount.com",
    "client_id": "105342202023265468399",
    "auth_uri": "https://accounts.google.com/o/oauth2/auth",
    "token_uri": "https://oauth2.googleapis.com/token",
    "auth_provider_x509_cert_url": "https://www.googleapis.com/oauth2/v1/
certs",
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    "client_x509_cert_url": "https://www.googleapis.com/robot/v1/
metadata/x509/vision-test%40dark-caldron-254807.iam.gserviceaccount.com"
  },
  "EngineType": 2,
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Logs\\Engine\\Google",
  "HttpTimeoutInSec": 300,
  "EnableCustomParse": false,
  "DistanceThreshold": 15
}

Related tasks
IQ Bot 11.x: Use Google Vision API OCR engine on page 126
Use the Google Vision API Распознавание текста (OCR) engine with IQ Bot to improve the accuracy of
the optical character recognition (Распознавание текста (OCR)) results for training documents in Asian
languages, particularly in Japanese and Korean.  Google Vision API Распознавание текста (OCR) engine in
IQ Bot supports all languages supported by the engine.
Related information
https://cloud.google.com/docs/authentication/production

IQ Bot 11.x: Использование модуля Распознавание текста
(OCR) Tegaki API
Use the Tegaki API Распознавание текста (OCR) engine with IQ Bot to improve the accuracy of the optical
character recognition (OCR) results for training documents in Japanese and Korean. You can configure it
for use with IQ Bot Version 11.3.5 and later.
Просмотрите указанные ниже предварительные условия для настройки модуля Распознавание
текста (OCR) Tegaki API.
• Server selection information for Tegaki API Распознавание текста (OCR) engine.

См. раздел Tegaki on-premises server selection guide.
• IQ Bot предоставляет Tegaki API в качестве встроенного подключаемого модуля. Установите

Tegaki API в качестве модуля Распознавание текста (OCR) в файле settings.txt, находящемся
в следующей папке:
C:\Program Files (x86)\Automation 360 IQ Bot <version>\Configurations

• Set the communication for the API endpoint on default port = 443, using TCP protocol.

Распознавание текста (OCR) Tegaki API поддерживает документы на указанных ниже языках.
• Японский
• Корейский
• Японский-английский
• Корейский-английский

1. Запустите установщик IQ Bot.
2. Install the Tegaki API Распознавание текста (OCR) engine for the On-Premises version on your

machine based on instructions received from your Automation Anywhere representative.
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3. Next, install your license key. IQ Bot does not provide you with the license to use the Tegaki API
Распознавание текста (OCR)engine. You have to use your own license key.
Выполните указанные ниже шаги для установки собственного лицензионного ключа.
a. Navigate to C:\Program Files (x86)\Automation Anywhere IQ Bot

\Configurations.
b. Настройте конечную точку Tegaki API, на которой установлена версия On-Premises. Set

APIKey = <your key here> and configure the TegakiOCREngineSettings.json file.

{
  "APIKey": "<ensure your key meets UUID format (https://
www.uuidgenerator.net)>”,
  "RestEndpointURL": "<your Tegaki Server URL here>”,
  "RestEndpointPort": <80>,
  "EngineType": 3,
  "EnableFieldMerging": false,
  "EnableFieldRegions": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation
 Anywhere IQBot Platform\\Logs\\Engine\\Tegaki"
}

4. Navigate to ..\Automation Anywhere IQ Bot\Configurations\Settings.txt, and modify
the following value: OCREngine=TegakiAPI.
Файл TegakiOCREngineSettings.json становится доступным после установки IQ Bot.

1. Создайте новый обучаемый экземпляр с использованием документа на одном из азиатских
языков, который вы хотите обучить.

2. Обучите документ и переведите обучаемый экземпляр в рабочий режим.
3. Отправьте файлы на азиатском языке и запустите бот.
4. Выполните загрузку и просмотрите точность результатов извлечения.

Related information
Tegaki on-premises Freeform API guide (Login required)
Tegaki on-premises troubleshooting guide (Login required)
Tegaki on-premises suport policy (Login required)
Tegaki on-premises sytem administrator guide (Login required)

Databases created during IQ Bot installation
Learn which databases and tables are created after installing IQ Bot.
Log into the database using the <dbusername> and <dbpasswd> to verify the names of the databases
and tables using <hostname>, <dbusername>, and <dbpasswd>.
The system creates the following databases:
• AliasData: This is the master database to store data about different aliases related to a field in the

system for different document types. This database also has the information about the languages and
different document types supported by IQ Bot.

• ClassifierData: This database has the data related to the classification output for both layout and
content classification.

• Configurations: This database stores data about the configurations used when installing IQ Bot, for
example, Control Room URL, output path, and so on.
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• FileManager: This database stores data related to learning instances and the files uploaded related to
learning instances and vision ботs.

• MLData: This database stores the training data used by the Machine Learning (ML) system in IQ Bot.

IQ Bot 11.x: Create a self-signed certificate with Subject
Alternative Name
Create a self-signed certificate with Subject Alternative Name (SAN) when you want to use an SSL
certificate for multiple domains.
1. Create a file with the name domain.cnf and add the following configuration as per your

requirement:
[req]

default_bits = 2048

prompt = no

default_md = sha256

x509_extensions = v3_req

distinguished_name = dn

[dn]

C = ES

ST = MyState

L = MyCity

O = MyOrg

emailAddress = email@mydomain.com (Any email address)

CN = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

[v3_req]

subjectAltName = @alt_names

[alt_names]

DNS.1 = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

DNS.2 = sss-laptop151.aaspl-brd.com (IQBOT URL FQDN Name)

2. Download the Openssl utility.
3. Create the certificate either on Microsoft Windows or on Linux:

• Run the following command to create the certificate on Microsoft Windows:

openssl.exe req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout
"D:\ssc\ssc\key.key" -days 3560 -out "D:\ssc\ssc\cert.crt" -config
"D:\ssc\ssc\domain.cnf"

• Run the following command to create the certificate on Linux:

openssl req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout /tmp/
cert/key.key -days 3560
-out /tmp/cert/cert.crt -config /tmp/cert/domain.cnf
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4. Create the .pfx file from cert and key file:
• Run the following command to create the .pfx file from the cert and key file on Microsoft

Windows:

openssl.exe pkcs12 -export -out "D:\ssc\ssc\sss-aspl.pfx" -inkey "D:
\ssc\ssc\key.key"
-in "D:\ssc\ssc\cert.crt"

• Run the following command to create the .pfx file from the cert and key file on Linux:

openssl.exe pkcs12 -export -out /tmp/cert/sss-aspl.pfx -inkey /tmp/
cert/key.key -in
/tmp/cert/cert.crt"

5. Import the .pfx file in Microsoft IIS.
Use the same .pfx file with the installation of IQ Bot.

6. Run the following command to import the certificate in the Java keystore:

keytool.exe -import -alias dev -keystore "C:\Program Files
(x86)\Java\jre1.8.0_91\lib\security\cacerts" -file "D:\cert\xyz.com.crt"

Based on the type of operating system 32-bit / 64-bit, this C:\Program Files (x86)\Java
\jre1.8.0_91\lib\security\cacerts directory can differ.
If the certificate is not imported in the Java keystore, then Control Room shows the following error
message: Java security certificate path validator signature check failed.

7. Go to %installation_dir%\Configurations and run stopanduninstallallservices.bat
as an administrator.

8. Go to %installation_dir%\Configurations and run installandstartervices.bat as an
administrator.

9. Import the cert.crt file to the Trusted Root using the Microsoft Management Console (MMC).

IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS
This section describes single and multiple domain scenarios when installing IQ Bot and Control Room with
various server certificates.
There are two main scenarios:
• Installing  and  with wildcard server certificates (single domain).
• Installing  and  with individual server certificates (different domains).

You can encrypt the communication between IQ Bot and Control Room by configuring Two-way (Mutual)
SSL. The following steps explain how to configure this and can be achieved by exchanging the SSL
certificates between IQ Bot and the Control Room.

Note:  IQ Bot does not support self-signed certificate.

Prerequisite for single domain
If Control Room and IQ Bot are on a single domain, and we name the domain as DomainOne, the following
certificate files are required:
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• PFX file:
Ensure you have the DomainOne.pfx file. The file size is approximately 7/8 KB. One pfx file is
required for a single domain.

• CA Bundled certificate from the Enterprise Control Room (with all intermediate certificate
information):
Use any tool to create the bundle certificate, or you can use openssl to create CA/bundled certificate
from DomainOne.pfx file.
Use the following example command to create CA/Bundled certificate using openssl for
DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -cacerts -nokeys -
chain -out "
{Outputlocation}\DomainOne_ControlRoom_CA.crt

Note:  You will need the Control Room bundle certificate for single or multiple domains.

• Public certificates from IQ Bot and Control Room:
Use any tool to create the public certificates or use openssl to create Public certificate from the
DomainOne.pfx file.
Use the following example command to create the Public certificate using openssl for DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -clcerts -nokeys -
out
"{Outputlocation}\DomainOne_ControlRoom_PublicCertificate.crt

Note:  For a single domain, there will be one public certificate for both, IQ Bot and Control Room.

Prerequisite for multiple domains
If the Control Room and IQ Bot are on separate domains, and the domain names are DomainOne (Control
Room) and DomainTwo (IQ Bot), the following certificate files are required:
• Pfx file:

Ensure you have the DomainOne.pfx and DomainTwo.pfx files. The file size is approximately 7/8
KB.

• Public certificates from IQ Bot and Control Room:
Use any tool to create the bundle certificate or use openssl to create Public certificate from
DomainTwo.pfx file.
Use the following example command to create the Public certificate using openssl for DomainTwo.pfx:

openssl.exe pkcs12 -in "{DomainTwo.pfx file location}" -clcerts -nokeys -
out
"{Outputlocation}\DomainTwo_IQBot_PublicCertificate.crt

Note:  : If you set up Control Room or IQ Bot with HTTPS, then configure IQ Bot with HTTPS before
registering.
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Related tasks
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
Related reference
Configure IQ Bot 11.x with HTTP when Control Room is configured with HTTPS on page 136
Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.
Configure IQ Bot 11.x with HTTPS using multiple domains on page 135
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.
Configure IQ Bot 11.x with HTTPS using single domain on page 134
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.

Configure IQ Bot 11.x with HTTPS using single domain
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.
1. Set up IQ Bot using the PFX file with HTTPS configuration during installation.
2. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for Control Room in the IQ Bot folder

after IQ Bot installation at C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys. Rename the DomainOne ControlRoom_CA.crt to
ca.crt.

Important:
If the ca.crt file in the C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys folder is already present, then replace it with the new ca.crt
file.

3. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe"
-import -alias cr -keystore "{IQ Bot installation directory}\JRE
\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

.
The system will ask for a keystore password, which is changeit.

Note:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

4. Next, restart the machine(s) and follow instructions to register IQ Bot.
См. IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118

Related tasks
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
Related reference
Configure IQ Bot 11.x with HTTP when Control Room is configured with HTTPS on page 136
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Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.
Configure IQ Bot 11.x with HTTPS using multiple domains on page 135
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.

Configure IQ Bot 11.x with HTTPS using multiple domains
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.
1. Set up IQ Bot using the PFX file with the HTTPS configuration during installation.
2. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for the Control Room in the IQ Bot

folder after IQ Bot installation at: C: \Program Files (x86)\Automation Anywhere IQ Bot
\Portal\keys.
Rename the DomainOne ControlRoom_CA.crt to ca.crt.

Important:  If the ca.crt file in the C:\Program Files (x86)\Automation Anywhere IQ
 Bot <version number>\Portal\keys folder is already present, then replace it with the new
ca.crt file.

3. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Note:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

4. Add the IQ Bot Public certificate (DomainTwo_IQBot_PublicCertificate.crt) to the keystore for the
Control Room by running the following command as a system administrator:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room 
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt"

Note:  For Automation 360 IQ Bot (Build 550), change JRE to jrk in the command mentioned above.

5. Next, restart the machine(s) and follow instructions to register IQ Bot.
См. IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118

Related tasks
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
Related reference
Configure IQ Bot 11.x with HTTP when Control Room is configured with HTTPS on page 136
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Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.
Configure IQ Bot 11.x with HTTPS using single domain on page 134
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.

Configure IQ Bot 11.x with HTTPS when Control Room is configured with
HTTP
Configure IQ Bot with HTTPS when Control Room is configured HTTP.
1. Set up IQ Bot using the PFX file with HTTPS configuration during installation.
2. Put the bundled certificate (DomainTwo_IQBot_CA.crt) for Control Room in the IQ Bot folder, after

IQ Bot installation at C: \Program Files (x86)\Automation Anywhere IQ Bot\Portal
\keys. Rename the DomainTwo_IQBot_CA.crt to ca.crt.

Important:  If the ca.crt file in the C:\Program Files (x86)\Automation Anywhere IQ
 Bot <version number>\Portal\keys folder is already present, then replace it with the new
ca.crt file.

3. Add the IQ Bot Public certificate (DomainTwo_IQBot_PublicCertificate.crt) to the keystore for the
Control Room by running the following command as a system administrator:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt" 

4. Next, restart the machine(s) and follow instructions to register IQ Bot.
См. IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118

Configure IQ Bot 11.x with HTTP when Control Room is configured with
HTTPS
Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.
1. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for Control Room in the IQ Bot folder

after IQ Bot installation at C: \Program Files (x86)\Automation Anywhere IQ Bot
\Portal\keys. Rename the ControlRoom_CA.crt to ca.crt.

Important:  If the ca.crt file in the C:\Program Files (x86)\Automation Anywhere IQ
 Bot <version number>\Portal\keys folder is already present, then replace it with the new
ca.crt file.

2. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
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in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Note:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

3. Next, restart the machine and follow instructions to register IQ Bot.
См. IQ Bot 11.x: Registering IQ Bot with the Control Room on page 118

Related tasks
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
Related reference
Configure IQ Bot 11.x with HTTPS using multiple domains on page 135
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.
Configure IQ Bot 11.x with HTTPS using single domain on page 134
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.

Configuring RabbitMQ v3.8.18 in SSL mode for IQ Bot
Configure RabbitMQ v3.8.18 to enable SSL/TLS communication between applications and RabbitMQ
v3.8.18. This configuration enables you to disable default or nonsecure listeners.
Ensure you install IQ Bot using the PFX file with HTTPS configuration.
1. Navigate to the following folder: C: \Program Files (x86)\Automation 360 IQ Bot

\Configuration

2. Edit the following settings in the Settings.properties file:
a) Change the value of secureRabbitMQCommunication from False to True.
b) Enter the certificate paths for RabbitMQClientP12CertPath,

RabbitMQClientJKSCertPath, and RabbitMQKeyPassphrase.

3. Open RabbitMQ v3.8.18 and enter the %appdata%\RabbitMQ directory.
4. Edit the rabbitmq.conf file and review the following parameters:

• listeners.tcp = none
• listeners.ssl.default = 5671
• ssl_options.cacertfile = <certificate path>/ca_certificate.pem
• ssl_options.certfile = <certificate path>/server_certificate.pem
• ssl_options.keyfile = <certificate path>/server_key.pem
• ssl_options.verify = verify_peer
• ssl_options.fail_if_no_peer_cert = true

5. Restart the RabbitMQ v3.8.18 service.
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6. In the C: \Program Files (x86)\Automation 360 IQ Bot\Configuration filepath, run
the following commands to reinstall IQ Bot services:
a) stopanduninstallallservices.bat

b) installandstartallservices.bat

RabbitMQ v3.8.18 is configured in SSL mode.

Контрольный список после установки
Verify if IQ Bot is installed, and ensure the IQ Bot services are running using the healthcheck APIs.
Automation Anywhere IQ Bot
Убедитесь, что элемент Automation Anywhere IQ Bot существует в разделе Панель управления
> Программы > Программы и функции на компьютере, на котором установлен IQ Bot.

Confirming Automation Anywhere cognitive services are running
Убедитесь, что указанные ниже службы установлены на компьютере, на котором установлен IQ Bot,
а для статуса служб в окне служб Microsoft Windows задано значение Выполняется.
Чтобы просмотреть список служб, которые запущены в данный момент, откройте services.msc,
используя Пуск > Запустить.
• Automation Anywhere Cognitive Alias
• Automation Anywhere Cognitive Application
• Automation Anywhere Cognitive Classifier Service
• Automation Anywhere Cognitive File Manager
• Automation Anywhere Cognitive Console
• Automation Anywhere Cognitive Gateway
• Automation Anywhere Cognitive MLScheduler Service

Note:  As of the latest build in IQ Bot, this service is removed, by default.

• Automation Anywhere Cognitive MLWeb Service
• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Report
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive Visionbot Manager
• Automation Anywhere Cognitive VisionbotEngine Service

Doing a healthcheck
If needed, use the Healthcheck API to verify about the required service. Сведения о запросах/ответах
API проверки работоспособности описаны в приведенной ниже таблице.
Запросы
The following table lists the API requests sent for doing a healthcheck of different IQ Botservices:

Имя службы URL-адрес

Alias http://<hostname/IP>:9997/
healthcheck

Application Service http://<hostname/IP>:9002/
healthcheck
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Имя службы URL-адрес

Project Service http://<hostname/IP>:9999/
healthcheck

FileManager Service http://<hostname/IP>:9996/
healthcheck

Visionbot http://<hostname/IP>:9998/
healthcheck

Validator Service http://<hostname/IP>:9995/
healthcheck

Report Service http://<hostname/IP>:9992/
healthcheck

Gateway Service http://<hostname/IP>:8100/
healthcheck

Frontend or Console Service http://<hostname/IP>:3000/
healthcheck

В списке таблиц замените <hostname/IP> именем/IP-адресом узла IQ Bot, чтобы создать запрос
API проверки работоспособности с помощью веб-браузера на компьютере, на котором установлен IQ
Bot.
Например, если ваш IQ Bot доступен по адресу http://localhost:3000, то доступ к FileManager
Healthcheck можно получить по следующему URL-адресу: http://localhost:9996/healthcheck.
Ответы
Типичный успешный ответ приведен в представленном ниже примере кода.
Subsystem

Application: <Service Name>

Status: OK

Application uptime: 0d 3h 45m 6s

Version: 1.2.0-RELEASE

Branch: RC-5.2-1

GIT #: d88e59c0435c3a836bb47cd586081205564904c5

Build Time: 2018-02-17T09:26:52.523Z

Dependencies:

Database Connectivity: OK

MessageQueue Connectivity: OK

Project: OK

VisionBot: OK

Значением **<Service Name> могут быть alias, application, filemanager, project, reports, gateway,
validator или visionbot.
Dependencies: отображается статус всех зависимых служб, например базы данных и очереди
сообщений рассматриваемой службы.
Checking created databases and tables
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Learn which databases and tables are created after installation of IQ Bot.
Выполните вход в базу данных с помощью <dbusername> и <dbpasswd>, чтобы проверить имена
баз данных и таблиц, используя <hostname>, <dbusername> и <dbpasswd>.
The system creates the following databases:
• AliasData: This is the master database that stores data about different aliases related to a field in the

system for different document types. This database also has the information about the languages and
different document types supported by the IQ Bot system.

• ClassifierData: This database has the data related to classification output for both layout and content
classification.

• Configurations: This database stores data about the configurations used when installing IQ Bot, for
example, Control Room URL, output path, and so on.

• FileManager: This database stores data related to learning instances, files uploaded related to
learning instances, and vision ботs.

• MLData: This database stores the training data used by a Machine Learning (ML) system in IQ Bot.

Related tasks
IQ Bot 11.x: Health Check API response if RabbitMQ v3.8.18 fails to start on page 147
Check the status of each IQ Bot service using the Health Check API if RabbitMQ v3.8.18 fails to start.
Databases created during IQ Bot installation on page 130
Learn which databases and tables are created after installing IQ Bot.

IQ Bot post installation validation
After installing IQ Bot and completing the post-installation tasks, validate the installation by creating IQ Bot
specific roles, accessing the Валидатор without a license, accessing the product without a device license,
and understanding permissions for role-based access control to the learning instances.

User roles and permissions
Learn about the roles and associated permissions required for each IQ Bot user.
Your permission to access specific areas in IQ Bot are defined depending on your user role. For example, a
Валидатор does not have permissions to access the Audit Trial Log page because the tasks on this page
are only for Administrators.
All the roles and permissions for the IQ Bot are defined in the Control Room. For more information on
creating these roles, see Control Room User Guide.
In the Control Room, Role-Based Access Control (RBAC) is implemented for only the following options:
• Navigate to Administration > Roles, and select View IQ Bot > View learning instances > View

learning instances from the same role.
• Navigate to Administration > Roles, and select View IQ Bot > View learning instances > View

ALL learning instances.

Note: 11.3.4

When you enable  caching, the cache in the Enterprise Client is active for 15 mins. Therefore, any change
in user roles in the Control Room is reflected after 15 minutes.
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The permissions and areas of IQ Bot that can be accessed by users based on their roles are described in
the following table:

Table 1: Roles and permissions for IQ Bot

The following table describes the different IQ Bot system defined roles and the associated
permissions:

System role Default IQ Botpermissions Access to tabs

AAE_Администратор IQ Bot All IQ Bot permissions • Информационная панель
• Экземпляры для обучения
• Боты
• Домены
• Administration Migration

utility can be accessed using
this tab.

AAE_Службы IQ Bot All permissions available as per
View my learning instances

• Информационная панель
• Обучаемые экземпляры
• Боты

AAE_Валидатор IQ Bot Launch Валидатор permission
available as per View my
learning instances

Обучаемые экземпляры

If both Services and Admin roles are allocated to a user, IQ Bot shows the following five tabs:
• Информационная панель
• Экземпляры для обучения
• Боты
• Домены
• Администрирование

To learn how to use custom roles, see Define access to learning instances using custom roles on page 141.
For IQ Bot create Bot Runner and Bot Creator users. See Bot Runner and Bot Creators - overview topic for
more information.

Define access to learning instances using custom roles
Role-based access control (RBAC) enables or restricts access to new learning instances, related features,
and functionality in IQ Bot based on permissions defined for various roles that are configured through the
Control Room.
Users with the View and manage roles privilege can create custom roles and assign privileges to roles
through the Control Room.

Просмотреть обучаемые экземпляры Users can decide to turn on permissions by
selecting any of the following view permissions:
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• View my learning instances
Allows users to view only the learning instances
created by them.

• View learning instances from the same
role
Allows users to only view learning instances
created using a particular role.

• View all learning instances
A user with this privilege can view all learning
instances created by all users across all roles.

Users can perform actions on learning instances
they can access based on the following:
• View permission selected for their roles.
• Learning instances that are also assigned the

same role as the user.
• The user is assigned a role with relevant

permissions selected.

Прим.:
• Users can use the Delete learning instance

option only if Edit learning instance is also
selected for that role.

• If users migrating from IQ Bot versions earlier
than Version 11.3.5 are unable to view learning
instances as before, an admin user with
the Assign Roles privilege has to assign
permissions to their custom roles and roles to
learning instances as required.

Просмотреть домены Users with only this permission can view the
Domains tab in IQ Bot but do not have the
permission to import or export domains. Select
Import Domains and Export Domains
permissions to enable importing and exporting
domains.

View administration Users with only this permission can view the
Administration tab in IQ Bot but do not have the
permission to import or export learning instances.
Select View and manage migration to enable
importing and exporting learning instances.
The View and manage migration privilege
allows users to only migrate learning instances
they have access to based on the view permission.
Therefore, permissions to view these learning
instances are necessary.

Прим.:  View domains and View administration permissions work as expected for the standard
AAE_IQBOTAdmin role.
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Пример

The following example explains some of the combinations of permissions set in custom roles. These roles
have specific permissions assigned to them that enable users to access learning instances and perform
actions:

Функции • RoleA = View LI from the same role + Edit +
Send learning instance to production

• RoleB = View LI from the same role + Train

Обучаемый экземпляр The learning instance is in staging.
Scenario 1 • Learning instance has RoleA assigned

• User2 is assigned RoleA + RoleB

Result:
• Only User1 will be able to access and perform

actions on the learning instance.
• User1 can only edit and send the learning

instance to production.

Scenario 2 • Learning instance has RoleA assigned
• User1 is assigned RoleA
• User2 is assigned RoleA + RoleB

Result:
• Both User1 and User2 will be able to access the

learning instance.
• Both User1 and User2 can edit and send learning

instance to production.

Scenario 3 • Learning instance has RoleA + RoleB assigned
• User1 is assigned RoleA
• User2 is assigned RoleB

Result:
• Both User1 and User2 will be able to access the

learning instance.
• User1 will be able to edit and send learning

instance to production, while User2 will be able
to only train the learning instance.

Scenario 4 • Learning instance has RoleA + RoleB assigned
• User1 is assigned RoleA + RoleB
• User2 is assigned RoleB
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Result:
• Both User1 and User2 can access the learning

instance.
• User1 can edit, train, and send learning instance

to production, while User2 will only be able to
train the learning instance.

Прим.:
• When the permissions of the current user role are changed or the user is assigned to a different role,

the access control is updated to reflect the latest permissions configured for the assigned role.
• If a role is deleted, the learning instances created by a user of that role are still accessible to other

users with the following roles:
• AAE_IQ Bot Admin
• AAE_IQ Bot Services
• A custom role with permission View all learning instances
• A custom role assigned to those learning instances with permission View learning instances from

the same role

• Using the AAE_IQ Bot Admin role makes any other additional custom role redundant. An admin user has
the default view of an administrator and has access to all learning instances.

• Exporting or importing learning instances from one IQ Bot environment to another does not migrate
roles. Users can use the Assign Roles feature to reassign roles to learning instances as required in the
destination environment.

Views in IQ Bot

A user has the option of three views in IQ Bot based on the roles and permissions assigned to their roles:

Службы Accessible tabs: Dashboard, learning instances, and
боты

Прим.:  This is the standard IQ Bot view.

Валидатор Accessible tabs: Learning instances (validation only)

Прим.:  This view is visible to a user in the
following scenarios:
• The user is assigned only the AAE_IQ Bot

Validator role.
• The user is assigned custom roles with only

Launch Validator action along with a view
permission. If any of the assigned roles has any
other actions selected, the default Services
view will be visible.

Администратор Accessible tabs: Dashboard, learning instances,
domains, боты, and administration
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IQ Bot 11.x: Create a user with an IQ Bot specific role
Create users in Control Room to access IQ Bot as an administrator, Bot Creator, and Валидатор.
Create administrator, services, and Валидатор IQ Bot users with Microsoft Windows credentials using the
following roles in the Control Room:
• AAE_IQBotAdmin
• AAE_IQBotServices
• AAE_IQBotValidator

Tip:  The Active Directory users are authenticated with their Active Directory credentials, and the
non-Active Directory users are authenticated with the credentials stored in the Control Room database.

Users in Control Room are created depending on the type of user configured during installation. IQ Bot
supports a maximum of five concurrent users.
1. Log in to Control Room with superadmin permissions.
2. Go to Administrator > Users.
3. Click the Create User link.

The Create User page appears.
4. Enter the required information on the Create User page.

Note:
• The First name, Last name, and Description fields are optional. For a first name and last

name, use numbers, spaces ( ), period (.), hyphen (-), and underscore (_).
• For a Non- Active Directory user, provide information in each field.
• If you are not configuring the Outgoing Mail Server settings, enter the password .

5. Select a license to be allocated to the user from the Allocate a device license to user area.
If no license slots are available for a role, an alert message appears.

6. To create a user with the administrator role, select AAE_IQBotAdmin. To create a user
with the services role, select AAE_IQBotServices, To create a Валидатор role, select the
AAE_IQBotValidator role. .

7. Click Save to create the user.

To switch a user type from Development to Run-time or vice versa, depending on the automation
requirements of your organization, update the license type from the License Management page in Control
Room.
After a Валидатор or a services user is created, an email is sent to the user. The user is asked to do the
following:
• Verify the email ID and set the Control Room access password, if the Control Room is configured for the

Non-Active Directory users.
• Verify the email ID, if the Control Room is configured for the Active Directory users.

Related tasks
User roles and permissions on page 140
Learn about the roles and associated permissions required for each IQ Bot user.
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Access IQ Bot without a Bot Creator or Bot Runner device license
Log in and operate IQ Bot without a device license (Bot Creator or Bot Runner) in Automation Anywhere
Control Room. However, using the IQ Bot command in the Automation Anywhere Enterprise Client requires
the appropriate device license identified in the table.
The following table summarizes the roles and associated UI views allowed for each role, with/without an
assigned device license. To view or assign device license, go to the Automation Anywhere Control Room
and navigate to Administration > Users > Allocate a device license to this user?.

Пользователь Лицензия
устройства

UI view in IQ Bot Портал Комментарии

Multi/single users:
• AAE_Администратор

IQ Bot
• AAE_IQ Bot Service
• AAE_Валидатор IQ

Bot

Нет Role-specific view Can access IQ Bot

Users with both roles:
• AAE_Администратор

IQ Bot
• AAE_Основы

Нет Admin view Can access IQ Bot

AAE_Основы Нет Нет Cannot access
IQ Bot. An error
message appears
with a link to the
Control Room.

AAE_IQ Bot Service Нет Службы Can access IQ Bot
but unable to access
the Enterprise Client.
Therefore, Production
documents in the
Enterprise Client
using the IQ Bot lite
command are unable
to upload.

AAE_IQ Bot Service Bot Creator Службы Can access IQ
Bot Портал and
Enterprise Client. In
the Enterprise Client,
to upload production
documents, navigate
to the New >
Workbench >
Command tab.
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Пользователь Лицензия
устройства

UI view in IQ Bot Портал Комментарии

AAE_IQ Bot Service Bot Runner Службы Can access the IQ
Bot Портал and
Enterprise Client. In
the Enterprise Client,
select a task and
run it. User cannot
create/edit a бот.

For more information go to Automation 360 platform, and see Licenses - an overview

Access IQ Bot Валидатор without a license
Access the Валидатор functionality in IQ Bot without requiring a Bot Creator or Bot Runner license. From
the Automation Anywhere Control Room, create any number of users and assign them to the system
defined Валидатор role (AAE_IQ Bot Validator).
Log in to the IQ Bot Портал and access all the Валидатор-specific tabs.
Понятия, связанные с данным
Define access to learning instances using custom roles
Role-based access control (RBAC) enables or restricts access to new learning instances, related features,
and functionality in IQ Bot based on permissions defined for various roles that are configured through the
Control Room.

Learn whether a profile is local or roaming
Follow these steps to learn whether a profile is local or roaming.

1. On your computer, right-click This PC, and click Properties, and then click the Advanced system
settings link.

2. In the User Profiles group, click Settings.
In the User Profile window, a list of all the users appears. Local appears in the Type column for the
user you have logged in to, to install the product. This user must be an administrator.
If you must switch the user profile from Roaming profile to Local profile, click Change Type…. In
the Change Profile Type window, select Local profile and click OK.

Note:  Do not install IQ Bot with a roaming profile. Install IQ Bot as a local profile with administrator
permissions.

IQ Bot 11.x: Health Check API response if RabbitMQ v3.8.18 fails
to start
Check the status of each IQ Bot service using the Health Check API if RabbitMQ v3.8.18 fails to start.
The Health Check response for RabbitMQ startup failure is different in case of FileManager, Project,
Validator, VisionBot as described in the following table.
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Service name Health Check response Reason for failure

FileManager

http://
<hostname>:<9996>/
healthcheck

Failure 1:
localhost refused to
 connect

Failure 2:
localhost refused to
 connect

Reason for failure 1:
The RabbitMQ v3.8.18 node/
service went down when
the Filemanager service was
running.
Reason for failure 2:
The RabbitMQ node/service
was already down when the
Filemanager service started.

Project

http://
<hostname>:<9999>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.

Validator

http://
<hostname>:<9995>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.

VisionBotManager

http://
<hostname>:<9998>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.

Gateway-2 service

http://<hostname>:8100/
healthcheck

Application: gateway-2
Failure 1:
localhost refused to
 connect

Failure 2:
localhost refused to
 connect

Reason for failure 1:
Port is blocked and the
Gateway-2 service is running.
Reason for failure 2:
The Gateway-2 service is not
running.

IQ Bot 11.x: Set up log file automatic rollover
This topic addresses setting up automatic rollover of log files based on the file size.
Once the log files are created, the system continues logging messages that increases the log file size
to a point where they are too large to open. This would prevent the user from opening the log files for
reviewing the information and error messages.

Note:  This would happen sooner if the logging level is increased to DEBUG or TRACE modes.
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For all Java services, user can identify the log files under <IQ Bot installation directory>/
Services . Open any logging configuration file, and add the following change under
<SizeBasedTriggeringPolicy size="100MB" /> in the first occurrence of Policies:

<Policies>
<TimeBasedTriggeringPolicy interval="720" />
<SizeBasedTriggeringPolicy size="50MB" />
</Policies>

In the following example setting, after the log file reaches 50 MB, the system creates a new file
automatically and starts logging in it. Though the user ends up with more files, but each file would be 50
MB only. This is standard practice to manage log files.

This example shows entries a user can add to the setting for IQ Bot Version 11.x. to automatically roll over
the logs after the files reach a certain size.

<RollingFile name="Alias" fileName="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Alias.log"
                     filePattern="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Archive/$${date:yyyy-MMM}/Alias-%d{yyyy-MMM-
dd}-%i.log.zip"
                     immediateFlush="true"
                     append="true">
            <PatternLayout pattern="CPL1 Alias %X{cid} %d{ISO8601}{UTC}Z
 %-5level %C %M %msg %n"/>
            <Policies>
                <TimeBasedTriggeringPolicy interval="720" />
                <SizeBasedTriggeringPolicy size="50MB" />
            </Policies>
            <DefaultRolloverStrategy max="10"/>
  </RollingFile>

This example shows entries a user can add to the setting for Automation 360 IQ Bot On-Premises to
automatically roll over the logs after the files reach a certain size.

<RollingFile name="Alias" fileName="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Alias.log"
                     filePattern="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Archive/$${date:yyyy-MMM}/Alias-%d{yyyy-MMM-
dd}-%i.log.zip"
                     immediateFlush="true"
                     append="true">
            <PatternLayout pattern="CPL1 Alias %X{cid} %d{ISO8601}{UTC}Z
 %-5level %C %M %msg %n"/>
            <Policies>
                <TimeBasedTriggeringPolicy />
                <SizeBasedTriggeringPolicy size="50MB" />
            </Policies>
            <DefaultRolloverStrategy max="10"/>
        </RollingFile>

Related concepts
Enabling tracing in logs on page 94
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Log files are generated by the system that store messages from various application and system
components. Different logs are generated for IQ Bot components for which you can enable tracing.

Reinstalling HTTPS SSL certificate on expiry
Reinstall HTTPs SSL certificate when your HTTPS SSL certificate expires.
The HTTPS SSL certificate is required for secure and encrypted communication between your browser
and IQ Bot, to protect highly confidential online transactions, for example, online financial and shopping
transactions. The padlock icon on your browser indicates that you have an active secure connection.
To enable a secure connection, get the HTTPS SSL certificate as follows:
1. Go to %installation_dir%\Configurations and as an administrator, run

stopanduninstallallservices.bat.

Note:  In a cluster installation, stop the services on each of the nodes for IQ Bot and Control Room
cluster.

2. Go to %installation_dir%\Portal\keys and make a backup of the cert.crt, key.key, and
ca.crt files.

3. Convert the .pfx file of the IQ Bot certificate to .crt and .key formats by running the following
commands:
• Extract an encrypted key from .pfx file.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -nocerts -out
"path_to_cert\example encp.key" 

Note:  If the .pfx file is password protected, you need to enter the pass phrase when prompted.

• Convert an encrypted key to a readable format.

openssl.exe rsa -in "path_to_cert\example encp.key" -out "path_to_cert
\key.key"
This command converts encrypted key to a readable format.

• Convert the .pfx file to .crt format.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -clcerts -nokeys -out
"path_to_cert\cert.crt"

• Fetch the ca.crt file from the Control Room certifcate (.pfx) file only if the Control Room
certificate also expires.

openssl pkcs12 -in <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>

4. Copy or replace the cert.crt, and key.key (generated in the previous step), and the ca.cert
(generated using the Control Room certificate .pfx file ) to the %installation_dir%\Portal
\keys folder.

5. Import the IQ Bot public certificate into the Java Key store for IQ Bot by running this command as a
system administrator:
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"JRE Location\bin\keytool.exe" -import -alias iqbot-keystore "cacerts
 location of iq bot" -file " iq bot public certificate file"

Пример. C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

6. To import the IQ Bot public certificate into Control Room, go to the Control Room installation
path, such as: C:\Program Files\Automation Anywhere\Enterprise, and run the
following command as a system administrator: jre\bin\java -jar certmgr.jar -appDir
 "C:\Program Files\Automation Anywhere\Enterprise" -importTrustCert "C:
\Certificate\cert.crt".
For Automation 360 IQ Bot, use the following path: jrk\bin\java -jar certmgr.jar -
appDir "C:\Program Files\Automation Anywhere\Enterprise" -importTrustCert
 "C:\Certificate\cert.crt".

7. After importing the certificates, restart the Control Room and IQ Bot servers.
This refreshes the system caches.

8. On the IQ Bot server, go to %installation_dir%\Configurations and as an administrator, run
installandstartallservices.bat.

If the Control Room certificate expires
1. Follow the steps: Import Control Room HTTPS and CA certificates

2. Convert .pfx to .crt format.openssl.exe pkcs12 -in "path_to_cert\example.pfx" -
clcerts -nokeys -out "path_to_cert\cert.crt".

3. Fetch the ca.crt file from the Control Room certificate (.pfx) file.openssl pkcs12 -in
 <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>

4. Copy or replace the ca.cert to the keys folder in IQ Bot.
5. Import the Control Room public certificate into Java Key store for IQ Bot by running this command

as a system administrator: "JRE Location\bin\keytool.exe" -import -alias cr
 -keystore "cacerts location of iq bot" -file "control room public
 certificate file".
Пример. C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

Note:  To change the Control Room certificate, follow steps here: Import Control Room HTTPS and CA
certificates

Related information
Compare SSL/TLS Certificates for Websites
SSL, TLS and HTTPS

IQ Bot upgrade and uninstallation
Follow the upgrade and uninstallation steps for IQ Bot to ensure a smooth and seamless process.
In addition, refer to Upgrading IQ Bot on page 233 to learn how to upgrade installation and migrate
learning instances to a different version of IQ Bot.
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Related tasks
Uninstalling IQ Bot 11.x on page 152
Uninstall IQ Bot and its dependencies.
Upgrading IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS on page 152
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
Upgrading and downgrading IQ Bot 11.x on page 153
Uninstall and install a later version to upgrade IQ Bot. Uninstall and install an earlier version of IQ Bot to
downgrade.

Uninstalling IQ Bot 11.x
Uninstall IQ Bot and its dependencies.
To manually uninstall, go to Windows > Control Panel > Programs > Uninstall a program, and
choose IQ Bot.
For all other versions, use the following steps.
1. Double-click the Automation_Anywhere_IQ_BOT_<version-number>.exe installer file. The

Automation Anywhere IQ Bot - Wizard appears.
2. Enter the administrative permissions in the User Access Control dialog box if a dialog box appears.

Note:  Ensure you close all the existing browser instances running IQ Bot before you begin
uninstallation.

3. Щелкните Вперед. The Ready to Remove page appears.
4. Click Remove.

The uninstallation process begins.

Note:  During the uninstallation process, if setup information appears, click OK to continue. Clicking
Cancel to close the process.

5. When complete, the Finished page appears. Click Finish to complete the process.

Note:  Uninstalling IQ Bot does not delete the IQ Bot database or any of the following dependencies.
Manually remove them using recommended third party procedures.
• Erlang/OTP
• RabbitMQ v3.8.18
• NodeJS
• Сервер SQL Native Client
• Python

Upgrading IQ Bot and Automation Anywhere Control Room from
HTTP to HTTPS
Upgrade IQ Bot and Automation Anywhere Control Room from HTTP to HTTPS by unregistering IQ Bot
first.
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Uninstall the HTTP versions of IQ Bot, and Automation Anywhere Control Room from your machine before
upgrading both the applications to HTTPS.
1. In HTTPS mode, install theAutomation Anywhere Control Room.
2. Update the Web Control Room HTTPS URL by logging in to Control Room > Administration >

General Setting.
3. Next, in HTTPS mode, install IQ Bot.
4. Unregister IQ Bot from the Control Room.
5. Copy the CA certificate of the Automation Anywhere Control Room to the IQBot_INSTALL_DIR/

Portal/Keys location.
6. Import the IQ Bot public certificate to the Automation Anywhere Control Room certmgr.
7. Import the Automation Anywhere Control Room public certificate to the IQ Bot keystore.
8. Restart the Console service.
9. Register the IQ Bot with the HTTPS URL in the Automation Anywhere Control Room.

Upgrading and downgrading IQ Bot 11.x
Uninstall and install a later version to upgrade IQ Bot. Uninstall and install an earlier version of IQ Bot to
downgrade.
To upgrade or downgrade IQ Bot, perform the following procedure.
• Upgrading IQ Bot

a) Create a new folder in any location and take a backup of the Settings.txt
and both or either of the .json files ImageProcessingConfig.json or
AbbyyImagePreProcessingSettings.json for your reference from the <Installation Path/
Configuration> folder to this new folder.

b) Take a backup of the existing IQ Bot databases before starting the upgrade.
c) Follow the uninstall process.
d) Copy a later version of IQ Bot installable file from <path of the installable file> to your local system.
e) Follow the installation process.

Note:
• Refer to the settings from the Settings.txt and both or either of the .json files

ImageProcessingConfig.json or AbbyyImagePreProcessingSettings.jsonto enter
the configuration values when you are installing an earlier version of the product.

• Back up your database to restore it in case any issue occurs in future or in case you downgrade
to an earlier version of IQ Bot.

Upgrading IQ Bot on page 233
Upgrading Automation 360 IQ Bot

• Downgrading IQ Bot
a) Create a new folder in any location and take a backup of the Settings.txt

and both or either of the .json files ImageProcessingConfig.json or
AbbyyImagePreProcessingSettings.json for your reference from the <Installation Path/
Configuration> folder to this new folder.

b) Uninstall the later version of IQ Bot.
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c) Take a backup of the current databases.
d) Remove the backup of the current databases.
e) Restore the database backup of the earlier IQ Bot version.
f) Install the earlier version of IQ Bot.

Note:
• Refer to the settings from the Settings.txt and both or either of the .json files

ImageProcessingConfig.json or AbbyyImagePreProcessingSettings.jsonto enter
the configuration values when you are installing an earlier version of the product.

• Back up your database to restore it in case any issue occurs in future or in case you upgrade to
a different version of IQ Bot.

Related tasks
Uninstalling IQ Bot 11.x on page 152
Uninstall IQ Bot and its dependencies.
IQ Bot 11.x: Installing IQ Bot in Express mode on page 106
Install IQ Bot in Express mode with the default settings.
Databases created during IQ Bot installation on page 130
Learn which databases and tables are created after installing IQ Bot.
Related reference
IQ Bot 11.x: IQ Bot installation prerequisites on page 99
Verify the hardware, software, and configuration required to install IQ Bot in your environment. Follow the
pre-installation checklist before installing IQ Bot.
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Использование IQ Bot
IQ Bot provides cognitive (intelligent) automation to uncover and transform important, but less structured
data to automate business processes quickly and efficiently, simultaneously reducing human error.

Обзор

Cognitive automation processes semi-structured and unstructured data and converts it into structured data
that is used by Robotic Process Automation (RPA) ботs for end-to-end automation.

Start using IQ Bot by creating a learning instance, which defines the type of document you must process,
the language of documents, and a list of data fields to capture and extract from each document. Next,
train the documents and review the results of the training. You can also download the extracted data to a
CSV file for review. After correcting any errors, save the ботand send it for production. In the production
environment, run the trained бот against a set of documents to automate data extraction.

Phases in IQ Bot business process

1. Preprocess documents.
2. Receive text segmentation and optical character recognition (OCR).
3. Classify documents in groups.
4. Extract document data.
5. Validate and correct failed documents.
6. Complete validation and save.
7. Trigger approval.
8. Obtain final review and approval.
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User prerequisites

Users who create and configure automation tasks and deploy TaskBots also create IQ Bot learning
instances, deploy the learning instances from staging to production environments, and correct documents
with exceptions.
The primary user roles are as follows:
• Services users: Automation experts who train боты on sample documents, so these боты can later

automatically process a larger volume of documents.
• Validators: Use a visual interface to manually verify or fix data extraction from a document.

Users are required to have an understanding of the following:
• Common administrative tasks of Automation Anywhere Control Room
• Differences between structured, semi-structured, and unstructured documents
• Standard fields in a semi-structured or unstructured document, for example, invoice number, invoice

date, and so on.
• General automation commands in Automation Anywhere
• Internet information services
• How to start and stop web services
• How to block and unblock ports

General process

Use the general process for IQ Bot to create a learning instance, upload documents, build/train the боты,
validate extracted data and make corrections, and set the боты to production.
The general process for using IQ Bot is described as follows:
1. IQ Bot 11.x: Создать экземпляр для обучения on page 160 and upload sample documents.
2. After the documents are analyzed, review the report in the IQ Bot 11.x: Performance report page on

page 203. The report shows you important insights about your sample documents, for example,
similar documents that can be grouped together, document groups that return all required fields, and
document groups used to create and train learning instances.

3. After the sample documents are analyzed, IQ Bot 11.x: Train a learning instance on page 171 by
mapping required fields and setting validation rules for a document in a group that best reflects
the documents in that group. When the learning instance is deployed in production, it processes all
documents identified as part of this group.

4. After training, IQ Bot 11.x: Move a learning instance to Production on page 199, and then use the
ботcommand to upload documents to the production environment for processing. См. раздел Upload
documents to a learning instance on page 205.

5. Any documents that do not complete straight-through processing because of field extraction or rule-
related problems require human validation. Users are required to Validate document with errors on page
211.

6. Throughout the process, use the IQ Bot Информационная панель on page 202 to monitor the
progress of the production instances.

Throughout the process, use the IQ Bot Информационная панель on page 202 to monitor the progress
of the production instances.
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Features and benefits of using IQ Bot

Use IQ Bot for the following features:
• Train the learning instances in order of importance on the web-based Designer.
• Reduce setup time for new use cases with the Domain Management utility.
• If you are logged in to the Control Room with the Single Sign-on feature, you can open the IQ Bot

Portal directly.
• Leverage the stronger security features in the Automation Anywhere platform as part of IQ Bot Version

6.0 integration.
• Exception handling is fast and seamless with the web-based Валидатор.
• Preview the data extraction results to verify the training provided to the learning instance.
• Use semantic analysis and automated classification to analyze and extract data types and formats from

learning algorithms, invoices, purchase orders, and bills. It also does the following:
• Autodetects file values after field mapping
• Autocorrects exceptions from human expertise
• Flags exceptions based on the built-in confidence levels mechanism

• Leverage OCR technology, document classification, and data extraction of documents.

Resources
To learn more, search for the following courses in Automation Anywhere University: RPA Training and
Certification (A-People login required):
• Intelligent Document Processing with IQ Bot
• Unleash Your Intelligent Bots: Develop Cognitive Bots Driven by AI & Machine Learning (IQ Bot)

Related concepts
Learning instance on page 158
Create a learning instance to upload and train sample documents. After training is complete, send the
learning instance to production and use it to run on actual documents to extract data. View a summary of
all learning instances and their details in a table on the My Learning Instances window.
Staging environment on page 169
The learning instance workflow consists of the Staging and Production environments. Staging is a training,
testing, and validation environment for hands-on experience with the IQ Bot workflow on documents that
represent the larger volume of documents to process in production.
Start training in Designer on page 170
After creating a learning instance, click the Train button to launch the Designer window to create or edit a
бот in that learning instance.
Информационная панель on page 202
View the IQ Bot performance report in real-time on the Dashboard.
Production environment on page 205
The learning instance workflow consists of the Staging and Production environments. This is a live
environment where a learning instance is set into operation with actual business documents uploaded from
a бот.
Migration Utility on page 219
Use the IQ Bot Migration Utility to export and import learning instances between different IQ Bot
installations to avoid re-creating similar learning instances. This makes the life cycle management of a
learning instance and the associated боты easier.
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Learning instance
Create a learning instance to upload and train sample documents. After training is complete, send the
learning instance to production and use it to run on actual documents to extract data. View a summary of
all learning instances and their details in a table on the My Learning Instances window.
Learning instances is an environment in which a user can upload documents and do specific tasks in two
phases:
• Training:

In the training phase, create, edit, and test ботs on sample documents that represent a larger volume
of documents you can process in the production stage.

• Production:
In the production phase, a user can upload new documents to IQ Bot for automatic processing by the
боты. A user can manually view and edit any documents the system flags with errors.

If a learning instance is in the staging environment, the details of the training are shown. If a learning
instance is in the production environment, the details from the production environment are shown.
When you log in to IQ Bot for the first time, the No current learning instances message appears. Click
the Create One Now button to create your first learning instance.
Click any learning instance to view a summary of all learning instances and their details in the Summary
tab. The Document Groups tab shows every group the documents are categorized into.

Document Groups tab

6.5.2

The Document Groups tab shows a list of the document classification groups for the learning instance in
a table.
When a user creates a learning instance and uploads documents to train, documents are automatically
categorized in the same document group based on their content and classified accordingly. These are
termed as classification groups. A бот is more likely to succeed extracting text across documents in a
group with similar content.
Type in the description for the document group in the Description column. You can use all the special
characters, except #. You can enter a maximum of 30 characters to add the group description. Click on the
description text to edit the group description. Refresh the Bots tab to update the document description.
The description tab is disabled, when the bot is in production mode.
In some situations, a document in production could lead to a new document group that has no documents
from staging. This happens if you set the Copy Production Files property to false, when creating a bot.
If you create a new bot with the Copy Production Files property set to false, the following message
appears:
There are no training documents available for this Bot. Upload some training documents for
the associated learning instance and try again.
Set the Copy Production Files property to true, so that the documents are automatically copied to the
staging environment.
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Summary tab

To view the summary of a learning instance, click the name of a learning instance from the Instances
table. The learning instance area shows the name of the learning instance with a label showing its current
environment.
Related concepts
Staging environment on page 169
The learning instance workflow consists of the Staging and Production environments. Staging is a training,
testing, and validation environment for hands-on experience with the IQ Bot workflow on documents that
represent the larger volume of documents to process in production.
Production environment on page 205
The learning instance workflow consists of the Staging and Production environments. This is a live
environment where a learning instance is set into operation with actual business documents uploaded from
a бот.
Migration Utility on page 219
Use the IQ Bot Migration Utility to export and import learning instances between different IQ Bot
installations to avoid re-creating similar learning instances. This makes the life cycle management of a
learning instance and the associated боты easier.
Related tasks
IQ Bot 11.x: Создать экземпляр для обучения on page 160
Create a learning instance to upload and train sample documents. After training completes, send the
learning instance to production and use it to run on actual documents to extract data. Creating a learning
instance is the first task you perform for creating and training a бот.

Search for a learning instance
Use the Search bar of the learning instance page to search for learning instances based on the specific
criteria, for example, All Fields, Environment, and Instance Name.
To search for a learning instance, do the following:
1. In the Search area, select a field from the All Fields drop-down list, and select from the specific

options.
2. In the Search field, enter the name of the learning instance to search.
3. Press Enter to show search results in the Instances area.

Refresh data in Learning Instance details page
The system does not automatically refresh (auto-refresh) the IQ Bot UI unless the user loads a screen
or clicks the Refresh button, thereby manually refreshing data on a page. This feature helps reduce the
response time for loading new data or performing any action in IQ Bot.
Making complex database calls and auto-updating the displayed pages slow down the system. Disabling
the UI auto-refresh helps the performance of IQ Bot considerably.

Note:  When you use the Refresh option in the Learning Instance details page or Bots page, the refresh
button is disabled for 60 seconds. The icon now spins for this duration indicating that a refresh is in
progress.

The following scenarios have changed due to the feature update:
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Disabled auto-refresh from the learning instance details page

In the Learning Instance details page, use the Refresh button to refresh the categories/groups table.
In the Learning Instance details page or Боты tab, click the Create or Edit buttons. The system directs
the user to the Designer without refreshing the groups or categories information. Click Refresh to update
the data on the screen.

Unable to train a group already in production

In the Learning Instance details page, without refreshing the page, click a group in staging. This same
group could have been set to production by another user in the Боты tab. But because the data on the
page does not auto-refresh, the page still displays older data. Clicking this group directs the first user to
the IQ Bot Designer and displays a message stating that the group cannot be trained as it is already in
production.

Save and go to next group button is always enabled

In the Designer, even when there are no further groups in queue, a user can click the Save and go to
next group button. The system displays a message stating that there are no groups available in the
queue and the group cannot be trained. Click Close to exit the Designer.

Note:  Since auto-refresh is turned off, the Save and go to next group button is always enabled to
provide users the option to manually refresh the page to see if another group was added to the queue.

IQ Bot 11.x: Создать экземпляр для обучения
Create a learning instance to upload and train sample documents. After training completes, send the
learning instance to production and use it to run on actual documents to extract data. Creating a learning
instance is the first task you perform for creating and training a бот.

Important:
• Ensure you know the file size and page limitations before creating a learning instance.

Supported file size and number of pages for processing in IQ Bot (A-People login required)
• If any existing learning instances use Tesseract OCR v3, we recommend that you plan to train with

alternative OCRs (Optical Character Readers), including Tesseract4 OCR. Tesseract OCR is an open
source Optical Character Reader engine leveraged by IQ Bot for document processing and extraction. It
has not been enhanced since 2018 and no new fixes will be applied to Tesseract OCR v3.

1. Click the New instance option.
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2. In the Create new learning instance screen, enter the following information:
a) Имя экземпляра. Enter a unique name.

IQ Bot does not allow duplicate learning instance names. Even if you delete a learning instance,
the name cannot be reused.

b) Optional: Описание: Введите описание.
c) Document type: Select the domain from the drop-down list.

Based on the domain selected, a predefined set of form and table fields for the domain type
appears. For example, when you select Invoices, the standard forms and tables of an invoice
appear.

Note:  If you want to use a custom domain, select Document type > Other.

d) Upload your documents: Click the Browse option to upload the documents samples to classify
and train for the learning instance.
• Use documents with a resolution value of at least 300 dots per inch (dpi). If multiple

documents are in a single PDF, split the PDF into separate documents before the upload. Use
the PDF command or Acrobat editor to split into separate documents.

• You can upload a maximum of 12 MB file size. You can add additional documents even after
creating the learning instance.

• Besides image formats, such as TIFF, JPG, and PNG files, you can also upload PDF, Vector,
Raster, and Hybrid (Vector and Raster) documents for classification and analysis.

e) Primary language of documents: Use the drop-down menu to select a language for the
learning instance.
IQ Bot 11.x: List of languages in IQ Bot on page 219
To create custom domains in other languages and access up to 190 languages that IQ Bot
supports, contact Automation Anywhere support.

Trouble:  If you are unable to see all languages in the IQ Bot interface, troubleshoot the
issue: Unable to extract data from Multiple languages in a document (A-People login required)

f) Optical Character Recognition: Select the necessary Распознавание текста (OCR) engine.
IQ Bot 11.x: Selecting an Распознавание текста (OCR) engine on page 164

g) Checkbox auto-detection: Check the Detect checkboxes check box to enable this feature.
Selecting this option allows IQ Bot to automatically detect check boxes in a document. However, it
might increase the processing time of documents.
IQ Bot 11.x: Extract repeated check boxes data on page 193

3. Add the standard fields in the Standard form fields and Standard table fields sections. To add
additional fields, enter the field name in the Other fields (Optional) section and click the Add as
form/Add as table options.
You cannot add duplicate fields using customization.
Follow the naming conventions when you enter a name in the Other fields (Optional) field:
• Field names can only begin with alphabetical characters (A-Z and a-z).
• Field names can only include alphanumeric characters and spaces.

4. Click the Create instance and analyze option to create the learning instance.
The system analyzes and sorts the training documents into logical groups based on field identification
and shows the details in the Learning Instance > Summary tab.
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When a new learning instance is created, it enters the staging environment and the View Details page is
displayed. You are now ready to train the бот.
Begin training the learning instance you created in the Designer.

Custom Domain in IQ Bot
A domain contains information about the language of the documents and the fields that the system
extracts from the documents. Besides the domains provided by IQ Bot, you can also create and add
custom domains to your IQ Bot environment, which displays in the Document type drop-down list.

Custom domain

Важное замечание:  Users with the Admin role or role assigned with domain access privileges (set in
the Control Room) can view and access the Domains tab and its features in IQ Bot.

The Domains tab displays all available domains for use in the system and their associated languages.
Besides out-of-box domains offered by IQ Bot, you can also create a custom domain and import it into IQ
Bot.
Create a custom domain (A-people login required)

When creating a learning instance using a custom domain:
• The languages assigned to the domain when creating the domain is displayed and is available for

selection from the Primary language of documents drop-down list.
• The fields that were selected when creating the custom domain are displayed in the Fields to extract

section of the create New instance page.

You can import or export a domain using the Import or Export option in the Domains tab.

Прим.:  Domains are created and saved with the .dom extension in the system.

Совет:  Troubleshoot classification issue with Chinese language documents:
Classification issue with Chinese Invoices (A-People login required)

Import a domain

You import a domain for the following scenarios:
• Import a new domain.
• Import an existing domain from another system to your current system.

When you are ready to import a domain into your system:
1. Go to the system where you want the domain to be imported.
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2. Click Import new domain in the Domains tab and select the .dom domain file in your local
machine that you want to import.
The domain import success message is displayed in the Domains tab.
The imported domain appears for the selection in the Document type drop-down list of the create
New instance page and is displayed in the domains list in the Domains page.

Export a domain

When you click the Export option next to a domain, it is exported to an output folder on your local drive.
The exported domain is encrypted and is created with a .dom filename extension.
You export an existing domain from one IQ Bot system to import to another.
To export a domain from your IQ Bot system, do this: In the Domains list page, click the Export option
next to the domain you want to export.
The system displays a success message for the exported domain.
The file is exported to a local output folder on your machine with a .dom filename extension.

Прим.:  The domain files are encrypted for security.

Current limitations to the domain import and export actions

Важное замечание:  Import or export of domains is independent of the migration action in the
Migration Utility feature.

When you migrate learning instances that were created using a custom domain from one system to
another, the field names and IDs must remain the same in the target machine as well. Otherwise, though
the learning instances are imported, the custom domain will not be imported and the associated field
names and IDs for the custom domain do not work in the imported learning instance. If you run the
imported learning instance on documents, the documents will not be classified.
Even if you import the custom domain to your new system, the field names and IDs will still not match as
these are automatically generated by the system. Hence classification will fail. This is the current limitation
of the Migration Utility feature using a custom domain.
Обходное решение. Copy the alias database from the current machine to the target machine. Then
migrate the learning instances, using a custom domain. Move all learning instances to the staging
environment, and test them before moving the learning instance to the production environment.

Custom domain enhancements

Import custom domains in any order
When you migrate learning instances (created using a custom domain) from the staging server to the
production server, migration fails unless you import the different versions of the custom domain in the
same order as they were created.
As the capability to edit a custom domain to add additional fields and aliases was not available, the user
had to create a new domain and add the additional fields and aliases to it. Then the user had to assign
that new domain to the learning instance. So when the user wanted to use the new domain, they had to
re-import the original and the new domain to the production server in the order they were created in.

© 2023 Automation Anywhere. All rights reserved.     163



    Automation Anywhere - Использование IQ Bot

Importing custom domain to IQ Bot production (A-People login required)

From release Automation 360 Сборка 5322, and IQ Bot Version 11.3.5.2 this restriction does not exist.
• You can edit and update an existing custom domain multiple times, and import them to the production

server multiple times as well.
• You can import the custom domains in any order. The system successfully migrates the updated fields

(form or table), and field aliases (variations of field values found in the training documents, associated
with a field) to the production server.

Важное замечание:  Perform all edits or updates to a custom domain in the staging server before
importing it to the production server to avoid errors.

IQ Bot performs document classification based on the defined fields and aliases of the version of custom
domain used when the learning instance was created.
Editing the same custom domain (with additional fields) changes the version of the custom domain. For
new learning instances created using the new version of the custom domain, classification occurs on
the updated fields as well. The edited fields (whether form or table fields) are displayed in the learning
instance with a double asterisk next to them to help identify them.

IQ Bot 11.x: Selecting an Распознавание текста (OCR) engine
You can select different Распознавание текста (OCR) engines from the UI to see what best suits your
requirements for data extraction based on your document types. A stop and restart of IQ Bot services is
not required for implementing an engine change.
Во время установки IQ Bot система в качестве модуля Распознавание текста (OCR) по умолчанию
устанавливает последнюю версию Tesseract Optical Character Reader. This is also the global setting for
the product.
However, you can manually set the Распознавание текста (OCR) engine in the Settings.txt file, which
becomes the default engine. Similar to the prior releases of IQ Bot, you can continue to manually update
the Settings.txt file with the Распознавание текста (OCR) engine name you want to set as default.
If you select a deprecated version of the Распознавание текста (OCR) engine or a non-supported engine
through the Settings.txt file configuration, the system displays an error message. When creating a
learning instance, you can select an Распознавание текста (OCR) engine from the Optical Character
Recognition drop-down menu. См. IQ Bot 11.x: Создать экземпляр для обучения on page 160

Note:  Selecting an Распознавание текста (OCR) engine overrides the values in the Settings.txt file.

1. On the Create a new learning instance page, select the domain and language of the documents.
In the My learning instance list page, a new OCR Engine column is available that shows the
Распознавание текста (OCR) engine used for creating each learning instance. This information is
useful to the user when deciding on document processing.

2. The Fields to extract and Advanced Settings sections are displayed when you select the domain.
Each domain is available with a predefined list of primary supported languages. Language selection
is enabled and available from the Primary language of documents drop-down list based on
supported languages for a specific domain.

Note:  If you select a language from the Primary language of documents drop-down list and then
select an engine that does not support that language, the system displays an error message in the
Optical character recognition drop-down list.
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3. Click Advanced Settings > Optical character recognition to display the Распознавание текста
(OCR) engine options drop-down list.
If the Распознавание текста (OCR) engine selection is invalid, the Create instance and analyze
option is not enabled.

Note:  IQ Bot automatically installs all Распознавание текста (OCR) engines during the installation
process, except for ABBYY FineReader Engine.

Important:  You can only configure the selected Распознавание текста (OCR) engine in Automation
360 IQ Bot On-Premises. Распознавание текста (OCR) settings in Automation 360 IQ Bot Cloud
cannot be edited as they are not accessible except for ABBYY FineReader Engine. You can edit the
configuration settings for ABBYY FineReader Engine using the appConfigurations REST API.

You can select from the following:

Вариант Описание

Tesseract OCR4 This is the default engine, unless changed in the Settings.txt
file.

ABBYY FineReader Engine To verify if ABBYY FineReader Engine is installed and available
for use on your machine, check the Settings.txt file, the
Распознавание текста (OCR) Plug-ins folder for the SDK files, and
the Optical character recognition drop-down list.

Note:  Also supported in IQ Bot [Local Device] пакет and IQ Bot
Extraction пакет.

Use ABBYY FineReader Engine Распознавание текста (OCR) engine in
IQ Bot 11.x on page 123

Microsoft Azure Computer
Vision OCR engine

IQ Bot supports all languages supported by this Распознавание
текста (OCR) engine.
IQ Bot 11.x: Use Microsoft Azure Computer Vision OCR engine on page
121

Google Vision API IQ Bot supports Google Vision API as an Распознавание текста
(OCR) engine and supports all languages supported by this engine.
IQ Bot 11.x: Use Google Vision API OCR engine on page 126

Tegaki API IQ Bot supports his Распознавание текста (OCR) engine to extract
data specific to Japanese and Korean language documents. You
need to download and use your private license to use Tegaki API.

Note:  Tegaki API Распознавание текста (OCR) engine is not
supported in Automation 360 IQ Bot Cloud.

IQ Bot 11.x: Использование модуля Распознавание текста (OCR)
Tegaki API on page 129
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Вариант Описание

В моих документах PDF
отсутствуют изображения

All the PDF documents that you upload are processed using the
PDFBox Распознавание текста (OCR) by default, regardless of
the Распознавание текста (OCR) engine you have specified or
selected.
If you are uploading non-PDF documents or PDF documents that
contain images, clear the My PDF documents do not have
images check box to ensure that the Распознавание текста (OCR)
engine that you have specified or selected is used to process the
documents.
The My PDF documents do not have images check box is
enabled by default. To disable this feature, see IQ Bot 11.x: Disable
PDFBox option on page 197.

Tip:  If IQ Bot is unable to extract data from low quality or handwritten documents, troubleshoot the
issue:
IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Classification criteria in IQ Bot
Learn about the requirements for a document to be classified in IQ Bot.

Обучаемые экземпляры, созданные с помощью готовых или
пользовательских доменов

IQ Bot searches a document for the minimum number of fields that you selected to successfully classify
the document. If IQ Bot does not find the minimum number of fields, the document is marked as
unclassified.
Пример.
• If you create a new learning instance with 1 to 4 fields selected, IQ Bot checks for at least 4 fields from

the total number of fields presented for that specific learning instance. Similarly, if you create a new
learning instance with 5 fields selected, IQ Bot checks for at least 5 fields.

• If you create a learning instance with 6 or more fields selected in the learning instance, IQ Bot checks
for at least 6 fields. For example, if you selected 8 fields in an invoice domain, IQ Bot checks for at least
6 fields out of the total fields available.

Обучаемые экземпляры, созданные с помощью других доменов

If you create a new learning instance with one or more fields, IQ Bot checks for at least one field
and classifies the document. Если IQ Bot не находит ни одного поля, документ помечается как
неклассифицированный.
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Факторы, влияющие на классификацию

Фактор Примечания

Макет страницы If the page layout is different from the original document
with respect to document content position, IQ Bot might have
difficulty classifying the document.

Ориентация метки Все метки в документе должны быть ориентированы в
одном направлении. If some of the labels are vertical and
some horizontal, the document will not be classified.

Позиция метки Метки можно расположить в любом месте страницы.
Однако последовательность меток слева направо и сверху
вниз должна быть такой же, как в обучающих документах.

Процент соответствия IQ Bot использует 70-процентное соответствие для меток.

Поля, добавленные после
создания обучаемого экземпляра

Поля, добавленные после создания обучаемого
экземпляра, исключаются из процесса классификации.

IQ Bot 11.x: Edit a learning instance
Edit a learning instance to change its name, description, add additional training documents, or include
additional fields for extraction.
You can edit learning instances that are in the staging environment. To edit instances in the production
environment, first set the learning instance to the staging environment.
1. On the Learning Instances page, click a learning instance.
2. Click the Edit icon to edit the learning instance.
3. Optional: Update the description field.
4. Optional: Change or update the learning instance name.

When you change the name of a learning instance, the following changes occur:
• A separate folder with the new learning instance name is created in the configured output directory

to store the .csv files of processed documents.
The previous folder containing the .csv files before the learning instance name was changed
remains as is in the output folder.

• When you migrate a learning instance with an updated name using overwrite or remove options, it
is updated in the source environment after the .iqba file is imported.

• An entry in the audit logs is created for this activity.

5. Optional: Click Browse to select additional training documents.
6. Optional: Select additional fields and table columns to add to the learning instance for data extraction.
7. Use the New groups creation setting field to restrict creation of new groups or set the threshold

for the number of groups.

Note:  The New groups creation setting option is not applicable for IQ Bot [Local Device] and IQ
Bot Extractionпакеты.
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8. Optional: Use the Default validations group option to select a default group for document
validations.
All new documents use the custom logic and validations defined in the default group. Validation rules
from this default group are applied when a document does not belong to any of the existing group.

9. Click Save to view a confirmation message.
10. Click Yes, proceed with field addition to upload, analyze, and classify the selected training

documents (if any) that were added to the learning instance.
The classification of documents remain unaffected by the newly added fields.

All additional fields become available in all the боты and appear as optional fields in the selected learning
instance. The боты must be retrained for these fields.
См. раздел IQ Bot 11.x: Errors generated while editing learning instances on page 168.
Related concepts
Варианты импорта on page 254
Find out about the impact of each import option.

IQ Bot 11.x: Errors generated while editing learning instances
Use case scenarios and error messages generated while editing a learning instance are explained in this
topic.

Обращение Сведения Сообщение

Бот in training Learning instance is in use
because of ongoing бот training
and you edit the same instance
A) User 2 is editing the same
learning instance

Case 1: Simultaneous editing of
same learning instance

Example for case 1:
User 1 uploads a document to
the same learning instance.
User 2 adds a field when editing
the same learning instance.
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Обращение Сведения Сообщение

Run and edit the same бот Run the бот and then edit
the same бот using the same
user login or two different user
logins.

IQ Bot 11.x: Delete a learning Instance
Use the Learning Instances page to delete a learning instance from the View Details page.
You cannot delete a learning instance that is in the production environment. To edit a learning instance, do
the following:
1. On the Learning Instances page, click the learning instance or View Instance Details icon to

show the Summary tab.
2. On the details page, : click the Edit icon. The learning instance becomes available for editing.
3. To delete the learning instance, click the Delete Instance button. A confirmation message appears.
4. Enter the learning instance name in the field and click the I understand, please delete button to

delete it.

Important:
Unless you have already exported the learning instance as a backup, the following occurs after you delete
a learning instance:
• It is permanently deleted and cannot be restored.
• All the associated боты are deleted and cannot be reused.
• You cannot reuse a deleted name for a learning instance to create a new one.

Staging environment
The learning instance workflow consists of the Staging and Production environments. Staging is a training,
testing, and validation environment for hands-on experience with the IQ Bot workflow on documents that
represent the larger volume of documents to process in production.
Use Staging to train, test, and improve the accuracy of a learning instance and its боты before deployment
to the Production environment.
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Note:  Data from the Staging environment does not appear in the Production environment.

The primary purpose of the staging environment is as follows:
• Provide an overview and give you the opportunity to review and correct the extracted data before

sending the боты to production
• Provide reporting data for the Staging environment so it does not interfere with reporting data in the

Production environment.

Do the following tasks in the Staging environment:
• Upload sample documents.
• Classify or digitize the sample documents.
• Create or train боты to extract data.
• Preview to verify extraction or make manual corrections.
• Save and set the боты to production.

Create and edit a бот
Use the Learning Instances page to create and edit боты using the View Details page.
This is an alternate way to create a learning instance and also edit it.
Do the following:
1. On the My Learning Instances page, click an instance or the View Instance Details icon to show

the instance details in the Summary and Document Groups tabs. You can also click the New
Instance button to create a new learning instance.

2. On the details page, do the following:
a) Click the Train button to launch the Designer window to begin training the бот.
b) Click the Edit icon to edit a бот for a document group.

Start training in Designer
After creating a learning instance, click the Train button to launch the Designer window to create or edit a
бот in that learning instance.
The Designer window opens and shows the first document in line for training, with automapped fields.
Define and map the form and table fields, and also verify the automapped fields to verify or remap them, if
required. The document name appears in the following format:
Group Name > Document Class Name [File name].
If the name of a document is too long, move your mouse over the partial name to show the full name of
the document as a tool tip.
In the Designer, the left panel shows the training panel with fields and table headers of the newly added
document class. The center panel shows the auto-mapped values, and lets you select/verify them. The
right panel shows the document under training.
A бот can be accessed by a single user at a time. If it is in use by another user, the open bot option is
disabled.
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Use the Zoom in, Zoom out, or Fit to screen icons at the bottom of the document pane to adjust the
display size of the document in training. Use the pagination arrows to move to a different page in the
document.

Note:  If you are inactive in IQ Bot for 20 minutes, the system logs you off and redirects you to the login
page.

Tip:  Learn how to convert PDF files to TIFF files:
How to convert PDF files to TIFF files (A-People login required)

Related concepts
Design panel on page 172
The Designer opens with auto-mapped fields and table columns, and lets you edit the existing mapping by
adding new fields and tables. The left panel also displays the Field Listing Header showing the name,
format, and requirement.
IQ Bot 11.x: Map a table on page 187
In the Designer, move one or more table fields from one table to another to train extraction, see multiple
tables and their extracted values to validate extraction, and add new tables.
IQ Bot 11.x Designer validation patterns on page 173
IQ Bot Designer allows you to validate a field and table column against a set of predefined parameters so
that you can be warned if any mismatch is found during data digitization process.
IQ Bot 11.x: Preview extracted data on page 197
After completing field and table mapping, click the See Extraction Results button to view OCR and
extracted results to verify the accuracy of the training.
Common fields across multiple document groups on page 196
Create a learning instance with a single document group.
Related tasks
IQ Bot 11.x: Map a field on page 185
The Designer opens with the field panel displayed. Correct and re-map the fields, and map new ones as
required.
Resize mapping area on page 184
In the Designer, after mapping a box around a field value on a document, you can resize the box in any
direction.

IQ Bot 11.x: Train a learning instance
To begin training боты to digitize and extract data from documents in a learning instance, click the
Train button. The system analyzes and sorts the training documents into logical groups based on field
identification.
The IQ Bot Designer displays each document group for you to train in order of importance.

Note:  Define all the fields and tables you want to extract from the documents in the Designer.

When you click a field in the left panel, the mapped field and its value displays in the center panel. You can
validate the field and its value in the document, displayed in the right panel.
If the mapped field value is accurate, the Designer displays a green check mark next to the mapped field in
the center panel.
Mark a field Optional in case the value in a field appears in some documents only. By default, fields are
marked as Required unless a field is added after creating the learning instance. In this case, the field is
Optional by default. See example below.
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If Tax is calculated in one document but not in another, you could mark this field as optional and provide a
default value of 2% .

Choose training document for a group
During document training, look at unique document layouts available in a group, and choose a different
document than the default one chosen by IQ Bot Designer, that is more representative of documents
across that group. That helps maximize straight-through processing (STP).
Follow the steps to choose a different document from a document group.
1. User can see the View each Group 'x' document button in the Designer training page next to the

document name.
The View each Group 'x' document button is disabled if there is a single document in the group.

2. Click the View each Group 'x' document button to display the previous and next arrows that will let
you move to another document. You can also cancel out of the task.
Choosing a different document as the group's training document will clear all mapping from the
previous document. IQ Bot displays a warning message stating the same.

3. Select a new document and click the Change the training document button to see a message
confirmation stating: If you change the training document for this group, any
mapping from the previously trained document will be lost. Do you want to
change the training document for <group name> to <document name>?

4. Choosing No, cancel takes you back to the Designer, whereas confirming the message Yes, change
loads and launches the new document with auto-mapped fields.

5. Click See extraction results to view extracted data from the new document.

Design panel
The Designer opens with auto-mapped fields and table columns, and lets you edit the existing mapping by
adding new fields and tables. The left panel also displays the Field Listing Header showing the name,
format, and requirement.
1. Click a field in the left panel, to display the selected field and its value in the middle panel. In the

middle panel, completed field mapping is identified with a green check icon at the top of the panel.
2. Using the draw icon, select/reselect the appropriate value with System Identified Regions (SIR) in the

document, which is represented by a blue-box text segment in the right panel of the document itself .

Note:  The blue-box text segment has boundary handles allowing resize of selected areas in the
document.

3. Next, create a design for a бот by adding and defining columns and tables you want to extract the
data from.

Note:  The extent of auto mapping depends on text segmentation and optical character recognition (OCR)
quality of the fields and also the depth of taxonomy related to the underlying domain for that learning
instance. Additionally, it also depends on the algorithm's decision-making logic.

IQ Bot 11.x: Improve output quality using OCR confidence
Improve the output quality of the IQ Bot platform using the system-identified region (SIR) and optical
character recognition (OCR) confidence by comparing it to a predefined threshold.
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Confidence-based validation is useful for a text type field and for Date or Number fields because it helps
route a document, with contentious values, for a human to view despite the fields satisfying the set
validation criteria.

Enable OCR confidence-based validation

Note:  This option is applicable only if you selected Tesseract OCR when creating the learning instance.

Эта функция по умолчанию отключена. To enable this feature, open the Settings.txt configuration
file available in <IQ Bot Installation Folder>\Configurations\, and set the desired threshold
value in the ConfidenceThreshold property. For this example, set the character-level confidence
threshold value to 99, that is ConfidenceThreshold=99. When this feature is disabled, the default
value is set to 0, signifying that the feature is disabled.

Note:  The confidence threshold value is uniformly applicable across all the learning instances.

How OCR confidence-based validation works

In a document if a field's SIR character level confidence is lower than that of the set confidence threshold,
the validation for that field fails, resulting in the failure of that document.

Note:  If a field value fails due to a validation rule (for example, Invalid Number Format) other than an
OCR confidence validation failure, you see that tooltip, and not the tooltip for Low confidence.

While training a document, a confidence-based validation failure against a field appears in an orange box
during preview if no other validation errors exist for that field. Other validation errors take precedence over
OCR character-level confidence validation.

Troubleshoot:  If the OCR engine is not able to identify SIRs for Chinese language PDF documents,
troubleshoot the issue:
• Data objects (SIRs) are not identified by OCR for Chinese PDF documents (A-People login required)
• How to convert PDF files to TIFF files (A-People login required)

IQ Bot 11.x Designer validation patterns
IQ Bot Designer allows you to validate a field and table column against a set of predefined parameters so
that you can be warned if any mismatch is found during data digitization process.

Validate a field or table

Validate a field or table column against the following predefined parameters of validation options:
• Start With / End With
• Шаблон
• Списки
• Formulas

IQ Bot classifies documents into groups based on similar content, structure, and layout, which is easily
identifiable. The sample documents for training are chosen based on these criteria as well. When you
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launch the Designer to train your learning instance, IQ Bot loads and displays a sample document from
each classified group in the document pane.

Tip:  In the Designer set the validation parameters by defining any field and or table column during
document training.

Related concepts
IQ Bot 11.x: Starts With and Ends With on page 174
While all validations can be set at the time of Design definition, you can set Starts with/Ends with and
Pattern validations during training.
IQ Bot 11.x: Шаблон on page 174
A pattern helps define an acceptable format for data.
IQ Bot 11.x: Текст on page 175
Select from a list of different available text data types.
Date on page 175
Specify any regular expression and special patterns in the Date data type.
Число on page 177
Choose from available number patterns. For example, regular expression and special patterns.
Related tasks
IQ Bot 11.x: Списки on page 180
While defining a field or table column in the Design view, you can specify a list as part of validation option
for a selected field or table column. The extracted value of the field is validated against this predefined list
during Preview and Test Run.

IQ Bot 11.x: Starts With and Ends With
While all validations can be set at the time of Design definition, you can set Starts with/Ends with and
Pattern validations during training.
To validate whether data in a field starts or ends with a certain value, use the Starts With and Ends
With validation option fields. While defining the design of a field or table column, you can specify whether
the data is part of the selected field.
• Start with a certain value using a Starts With field
• End with a certain value using an Ends with field

If the Start With value is "IN" and extracted value is "1N7646464", then validation fails. While if End With
value is 2017 and the extracted date value is 10-Aug-2017, the validation passes.

IQ Bot 11.x: Шаблон
A pattern helps define an acceptable format for data.
Validate data in the field or table column against a specific pattern. While defining the field or column in
the Design view, specify a pattern of the data in the selected field.
Select pattern for date and number fields based on the different available patterns.

You can have different patterns for Text, Date, and Number.

Related concepts
IQ Bot 11.x: Текст on page 175
Select from a list of different available text data types.
Date on page 175
Specify any regular expression and special patterns in the Date data type.

© 2023 Automation Anywhere. All rights reserved.     174



    Automation Anywhere - Использование IQ Bot

Число on page 177
Choose from available number patterns. For example, regular expression and special patterns.

IQ Bot 11.x: Текст
Select from a list of different available text data types.
Specify any regular expression in the Text data type. The following table lists some of the common
examples:

Field Pattern Notes Description

Эл. почта ^([a-z0-9_
\.-]+)@([\da-z
\.-]+)\.([a-z\.]
{2,6})$

This regular expression
validates emails like
john@ado.com.

The Email field
supports regular
expressions.

Номер телефона ^(\(?\+?[0-9]*
\)?)?[0-9_\-
 \(\)]*$

This regular expression
validates phone
numbers like (+64) 38
3235393.

The Phone Number
field supports regular
expressions.

Website ^([a-zA-
Z0-9]+(\.[a-zA-
Z0-9]+)+.*)$

This regular expression
validates websites like
www.domain.com.

The Website field
supports regular
expressions.

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Alpha-numeric ^[A-Za-z0-9_@./
#&amp;+-]*$

This regular
expression validates
a string containing
alphanumeric values
like INV-001.

The Alpha-numeric
field supports regular
expressions.

Date
Specify any regular expression and special patterns in the Date data type.
The following table lists some common examples:
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Поле Шаблон Примечания

Date • d-m-yy
• dd-mm-yy
• mm-dd-yy
• dd-mm-yyyy
• mm-dd-yyyy
• dd-mmm-yyyy
• mmmm dd, yyyy

Supported date separators
include /(forward slash), –
(dash), space, .(dot), and ,
(comma).
Here,
• d - Numeric day of the

month, from 1 through 31
(eg. 5, 15 etc.)

• dd - Numeric day of the
month, from 01 through 31
(eg. 05, 15 etc.)

• m - Numeric month (eg. 1
for January)

• mm - Numeric month (eg.
01 for January)

• mmm - First 3 letters of
the month (eg. NOV for
November)

• mmmm - Full name of the
month (eg. June)

The following table lists some date examples and it's corresponding valid patterns:

Дата Pattern

01-31-18 mm-dd-yy

Jan-31-2018 mmm-dd-yyyy

2018-1-31 mmmm dd, yyyy

2018-1-09 Mmmm d, yyyy

9 5 15 D M YY

9 11 15 D MM YY

7 MAR 15 D MMM YY

7 MARCH 15 D MMMM YY

5 05 2018 M DD YYYY

2018-5-05 D/MM/YY

2015-9-05 M/D/YY

05 / 9 / 2018 DD / M / YYYY

MAR / 05 / 18 MMM / DD / YY

09-APRIL-18 D-MMMM-YY

5-5-18 M-D-YY

11-5-18 MM-D-YY

NOV-13-2018 MMM-DD-YYYY

© 2023 Automation Anywhere. All rights reserved.     176



    Automation Anywhere - Использование IQ Bot

Дата Pattern

13 - 5 – 2019 DD - M - YYYY

OCTOBER - 05 – 18 MMMM - DD - YY

05.APRIL.2018 D.MMMM.YYYY

APRIL.05.2018 MMMM.DD.YYYY

5 . 5 . 18 D . M . YY

5 . 05 . 18 D . MM . YY

05 . JUL . 18 DD . MMM . YY

5 . 11 . 2018 M . DD . YYYY

MAY . 13 . 13 MMMM . DD . YY

2018-1-27 YYYY-MM-DD

2017/07/27 YYYY/MM/DD

Число
Choose from available number patterns. For example, regular expression and special patterns.

Регулярное выражение

The following table provides an example of the numeric regular expression.

Field Pattern Notes Description

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Special patterns

A Pattern consists of a Prefix, a Number Pattern, and a Suffix. Use for each is explained as follows:
• Prefix: Any symbol or a text string that is appended before the Number Pattern.
• Suffix: Any symbol or a text string that is appended after the Number Pattern.
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• Number Pattern: Number pattern has two parts:
• Integer-part:

They are represented by nines (9s).
The 9s in the integer part represents integer pattern and separators such as commas, spaces, and
so on.

• Fractional part
They are represented by zeros.
If you need two fractional number, then it will be represented by two zeros.
Specifying fractional part is optional.
Format of numbers defined for validating numeric data.

Field Pattern Notes Description

Числовой Supported patterns Supported format for
numeric patterns:
• Decimal (India)
• Decimal (US, UK,

Australia and others)
• Number (India)
• Number (US, UK,

Australia and others)
• Normal Decimal
• Normal Number

The Numeric
field supports
special patterns
(system recognized
patterns) and regular
expressions.

9999999,00 2597,23

9999999,00 7562597,23

9 999 999.00 2 597.23

9 999 999,00 7 562 597,23

9999999,00 2597,23

9999999,00 7562597,23

99,99,999.00 75,26,569.56

$ 9.999.999,00 $ 7.562.597,23

$9 999 999.00 $7 562 597.23

9 999 999,00 $ 2 597,23 $

€ 9999999,00 € 7562597,23

€9999999.00 €7562597.23

99,99,999.00 € 75,62,597.23€

EUR 9,999,999.00 EUR 7,562,597.23

EUR9 999 999.00 EUR7 562 597.23

9999999,00 EUR 62597,23 EUR
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Field Pattern Notes Description

9.999.999.00 62.986.51

9, 999, 999. 00 232, 510. 68

IQ Bot supports prefixes and suffixes to make processing and validation of data easier. Specifying a suffix
and prefix in the pattern and in the numeric fields is optional. Even if you do not specify the suffix or
prefix, IQ Bot auto corrects and includes the required currency symbols and units of measure for the
numeric fields as prefix or suffix. If you specify the currency symbols and units of measurements in the
pattern and in the numeric data, IQ Bot deletes the currency symbol and unit of measure from the data.

Note:  IQ Bot automatically recognizes these currency symbols: $, ¥, £, ₹, €, Rs, USD, EUR,
 CAD, AUD, GBP, and INR. We recommend specifying valid currency symbols in the data.

Auto Correction

This is one of the built-in features of IQ Bot for date and number format types. It performs automatic
validation and correction based on the defined pattern , even when the date/number in the scanned
document is incorrect.

Note:  Auto correction is only supported for special patterns.

The following table illustrates the auto-correction of an incorrect date and numbers by IQ Bot.

Incorrect OCR
value

Pattern Auto-Correction Description

DATE 12 F3B 2 0 1 5
15 10-2015

dd mmm yyyy
dd-mm-yyyy

12 FEB 2015
15-10-2015

In the first
example, IQ Bot
auto corrects
incorrect OCR
"F3B" to "FEB".
In the second
example, IQ Bot
auto corrects
"15 10-2015"
to"15-10-2015".

ЧИСЛО 123 4567
12.34,S67.12

9999999
99,99,999.00

1234567
1234567,12

In the first
example, the extra
space between
"3" and "4" is
deleted after
validation against
the pattern.
In the second
example, the
alphabet "S" is
corrected as "5".
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Note:  English language numeric value with at least one digit to the left and two consecutive digits to the
right (for example, 1.23) gets auto corrected if there is a space found between the decimal and the digits.
For example, values 1 . 23 or 1. 23 or 1 .23 get auto corrected to 1.23.

To use this feature, add Pattern (in validation options) to the selected date and number format fields.

IQ Bot 11.x: Списки
While defining a field or table column in the Design view, you can specify a list as part of validation option
for a selected field or table column. The extracted value of the field is validated against this predefined list
during Preview and Test Run.
You can only specify list validation when format of field or table column is "Text". If the lookup returns
multiple values for a word, the value is not auto corrected and the validation fails.
To specify list validation, do the following:
1. Select the validation type as List from the Validate drop-down menu.
2. Type a predefined list and click Define to save.

Each value in the list should be in a separate line.
If the extracted value does not match any value in the predefined list, the field is considered to have
failed validation.

IQ Bot 11.x: Formulas
For calculative or comparative validation, in the design view, specify a formula as part of validation options
for a selected field or table column.
You can specify formula validation only when format of field or table column is a number.
The formulas you specify in the Designer are saved and carried over to the Валидатор as well. Opening a
бот in the Валидатор will let you see and use the formulas associated with the бот.
• In the Designer, in Preview (See extraction results) view, the formula validation flags errors as

expected, to process the training documents.
• Upload the same documents to production. The documents get processed and failed due to the same

formula validation.
• In the Валидатор, the same formula validation continues to flag errors to process the documents.

To specify a formula for validation, perform the following steps.
1. Select the validation type as Formula from the Validate drop-down menu.
2. Type the formula of your choice and click Define to save the formula.
3. To write a formula, you can use basic arithmetic, comparative, logical, and functional operations.

Validation rules can be built by combining these operations with different fields and table columns.
4. Fill in the fields in the form, as appropriate.

Таблица 2. Mathematical Operators

Operations Description Syntax

+ Addition Field/Column_Name1 +
Field/Column_Name2

- Subtraction Field/Column_Name1 - Field/
Column_Name2
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Operations Description Syntax

* Multiplication Field/Column_Name1 *
Field/Column_Name2

/ Деление Field/Column_Name1 / Field/
Column_Name2

Таблица 3. Comparative Operators

Operations Description Syntax

== Equal To [Current Field/Column
Name] == [expression
comprised of one or more
field/column name or fixed
numeric values]
For example, AMOUNT
== MUL(QUANTITY,
UNIT_PRICE)

>= Greater than or Equal To [Current Field/Column
Name] >= [expression
comprised of one or more
field/column name or fixed
numeric values]
For example,
TOTAL_BILL_AMOUNT >=
AMOUNT_PAID

<= Less than or Equal To [Current Field/Column
Name] <= [expression
comprised of one or more
field/column name or fixed
numeric values]
For example, AMOUNT_PAID
<= TOTAL_BILL_AMOUNT

> Больше [Current Field/Column
Name] > [expression
comprised of one or more
field/column name or fixed
numeric values]
For example, BILL_AMOUNT
> 0
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Operations Description Syntax

< Меньше [Current Field/Column
Name] > [expression
comprised of one or more
field/column name or fixed
numeric values]
For example,
DISCOUNT_PERCENTAGE <
100

!= Not Equal To [Current Field/Column
Name] != [expression
comprised of one or more
field/column name or fixed
numeric values]
For example,
DEBIT_AMOUNT != 0

Таблица 4. Logical Operators

Operations Description Syntax

&& And: Field/Column is valid if
all conditions are true

<Current Field/Column
Name> <operator 1>
<expression 1> &&
<Current Field/Column
Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE
>= 0 &&
DISCOUNT_PERCENTAGE
<=100

|| Or: Field/Column is valid
if any one of the given
conditions is true

<Current Field/Column
Name> <operator 1>
<expression 1> || <Current
Field/Column Name>
<operator 2> <expression
2>
For example,
DISCOUNT_PERCENTAGE
>= 0 ||
DISCOUNT_PERCENTAGE
== 'Net'
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Operations Description Syntax

! Not: Converts a true
expression to false and also
the other way round

!<expression>
For example, !(AGE < 18)
==> valid when AGE is not
less than 18

Таблица 5. Functional Operators

Operations Description Syntax

СУММА Summation: gives result
of addition of one or more
field/column/fixed-number
values

SUM(n1,n2,....,nN)
For example,
SUM(SUB_TOTAL,
SERVICE_TAX,
EDUCATION_CESS) ==>
equivalent to SUB_TOTAL
plus SERVICE_TAX plus
EDUCATION_CESS

SUB Subtraction: gives result
of subtraction of one or
more field/column/fixed-
number values from the first
specified value

SUB(n1,n2,....,nN)
For example,
SUB(SUB_TOTAL,
TOTAL_DISCOUNT,
ADJUSTMENTS) ==>
equivalent to SUB_TOTAL
minus TOTAL_DISCOUNT
minus ADJUSTMENTS

MUL Multiplication: gives result
of multiplication of one or
more field/column/fixed-
number values

MUL(n1,n2,....,nN)
For example,
MUL(QTY_IN_BOX,
UNIT_PRICE,
SHIPPED_BOXES)
==> equivalent to
QTY_IN_BOX multiply-with
UNIT_PRICE multiply-with
SHIPPED_BOXES

DIV Division: gives result of
division of one or more field/
column/fixed-number values
from the first specified value

DIV(n1,n2,....,nN)
For example, DIV(AMOUNT,
SHIPPED_BOXES,
UNIT_PRICE) ==>
equivalent to AMOUNT
divide-by SHIPPED_BOXES
divide-by UNIT_PRICE
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Operations Description Syntax

COLSUM Sum of a given Column
in a table: gives result after
evaluating given expression
for each row of specified
table and adding them all
together

COLSUM("<table-name>",
"<expression to evaluate for
each row of specified table-
name>")
For example, FINAL_TOTAL
== COLSUM("LINE_ITEMS",
"MUL(QTY, UNIT_PRICE)")
Say there are 3 rows for
table LINE_ITEMS, then
FINAL_TOTAL should
be equal to MUL(QTY1,
UNIT_PRICE1) + MUL(QTY2,
UNIT_PRICE2) + MUL(QTY3,
UNIT_PRICE3)
where, QTY1 is QTY
value in row 1, similarly
UNIT_PRICE1 is UNIT_PRICE
value in row 2, and so on for
other rows as well.

Совет:  We recommended using functional operators instead of mathematical operators when
validating fields and tables for better accuracy.

When formulating an expression remember the following:
• All function names must be in capital letters.
• All formulas must result in either a true or false validation.
• Field and column names are case sensitive when used within formulas. If field is defined as Qty in

design, using qty or QTY in formula results in an invalid formula.
• For variable declaration or manipulation, ensure not to use certain keywords that are reserved for

formulating an expression.

SUM, SUB, DIV, MUL, COLSUM, IF.

If the expression evaluated is false, a validation error is raised.

Совет:  Ensure you do not write "=" (single equal) where you intend to use "==" (double equal).
For example, AMOUNT == MUL(QUANTITY, UNIT_PRICE) is valid. But AMOUNT = MUL(QUANTITY,
UNIT_PRICE) is not a valid resultant formula.

Resize mapping area
In the Designer, after mapping a box around a field value on a document, you can resize the box in any
direction.

1. In IQ Bot Designer, select a field name in the left panel to see a box with boundary handles around
the field value on the document in the right panel.
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2. If a field value is not mapped, select a blue-bounded box around the field label on the document to
auto-populate the field value. A highlighted box has boundary handles that lets you adjust the size.

3. Alternatively, in the Designer, after drawing a box around a field value, and then releasing the cursor a
highlighted box appears with boundary handles that lets you adjust the size.

4. Additionally, make the selected area larger than the segment of text (for example, to enclose multiple
segments of text) to extract text in that larger selected area.

IQ Bot 11.x: Map a field
The Designer opens with the field panel displayed. Correct and re-map the fields, and map new ones as
required.
For mapping a system identified region (SIR) as a field, do the following:
1. For a selected SIR, select type from the Type drop down list.
2. Map the field label and field values separately by clicking the Draw icon next to the Label and

Value fields. Draw a rectangle around the label and value. The value is detected and shows up in the
validation pane.
If a mapped field has multiple SIRs, then select any one of the SIR and add the whole key words in
the Label field. For example, if you have two SIRs such as: Invoice and Number, then add the whole
key words Invoice Number in the Label field.

3. Click Save and close.
When you accept the system-detected value mapping for a field, the value stays relative to the field.
In some cases, in a different document type, even if the value of the field appears in another location,
the system is able to detect it.

4. Click Validation Options to validate the field against a set of predefined parameters.
For validation, type the End with, and pattern fields when mapping document groups. Additionally,
you can also use list validation if the field data type is text.

5. Click Save to confirm your changes.
It is mandatory to map all the required fields and table columns defined at the time of creating the
learning instance. If any of the required fields is not mapped, a greyed out check icon displays next
to the document class. It continues to display until you complete mapping all the required fields and
table columns.

Tip:  For additional information, see What are the different ways to map form fields in IQ Bot (A-People
login required)

Related concepts
IQ Bot 11.x Designer validation patterns on page 173
IQ Bot Designer allows you to validate a field and table column against a set of predefined parameters so
that you can be warned if any mismatch is found during data digitization process.

IQ Bot 11.x: Use list validation to improve accuracy of a text field
Setting validations while defining any field or table column while mapping the document class helps
validate a field or table column against predefined parameters so that you can be warned if any mismatch
is found during the data digitization process.
Enter each text value in a separate line.
• The бот validates extracted value of field/table column against this predefined list and checks for any

mismatch found during the See Extraction Results phase.
• Besides validating, the process also helps auto correct the extracted values.
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• Errors in validation are marked with a red border and can be seen in the See Extraction Results
phase. Move your cursor over the error to know the error type.

If list validation value is Adam, and the extracted value is Adem; the extracted value will be auto
corrected to Adam. In this example, there is a 75% match of characters; and threshold for match is at
least 66%.

Задачи, связанные с данной
Use Machine Learning to fix extraction errors
In the Validation queue (in Валидатор), IQ Bot can learn from manually corrected (by humans) field
values, over a specific time period.

IQ Bot 11.x: Use validation patterns/lists to flag discrepancy in extracted data
Use validation patterns/lists to flag discrepancies in extracted data and prevent incorrect data from going
through.
When a date/number format pattern is explicitly specified, the date/number is auto corrected.
See the following examples:

Таблица 6. Example of date format pattern

Incorrect OCR Data Шаблон Auto-Correction

15 10-2015 dd-mm-yyyy 15-10-2015

Таблица 7. Example of number format pattern

Incorrect OCR Data Шаблон Auto-Correction

123 4567 9999999 1234567

Text segment
A text segment is a blue-box display of a mapped field/column value in the document panel. This feature
helps train the боты.
Text segments provide better results for OCR, document classification, and ultimately data extraction.
For example, words that should be grouped in the text segment are more likely grouped together, and
documents with different layouts are less likely to be grouped together.
In Designer, Валидатор, and Preview (See extraction results) views, place your cursor over a text
segment on a document to see segment's OCR display in a pop-up box.
In Designer, the pop-up displays a text segment's OCR on the document (in the right panel) with matching
corresponding extracted value in the middle panel.
In the Preview (See extraction results), and Валидатор views, see the pop-up display a text segment's
OCR on the document (in the right panel) with matching corresponding extracted value in the left panel.
If a text segment encloses other smaller text segments, place your cursor over any single text segment to
see a pop-up display of its corresponding optical character recognition (OCR) extracted value.
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Понятия, связанные с данным
IQ Bot Validation queue
Validation eliminates the complexity of validating and fixing issues with the бот, requires less time to fix
the issues, and requires minimal human intervention.

Multi line segmentation for data extraction
In the Designer, re-size/draw a region consisting of a group of system identified regions (SIRs). The re-
sized/draw boxes extract data only from the enclosed SIRs. Additionally, you can also extract text from an
entire region by selecting it.
IQ Bot offers multi line segmentation for data extraction. For example, there can be segmentation for
patient name, member ID, date of birth, provider name, and gender. All of this information can be
contained within a bigger segment box. The Designer can extract data from text segments enclosed within
bigger text segments. The blue text segments display in the Designer, Валидатор, and in Preview (See
extraction results views). The blue text segment boxes that enclose or are enclosed by other text
segment boxes help extract data from any of these segments.
For text segments Y and Z enclosed within the main text segment X, when you select/draw around the text
segment X, the Designer extracts data enclosed in the text segment X, which would comprise of data in Y
and Z.
Select/draw around a text segment Y (that is enclosed by text segment Z) to extract text from text
segment Y.
Resizing the X text segment to exclude the Y text segment will extract data from text segment Z only.
When mapping a text segment box X that encloses other segment boxes Y and Z, IQ Bot provides the best
guess and auto maps the corresponding value of text segment box X.

IQ Bot 11.x: Map a table
In the Designer, move one or more table fields from one table to another to train extraction, see multiple
tables and their extracted values to validate extraction, and add new tables.
To map a table fields and columns, do the following:
1. Click Add table/section in the left panel and assign a name for the table in the middle panel.
2. Expand Move fields in the middle panel, and select the field labels you want to move to other tables.
3. Click the down arrow, and begin mapping the table fields.
4. Select the table field in the left panel and to begin mapping them using any of the following options:

• Вариант 1. Click the column name field in the middle panel and select from available drop-down
options.

• Вариант 2. Click the column name field in the middle panel and select the column value from the
document view in the right panel.

5. Place your cursor in the Column value field in the middle panel and then click the value in the
document view to populate the field.

6. Alternatively, use the draw icon to select the value from the document in the right panel.
7. In the Data type section, select the data type value of the column from the drop-down list.
8. Next, select Column options in the middle panel and choose Required or Optional. Use the

optional value if the column value is not consistently available in the training documents.
9. Use the Validate pattern section to specify the following parameters:

• Starts With
• Ends With
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• Шаблон
• Список

Note:  IQ Bot 11.x Designer validation patterns on page 173

10. Map values for the other table fields using the same steps.

Once you complete mapping the table columns, the selected SIR region in the document gets highlighted
in yellow for easy identification. After mapping the table columns, assign the Best field for table/
repeated section and Best field for table/repeated section for the table.

Best field for table/repeated section (Reference Column)

The Best field for table/repeated section is auto detected and can be viewed in the inspection panel
(right panel) of the Designer window. Ensure the Best field for table/repeated section does not
contain multiple lines, or is empty.
Other columns are extracted in reference to this column. If the Best field for table/repeated section
has five rows, then the user can expect a maximum of five rows to be extracted from the other columns.

End of table/section indicator

The End of table indicator is the end-point of a table. Enter name of the first field that appears where a
table ends. For example, Total, Grand Total etc.
The End of table/section indicator helps create a бот in an accurate and efficient way, and is optional.
This functionality lets you create and train more боты without worrying about assigning an end of table
indicator.
Complete Table/section name and Best field for table/repeated section in the left and middle
panels to set the green check mark for the Table Settings section.

Best field for table/repeated section and End of table/section indicator

Do the following to assign a Best field for table/repeated section and End of table/section
indicator :
1. In the left panel, select the table for which you want to assign the Best field for table/repeated

section and End of table/section indicator .
2. The middle panel gets updated with the details related to the table.
3. Select the Best field for table/repeated section from the drop-down list of defined table columns.

Note:  It is mandatory to define a Best field for table/repeated section for a table. If you do not
define one, a warning icon displays next to the document group.

4. To enter the End of table/section indicator value, add the first field that appears after a table, as
the footer value. Use the pipe symbol to add multiple values to the End of table/section indicator .

5. Go to Advance table options and select the Stop extraction at end of table indicator option to
stop data extraction when an end of table indicator value is found.

6. Click Save to confirm the values.
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Tip:
For tables that span across pages but do not have column headers on every page, IQ Bot might skip
extracting rows from the pages without column headers. To prevent this, you must accurately select the
End of table indicator/section. However, this approach does not work with advanced table mapping.
For additional information, see How to map tables in IQ Bot (A-People login required)

Tips for mapping
Use the following tips to save time and simplify work on IQ Bot tasks.
• Use the special character Pipe "|" Symbol to add multiple aliases to extract similar fields and table

columns across multiple document classes. Using and alias helps you create generic IQ Bots.
• When you resize any value region or create your own value region using select, its position gets fixed

relative to the field label. The value for that field is always searched in that relative region.
• Reset a fixed field region defined by the user in the auto-detected mode by clicking the close button at

the top right corner of the field.
• Map all the required fields or table columns. If missed fields or table columns exist, the system shows a

warning icon against the missed fields or columns.
• Define a reference column and footer (footer is optional, and does not always yield a message) for a

table. Otherwise, the system shows a warning icon against the missed column/footer.

Stop extraction at End of table/section indicator
Use the End of table/section indicator field in the Designer to specify to IQ Bot where to stop
extracting data from a table.
Create a learning instance and begin training documents in the Designer. Map all the fields in the
document before populating the End of table/section indicator field.
As an example, an invoice might contain the subtotal, sales tax, and total in the table, but since each of
these fields only have one value per document, they should not be extracted as part of the table.
To prevent IQ Bot from extracting values beyond the End of table indicator/section, do the following
steps:
1. In the table/section setting, navigate to the Best field. . field. For that field, map a table/section

header as field label, but shift to advanced table/section, mapping the first row value as the field
value.

2. For other table/section fields, you only need to map their first row values as the field values.
3. In the middle panel, for Advanced table options, select Stop extraction at End of table/

section.
Provide the value for the End of table/section indicator field in any of the following ways:
• In the right panel, select a blue-bounded box around a text value to populate that text value as the

End of table/section indicator.
• Alternatively, type a value directly in to the End of table indicator/section field, in the middle

panel.
• To add multiple values for the End of table indicator/section field, type a pipe symbol and a

subsequent text value where | refers to OR (for example, Subtotal | Subtotal Amounts refers to
Subtotal OR Subtotal Amounts).
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IQ Bot 11.x: Add multiple tables in Designer
Add multiple tables in the Designer simultaneously.
Add multiple tables in the Designer to extract their value and validate them. Move one or more table fields
from one table to another to train extraction. To add tables do the following:
1. Navigate to Learning Instance > Start Training > Designer window.
2. Click the Add Table link.
3. Select the columns to add from the Available columns list and click the arrow to add to the new

table column list.
4. Map the field label or value, for example, column header, and specify the footer. This action provides

the бот with a header and footer parameter and informs it to extract the value from the rows in.Use
the Draw icon or select a blue box text segment on the document for a field label/field value.

5. Click Save and close.
6. To delete a table, click the Delete Table option.

When a field that is used as a reference column is removed from a table, the system reassigns the
first field of that table as a reference column.

After you finish adding/removing tables and mapping field labels for the columns, choose from the
following options:
• Click Next group, to move to the next document group in the queue.
• Click Save and close to return to the learning instance.

IQ Bot 11.x: Defining one or more linked fields in a child table
In the Designer, define one or more linked fields/sections in a child table, to link parent and child tables in
a flexible way.
Use the linked fields in a child table feature in Designer to create table links, and a hierarchy of table links
among parent and child tables. This helps efficient data extraction of the linked fields besides easy linking
among tables. Foreign key data extraction allows the following relationships only:
• Link single parent row to a single child row (one-to-one linking).
• Link single parent row to multiple child rows (one-to-many linking).

Прим.:  IQ Bot does not support linking of check boxes.

Use the feature for documents with a list of names or IDs with specific information on each. For example,
documents from an electric company with a list of customers and their billing/usage information. Or a
document with a list of student names displaying their test scores. Create multiple tables and link the
common fields thus allowing efficient and accurate data extraction. IQ Bot supports linking of up to 50
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columns and unlimited rows. However, data extraction from rows spanning across multiple pages is not
supported.
• Single parent-child table field/section linking:

In the Table/Repeated Section of the Designer, choose one or more fields/sections from a parent
table to link to a child table.
1. Click Table Settings in the child table and click on Link Table Fields and select the parent table

from the drop-down list of table names. This displays the available column options in the parent
table you can choose to link to.

2. Select the columns you want linked and click the downward arrow to link the columns to the child
table.

3. The linked columns display under child table > Table Settings > Linked to (table name).
4. When previewing the extracted data (click See extraction results), the linked fields from the

parent table show up in the extreme left columns of the child table.

• Multiple hierarchical table field/section linking:
When linking table 1, 2, and 3 in a hierarchy, link in a way so that table 1 is the parent of table 2, and
table 2 is parent of table 3. All three tables would be linked. Child table 3 would display linked fields
from table 2 and 1. IQ Bot supports hierarchy linking up to six tables at a time.

Прим.:  For table 3, you can only choose fields from table 2 that are not from table 1.

When previewing the extracted data for child table 3 (click See extraction results), the extreme left
columns show linked fields from table 1. The next columns show linked fields from table 2.

Важное замечание:  For successful linking, the child table must be at the same or lower level than
the parent.

Map repeated tables and sections
This topic explains how to map repeated section labels and values.
Follow the steps to map repeated section labels and values:
1. Create a learning instance with an attached document in the domain of your choice and add additional

fields that you need. For example, create an instance in the Invoice domain and add Patient name,
Date of service, Net amount, and Billed amount.

2. Open the Designer/Training page.
3. Select a repeated section.
4. For a selected system identified region (SIR), select the type from the Type drop-down menu.
5. Map the repeated section value separately by clicking the Draw icon next to the Value field and draw

a rectangle around the value. The value is auto detected in the validation pane. Map the repeated
section Label field by manual entry or selecting the label in the document view. Verify the extracted
value in the middle validation panel.

Note:  If a mapped field has multiple SIRs, select any one of the SIR and add the whole key words
in the label field. For example, if you have two SIRs, "Invoice" and "Number", then add the whole key
words "Invoice Number" in the label field.
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6. Click Save and close.

Note:  When you accept and map the automatically detected value region for a field, the value stays
floating relative of the field. Sometimes, in a different document type, even if the value of the field
appears in another location, it will be detected.

UI help to extract tables and repeated sections
When extracting data from tables and repeated sections, IQ Bot offers real-time inline help. View the
Information icon in the following locations.
• On the create/edit learning instance page, hover over the Information icon next to the Standard

table/repeated section fields header, to see a pop-up screen with an example.
• On the create/edit learning instance page, under Other fields (optional) section, to the right of Add

as form/Add as table buttons, hover over the Information icon to display an example.
• In the middle panel of the Designer, for Table/section Settings, hover over the Information icon to

the right of the Best field for table/section extraction section, and the Advanced table/section
options to see image examples of table/repeated section fields, and table summary row.

Rename tables and repeated sections
Rename tables and repeated sections in the Designer, and identify their content.
In the Learning Instance tab, click Create Bot to bring up the Designer. In the middle panel, edit the
default name of the first table/repeated section (Table-repeated-section-1), to describe the content.
1. In the left panel, select Add Table to add a new table. The new default table name appears in the

left and middle panels with a placeholder name. Provide a suitable name.
2. In the setting option of the middle panel, enter up to 30 characters to provide a new/revised table

name.
3. After saving the table name, the updated name displays in the left panel, describing the content.
4. On trying to save a name that is a duplicate table/field/repeated section name, a text box with a red

border and a tooltip displays showing an error message.
5. In the left panel, clicking out of current settings without entering a table/repeated section name shows

an error icon in the left panel, and a corresponding error message in the middle panel.
6. Failing to enter valid names for all table/repeated sections disables the See Extraction Results

(Preview) and Save buttons to prevent user from proceeding any further.

Extract data from check box or check box groups
When you create a learning instance and set it for training, IQ Bot displays the Designer where document
groups are trained to extract data. This topic specifies the data extraction for single or group check boxes
in the staging environment.
Флажок — это объект пользовательского интерфейса, который позволяет сделать двоичный выбор:
выбрать определенную функцию или оставить ее невыбранной. IQ Bot supports extracting data from
check boxes or radio buttons with the marked with a tick, cross, or dot. В дополнение к квадратным
флажкам и круглым переключателям IQ Bot поддерживает треугольные и ромбовидные контуры.
When IQ Bot processes documents with a check box, it extracts either a Yes (check box selected) or No
(check box not selected) value.
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You can also combine multiple check boxes into a single group, for example a payment methods group
that contains check boxes for cash, credit card, and check. When IQ Bot processes documents with a
check box group, it includes the group name in the extraction results.
Recurring check boxes or groups
By default, IQ Bot extracts check box values as a form field. However, if a check box or group appears
on a recurring basis in the uploaded documents, you manually select the Column option so that IQ Bot
extracts the values as table fields. This enables IQ Bot to extract values from the subsequent occurrences.
Otherwise, IQ Bot will only extract the check box value the first time it appears.
1. Click the field you want to map from the left panel.
2. In the center panel, in the Data type drop-down field, select value as check box or checkbox

group.
• To extract data from single check box or check box groups, click the Field label field and

then click the corresponding value in the document in the right pane.
• Extract data from recurring check box or check box groups, click the Column name field

and then click the corresponding value in the document in the right pane.

3. To extract the check box value, draw an outline around the check box excluding the value.
• For a single check box, use the Draw tool to draw over the check box or select the auto-

mapped check box segment.
• For a check box group, use the Draw tool to draw over the region covering all the check boxes

in that group.

4. For single check boxes or check box groups: Verify the extracted data either in the Field value
field in the Designer or click See Extraction Results to see the extracted data.
For recurring check boxes or check box groups: You can only view the extracted data by clicking
See Extraction Results; the extracted data is not shown in the Designer.

5. Необязательно: To add an individual check box to a check box group, select the desired value from
the Checkbox group drop-down menu.

6. When you are done configuring the check boxes, click Save and close or Save and go to next
group.

IQ Bot 11.x: Extract repeated check boxes data
This topic explains how to extract data from the repeated check boxes.
To extract values of these repeated check boxes, first add the repeating check boxes as table fields to your
document in the learning instance. In this example, Master Card and Visa Card are the two repeated check
boxes.
To extract repeated check box data:
1. Add fields to the learning instance as a table field for the check boxes. For example, add Master Card,

and Visa Card.
2. On the Design tab, change Format of Master Card and Visa Card check box fields to

Checkbox_Single.
3. On the Design tab, change Format of Card Type field to Checkbox_Group.
4. On the Train tab, map Master Card check box. Similarly, map Visa Card check box.
5. Select Card Type from the Group drop-down list for both the check boxes.
6. Щелкните Сохранить.
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7. On the Train tab, click Preview or CSV. Based on your selection, the check box and its values are
extracted in the preview or in a CSV file.
The data from the two check boxes that are repeated across multiple pages is extracted.
If the Master Card check box field is selected, Yes value is extracted and if a check box is not
selected, No value is extracted. If the check box is drawn away from the actual position of the check
box, then No checkbox found value is extracted.

Note:  To prevent validation errors, update check box value as Yes or No in Validator.

Related tasks
Use Machine Learning to fix extraction errors on page 210
In the Validation queue (in Валидатор), IQ Bot can learn from manually corrected (by humans) field
values, over a specific time period.

IQ Bot 11.x: Delete mapping in the Designer
Delete mapping of field labels and field values, selecting the X delete symbol next to the mapped label or
value.
The following use cases explain the delete field labels and value mapping options in the Designer.

Delete a field label and its mapped value: Select a field label in the middle panel and click the
X delete symbol of the bound box in the document
view to delete both, label and value mapping . The
label and the value from the middle panel gets
deleted as well. The mapping check mark in the
left and middle panels turns from green to gray
indicating incomplete mapping.

Delete field value: Select the field value and click the X delete symbol
of the mapped box in the document view, to delete
the mapped value. The value from the middle panel
gets deleted as well. The check mark in the left and
middle panels turns from green to gray indicating
incomplete mapping.

Delete auto mapped value fields: The X delete symbol of the mapped box in
document view is not visible till user resizes or
manually maps it.
For a form field, when a user deletes a resized or
manually mapped box around a the field value, IQ
Bot repopulates the original auto mapped value.
For a table/section field, that same behavior does
not apply, as a user has the option to map a table/
section field name but not a field value, and vice
versa.

Delete a field label/value with or without
auto mapped value:

Select a field label/value with or without auto
mapped value. The field label bound box displays
in the document with an X delete symbol allowing
users to delete the label.

Delete field label mapping with validation
pattern:

In spite of deleting a field label, the validation
pattern that was assigned to the field remains in
place.
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Delete option ('X') when bounded box
reaches space limit:

If the label/field value bounded box in the
document view covers a bigger area, extending to
the edge of or beyond the document view, the 'X'
delete symbol appears in the nearest corner of the
box.

Прим.:  The field value box in the middle panel is disabled and users cannot enter text manually.

Extract data from table summary rows
User can map table summary rows in the Designer to extract different structures. This topic explains a
typical scenario for extracting data from table summary rows.
The following criteria enables this functionality.
In the Designer, navigate to Table/section settings > Advance table option > Extract table
summary row, and select Extract Table Summary Rows to activate extraction of a table summary
row.
Select a field label for Best column for row extraction, and map the field label and value to turn the
field check mark green in the left panel.
For other columns, just map either the field label or field value, to turn the check mark green in the left
panel.
In the Designer map one table summary row only to automatically extract subsequent table summary rows
(with similar labels and structure in the document).
In staging, in the preview view, CSV file view, and Валидатор, view the listed field names and extracted
field values to validate.

IQ Bot 11.x: Пример
Extract Table Summary Rows functionality works to extract values between label of reference
column and End of table indicator labels and avoids duplicate extraction of values from similar areas in
other tables.
User is in the Designer training a бот, with at least one table having duplicate or similar regions matching
those of another table. Extract Table Summary Rows functionality does not impact data extraction
irrespective of whether user specifies the End of table indicator value.
1. Create two tables with similar or duplicate areas. For example, one table with claims total and other

with record details related to line number.
2. Map all table columns related to line number.
3. Map all value columns without table label, but related to claims total.

Claim totals table has duplicate or similar areas like another table related to line number. So the billed
amount column is a duplicate area for both tables.

4. Map one column of claims total table with the claims total label, as at least one column label is required
for data extraction for a table.

5. Click on See extraction results to see duplicate rows that have duplicate or similar areas on claims
total table. For example, When single page has multiple claim totals records.

6. Click Back to training to return to the training page.
7. Navigate to Claim totals table > table settings, and check the box for Extract Table Summary

Rows label under Advance Table Options.
8. Enter value for End of table indicator and click on See extraction results.
9. User can see rows in claims total table related to claims total only.
10. Click on Export to CSV to open the file.
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11. User can see table related to claims total extraction, as seen in preview.
12. Next, set the learning instance, and бот to production and upload some files related to the бот.

• If the бот does not have any validation errors, the user can see claims total table as per mapping in
production CSV file.

• If the бот has some validation errors, the user can see claims total table as per mapping in the
Валидатор.

Common fields across multiple document groups
Create a learning instance with a single document group.
1. Pick any good document from your list of documents.
2. Create, design, and map all the fields as dynamic floating fields.
3. Add aliases to the mapped field labels using "|", if the values are different across various documents.

Пример. Invoice header mapped in the document could have values such as, Invoice#, Invoice No.,
Document No and so on in other documents.

Note:  "|" stands for the term, "or". Пример. Invoice Total | Invoice Amount tells the bot to find the
label - if equal to Invoice Total or Invoice Amount.

Tip:  Test and refine the aliases as required.

IQ Bot 11.x: Extract data using magnetic ink character recognition
Use the magnetic ink character recognition (MICR) OCR feature with ABBYY FineReader Engine version
12.2 support to extract MICR data from financial checks.

Note:  Documents in Non-Latin based languages cannot be processed if MICR is enabled on ABBYY
FineReader Engine OCR version 12.3 and 12.4.

• Ensure that ABBYY FineReader Engine is installed in the plug-ins folder: \OCR Plugins\ABBYY SDK
\12\. . ..

• From the C:\Program Files (x86)\Automation Anywhere IQ Bot
 (version)\Configurations folder, open the Settings.txt file, change OCREngine=Tesseract4
to OCREngine=Abbyy, and save the file.

Note:  A system restart is not required.

1. Set ABBYY FineReader Engine in your settings.txt file as the primary OCR engine.
2. Navigate to the IQ Bot\Configurations\AbbyyImagePreProcessingSettings.json file.
3. Update these parameters:

• TextTypes = 129
• DetectTextTypesIndependently =true

The MICR feature is activated in the system.

• Create a learning instance and add form fields to extract MICR data from financial checks such as
MICR and Pay to fields.
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• Scan and upload a check to IQ Bot for training. In production, upload the financial checks for accurate
MICR data extraction.

• In the Designer, map the MICR data in the financial check for extraction.
• In production, upload the financial checks for accurate MICR data extraction.

Related tasks
Use ABBYY FineReader Engine Распознавание текста (OCR) engine in IQ Bot 11.x on page 123
IQ Bot installation now automates the installation of ABBYY FineReader Engine (FRE) optical character
recognition (OCR) plug-in.

IQ Bot 11.x: Disable PDFBox option
The PDFBox option is enabled by default. Disable the option when you are training hybrid PDF documents
containing images and text.
The PDFBox option works best with completely digital documents only. When using hybrid documents
containing images and text, our recommendation is to disable the PDFBox option for better document
classification.
There are two ways in which you can disable/enable the PDFBox option in IQ Bot:
• Directly in the UI during the creation of a learning instance. In the Create new learning instance

page go to Advanced Settings > Optical character recognition and disable/enable the My PDF
documents do not have images check-box.

• In the Setting.txt file described as follows.

Note:  The PDFBox option is enabled in the system by default.

1. Navigate to C:\Program Files (x86)\Automation Anywhere IQ Bot\Configurations.
2. Open the Setting.txt file, and change PDFBoxOCREnabled=true to

PDFBoxOCREnabled=false

This turns off the processing of uploaded documents by PDFBox for new learning instances (after
applying this change), and does not apply to the existing learning instances. IQ Bot will use your
selected OCR engine for PDF documents as well.

Note:  When PDFBox is disabled, ensure that your PDF document is less than 60 pages.

3. After updating the Setting.txt file, execution of stoppedanduninstalled and
installedandstartedstart of IQ Bot services is not required.

Related reference
Матрица сравнения функций IQ Bot on page 13
Compare features between different product releases.

IQ Bot 11.x: Preview extracted data
After completing field and table mapping, click the See Extraction Results button to view OCR and
extracted results to verify the accuracy of the training.
The extraction result displays information that the Валидатор view would display and lets you do the
following:
• See the listed fields and values. Display an indication if value was successfully extracted, if there was a

validation error, or lack of OCR confidence.
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• See all table headers and the values for each row, also indicating if there was an error on validation or
lack of confidence.

At this point, you can export the preview data to a CSV file for further analysis by clicking on the Export
to CSV link at the top right header area. Alternatively, click Back to Training button to continue with the
training. Once all fields and tables complete the training and pass validation, a green check mark displays
next to the group title in the middle panel.

Important:  A training document can pass in spite of an error flagged by the validation pattern.
Sometimes we want a validation pattern to flag an error, so it would not pass specific documents at a later
stage in production; instead enter them in the manual validation queue.

After training the documents groups, choose Save and close. At this point choose any of the following:
• Choose Cancel to stay on the current training.
• Choose Save to save the training.
• Choose Save and send to production to send the learning instance to the Production environment.

Preview any time during or after the document training, or after completing the mapping of fields and
tables for each document group. The See Extraction Results button is available for a current document
that lets you see the extracted results with the mapped fields and table columns. Errors, if any, are visible
and highlighted within a red box. Hover on the error to know more about the error, and correct it.
Click the Back to Training button to return to the training.

Important:  If you upload 30 documents and all documents are classified into one group, you can see
only one document for each unique layout.

Navigating through your training documents
IQ Bot analyzes training documents and groups, and arranges them in an alpha-numeric sequence.
IQ Bot performs an initial field mapping based on existing knowledge from any pre-trained document
types. The training documents are listed in an alpha-numeric sequence.
The See Extraction Results menu lists the uploaded training documents in an alpha-numeric sequence.
The files are listed in an old to new sequence. You can navigate through the documents one by one, or use
the forward and the back arrows to jump to the first, or the last training document.
For IQ Bot Version 11.3.3.1 onward, when you click Change Training Document , you are able to view
all training documents available in that group, and can select a specific document from that group.
Training documents in a batch are listed in the following order:
• Files names starting with special characters.
• File names starting with numbers.
• File names starting with alphabets.

After you upload the training documents, in the Review menu, click View Each Group. The training
documents appear in alpha numeric sequence. Perform the following steps to preview the training
documents:
1. Click the forward button to navigate to the next file.
2. Click the fast forward button to navigate to the last file.
3. Click the backward button to navigate to the previous file.
4. Click the fast-backward button to navigate to the first file.

© 2023 Automation Anywhere. All rights reserved.     198



    Automation Anywhere - Использование IQ Bot

5. Click Change Training Document .
The confirmation window appears.

6. Click Yes, Change.
Edit the training document as per the requirement.

Прим.:  The sequence in which the training documents appear remains the same, even if you edit the
documents.

Each training document that you copy from the staging environment to the production environment,
has its own time-stamp. However, in the staging environment, the documents are listed based on
original uploading sequence.
When you upload the training files from production environment to staging environment, the
documents are listed based on the original time-stamp.

IQ Bot 11.x: Export data to a csv file
In the See Extraction Results view, you can export the extracted data to a CSV file for ease of review.
Export data to a CSV file:
1. During training when you click the See Extraction Results button, you can view the correct/

incorrect data extraction for the current training document.
2. In this view, you have the option to export the data to a CSV file for further review.
3. Click the Export to CSV option to export data and view it in a spreadsheet.

The CSV file is downloaded with the data extracted from the document.
Click the > next to the document name at the top to see other documents in the group. This allows
you to download the data extracted from other documents.

IQ Bot 11.x: Move a learning instance to Production
Use the Set instance to production button to move a learning instance to Production.
When you move a learning instance to the Production environment, a confirmation message appears. To
confirm, click Yes, send to production. Learning instances in the Production environment are identified
by the Production label next to their name.

Tip:  You can also use the My Learning Instances page to move a learning instance to Production.

Боты
The Bots page of the IQ Bot Портал lists all available боты for a learning instance, and enables you to
perform tasks such as run, change the status, or launch the IQ Bot Designer.
Create a бот to extract text from a document. Define the field labels and values in a document so that the
system can learn from it and automatically process other documents in the document group..
Monitor the progress and status of all боты created for a learning instance and set the status from Staging
to the Production environment.
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Testing a бот verifies that the бот can reach the required accuracy based on the training. It also runs it
against all the sample documents associated with that category or group and benchmarks document and
field accuracy. Test a бот only in the Staging environment.

Note:
• To view the updated document and field accuracy, refresh the Bots page and click the бот name. The

updated document and field accuracy appear in the details area.
• You cannot edit a бот that another user is already editing.

Bot states

The status of a bot is dependent on the state of the learning instance as well as the bot. The table below
shows the relationship between learning instance state, bot state, and bot status.

Learning Instance State Bot State Bot Status

Staging Staging Обучение

Staging Производство Ready

Производство Staging Обучение

Производство Производство Активный

Создан Not created No listing

Delete a бот

The following are some key points:
• Clicking the Delete bot button displays a message asking if you want to delete the Бот. Selecting

yes displays a success message in the Learning Instance details page. The Summary tab shows the
updated information in the Staging and Production results sections for the Groups found and Bots
created fields.

• You can delete a Бот in Staging only. Once deleted, the Бот does not display in the Learning Instance
details page or the Бот listing page.
• All associated staging documents are removed from the system.
• All associated unprocessed production documents get moved to the Валидатор for processing.

Note:  A new Бот is created when the same documents are uploaded again to Staging or Production.

• On re-uploading the deleted documents from the learning instance, the system classifies the documents
and displays the groups again with the Create Bot option for each group. Clicking the Create Bot
option creates the Бот and you can see it in the Create Bot details page.

• In case of backend exceptions, such as disruption of Services, the system does not let you delete the
Бот. Instead, it displays an error message saying that an unexpected error has occurred.
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Control creation of groups in IQ Bot

Use the new feature to limit creating groups in IQ Bot. A Bot Creator can now configure a threshold
defining when a group for a specific document type should be created, thus saving time. New documents
uploaded to a learning instance (in production) are sent directly to the Валидатор, instead of creating
a new group when the threshold is not met. This enables the user to prioritize training a new document
type, based on its frequency of occurrence in production.
To use the new feature:
1. Go to the Learning Instances tab, select a learning instance, and click Edit.

The New groups creation setting section is shown in the edit page.
2. Select any of the following to control the creation of groups:

Вариант Описание

Select the Never create new groups
check box

No new groups are created, irrespective
of the number of document uploads. The
uploaded documents are sent directly to the
Валидатор.
• This check box is deselected by default.
• When this option is selected, the

Threshold to create new groups field
is disabled.

• You can create new groups manually by
uploading them to the learning instance
in staging.

Set a value for the Threshold to create
new groups field

When you set a threshold value, IQ Bot
does not create a group for the uploaded
documents till it reaches the defined value.
Till the set threshold value is reached, all
documents are sent to the Валидатор.
• By default, the value is set to 10 for all

new learning instances.
• You can set a value of up to 10 digits.
• IQ Bot does not allow you to enter non-

numerical characters, zero, or floating
points.

3. Save your updates, which are then reflected in the Summary tab.

Note:  The Summary tab displays all the staging and production details. The information is updated
based on any applied setting in the New groups creation setting section.

For new learning instances, unless you set the minimum threshold in the New groups creation
setting section, IQ Bot applies the default set value of 10 and does not create groups for the first 9
uploaded documents.
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4. For existing learning instances, you can set the minimum threshold in the Learning Instance > Edit
page. The new threshold is applied to all documents from then onward.
All existing learning instances, even after upgrade, will continue with a threshold as 1.
All changes take effect only on the documents uploaded in production after the setting is edited.
If you change the setting to a new threshold or never create new groups with an existing learning
instance, this check will be performed only on the next document uploaded in production.

In the production environment, all classified documents that do not belong to any group and do not meet
the minimum threshold requirement are sent to the Валидатор. You can update the values and make
necessary corrections. However, all fields are optional and are text data type. The user can Save current
document without making any corrections, or choose the Mark as Invalid option.
You can delete a group from the IQ Bot Designer when the group is in staging. If the same document
group occurs in production and meets the minimum threshold again, the system automatically creates a
new group with the latest document.

Note:  The Delete option is not available on the Learning Instance list page or the Бот page, to ensure
that documents are not deleted without reviewing them.

Информационная панель
View the IQ Bot performance report in real-time on the Dashboard.
The report appears when you log in to the IQ Bot Portal. Информационная панель обобщает отчет
о работе и предоставляет информацию об обработке документов в графическом формате.
Отображается информация о классификации документов, сквозной обработке (STP) и точности, а
также о проверке человеком сведений о действиях для конкретного обучаемого экземпляра. Это
позволит вам сосредоточиться на областях, требующих внимания.
Информационная панель IQ Bot разделена на две основные области.
• Мое общее количество
• Мои обучаемые экземпляры

Область «Мое общее количество»

Мое общее количество — это отображаемая на информационной панели область, которая дает
краткий общий обзор статуса всех обучаемых экземпляров в рабочей среде.
В области Мое общее количество просмотрите приведенную ниже информацию.
• Files Processed: The total number of files uploaded against a learning instance, which are in the

production environment.
• Сквозная обработка (STP). Процент от общего числа загруженных файлов, которые были

успешно обработаны без ручного вмешательства.
• Точность. Точность полей, которая представляет собой процентное значение точно

идентифицированных полей. Сюда входят поля, уровни доверия оптического распознавания
символов (OCR) которых превышают заданный порог доверия.
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Область «Мои обучаемые экземпляры»

Просмотрите сведения о созданных вами обучаемых экземплярах, которые находятся в
промежуточных и рабочих средах.
Просмотрите информацию об обучаемых экземплярах в промежуточной среде.
• Имя обучаемого экземпляра
• Область или тип документов. Например, счета-фактуры и квитанции.
• Количество документов в обучаемого экземпляре
• Графическое представление обучаемых документов, показывающее подробные сведения в

процентах

Просмотрите информацию об обучаемых экземплярах в рабочей среде.
• Количество обработанных файлов
• Процент сквозной обработки (STP) файлов, которые были успешно обработаны без ручного

вмешательства
• Точность поля в процентах

Important:  Иногда количество документов на информационной панели и на странице со сводными
сведениями об обучаемых экземплярах не совпадает с количеством документов, поданных на
обработку. Это может произойти, когда документы классифицируются по группам, которые не
относятся к производству. Документы в этой категории не обрабатываются (преднамеренно),
что приводит к несоответствию между количеством обработанных документов и количеством
всех документов. В таком случае, если эти группы перевести в производство, общее количество
документов будет совпадать.

IQ Bot 11.x: Performance report page
The performance report page displays the details of a learning instance in the production environment.
Navigate to My learning instances > Production button to view the Performance report page
showing details of all learning instances in the production environment.

Note:  The Performance report page is not available for learning instances that are in the staging
environment.

The top right corner of the performance report page displays the percentage of bots trained for the
learning instance. The following is an example of how to interpret the percentage information.

Cathy has uploaded 10 documents and has created three bots for the learning instance:
• Bot1
• Bot2
• Bot3

Of these, three documents are a part of Bot1, four documents of Bot2, and three documents of Bot 3.
When Cathy sets Bot1 into the production environment, the label displays 33% as the percentage of bots
trained for the learning instance, which means that 3 out the 10 (33%) uploaded documents (for Bot1)
have been trained.
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IQ Bot 11.x: Performance report details
In the My learning instances area, click any displayed information to bring up the Performance report
page. The following sections describe the information for each displayed section of the performance report.

Instance totals and Processing results

The instance totals and processing results area shows the following information for a learning instance:
• Number of files uploaded for the learning instance – total number of files uploaded that need to be

processed.
• Number of files processed for the learning instance - number of files that was processed by a bot.
• Number of files successfully processed for the learning instance – includes files that were successfully

processed by a bot without human intervention.
• Number of files sent to validation for the learning instance – files flagged with one or more errors that

need human intervention for review.
• Number of files validated for the learning instance – number of files that were reviewed by an individual

and the results were saved.
• Number of files marked as invalid for the learning instance – number of files that were reviewed by an

individual and marked as invalid.

Classification results

The Classification area provides a statistical display of the field representation graphically.

Field accuracy results

The Field accuracy area provides a graphical representation of the number of times a field is correctly
extracted by the system.

Валидация

The Validation area provides the following information:
• A statistical representation of the corrections made to individual fields during the process of validating a

document.
• A statistical representation of the average time spent to validate a group.

Track page count on IQ Bot Dashboard
IQ Bot keeps track of pages that are uploaded to production and displays the information on the
dashboard. Users can view the number of pages uploaded to compare against their purchased license
limit.

Прим.:
• This feature is available IQ Bot Version 6.5.x onward.
• When you upgrade from an IQ Bot version earlier than Version 6.5.x, documents migrated from the

earlier version will not be counted in track page count.
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Each document uploaded to IQ Bot production using RPA is counted towards the license limit.
• See the number of pages uploaded in the IQ Bot Dashboard, learning instance dashboard, learning

instance summary, and at the group level.
• When IQ Bot processes a document, the dashboard shows an incremented page count.
• On deleting a learning instance, the page count on the IQ Bot Dashboard remains unchanged.

Прим.:
• IQ Bot counts the pages of classified and unclassified files. Only corrupt files that cannot be opened will

not have any effect on page count.
• Documents uploaded to staging are not included in the page count.

Production environment
The learning instance workflow consists of the Staging and Production environments. This is a live
environment where a learning instance is set into operation with actual business documents uploaded from
a бот.
The learning instance uses the боты created in the Staging environment and executes on actual business
documents uploaded against it from a TaskBot.
The primary purpose of the Production environment is as follows:
• Run the бот on uploaded business documents to extract relevant data, thereby automating the

business process.
• Do the following tasks in the Production environment:

• Collect the processed documents that IQ Bot processes, which can result in end-to-end, or
unclassified processing.

• Validate the documents marked for review and export the output to a CSV file for manual review.
• Do manual review and correction of the extracted data and submit back to IQ Bot.
• Mark incorrect documents as invalid.
• Collect and download the invalid documents.

Upload documents to a learning instance
Upload the Production-ready documents from Automation Anywhere Enterprise to IQ Bot for processing.
You can upload documents to IQ Bot in the following scenarios:
• When you create a new learning instance. См. раздел IQ Bot 11.x: Создать экземпляр для обучения

on page 160.
• When you edit a learning instance in the Staging environment. См. раздел IQ Bot 11.x: Edit a learning

instance on page 167.
• In the Production environment in Automation Anywhere Enterprise Client using the IQ Bot lite

command.
• In Automation 360 IQ Bot using Upload Document action in IQ Bot package.

The following steps describe the document upload process using Automation Anywhere Enterprise Client.
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Note:  This does not apply to Automation 360 IQ Bot.

1. Click File > New in the Automation Anywhere Enterprise Client window to show the Automate
dialog box.

2. Click Workbench to show the window.
3. From the Commands panel, select the IQ Bot command and move it to the Task Actions List panel

using drag-and-drop. The IQ Bot upload dialog box appears.
4. In the IQ Bot upload dialog box, do one of the following Y:

a) Имя. Select the learning instance to upload your document.
b) File Path: Click the browse button to select the learning instance file to upload.

The Output Path area is populated with the name of the learning instance files and path.
c) Success: This is the physical location on the IQ Bot server where the successfully extracted CSV

files are stored. Click the Copy button to copy the path to your clipboard.
d) Invalid: This is the physical location on the IQ Bot server where the invalid source files are

stored. Click the Copy button to copy the path to your clipboard.

5. Щелкните Сохранить. The command is added to the Task Action List panel.
To upload multiple files from a folder, use the Each File In A Folder loop command with the IQ Bot
command and add it to the Task Actions List panel. An example of this task is described in the next
topic.

Related tasks
Upload multiple folder files to a learning instance on page 206
Use this task to upload multiple documents to the IQ Bot server. Uploading multiple documents at one time
will save you time.

Upload multiple folder files to a learning instance
Use this task to upload multiple documents to the IQ Bot server. Uploading multiple documents at one time
will save you time.
The following example uses the IQ Bot command with the Each File In a Folder loop command to
upload multiple documents from a local folder to the IQ Bot server.
1. Move the IQ Bot command from the Commands list to the Task Actions List panel using drag-and-

drop. The IQ Bot dialog box appears.
2. Select the learning instance to upload your document and click the browse button to select the file to

upload.
3. Click the Save button. The IQ Bot command is added to the Task Actions List panel.
4. For the source file, the file path can be browsed, or it can contain variables for example,

$CurrentDirectory$\$FileName$.$Extension$.
Use the Variable Manager to define extended parameters.

5. Move the Each File in A Folder loop command to the Task Actions List using drag-and-drop. The
Loop dialog box appears.

6. Click the Browse button, select the folder of your choice, and click Save. The loop command is
added to the Task Actions List panel.

7. Delete the existing file path item in the File Path field and choose the F2 and Fn buttons on a
MicrosoftWindows machine. The Insert Variable dialog box appears.
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Download a document from a learning instance
Once documents are uploaded to a learning instance, some files process successfully, while others fail.

Note:  To download documents from an Automation 360 IQ Bot server, use the Download all
documents action in IQ Bot package.

For documents that are processed but enter the Validator queue for human review, use the option to mark
the document digitization and extraction as Invalid. Depending on the scenario, download and remove
these files from the learning instance. Copy the paths shown in the Success and Invalid labels of the IQ
Bot dialog box to your clipboard.

Output folder structure

Use the copied output paths as a variable in the Task Editor. The output paths are formatted as follows:
• If you did not choose the path during installation, then IQ Bot sets the following as the default path: C:

\Users\Public\Documents\Automation Anywhere IQBot Platform\Output\.
• After the files are uploaded for processing, the output for every learning instance is categorized into the

following:

Success folder <output path>\<learning instance
 name>\Success\

Documents go into this folder when IQ Bot
successfully classifies a document in production
with a trained group and matches the following
validation rules:
• The document is associated with a group

under a learning instance based on a domain
(out-of-the-box or custom). Groups are created
based on layout or format of the documents. If
60 percent of the documents' format or layout
match, they are categorized into the same
group.

• The fields intended to be extracted from the
document match the patterns or rules set
during its training.

Successfully extracted fields are saved in a .csv
format.

Unclassified folder <output path>\<learning instance
 name>\Unclassified\

Documents go into this folder when IQ Bot is
unable to classify them. This can happen due to
various reasons, some of which are as follows:
• Document is noisy or has low dots per inch

(DPI) count (recommended is 300 DPI or
more).

• Wrong language was selected during instance
creation.
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• The document contains a heavily colored
background. In this case, try removing the
color and try again.

Invalid folder <output path>\<learning instance
 name>\Invalid\

Documents in this folder did not pass IQ Bot
validation.
IQ Bot processes and flags field errors in that
document before it can be viewed in the Validator,
where you can fix and verify the flagged fields.
IQ Bot processes and flags field errors in that
document before it can be viewed in the Validator.
In the Validator, you can fix and verify the flagged
fields in the Validator.
Files that fall into groups but do not have
an associated бот become available in Not
 Processed folder.

Not processed folder <output path>\<learning instance
 name>\Unclassified\

Documents in this folder fall into groups but do
not have an associated бот.
This can happen due to various reasons, some of
which are as follows:
• The document layout is not yet trained and

creates a new group.
• Documents for which training is complete but

the associated бот is still in staging.
In this folder, sub-folders might be created
based on the groups. For example,
Group_123, where 123 is the group number.
In these sub-folders, you can view documents
that have been processed by IQ Bot for that
learning instance.

Related tasks
Read a successfully digitized document using TaskBot on page 208
Use a TaskBot to read a processed document from a CSV file.

Read a successfully digitized document using TaskBot
Use a TaskBot to read a processed document from a CSV file.

Important:
Typically, the .csv output directly reflects the sequence in which fields are selected while creating a learning
instance. Fields added later by editing a learning instance are displayed at the end. However, all .csv files
generated for the same learning instance is not guaranteed to have the same sequence of header fields.
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This occurs because some features such as Nested Table and Multi Table, which have their own specialized
configuration at the bot level, alter the field sequence based on how that bot is configured during training.
Therefore, you should access the output .csv file using field names instead of index in header.

1. On the Automation Anywhere Enterprise Client Editor UI, drag the Read From CSV/Text command
from the Commands list to the Task Actions List panel.

2. Do the following
a) Choose Select File to read the file.
b) Choose fromDelimiter, Header and Trim modes, as appropriate.

3. Select Encoding > UTF-8 to ensure all the special characters from different languages appear
accurately.

4. Click Save to add the command to the Task Action List panel.
5. Use $Filedata Column$ variable to specify the CSV column for extraction.

The following example uses the Read From CSV/Text command with the loop command to read
digitized documents in the CSV format, from the IQ Bot Success path.
$Filedata Column(1)$ returns the value from the first column. $Filedata Column(2)$ returns the
value from the second column. The Loop iterates through each record in the CSV file and returns values for
the first and second columns. Use these values for further automation, as required.

Tip:  In the $Filedata Column(name)$, the name could be $Filedata Column(Invoice_Date)$.

After upgrading from a previous version of IQ Botto the latest installed version, if you are using a TaskBot
to read the output CSV, change the encoding in the Read from CSV command in the TaskBot to UTF-8.

IQ Bot Validation queue
Validation eliminates the complexity of validating and fixing issues with the бот, requires less time to fix
the issues, and requires minimal human intervention.
IQ Bot processes a document before it can be viewed in the Валидатор, and flags field errors in that
document. The user corrects the flagged fields and/or verifies the unflagged fields in the Валидатор.
After the updated document is fixed and saved, it does not count as straight-through processing (STP) but
still moves to the successful queue where it can be picked up by an upstream automation task. This is the
IQ Bot Validation queue.
Documents that fail automated processing rules or have field values failing because of low optical character
recognition (OCR) confidence are pushed into a folder to be reviewed and fixed manually. Manual review is
time-consuming and complex because it requires navigating to the correct folder and scripting knowledge
(done in a CSV file) to fix the document.

Note:  To learn more about how field-level OCR confidence can be used to improve the quality of STP
output, see IQ Bot 11.x: Improve output quality using OCR confidence on page 172.

Related tasks
Use Machine Learning to fix extraction errors on page 210
In the Validation queue (in Валидатор), IQ Bot can learn from manually corrected (by humans) field
values, over a specific time period.
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Use Machine Learning to fix extraction errors
In the Validation queue (in Валидатор), IQ Bot can learn from manually corrected (by humans) field
values, over a specific time period.
IQ Bot can learn from the document field data pairs, for example, incorrect field values and manually
corrected field values, and become more confident about an erroneous field value and what that value
correction is. If IQ Bot reaches a 90%+ confidence level, it auto-corrects the erroneous field value.
If additional documents are uploaded in Production, IQ Bot auto-corrects errors, skips the Validation
queue, and counts the documents as straight-through processing (STP).
Sometimes, IQ Bot does not reach the 90%+ confidence level. For example, if incorrect data and manually
corrected data differ in length by more than four characters, the manually-corrected data is not provided to
the Machine Learning (ML) model.

Прим.:  The Validation queue auto-correction does not apply to check box extraction.

1. In the Validation queue, when correcting a field value error, select from the available options.
2. Choose to not select a suggestion, but instead enter a value, or click to another field.
3. Choose to enter a value in a field to fix the error, and save your corrections, IQ Bot saves your

manually-corrected field value.
4. If you make multiple corrections for the same fields with the same value, the confidence of IQ Bot

might increase. If the confidence level reaches 90%; the system auto-corrects the field value in real-
time with your suggested value (when you click into the cell).

Прим.:  For uploaded documents, if all failed fields are auto-corrected, the document skips the
Валидатор, and instead, exports directly to CSV, counting as Dashboard STP.

Validator window
The Валидатор window helps validate the uploaded and processed documents for a learning instance.
To open the Валидатор user interface, navigate to http://<IQ Bot installation path>/ > Learning
Instances and click the Launch validator icon on your Web browser.

Note:  Only users with an assigned Валидатор role using Control Room can view the Validation page.

Launch the validator window

Launch the Validator window from the Learning Instances page in any of the following ways:
• Click the Launch validator icon for a learning instance.
• Click the Validate button from the Summary or Document Groups tab.

The Validator launches displaying the first file from the validation list.

Note:  The user sees an empty page and a message saying: There are no documents available for validation,
you will be redirected to the learning instance page, in the following scenarios:
• If no files are available in the validation queue.
• If a file does not exist in the validation queue.
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• If another user is working on the remaining file in the validation queue.

Related concepts
Validate document with errors on page 211
The Валидатор window appears with data requiring validation marked in red color fonts and boxes.
Multiple table relationship in Валидатор on page 211
To complete successful validation, in the Validation queue (in the Валидатор), edit shared columns
between two or more tables, or add corresponding rows to two or more tables.
Multiple table relationship in CSV file on page 212
Preview the linked columns of a learning instance in a CSV file to see the mapped values of those multiple
linked tables. Review and confirm the accuracy of the mapping. Then save the validation.
Mark document as invalid on page 212
The Валидатор might want to flag a certain document as invalid if the validation conditions are not met,
and if the document requires retraining.
Validator audit logs on page 212
All events related to validation are stored in a log file in the Microsoft Windows Public folder.
Tips for mapping on page 189
Use the following tips to save time and simplify work on IQ Bot tasks.
Related tasks
User roles and permissions on page 140
Learn about the roles and associated permissions required for each IQ Bot user.

Validate document with errors
The Валидатор window appears with data requiring validation marked in red color fonts and boxes.
To validate a document with errors do the following:
1. Click the Tab button or click the mouse on the field that requires validation (marked in red). The

associated field value of the document is highlighted so that it is visible and focused.
2. Validate the fields by entering the correct information.

When you try to save a document without validating all the errors in the document, an error message
appears.
Do the following during validation:
• Add or delete a table row: To insert or delete rows while validating a document, hover over the

ellipses to show the icons for adding or deleting table rows.
• Skip to next file: If you want to skip a file without correcting its errors, click the Skip to next file

option at the bottom of the validator window.
• Validation queue: See all information about the validation queue in the validator screen as a subtitle.

Multiple table relationship in Валидатор
To complete successful validation, in the Validation queue (in the Валидатор), edit shared columns
between two or more tables, or add corresponding rows to two or more tables.
In the Валидатор, you can edit values in the extracted primary field of the parent table or repeated
section.
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If shared fields between the linked tables do not match values, the Валидатор does not let you complete
validation and save.
This functionality helps avoid manual validation errors that can occur when there is a mismatch of field
values between the parent and child tables. The Валидатор shows an error message and prevents the
save.

Multiple table relationship in CSV file
Preview the linked columns of a learning instance in a CSV file to see the mapped values of those multiple
linked tables. Review and confirm the accuracy of the mapping. Then save the validation.
Вариант 1.
If you edit a learning instance to add a field, and then link that field to a child table, that field appears
in the leftmost columns of that child table of the CSV file. For files in the IQ Bot production (success)
folder, you can leverage RPA to access the CSV files, and use the extracted linked fields from the leftmost
columns of a child table to merge that child table with a parent table.
Вариант 2.
If you edit a learning instance to add a field, and that field is not a primary or linked field in a child table,
the field appears in the rightmost column of the CSV file.

Mark document as invalid
The Валидатор might want to flag a certain document as invalid if the validation conditions are not met,
and if the document requires retraining.
Mark documents that cannot be processed as invalid because of some of the listed reasons. To mark
documents as invalid, click the Mark as Invalid button in the Validator window. Select the appropriate
reason in the confirmation window from the following options:
• Fields missing
• Tables missing
• Wrong values

Note:  To view and access the documents marked as invalid, go to the Invalid > Output folder located
in your server.

1. After successfully validating the fields and tables, click the Save Current Document button.
2. Click the Skip to next file button to scroll to the next document in the queue.

Validator audit logs
All events related to validation are stored in a log file in the Microsoft Windows Public folder.
The logs are stored in a validator.events file and the location of the folder is %Public%\Documents
\Automation Anywhere IQ Bot Platform\Logs\Audit. The following events are stored in the log file:
• Name of the platform
• Имя компьютера
• Time stamp
• Whether a document was validated successfully
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Note:  The logs stored in the validator.events file are updated asynchronously.

Валидатор enhancements
Review the IQ Bot Валидатор enhancements, which are available to users with Валидатор access.
Some of the Валидатор enhancements are as follows:
• You can now hide the Skip to next file and Mark as Invalid options using configuration settings.

The options are currently enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

• You can now hide the Hide successful fields and Hide optional fields options using configuration
settings. The options are enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

Note:  Selecting the Hide successful fields and Hide optional fields check boxes hides all the valid
fields and reduces the display of a large number of fields, thus making correction easier. However, if
there is an invalid field, it continues to be displayed because the invalid field requires correction.

• Clicking in any column field expands the column width to accommodate the text entry. The Валидатор
shows the value of the field that is being validated, in the document.

• Draw an area around single or multiple values in the document image to automatically populate a field
in the Валидатор. This function is similar to the Designer.
Text segment on page 186

Search in Валидатор, by file name

As users process documents from various vendors simultaneously, IQ Bot classifies these documents
into different validation groups, which makes it difficult for the user to identify and prioritize a specific
document for validation.
Users with Валидатор access roles can see the new search box in the Валидатор page, and search for a
specific document in the validation queue.
Click the Валидатор icon next to the learning instance to load the IQ Bot Валидатор and use the new
search feature as follows:
• Enter a specific file name or search term (from the document name) in the search box.

IQ Bot uses the single search terms like a wildcard and retrieves a list of documents with the search
word in the document name.

Note:  There is a 150-character limit for entering a file name in the search box.

• The Валидатор displays 10 search results at a time. The search box has a search and cancel icon, and
a scroll bar to view the entire search list.

Note:  The search does not display locked documents in the result list.

• Clicking a search result opens the document in a new window, allowing you to return to the search list
to click and open another document. You can open multiple windows simultaneously, with a different
document displaying in each window.
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• Search is specific to a learning instance. When you click the Validate option for a specific learning
instance, the system searches only within that learning instance.

Note:  The validator restricts the use of certain characters in the search box. Using any of the following
characters displays an error message: / * < > " | ? : .

• The Валидатор locks the document you are working on, ensuring no one else has access to it at that
time and allowing you to work on one document at a time. If you move away from the document while
working on it, the system allows the lock to remain in place for 15 minutes before unlocking it.

Note:  Validate one document at a time.

If user opens multiple documents in different tabs, the last document opened will be locked. Other
documents will not be locked.

IQ Bot 11.x: Adding custom logic to improve automatic extraction
in production
Enter the logic in the IQ Bot Designer to improve text extraction and validation, and to reduce the number
of documents entering the Валидатор that requires RPA post processing.

Обзор

For Automation 360 IQ Bot Cloud, there is an identified list of Python libraries and packages that are
safe to use for the Custom Logic feature. Use only these packages to ensure security for your cloud
infrastructure, file systems, databases, and network resources: List of Pandas Libraries which are supported
and not supported on Automation 360 IQ Bot (A-People login required)

Keep in mind the following:
• Custom logic executes in a sequential order across all tables and fields.
• Applying custom logic might increase the extraction time per document.
• Automation 360 IQ Bot validation rules apply over the extracted values processed by the custom script.
• Custom script only works on the extracted data and does not influence the OCR extraction quality.

The custom logic feature helps clean up extracted values ahead of the validation step but does not replace
all the post-processing currently done using the TaskBot. In addition to adding inline scripts, users can use
the Python scripts in a central location, import those as modules, and call functions to reduce the amount
of Python code at the field or table level.

Restriction:  If the number of characters in the Python code along with other information exceeds 32000,
and when this code is sent to the back-end as a Windows runtime argument for the process, the execution
fails, and does not display any error message.

Resources
To learn more, search for Using Custom Logic in IQ Bot course in Automation Anywhere University: RPA
Training and Certification (A-People login required).

Следующий шаг
Using scripts, in the IQ Bot Designer add the Form fields and Table fields.
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Related concepts
IQ Bot 11.x: Use cases and examples on page 216
These are some use cases the Designer script feature supports.
IQ Bot 11.x: Pre-installed Python packages on page 217
To facilitate ease of use and consistent behavior across servers, IQ Bot auto installs Python v3.5.4 and
some popular Python packages mentioned as follows. For example: at C:\Python354-x86-IQBot.
IQ Bot 11.x: Additional Python packages on page 218
To allow further empowerment, you can add more Python libraries for use in IQ Bot.
Related tasks
IQ Bot 11.x: Поля формы on page 215
Add scripts in Designer for form fields.
IQ Bot 11.x: Поля таблицы on page 215
Add scripts in Designer for table fields.

IQ Bot 11.x: Поля формы
Add scripts in Designer for form fields.
The List validation via external file can be implemented as a part of the field custom logic using python
scripts directly in the Designer.
1. In the IQ Bot Designer, left-hand panel, highlight a form field whose extraction/validation you aim to

improve further.
2. In the middle panel, scroll down to Field options > Logic.
3. In that Logic section, toggle between fullscreen and smallscreen for ease of use.
4. Add code to modifyIQ Bot's extracted text value. See example below:

# variable that stores the value: field_value

# import the Python regular expression library, re
import re

# call the regular expression library's method, findall, to extract the
 date value only
field_value = re.findall(r'\d{2}-\d{2}-\d{4}', field_value)[0]

5. Select Test Run to test your script and see the results before vs. after.

value_before: 2018/11/09 B210
value_after:  2018/11/09

IQ Bot 11.x: Поля таблицы
Add scripts in Designer for table fields.
1. In IQ Bot Designer, left-hand panel, highlight Table/section settings for the table whose

extraction/validation you aim to improve further.
2. In the middle panel, scroll down to Logic.
3. In the Logic section, toggle between fullscreen and smallscreen for ease of use.
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4. Add code to modify the extracted table values, which are stored as a Python dictionary in a user
variable called table_values. See example below.
Each row has a Guid (Global unique identifier), which allows IQ Bot to auto track rows that are added
and deleted. If you add a row, you need not enter a Guid. IQ Bot will handle this automatically.

# variable that stores the value: table_values

# convert from dictionary to dataframe
df = pd.DataFrame.from_dict(table_values)

# print dataframe before update
print(df)

# Item_Description: drop rows with a missing value
df = df[(df["Item_Description"] != "")]

# Quantity: extract first part of the string, the numeric part only
df['Quantity'] = df['Quantity'].str.split(' ', 1).str[0].str.strip()

# print dataframe after update
print(df)

# convert back from dataframe to dict to override what IQ Bot stores
table_values = df.to_dict()

5. Select Test Run to test your script and see the results before vs. after.

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00 PCS   5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
            1.00 EA      65.00
2                       6bddfed1-2359-4305-a0ac-a1769c113bfb   5% VAT :
 Total -  4.00PCS GR:   5,905.00
3                       2dc642a7-8e6e-4bc6-9672-85afff8c21db           
 Total -         KGD:       0.00

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00       5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
           1.00          65.00

6. If you select See extraction results or save the бот, your script is saved.

IQ Bot 11.x: Use cases and examples
These are some use cases the Designer script feature supports.
For examples of user scripts and use cases, see: IQ Bot custom logic use cases and examples

Following are some use cases:
• Query an extracted value vs. a database in an ERP system to validate values.
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• Extract "0123456" from "PO 0123456".
• Remove table rows that contain "Page x of y".
• Extract the currency from one table field (for example: Item Total) and save in an empty table field.
• Extract the product number from a table field (for example: Item Description).
• Extract the zip code from an address.
• Query a REST service (for example: add NLP, retrieve data from an outside system, and so on).
• Return a Boolean yes/no value on whether handwriting exists for a field.

IQ Bot 11.x: Pre-installed Python packages
To facilitate ease of use and consistent behavior across servers, IQ Bot auto installs Python v3.5.4 and
some popular Python packages mentioned as follows. For example: at C:\Python354-x86-IQBot.

Table 8: Pre-installed Python packages

Main package Версия URL-адрес

difflib In-built Python with installer https://docs.python.org/3/library/
text.html

io In-built Python with installer https://docs.python.org/3/library/
io.html

re In-built Python with installer https://docs.python.org/3/library/
text.html

sqlite3 In-built Python with installer https://docs.python.org/2/library/
sqlite3.html

строка In-built Python with installer https://docs.python.org/3/library/
text.html

stringprep In-built Python with installer https://docs.python.org/3/library/
text.html

sys In-built Python with installer https://docs.python.org/3/library/
sys.html

textwrap In-built Python with installer https://docs.python.org/3/library/
text.html

unicodedata In-built Python with installer https://docs.python.org/3/library/
text.html

Дата/время 4,3 https://pypi.org/project/DateTime/

pandas 0.24.2 https://pypi.org/project/pandas/

inflection 0.3.1 https://github.com/jpvanhal/
inflection

dateutils 0.6.6 https://pypi.org/project/dateutils/

tabulate 0.8.3 https://pypi.org/project/tabulate/

numby 1.16.4 https://pypi.org/project/numpy/

json 2.0.9 https://docs.python.org/3/library/
json.html
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Main package Версия URL-адрес

requests 2.22.0 https://github.com/kennethreitz/
requests

psycopg2 2.8.3 https://pypi.org/project/psycopg2/

pymongo 3.8.0 https://pypi.org/project/pymongo/

pyodbc 4.0.26 https://github.com/mkleehammer/
pyodbc

opencv-python 4.1.0.25 https://pypi.org/project/opencv-
python/

Pillow 6.0.0 https://github.com/python-pillow/
Pillow

cx_Oracle

Note:  As of Сборка 16685,
this module is replaced by
oracledb. See Upgrading from
cx_Oracle 8.3 to python-oracledb

7.1.3 https://github.com/oracle/python-
cx_Oracle

oracledb 1.2.1 https://github.com/oracle/python-
oracledb

Python Arabic Reshaper 2.0.15 https://github.com/mpcabd/python-
arabic-reshaper

IQ Bot 11.x: Additional Python packages
To allow further empowerment, you can add more Python libraries for use in IQ Bot.
1. Open the Command Prompt.
2. In the Command Prompt, change directory to IQ Bot's Python dictionary. Пример. C:\Python354-

x86-IQBot.
3. Install your Python package there. For example: pip install PyArabic.
4. In IQ Bot Designer > Logic, you can import and use that Python package.
5. If step 4 does not work, then stop/uninstall and then install/start services.

Prevent automatic copying of documents to Staging
Prevent automatic copying of production documents to the Staging environment to keep training and
production data separate and also meet information security compliance requirements.
Prevent automatic copying of production documents to Staging as follows:
1. Open the Settings.txt file from the %PROGRAMFILES(X86)%/Automation Anywhere IQ Bot

 6.0/Configurations folder.
2. Assign the False property to the CopyProductionFiles .
3. From the service console, restart the Automation Anywhere Cognitive File Manager service.
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4. Click any Create Bot link to open the IQ Bot Designer to view the following message:There are no
 training documents available for this Bot. Upload some training documents
 for the associated learning instance and try again.

After making this change, to train боты for the groups created in Production for this learning instance,
manually upload sample documents to Staging (resembling the Production documents).

Migration Utility
Use the IQ Bot Migration Utility to export and import learning instances between different IQ Bot
installations to avoid re-creating similar learning instances. This makes the life cycle management of a
learning instance and the associated боты easier.
If you are using Version 11.3, see Using Migration Utility to import and export learning instances on page
251.
If you are using Automation 360 IQ Bot, see Migrate IQ Bot learning instances.

Keep learning instance document classifier version during IQ
Bot upgrade

After upgrading to another version of IQ Bot, retain the previous document classifier version. This lets
user access the learning instances created in the other version of IQ Bot, and also saves the effort of re-
creating and retraining the боты after an upgrade.
1. During the IQ Bot installation process, after configuring the IQ Bot installation and output folder path,

verify the classifier version page appears. The document classifier is specific to the learning instance,
and not to the IQ Bot system

2. Select the previous classifier version from the drop-down list to preserve the existing learning
instances' classifier version. This allows access to the learning instances created in the previous
version of IQ Bot, and avoids retraining the боты.

3. After installation, open the existing learning instances in the IQ Bot Version 6.5 UI. The боты show
the same classification and text segmentation in the upgraded version of IQ Bot as in the previous
version because the user chose to preserve the previous classifier version during installation. If the
user exports or imports IQ Bot Archive (IQBA) files from one Version 6.5 machine to the same or
another Version 6.5 machine, the existing learning instances and functions are preserved.

IQ Bot 11.x: List of languages in IQ Bot
There are up to 30 languages available in IQ Bot. You can also access up to 190 languages by using an
Распознавание текста (OCR) engine.
When you review the list of languages in IQ Bot, you will observe the following:
• Some languages are listed multiple times as variants, for example, Norwegian, Norwegian (Bokmal),

Norwegian (Nynorsk).
• Among languages that are written from right to left, such as Arabic, Aramaic, Azeri, Divehi, Fula,

Hebrew, Kurdish, N'ko, Persian, Rohingya, Syriac, and Urdu, Arabic is currently supported on IQ Bot.
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• For languages not in the IQ Bot UI by default:
• These rely on ABBYY FineReader Engine 12.2 for text segmentation and OCR, then IQ Bot for

classification, extraction, and autocorrection.
• Contact your Cognitive Services or Sales Engineering representative to create IQ Bot custom

domains to access these languages.
• In the SQL database and .json file, IQ Bot requires language codes for 160 of the additional

languages to appear in the UI, and culture codes to allow numeric and date validation.

Прим.:
• For ABBYY FineReader Engine and Microsoft Azure Computer Vision OCR engine, IQ Bot uses its text

segmentation + Распознавание текста (OCR).
• For Microsoft Azure Computer Vision OCR engine, user can select any language from IQ Bot's drop-

down, but the API aims to auto-detect the language during processing, and override user selection.

Supported OCR engines

The following table provides you with links to supported languages for all IQ Bot supported Распознавание
текста (OCR) engines except Tesseract4 OCR:

IQ Bot supported Распознавание текста (OCR)
engines

Supported languages by OCR

Tesseract4 OCR See table below for list of supported languages.

ABBYY FineReader Engine ABBYY FineReader Engine OCR supported
languages

Microsoft Azure Computer Vision OCR engine https://docs.microsoft.com/en-us/azure/cognitive-
services/computer-vision/language-support

Google Vision API https://cloud.google.com/vision/docs/languages

Tegaki API • Японский
• Корейский
• Japanese - English
• Korean - English

The following table contains the languages supported by the Tesseract4 OCR and in IQ Bot when you
select Other in the Document type field.

OCR language Tesseract4 IQ BotOther domain

Английский X X

Abkhaz

Adyghe

Afrikaans X X

Agul

Albanian
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OCR language Tesseract4 IQ BotOther domain

Altaic

Armenian (Eastern)

Armenian (Grabar)

Armenian (Western)

Avar

Aymara

Bashkir

Basque

Belarussian

Bemba

Blackfoot

Breton

Bugotu

Bulgarian X X

Burmese (technical preview)

Buryat

Catalan X X

Chamorro

Chechen

Китайский (упрощенное
письмо)

X X

Китайский (традиционное
письмо)

X X

Chukcha

Chuvash

Corsican

Crimean Tatar

Croatian

Crow

Чехия X X

Датский X X

Dargwa

Dungan

Dutch

Нидерландский (Нидерланды)
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OCR language Tesseract4 IQ BotOther domain

Dutch (Belgium) or Flemish X X

Eskimo (Cyrillic)

Eskimo (Latin)

Esperanto

Estonian

Even

Evenki

Faeroese

Fijian

Finnish

Французский X X

Frisian

Friulian

Scottish Gaelic

Gagauz

Galician

Ganda

Немецкий X X

German (new spelling)

German (Luxembourg)

Greek X X

Guarani

Hani

Hausa

Hawaiian

Венгерский X X

Icelandic

Ido

Indonesian X X

Interlingua

Irish

Итальянский X X

Японский X X

Kabardian

© 2023 Automation Anywhere. All rights reserved.     222



    Automation Anywhere - Использование IQ Bot

OCR language Tesseract4 IQ BotOther domain

Kalmyk

Karachay-Balkar

Karakalpak

Kasub

Kawa

Kazakh

Khakas

Khanty

Kikuyu

Kirghiz

Kongo

Корейский X X

Korean (Hangul)

Koryak

Kpelle

Kumyk

Lak

Sami (Lappish)

Latin X X

Latvian

Latvian language written in
Gothic script

Lezgin

Lithuanian

Luba

Macedonian

Malagasy

Malay X X

Malinke

Maltese

Mansi

Maori

Mari

Maya

Miao
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OCR language Tesseract4 IQ BotOther domain

Minangkabau

Russian and English

Mohawk

Mongol

Mordvin

Nahuatl

Nenets

Nivkh

Nogay

NorwegianNynorsk and
NorwegianBokmal

Norwegian X X

Norwegian (Bokmal)

Norwegian (Nynorsk)

Nyanja

Occidental

Ojibway

Old English

Old French

Old German

Old Italian

Old Slavonic

Old Spanish

Ossetian

Papiamento

Tok Pisin

Польский X X

Португальский X X

Португальский (Бразилия)

Portuguese (Portugal)

Provencal

Quechua

Rhaeto-Romanic

Romanian X X

Romanian (Moldavia)

© 2023 Automation Anywhere. All rights reserved.     224



    Automation Anywhere - Использование IQ Bot

OCR language Tesseract4 IQ BotOther domain

Romany

Ruanda

Rundi

Russian (old spelling)

Russian X X

Russian (with accents marking
stress position)

Samoan

Selkup

Serbian X X

Serbian (Cyrillic)

Serbian (Latin)

Shona

Sioux (Dakota)

Slovak X X

Slovenian

Somali

Sorbian

Sotho

Испанский X X

Sunda

Swahili

Swazi

Шведский X X

Tabassaran

Tagalog

Tahitian

Tajik

Tatar

Thai

Jingpo

Tongan

Tswana

Tun

Турецкий X X
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OCR language Tesseract4 IQ BotOther domain

Turkmen

Turkmen (Latin)

Tuvan

Udmurt

Uighur (Cyrillic)

Uighur (Latin)

Ukrainian

Uzbek (Cyrillic)

Uzbek (Latin)

Vietnamese

Cebuano

Welsh

Wolof

Xhosa

Yakut

Yiddish

Zapotec

Zulu

Совет:  If you are unable to see all languages in the IQ Bot UI or if IQ Bot is unable to extract data from
multiple languages in a document, troubleshoot the issue:
Unable to extract data from Multiple languages in a document (A-People login required)

Стандартные формы for custom extraction
Стандартные формы provides support for customized extraction of complex, fixed format documents used
across various industry verticals. For example, Acord Forms are used as fixed format documents in the
global insurance industry. Form CMS1450 (UB-04) is a fixed format document used in healthcare for billing
and claims.
IQ Bot allows users to process fixed format documents without any required training. During instance
creation, selecting a fixed format document domain lets the user skip the document training in the
Designer, and the user only needs to select the appropriate fields. The created learning instance will have
a single бот that is always in production.
IQ Bot provides the flexibility to use a custom extraction service with extraction models that are better
suited for specific fixed format documents. The custom extraction services have pre-processing, extraction,
and post-processing components that are optimized for extracting information from specific fixed format
documents.

The custom extraction service also lets the user pre-process some forms in a different way.
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Phases of processing fixed format documents

Follow the stages to process fixed format documents as a business user:

Import domains for fixed format documents on page
227:

Obtain domain files from Services, and import them
to IQ Bot.

Create learning instance using fixed format documents
on page 228:

Create a learning instance using a fixed format
document and set the бот to production.

Process fixed format documents in production on page
229:

Upload documents to Enterprise Client and run the
бот in the production environment. Then download
the processed CSV file with the extracted data from
the success folder on your machine.

Using Валидатор for fixed format documents
processing on page 229

Finally, validate the extractions in the IQ Bot
Валидатор.

Related concepts
Using Валидатор for fixed format documents processing on page 229
Validate the extracted data in IQ Bot Валидатор.
Related tasks
Import domains for fixed format documents on page 227
Import the domain file (with .dom file extension) for fixed format documents to IQ Bot.
Create learning instance using fixed format documents on page 228
Import the relevant domain file for the fixed format document.
Process fixed format documents in production on page 229
For fixed format document domains, IQ Bot uses the custom extraction service to process the documents
and output the extracted result to a success folder.
Related reference
Hardware and software requirements for IQ Bot with Extensions on page 29
The following diagram provides the deployment architecture for IQ Bot with Extensions.

Import domains for fixed format documents
Import the domain file (with .dom file extension) for fixed format documents to IQ Bot.
• Install IQ Bot on your machine and obtain necessary access rights for an administrator.
• Reach out to your service representative/sales engineer for the relevant domain file for the fixed format

documents and get the custom extraction service installed on your environment.

The domain files contain relevant metadata about the specific fixed format documents, and details of the
custom extraction service for IQ Bot extensions. For example, a UB-04 domain file contains all relevant
fields for that form along with the information for the UB-04 custom extraction service.
Follow this process to import a domain file specifically designed for processing a fixed format document.
User can then create a learning instance using the imported domain.
1. Log in to IQ Bot as an administrator and navigate to the Domains tab.
2. Click the Import new domain button at the top right corner of the Domains page.
3. Select the domain from the location where you have it stored on your machine and choose Open.
4. A message with the domain name displays confirming the successful import.
5. Next, navigate to the LEARNING INSTANCES tab, and click on the Create one now button.
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6. User can see the imported domain in the Upload documents field drop-down list.

Create a learning instance using the imported domain.
Related tasks
Import domains for fixed format documents on page 227
Import the domain file (with .dom file extension) for fixed format documents to IQ Bot.

Create learning instance using fixed format documents
Import the relevant domain file for the fixed format document.
1. Navigate to the LEARNING INSTANCE tab.
2. On the Create new learning instance page, click the Document type drop-down list to see all

imported domains available for selection. The fixed format documents domains that were imported are
also visible.

3. Select a fixed format documents domain from the list. Selecting a fixed format documents domain
modifies the actions/fields/buttons in the Create new learning instance page as follows:
a) The Classify and Train icons get removed from the page.
b) The Upload documents field gets replaced with a note mentioning that fixed format documents

domains are pre trained and uploading training documents is not required.
c) The custom field selection is not available.
d) By default, all fields are selected. User has an option to Clear All Fields/Select All Fields.

The Create fixed format documents instance button is enabled when at least one field is
checked.

e) The user sees the assigned language for the domain (under the primary language).

4. After selecting a fixed format documents domain and the relevant fields, click the Create fixed
format documents instance button. The system takes the user back to the Learning instance
list page showing a list of learning instances. User gets a confirmation that the learning instance was
created successfully.

5. In the Bot tab, user can see the created бот in production status.
6. User cannot edit the Description or move the бот status to staging. The system always displays the

бот with Group 0, which is specific to fixed format documents only.
7. Next, navigate to the Learning instances tab and click the View details icon to see the Document

Groups and Summary tab details.
8. User can edit the learning instance, but is limited to updating/adding the description, or selecting

more fields only, if there were any unselected ones during the learning instance creation.
You cannot add custom fields to the learning instance.

Note:  Added/updated description is visible on the Learning instance details page.

9. Next, set the learning instance to production.
User has successfully created a learning instance using a fixed format documents domain and has set
it to production.

Log in to Enterprise Client to upload documents and run the бот the user created.
Related tasks
Process fixed format documents in production on page 229
For fixed format document domains, IQ Bot uses the custom extraction service to process the documents
and output the extracted result to a success folder.
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Process fixed format documents in production
For fixed format document domains, IQ Bot uses the custom extraction service to process the documents
and output the extracted result to a success folder.
Create a learning instance using a fixed format document domain set the instance to production. Launch
Enterprise Client.
Using the IQ Bot lite command in Enterprise Client, upload documents to IQ Bot so it can process the
documents.
1. In Enterprise Client, open the IQ Bot Upload command. User can see the learning instances in IQ Bot

in the drop-down list.
2. Provide a File Path to upload documents and choose Save.
3. Once the upload is complete, IQ Bot queues the documents to the custom extraction service for

execution.
4. User can see the document upload status in the log file that includes details such as, number of

documents uploaded, number of documents in the processing queue, errors, and so on.
5. Save the Upload command, and choose Run.

The custom extraction service extracts the data from the documents and sends it to a CSV file.
6. Open and run the Download command.
7. Navigate to Output > learning instance name > Success folder to see the processed document in

the CSV format.

Related concepts
Using Валидатор for fixed format documents processing on page 229
Validate the extracted data in IQ Bot Валидатор.
Download a document from a learning instance on page 207
Once documents are uploaded to a learning instance, some files process successfully, while others fail.
Related tasks
Upload documents to a learning instance on page 205
Upload the Production-ready documents from Automation Anywhere Enterprise to IQ Bot for processing.
Upload multiple folder files to a learning instance on page 206
Use this task to upload multiple documents to the IQ Bot server. Uploading multiple documents at one time
will save you time.

Using Валидатор for fixed format documents processing
Validate the extracted data in IQ Bot Валидатор.
Follow the same validation steps for validating fixed format documents as you would for forms belonging to
other domains. The following are few exceptions based on the capability of the custom extraction service
used for fixed format documents:
• The number of bounding boxes displayed on the document and the accuracy of the boxes varies and is

based on the capability of the custom extraction service.
• Mandatory fields are marked in the domain files or could be built into the engine. Documents that have

empty extracted values for the mandatory fields are sent to the Валидатор.
• Some field validations, such as: dates, phone numbers, and dollar amounts are unique to fixed format

documents, and are built into the custom extraction services.
• Auto-suggestion and auto-correction is not currently available for fixed format documents.
• Re-validation of user corrected values is not currently available for fixed format documents.
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Note:  See IQ Bot Validation queue for details.

Related concepts
IQ Bot Validation queue on page 209
Validation eliminates the complexity of validating and fixing issues with the бот, requires less time to fix
the issues, and requires minimal human intervention.

IQ Bot database encryption
The IQ Bot database is encrypted to prevent unauthorized access to sensitive information.
The following database tables and columns are encrypted because they store potentially sensitive data
from documents:
• FileManager.FieldLevelAccuracy.oldvalue
• FileManager.FieldLevelAccuracy.newvalue
• FileManager.FileDetails.filename
• FileManager.SegmentedDocumentDetails.SegmentedDocument (data stays until the document is in

Validation queue)
• FileManager.VisionBot.datalob
• FileManager.VisionBotDocuments.VBotDocument
• FileManager.TestSet.DocItems
• FileManager.FileBlobs.fileblob
• FileManager.VisionBotDocuments.CorrectedData
• FileManager.DocumentPageCache.fileblob

Note:  Although the data is encrypted, the APIs that use this data work as before.

Database encryption occurs during the following instances:

Database is encrypted during a fresh install
of IQ Bot

By default, the database is encrypted, regardless
of the installation type (fresh installation or an
upgrade).
All files uploaded to IQ bot (for training or
production) are encrypted. The database
administrator requires the encryption key to access
any information in the database.

Database is encrypted during migration of
learning instance

When a learning instance is exported, the archived
(.iqba) data file is not encrypted. Instead, the data
is exported in plain text format. However, when
importing a learning instance through an archived
(.iqba) file, regardless of the import options, the
updated IQ Bot database is encrypted.

Note:  Impacted areas constitute the import/export functionalities.

Database is encrypted during upgrade of IQ
Bot from a previous version

When upgrading IQ Bot from an older version, the
installer encrypts data related to the files in the
database.
After completing the RabbitMQ v3.8.18
configuration step in the installer, database
encryption begins, and the system shows an
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explatory message. After the upgrade is complete,
the system works as before.
If the encryption process fails, the installer shows
an error message and the upgrade gets rolled back
to the previous version.

Note:  Before the upgrade, copy and keep a
backup of the database so you can revert back to it
if errors occur during the upgrade process.

As an administrator, you must be aware of the location and security of the encryption key. The encryption
key file is not stored in a credential vault, but is located in the IQ Bot installation directory/
Configurations/private.key. Secure the encryption key with appropriate access restrictions to
significantly reduce the possibility that other users can decrypt the encrypted data.
The encryption key is shared across all servers of the IQ Bot cluster, to ensure seamless database
encryption across all servers. If the encryption key is lost, uninstall and reinstall IQ Bot to restore
functionality.

IQ Bot Microsoft Windows authentication
The IQ Bot platform administrator can enable Microsoft Windows authentication for the database
during IQ Bot platform installation. This enables the connection of SQL databases with Windows or dual
authentication.
When installing IQ Bot, select the Windows authentication check box to enable it. In this case, the
username and password fields are disabled. An error message appears for connection or credential issues.

Note:  By default, the Windows authentication box is unselected.

The IQ Bot Installer has an advanced mode to allow the IQ Bot platform administrator to enable Windows
authentication for the database.
Error messages appear for the following information:
• Invalid port number
• Empty hostname/port
• Database connection failure

IQ Bot audit log in Control Room
IQ Bot uses audit logs to enforce accountability, reconstruct events, and detect intrusion and issues. The
administrator is able to see logs for all users in the Audit Logs tab of the Control Room.
Actions done in IQ Bot by a user are logged in the Audit Logs tab in the Control Room. All successful and
unsuccessful entries are logged with the reasons for failures.
The Audit Log tab of the Control Room is updated every 60 seconds after user actions are taken in IQ
Bot.
1. Navigate to Automation Anywhere Control Room > Audit Log, and click the column drop-down

list to select the Source from the list of available options.
2. From the Choose source drop-down list, select IQ Bot.
3. The Audit Logs tab shows all logs for IQ Bot.
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4. Click the Audit details icon to view the following:
• Action details for successful logs
• Results for failure logs

5. Use the All columns field to select the column to filter by. The logs appear by the following columns:
• Статус
• Время
• Action Type
• Имя элемента
• Action Taken By
• Source Device
• Источник

The following actions are logged in the Audit Log tab :
• Learning instance

• Create, edit, or delete learning instance
• Send learning instance to Production (and vice versa)
• Send learning instance to Staging (and vice versa)

• Validation of learning instance
• file marked as invalid
• file validated successfully

• Train bot
• Бот training
• Send бот to Production (and vice versa)
• Send бот to Staging (and vice versa)

• Administration
Migrate learning instances (export or import)

• Configure domain
Создать домен
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Upgrading IQ Bot
Find out how to upgrade to the latest version of IQ Bot. Learn how to migrate learning instances from an
earlier version of IQ Bot to the most recent one.

Related concepts
Using Migration Utility to import and export learning instances on page 251
Use the IQ Bot Migration Utility feature to export and import a learning instance between different IQ Bot
installations to avoid recreating the learning instances.
Related tasks
IQ Bot upgrade options on page 233
This topic gives you options and use cases in a customer environment to try a version of IQ Bot before
upgrading the existing IQ Bot servers to development and production environments.
Upgrade from IQ Bot Version 11.3.4 to Version 11.3.4.x patch on page 243
Install an IQ Bot Version 11.3.4.x patch on your IQ Bot Version 11.3.4 system.
Upgrade IQ Bot Version 6.5 or earlier to IQ Bot Version 11.3.4 on page 244
Find out how to upgrade your system from IQ Bot Version 6.5.x and earlier to Version 11.3.4.
Upgrading IQ Bot to Version 11.3.3.x on page 246
This topic provides instructions on upgrading IQ Bot from Version 6.5.x and older, to Version 11.3.3.x.
Upgrading system from IQ Bot Version 5.3.x or IQ Bot 6.0.x to Version 6.5 on page 248
Find out how to upgrade your system from IQ Bot Version 6.0.x to Version 6.5.
Upgrading system from IQ Bot 5.3.x to 6.0.x on page 249
Find out how to upgrade your system from IQ Bot 5.3.x to 6.0.x
Upgrading system from IQ Bot 5.1.x to 5.2.x on page 250
Find out how to upgrade your system from IQ Bot 5.1.x to 5.2.x.
Upgrading system from IQ Bot 5.0.x to 5.1.x on page 250
Find out how to upgrade your system from IQ Bot 5.0.x to 5.1.x
Export or Import learning instances within IQ Bot 5.2 installation on page 257
Find out how to migrate learning instances within different installations of the same version of IQ Bot.
Export/Import learning instances within IQ Bot 5.3.x, and later versions on page 258
Find out how to migrate learning instances within different installations of IQ Bot 5.3, Version 6.0, and
Version 6.5.x and above.

IQ Bot upgrade options
This topic gives you options and use cases in a customer environment to try a version of IQ Bot before
upgrading the existing IQ Bot servers to development and production environments.
The following are primary tools/processes involved:
1. Import/Export

• This is an IQ Bot feature.
• We recommend transferring staging data from one IQ Bot installation to the other, provided both

belong to the same IQ Bot version.
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2. Database backup/Restore
• This is an SQL server feature.
• Creates backup of existing database that could be restored on same or different SQL server

instances.
• Prepare a database replica of the development environment.

• Backup all IQ Bot databases.
• Restore the backups on a new database server.

• Install the latest IQ Bot setup on or against the restored database server.
• This ensures you have the latest IQ Bot server for trial purposes that uses existing development

server data.

Прим.:  If any existing learning instances use Tesseract OCR v3, you should plan to train with
alternative OCRs (Optical Character Readers), including Tesseract4 OCR before any upgrade.

Прим.:  The task creates two development environments:
1. Development-old: with an older version of IQ Bot (which we will address as Dev-old)
2. Development-new: with a newer version of IQ Bot (which we will address as Dev-new)

Use the scenarios primarily where active development (such as, training of groups/ботs) continues along
with the trial of new IQ Bot versions.
1. Scenario 1: Active development happens on Dev-old environment only.

• Continue trial/use of Dev-new, though we are not concerned about the data on this machine.
• At the end of trial, if satisfied with new IQ Bot version then:

a. Discard Dev-new, as it has trial data only.
b. Upgrade Dev-old by first uninstalling older version of IQ Bot and then installing the new

version on it.

2. Scenario 2: Active development happens on Dev-new only.
• Stop using Dev-old. All new development happens in Dev-new environment only.
• At the end of trial, if satisfied with new IQ Bot version then:

a. Backup databases of Dev-new, and restore on Dev-old environment.
b. Upgrade Dev-old first by uninstalling older version of IQ Bot, and then installing the new

version on it.

3. Scenario 3: Active development happens on neither Dev-old nor on Dev-new environments.
• Stop using Dev-old. Since Dev-new environment is being used for trial only, no active development

happens on it.
• At end of trial, if we are satisfied with the new IQ Bot version then:

a. Discard Dev-new environment, as it has just trial data.
b. Upgrade Dev-old environment by first uninstalling the older IQ Bot version, and then installing

the new one.
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4. Scenario 4: Active development happens on both Dev-old and Dev-new environments.
• We intend to do active development on both the (Dev-old and Dev-new) environments.

Прим.:  We cannot merge training from two different IQ Bot servers.

• We do not recommend doing active development on both the environments. Instead pick either
scenario 1 or scenario 2.

When transferring data from development
to the production environment, do the
following:

First upgrade the production server by uninstalling
the current installed version of IQ Bot, and then
installing the new version of IQ Bot. This ensures
that both development and production servers have
the same IQ Bot version.
Migrate the data from development server to
production server using import/export (standard IQ
Bot process) operation.

Задачи, связанные с данной
Upgrading system from IQ Bot 5.0.x to 5.1.x
Find out how to upgrade your system from IQ Bot 5.0.x to 5.1.x
Upgrading system from IQ Bot 5.1.x to 5.2.x
Find out how to upgrade your system from IQ Bot 5.1.x to 5.2.x.
Upgrading system from IQ Bot 5.3.x to 6.0.x
Find out how to upgrade your system from IQ Bot 5.3.x to 6.0.x
Upgrading system from IQ Bot Version 5.3.x or IQ Bot 6.0.x to Version 6.5
Find out how to upgrade your system from IQ Bot Version 6.0.x to Version 6.5.
Upgrading IQ Bot to Version 11.3.3.x
This topic provides instructions on upgrading IQ Bot from Version 6.5.x and older, to Version 11.3.3.x.

Upgrading system to IQ Bot Version 11.3.5.7
As enhancements and bug fixes are provided with Version 11.3.5.7, use this topic to review the upgrade
instructions.
1. If you are using any of the earlier IQ Bot versions (11.3.5.3, 11.3.4.3, and so on), ensure that you first

upgrade to IQ Bot Version 11.3.5.6 before upgrading to Version 11.3.5.7.
Upgrading system to IQ Bot Version 11.3.5.6 on page 236

2. Log in to Automation Anywhere support site and download
Automation_Anywhere_IQ_BOT_11.3.5.7.zip:
A-People Downloads page (Login required)
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3. Perform the following steps to preserve the desktop shortcut:
a. Navigate to the IQ Bot installation directory.
b. Right-click the Cognitive Platform internet shortcut, go to Properties > Web Document, and

copy the URL.
After installing Version 11.3.5.7, you can use this to launch IQ Bot.

c. Install Version 11.3.5.7.
d. Use the copied URL to launch IQ Bot Version 11.3.5.7.

The IQ Bot desktop shortcut cannot be edited. Use the copied URL to open IQ Bot Version
11.3.5.7 every time.

Alternatively, after registering IQ Bot with the Control Room, you can access the IQ Bot application by
usinghttp://controlroom-URL/IQBotилиhttps://controlroom-URL/IQBot.

The installer stops all IQ Bot services and restarts them after the installation is complete.
1. Extract the contents from the Automation_Anywhere_IQ_BOT_11.3.5.7.zip file, and double-

click the Automation_Anywhere_IQ_BOT_11.3.5.7.exe to launch the installer.
Ensure that you run the installer as an administrator user.

2. Click Next to start the installation.
3. Click Finish to exit the installer.

IQ Bot Version 11.3.5.7 is installed, and you can restart the system.

1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Upgrading system to IQ Bot Version 11.3.5.6
As enhancements and bug fixes are provided with Version 11.3.5.6, use this topic to review the upgrade
instructions.
1. If you are using any of the earlier IQ Bot versions (11.3.5.3, 11.3.4.3, and so on), ensure that you first

upgrade to IQ Bot Version 11.3.5.5 before upgrading to Version 11.3.5.6.
Upgrading system to IQ Bot Version 11.3.5.5 on page 237

2. Log in to Automation Anywhere support site and download
Automation_Anywhere_IQ_BOT_11.3.5.6.zip:
A-People Downloads page (Login required)
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3. Perform the following steps to preserve the desktop shortcut:
a. Navigate to the IQ Bot installation directory.
b. Right-click the Cognitive Platform internet shortcut, go to Properties > Web Document, and

copy the URL.
After installing Version 11.3.5.6, you can use this to launch IQ Bot.

c. Install Version 11.3.5.6.
d. Use the copied URL to launch IQ Bot Version 11.3.5.6.

The IQ Bot desktop shortcut cannot be edited. Use the copied URL to open IQ Bot Version
11.3.5.6 every time.

Alternatively, after registering IQ Bot with the Control Room, you can access the IQ Bot application by
usinghttp://controlroom-URL/IQBotилиhttps://controlroom-URL/IQBot.

The installer stops all IQ Bot services and restarts them after the installation is complete.
1. Extract the contents from the Automation_Anywhere_IQ_BOT_11.3.5.6.zip file, and double-

click the Automation_Anywhere_IQ_BOT_11.3.5.6.exe to launch the installer.
Ensure that you run the installer as an administrator user.

2. Click Next to start the installation.
The Finished screen on the installer window indicates that the installation was successful.

3. Click Finish to exit the installer.
IQ Bot Version 11.3.5.6 is installed, and you can restart the system.

Installing Version 11.3.5.6 removes the setting where you have configured IQ Bot services to run with
a service account user. The services will then run as a local user. After the installation, use the following
instructions to reconfigure each service to the appropriate account user credentials:
1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Upgrading system to IQ Bot Version 11.3.5.5
As enhancements and bug fixes are provided with Version 11.3.5.5, use this topic to review the upgrade
instructions.
• Log in to Automation Anywhere support site and download

Automation_Anywhere_IQ_BOT_11.3.5.5.zip:
A-People Downloads page (Login required)
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• Perform the following steps to preserve the desktop shortcut:
1. Navigate to the IQ Bot installation directory.
2. Right-click the Cognitive Platform internet shortcut, go to Properties > Web Document, and

copy the URL.
After installing Version 11.3.5.5, you can use this to launch IQ Bot.

3. Install Version 11.3.5.5.
4. Use the copied URL to launch IQ Bot Version 11.3.5.5.

The IQ Bot desktop shortcut cannot be edited. Use the copied URL to open IQ Bot Version 11.3.5.5
every time.

Alternatively, after registering IQ Bot with the Control Room, you can access the IQ Bot application by
usinghttp://controlroom-URL/IQBotилиhttps://controlroom-URL/IQBot.

The installer stops all IQ Bot services and restarts them after the installation is complete.
1. Extract the contents from the Automation_Anywhere_IQ_BOT_11.3.5.5.zip file, and double-

click the Automation_Anywhere_IQ_BOT_11.3.5.5.exe to launch the installer.
Ensure that you run the installer as an administrator user.

2. Click Next to start the installation.
The Finished screen on the installer window indicates that the installation was successful.

3. Click Finish to exit the installer.
IQ Bot Version 11.3.5.5 is installed, and you can restart the system.

Installing Version 11.3.5.5 removes the setting where you have configured IQ Bot services to run with
a service account user. The services will then run as a local user. After the installation, use the following
instructions to reconfigure each service to the appropriate account user credentials:
1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Upgrading system to IQ Bot Version 11.3.5.x
Find out how to upgrade your system from IQ Bot Version 5.3.x, 6.x and Version 6.5.x and Version 11.3.x
to Version 11.3.5.x.
IQ Bot Version 11.3.5.x is compatible with Control Room Version 11.3.4.3 and above only.

Note:  The following prerequisites do not apply if you are upgrading from IQ Bot Version 11.3.4 onward.

• If the SQL version on your machine is older than SQL Server Native Client 2012, a dialog box appears,
providing you the option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER).
Then continue with the installation process.

• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. To keep the classifier version for the existing learning instances, select that prior version of IQ
Bot from the drop-down list.
• Version 1 (IQ Bot 5.3 / 6.0.1), if upgrading from IQ Bot versions 5.3.0 or Version 6.0.1.
• Version 2 (IQ Bot 5.3.1 / 6.5 Beta), if upgrading from IQ Bot versions 5.3.1, 6.5 Beta, or 6.5.
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• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5.x is used.

• If upgrading from IQ Bot Version 5.3.1.x and you have learning instance that rely on 5.3.1.x check box
or linked table functionality, clear the validation queue before upgrading to IQ Bot Version 11.3.5.x.

• When upgrading to IQ Bot Version 11.3.5.x, all group information gets stored in a new table,
ContentClassification, and all data gets automatically upgraded or transferred to this table during
the installation process.

• If you have customized the settings or configurations of certain files in the database, then you must
create a backup of these files before upgrading to another version of IQ Bot.

• To import learning instance backups on an IQ Bot Version 11.3.5.2 environment, the backup (.iqba)
file must be exported from an IQ Bot Version 11.3.5.2 environment only. Therefore, you must also
upgrade your source IQ Bot environment to Version 11.3.5.2. This requirement is due to changes made
in database schemas and version information in the backup (.iqba) files.

1. Refer to IQ Bot hardware and software requirements on page 27 before you begin with the upgrade
process.

2. Open all required ports. См. раздел IQ Bot 11.x: IQ Bot prerequisite steps on page 100.

Note:  Additionally, open ports 4369 and 25672, and add inbound firewall rules to allow traffic to
these ports.

3. Backup the IQ Bot database on the target server where installation is to be done. (This does not apply
to fresh installs).

4. Download Automation_Anywhere_IQ_Bot_Version 11.3.5.x.zip from Customer portal into
target machine.

5. Unzip Automation_Anywhere_IQ_Bot_Version 11.3.5.x.zip into
Automation_Anywhere_IQ_Bot_11.3.5.x folder.

6. Uninstall your current IQ Bot version. Refer to the note below on how to uninstall IQ Bot. (This does
not apply to fresh installs).

Note:  См. раздел Uninstalling IQ Bot 11.x on page 152.

7. Check that the correct versions of Control Room andEnterprise Client, that are being installed are
compatible per the compatibility matrix. См. раздел IQ Bot version compatibility matrix on page 8.

8. Open Automation_Anywhere_IQ_Bot_Version 11.3.5.x folder and execute the following files:
a) CleanupRabbitMQandErlang.bat

b) CleanupRabbitMQErlangPython.bat

c) UninstallPython.bat

d) UninstallPython385.bat

The .bat files uninstall RabbitMQ v3.8.18, Erlang/OTP relevant IQ Bot Pythonfiles, and remove
necessary registry entries. No other Python versions will be affected.

9. Restart your machine.
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10. Open Automation_Anywhere_IQ_Bot_Version 11.3.5.x folder and execute the following files
again:
a) CleanupRabbitMQandErlang

b) CleanupRabbitMQErlangPython

c) UninstallPython

d) UninstallPython385

This removes any empty folders from RabbitMQ v3.8.18, Erlang, and Python from the system.
11. Open Automation_Anywhere_IQ_Bot_Version 11.3.5.x folder and launch

Automation_Anywhere_IQ_Bot_Version 11.3.5.x.exe.
12. Next, install IQ Bot Version 11.3.5.x as per your requirement:

• IQ Bot 11.x: Installing IQ Bot in Express mode on page 106
• IQ Bot 11.x: Установка IQ Bot в пользовательском режиме on page 108
• IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113

Important:  If the installation fails due to a migration issue (despite the installation checklist),
contact support.

13. Change the load balancer port from 8100 to 3000. The default port number is selected from the
previous screen.
If you have installed an external load balancer, change the port number.

14. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.
Your upgrade is now complete.

After installing IQ Bot, ensure that you:
1. Register IQ Bot with Control Room. См. раздел IQ Bot 11.x: Registering IQ Bot with the Control Room on

page 118.
2. Complete the configuration settings to ensure registration with Control Room. See IQ Bot post

installation configuration on page 118 for more information.
3. Validate the installation. См. раздел IQ Bot post installation validation on page 140.

Upgrading system to IQ Bot Version 11.3.5
Find out how to upgrade your system from IQ Bot Version 5.3.x, 6.x and Version 6.5.x and Version 11.3.x
to Version 11.3.5.
IQ Bot Version 11.3.5 is compatible with Control Room Version 11.3.4.3 and above only.

Note:  The following prerequisites do not apply if you are upgrading from IQ Bot Version 11.3.4 onward.

• If the SQL version on your machine is older than SQL Server Native Client 2012, a dialog box appears,
providing you the option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER).
Then continue with the installation process.
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• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. To keep the classifier version for the existing learning instances, select that prior version of IQ
Bot from the drop-down list.
• Version 1 (IQ Bot 5.3 / 6.0.1), if upgrading from IQ Bot versions 5.3.0 or Version 6.0.1.
• Version 2 (IQ Bot 5.3.1 / 6.5 Beta), if upgrading from IQ Bot versions 5.3.1, 6.5 Beta, or 6.5.

• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5.x is used.

• If upgrading from IQ Bot Version 5.3.1.x and you have learning instance that rely on 5.3.1.x check box
or linked table functionality, clear the validation queue before upgrading to IQ Bot Version 11.3.5.

• When upgrading to IQ Bot Version 11.3.5, all group information gets stored in a new table,
ContentClassification, and all data gets automatically upgraded or transferred to this table during
the installation process.

• If you have customized the settings or configurations of certain files in the database, then you must
create a backup of these files before upgrading to another version of IQ Bot.

1. Refer to IQ Bot hardware and software requirements on page 27 before you begin with the upgrade
process.

2. Open all required ports. См. раздел IQ Bot 11.x: IQ Bot prerequisite steps on page 100.

Note:  Additionally, open ports 4369 and 25672, and add inbound firewall rules to allow traffic to
these ports.

3. Backup the IQ Bot database on the target server where installation is to be done. (This does not apply
to fresh installs).

4. Download Automation_Anywhere_IQ_Bot_11.3.5.zip from Customer portal into target
machine.

5. Unzip Automation_Anywhere_IQ_Bot_11.3.5.zip into
Automation_Anywhere_IQ_Bot_11.3.5 folder.

6. Uninstall your current IQ Bot version. Refer to the note below on how to uninstall IQ Bot. (This does
not apply to fresh installs).

Note:  См. раздел Uninstalling IQ Bot 11.x on page 152.

7. Check that the correct versions of Control Room andEnterprise Client, that are being installed are
compatible per the compatibility matrix. См. раздел IQ Bot version compatibility matrix on page 8.

Important:  If you are upgrading from IQ Bot 5.x, run the Cleanup_Components.bat before
installing the latest Control Room and IQ Bot versions.

8. Open Automation_Anywhere_IQ_Bot_11.3.5 folder and execute Cleanup_Components.bat
file. The .bat file will uninstall RabbitMQ, Erlang relevant IQ Bot Python files, and remove necessary
registry entries. No other Python versions will be affected.

9. Restart your machine.
10. Open Automation_Anywhere_IQ_Bot_11.3.5 folder and execute Cleanup_Components.BAT

file again. This removes any empty folders from RabbitMQ v3.8.18, Erlang, and Python from the
system.

11. Open Automation_Anywhere_IQ_Bot_11.3.5 folder and launch
Automation_Anywhere_IQ_Bot_11.3.5.exe.
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12. Next, install IQ Bot Version 11.3.5 as per your requirement:
• IQ Bot 11.x: Installing IQ Bot in Express mode on page 106
• IQ Bot 11.x: Установка IQ Bot в пользовательском режиме on page 108
• IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113

Important:  If the installation fails due to a migration issue (despite the installation checklist),
contact support.

13. Change the load balancer port from 8100 to 3000. The default port number is selected from the
previous screen.
If you have installed an external load balancer, change the port number.

14. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.
Your upgrade is now complete.

After installing IQ Bot, ensure that you:
1. Register IQ Bot with Control Room. См. раздел IQ Bot 11.x: Registering IQ Bot with the Control Room on

page 118.
2. Complete the configuration settings to ensure registration with Control Room. See IQ Bot post

installation configuration on page 118 for more information.
3. Validate the installation. См. раздел IQ Bot post installation validation on page 140.

Upgrading system to IQ Bot 11.x
As enhancements and bug fixes are provided with Version 11.3.4.3, use this topic to review the upgrade
instructions.
• Log in to Automation Anywhere support site and download

Automation_Anywhere_IQ_BOT_11.3.4.3.zip:
A-People Downloads page (Login required)

• Perform the following steps to preserve the desktop shortcut:
1. Navigate to the IQ Bot installation directory.
2. Right-click the Cognitive Platform internet shortcut, go to Properties > Web Document, and

copy the URL.
After installing Version 11.3.4.3, you can use this to launch IQ Bot.

3. Install Version 11.3.4.3.
4. Use the copied URL to launch IQ Bot Version 11.3.4.3.

The IQ Bot desktop shortcut cannot be edited. Use the copied URL to open IQ Bot Version 11.3.4.3
every time.

Alternatively, after registering IQ Bot with the Control Room, you can access the IQ Bot application by
usinghttp://controlroom-URL/IQBotилиhttps://controlroom-URL/IQBot.
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The installer stops all IQ Bot services and restarts them after the installation is complete.
1. Extract the contents from the Automation_Anywhere_IQ_BOT_11.3.4.3.zip file, and double-

click the Automation_Anywhere_IQ_BOT_11.3.4.3.exe to launch the installer.
Ensure that you run the installer as an administrator user.

2. Click Next to start the installation.
The Finished screen on the installer window indicates that the installation was successful.

3. Click Finish to exit the installer.
IQ Bot Version 11.3.4.3 is installed, and you can restart the system.

Installing Version 11.3.4.3 removes the setting where you have configured IQ Bot services to run with
a service account user. The services will then run as a local user. After the installation, use the following
instructions to reconfigure each service to the appropriate account user credentials:
1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Upgrade from IQ Bot Version 11.3.4 to Version 11.3.4.x patch
Install an IQ Bot Version 11.3.4.x patch on your IQ Bot Version 11.3.4 system.
• Ensure you have IQ Bot Version 11.3.4 installed.

This patch requires Version 11.3.4 as the base release.
• To preserve the desktop shortcut, perform the following steps:

1. Navigate to the IQ Bot installation directory.
2. Right-click the Cognitive Platform internet shortcut, go to Properties > Web Document, and

copy the URL.
You can use this later to launch IQ Bot after installing Version 11.3.4.2 patch.

3. Uninstall IQ Bot Version 11.3.4.1 patch.
4. Install Version 11.3.4.2 patch.
5. Use the copied URL to launch IQ Bot Version 11.3.4.2.

The IQ Bot desktop shortcut cannot be edited. Use the copied URL to open IQ Bot Version 11.3.4.2
every time.

Alternatively, you can access the IQ Bot application by usinghttp://controlroom-URL/
IQBotилиhttps://controlroom-URL/IQBotafter registering IQ Bot with the Control Room.

• If you have Version 11.3.4.1 patch installed, then you have to uninstall it before installing the Version
11.3.4.2 patch.

• Ensure that you have downloaded AA_IQBOT_Update_11.3.4.x.exe patch installer.

During installation, the installer stops all IQ Bot services and restarts them after the installation is
complete.
1. Double click the AA_IQBOT_Update_11.3.4.x.exe file to launch the installation wizard.

Important:  Run the installer as an Administrator.
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2. On the Setup Wizard welcome screen, click Update to begin the installation process.
The Finished screen on the installer window indicates that the IQ Bot patch is successfully installed.

3. Click Finish to exit the installer.
4. Click Yes to immediately restart your system, or click No to restart later.

Note:  Restart the system after the installation is complete.

If you have configured IQ Bot services to run with a service account user, installing the Version 11.3.4.x
patch removes that setting. So the services run as a local user. After the patch is installed, and the services
are reinstalled, follow these steps to reconfigure each service to the appropriate account user credentials:
1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Related tasks
Uninstall IQ Bot Version 11.3.4.x patch on page 244
Follow these steps to uninstall Version 11.3.4.x patch.

Uninstall IQ Bot Version 11.3.4.x patch
Follow these steps to uninstall Version 11.3.4.x patch.
1. Launch the operating system Control Panel from the Start menu. Open Programs > Programs >

Uninstall a program.
2. In the left pane, click View Installed Updates.
3. Locate and double-click the Automation Anywhere IQ Bot Version 11.3.4.x entry.
4. Click Yes in the confirmation dialog box.

The installer uninstalls the application.
5. In the restart confirmation box, click Yes to immediately restart your system, or click No to restart

later.

Note:  Restart your system after the uninstall is complete.

If you have configured IQ Bot services to run with a service account user, uninstalling Version 11.3.4.x
patch removes that setting. So the services run as a local user. After the patch uninstall is complete, and
the services are reinstalled, follow the steps to re-configure each service to the appropriate account user
credentials:
1. Navigate to Start > Services.
2. Right-click each service and select Properties > Log On > This account to change to the

appropriate service account user.

Upgrade IQ Bot Version 6.5 or earlier to IQ Bot Version 11.3.4
Find out how to upgrade your system from IQ Bot Version 6.5.x and earlier to Version 11.3.4.
For IQ Bot Version 11.3.4.x
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• If your SQL machine version is older than SQL Server Native Client 2012, a dialog box appears, giving
you the option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER). Then
complete the installation process.

• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. Select that prior version of IQ Bot from a drop-down list to keep the classifier version for the
existing learning instances. From the drop-down list the option Version 2 (IQ Bot 5.3.1 / 6.5 Beta)
refers to IQ Bot 5.3.1 / 6.5 Beta / 6.5 .

• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5.x is used.

• If upgrading from IQ Bot Version 5.3.1.x and you have learning instance that rely on 5.3.1.x check box
or linked table functionality, clear the validation queue before upgrading to IQ Bot Version 6.5.x.

• When upgrading to IQ Bot Version 11.3.4.x, all group information gets stored in a new table
ContentClassification, and all data gets automatically upgraded/transferred to this table during the
installation process.

• If you have customized the settings or configurations of certain files in the database, then you must
create a backup of these files before upgrading to another version of IQ Bot.

If you configure IQ Bot with a load balancer, ensure you are logged onto the Automation Anywhere
cognitive projects service as an administrator to enable access to all nodes for migration utility.
1. Refer to IQ Bot hardware and software requirements on page 27 before you begin with the upgrade

process.
2. Open all required ports. См. раздел IQ Bot 11.x: IQ Bot prerequisite steps on page 100.

Note:  Additionally, open ports 4369 and 25672, and add inbound firewall rules to allow traffic to
these ports.

3. Backup the IQ Bot database on the target server where installation is to be done. (This does not apply
to fresh installs).

4. Download Automation_Anywhere_IQ_Bot_11.3.4.zip from Customer portal into target
machine.

5. Unzip Automation_Anywhere_IQ_Bot_11.3.4.zip into
Automation_Anywhere_IQ_Bot_11.3.4 folder.

6. Uninstall your current IQ Bot version. Refer to the note below on how to uninstall IQ Bot. (This does
not apply to fresh installs).

Note:  См. раздел Uninstalling IQ Bot 11.x on page 152.

7. Check that the correct versions of Control Room andEnterprise Client, that are being installed are
compatible per the compatibility matrix. См. раздел IQ Bot version compatibility matrix on page 8.

Important:  If you are upgrading from IQ Bot 5.x, run the Cleanup_Components.bat before
installing the latest Control Room and IQ Bot versions.

8. Open Automation_Anywhere_IQ_Bot_11.3.4 folder and execute Cleanup_Components.bat
file. The .bat file will uninstall , Erlang relevant IQ Bot Python files, and remove necessary registry
entries. No other Python versions will be affected.

9. Restart your machine.
10. Open Automation_Anywhere_IQ_Bot_11.3.4 folder and execute Cleanup_Components.BAT

file again. This removes any empty folders from RabbitMQ v3.8.18, Erlang, and Python from the
system.

11. Open Automation_Anywhere_IQ_Bot_11.3.4 folder and launch
Automation_Anywhere_IQ_Bot_11.3.4.exe.
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12. Next, install IQ Bot Version 11.3.3 as per your requirement:
• IQ Bot 11.x: Installing IQ Bot in Express mode on page 106
• IQ Bot 11.x: Установка IQ Bot в пользовательском режиме on page 108
• IQ Bot 11.x: Installing IQ Bot in Cluster mode on page 113

Important:  If the installation fails due to a migration issue (despite the installation checklist),
contact support.

13. Change the load balancer port from 8100 to 3000. The default port number is selected from the
previous screen.
If you have installed an external load balancer, change the port number.

14. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.
Your upgrade is now complete.

After installing IQ Bot, ensure that you:
1. Register IQ Bot with Control Room. См. раздел IQ Bot 11.x: Registering IQ Bot with the Control Room on

page 118.
2. Complete the configuration settings to ensure registration with Control Room. See IQ Bot post

installation configuration on page 118 for more information.
3. Validate the installation. См. раздел IQ Bot post installation validation on page 140.

Related concepts
IQ Bot post installation configuration on page 118
After installing IQ Bot complete the configuration settings to ensure registration with Control Room,
confirm the creation of all required databases, create the appropriate certificates, configure the HTTP and
HTTPS settings, generate the authorization token for performing any task, and verify the completion of all
tasks in the post-installation checklist.
IQ Bot post installation validation on page 140
After installing IQ Bot and completing the post-installation tasks, validate the installation by creating IQ Bot
specific roles, accessing the Валидатор without a license, accessing the product without a device license,
and understanding permissions for role-based access control to the learning instances.
Related tasks
IQ Bot 11.x: Configure IQ Bot with HTTP and HTTPS on page 132
This section describes single and multiple domain scenarios when installing IQ Bot and Control Room with
various server certificates.
Related reference
Configure IQ Bot 11.x with HTTPS using multiple domains on page 135
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.
Configure IQ Bot 11.x with HTTPS using single domain on page 134
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.
Configure IQ Bot 11.x with HTTP when Control Room is configured with HTTPS on page 136
Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.

Upgrading IQ Bot to Version 11.3.3.x
This topic provides instructions on upgrading IQ Bot from Version 6.5.x and older, to Version 11.3.3.x.
For IQ Bot Version 11.3.3.x
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• If your SQL machine version is older than SQL Server Native Client 2012, a dialog box appears, giving
you the option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER). Then
complete the installation process.

• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. Select that prior version of IQ Bot from a drop-down list to keep the classifier version for the
existing learning instances. From the drop-down list the option Version 2 (IQ Bot 5.3.1 / 6.5 Beta)
refers to IQ Bot 5.3.1 / 6.5 Beta / 6.5 .

• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5.x is used.

• If upgrading from IQ Bot Version 5.3.1.x and you have learning instance that rely on 5.3.1.x check box
or linked table functionality, clear the validation queue before upgrading to IQ Bot Version 6.5.x.

• When upgrading to IQ Bot Version 11.3.3.x, all group information gets stored in a new table
ContentClassification, and all data gets automatically upgraded/transferred to this table during the
installation process.

• If you have customized the settings or configurations of certain files in the database, then you must
create a backup of these files before upgrading to another version of IQ Bot.

If you configure IQ Bot with a load balancer, ensure you are logged onto the Automation Anywhere
cognitive projects service as an administrator to enable access to all nodes for migration utility.
1. Refer to IQ Bot hardware and software requirements on page 27 before you begin with the upgrade

process.
2. Open all required ports. См. раздел IQ Bot 11.x: IQ Bot prerequisite steps on page 100.

Note:  Additionally, open ports 4369 and 25672, and add inbound firewall rules to allow traffic to
these ports.

3. Backup the IQ Bot database on the target server where installation is to be done. (This does not apply
to fresh installs).

4. Download Automation_Anywhere_IQ_Bot_11.3.3.x.zip from Customer portal into target
machine.

5. Unzip Automation_Anywhere_IQ_Bot_11.3.3.x.zip into
Automation_Anywhere_IQ_Bot_11.3.3.x folder.

6. Uninstall your current IQ Bot version. Refer to the note below on how to uninstall IQ Bot. (This does
not apply to fresh installs).

Note:  См. раздел Uninstalling IQ Bot 11.x on page 152.

7. Ensure the correct versions of Control Room and Enterprise Client are installed as per the IQ Bot
compatibility matrix. См. раздел IQ Bot version compatibility matrix on page 8.

8. Open Automation_Anywhere_IQ_Bot_11.3.3.x folder and execute
Cleanup_Components.BAT file. The .bat file will uninstall , Erlang relevant IQ Bot Python files, and
remove necessary registry entries. No other Python versions will be affected.

9. Restart your machine.
10. Open Automation_Anywhere_IQ_Bot_11.3.3.x folder and execute

Cleanup_Components.BAT file again. This removes any empty folders from RabbitMQ v3.8.18,
Erlang, and Python from the system.

11. Open Automation_Anywhere_IQ_Bot_11.3.3.x folder and launch
Automation_Anywhere_IQ_Bot_11.3.3.x.exe.
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12. Next, install IQ Bot Version 11.3.3.x as per your requirement:

Option 1: IQ Bot 11.x: Установка IQ Bot в
пользовательском режиме on page 108.

Option 2: IQ Bot 11.x: Installing IQ Bot in Cluster mode on
page 113.

Option 3: IQ Bot 11.x: Installing IQ Bot in Express mode on
page 106.

13. Change the load balancer port from 8100 to 3000. The default port number is selected from the
previous screen.
If you have installed an external load balancer, change the port number.

14. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.
Your upgrade is now complete.

After installing IQ Bot, ensure that you:
1. Register IQ Bot with Control Room. См. раздел IQ Bot 11.x: Registering IQ Bot with the Control Room on

page 118.
2. Complete the configuration settings to ensure registration with Control Room. See IQ Bot post

installation configuration on page 118 for more information.
3. Validate the installation. См. раздел IQ Bot post installation validation on page 140.

Related concepts
IQ Bot 11.x: RabbitMQ v3.8.18 and Erlang/OTP upgrade on page 103
The IQ Bot Version 11.3.x installation package includes the RabbitMQ v3.8.18 version 3.7.17 and Erlang/
OTP version 22.0.
Related tasks
Uninstall previous version of RabbitMQ v3.8.18 / Erlang/OTP on page 104
When upgrading to IQ Bot Version 11.3.x, you need to uninstall the previous version of RabbitMQ v3.8.18 /
Erlang/OTP.

Upgrading system from IQ Bot Version 5.3.x or IQ Bot 6.0.x to
Version 6.5

Find out how to upgrade your system from IQ Bot Version 6.0.x to Version 6.5.
For IQ Bot Version 6.5
• If your machine version is older than SQL Server Native Client 2012, a dialog box appears, giving you the

option to upgrade. Open services.msc and stop SQL Server (MSSQLSERVER). Then complete
the installation process.

• During the upgrade, the installer detects if you have existing learning instances from a prior version of
IQ Bot. Select that prior version of IQ Bot from a drop-down list to keep the classifier version for the
existing learning instances.

• For any new learning instances created after installation, the classifier version of IQ Bot Version
5.3.1/Version 6.5 is used.

• When upgrading from IQ Bot Version 5.3.1.x, if you have learning instance that relies on 5.3.1.x check
box or linked table functionality, clear the validation queue before upgrading to IQ Bot Version 6.5.
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• If you have customized the settings or configurations of certain files in the database, then you must
create a backup of these files before upgrading to another version of IQ Bot.

For IQ Bot Version 6.5 Beta
• If you have a prior version of IQ Bot in a current environment, install and use IQ Bot Version 6.5 in a

fresh development environment, rather than uninstalling your prior version in your current environment.
• If you have multiple tables in a бот in IQ Bot Version 5.3.1, after upgrade, multiple tables migrate, but

as one consolidated table in that бот of IQ Bot Version 6.5.

If you still prefer to upgrade, follow these steps:
• Keep a valid PFX format certificate handy for HTTPS.
• Before upgrading from IQ Bot Version 6.0.x to Version 6.5, take a backup of the database. If any

encryption issues occur after upgrading IQ Bot, you can restore your system using this backup.

Perform these steps on a machine with IQ Bot 6.0.x installed.
After upgrading from previous IQ Bot version, for example, from 5.3.0 to the current version, if you
are using an existing TaskBot to read the output CSVs, change the encoding in the Read from CSV
command to UTF-8. The output format has been updated to enable RPA task to read UTF-8 characters
starting from IQ Bot 5.3.0 and later.
If you configure IQ Bot with load balancer, ensure you are logged onto the Automation Anywhere cognitive
projects service as an administrator to enable access to all nodes for migration utility.
1. Uninstall your current IQ Bot version from Add remove programs in the Control Room.
2. Ensure the correct versions of Control Room (Version 11.3.1 base + either Version 11.3.1.1 patch or

Version 11.3.1.2 patch) and Enterprise Client are installed, and not the 10.x versions.
3. Uninstall  and Erlang.
4. Next, install IQ Bot Version 6.5 in custom mode.
5. Change the load balancer port from 8100 to 3000. The default port number is selected from the

previous screen.
If you have installed an external load balancer, change the port number.

6. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.
Your migration is now complete.

You can launch IQ Bot.

Upgrading system from IQ Bot 5.3.x to 6.0.x
Find out how to upgrade your system from IQ Bot 5.3.x to 6.0.x
Perform these steps on a machine with IQ Bot 5.3.x installed.

Note:  keep the PFX format certificate handy for HTTPS.

After upgrading from previous IQ Bot version to the current version, if you are using an existing TaskBot to
read the output CSVs, change the encoding in the Read from CSV command to UTF-8. In IQ Bot 5.3.x,
the output format has been updated to enable RPA task to read UTF-8 characters.
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If you configure IQ Bot with Load Balancer, ensure you are logged onto the Automation Anywhere
cognitive projects service as an administrator to enable access to all nodes for migration utility.
1. Uninstall IQ Bot 5.3.x from Add remove programs in the Control Room.
2. Uninstall  and Erlang.
3. Next, install IQ Bot 5.3.x in custom mode.

For an HTTPS based installation, add the PFX format certificate.
4. Change the load balancer port from 8100 to 3000. The default port number is selected from the

previous screen.
If you have installed an external load balancer, change the port number.

5. Complete the installation by retaining the rest of the settings, as they get auto populated during
installation.

6. Your migration is now complete.

Launch IQ Bot.

Upgrading system from IQ Bot 5.1.x to 5.2.x
Find out how to upgrade your system from IQ Bot 5.1.x to 5.2.x.
• Perform the followig tasks on a machine with IQ Bot 5.1.x installed.
• Keep the PFX format certificate handy for HTTPS.

This task walks you through the steps to upgrade your IQ Bot system from 5.1.x to 5.2.x.
1. Uninstall IQ Bot 5.1.1 from Add remove programs in the Control Room.
2. Next, install IQ Bot 5.2.1 in custom mode.

For an HTTPS based installation, add the PFX format certificate.
3. Change the auto-populated load balancer port from 8100 to 3000.
4. Complete the installation by keeping the rest of the settings as is, that get auto populated during

installation.
5. Your migration is now complete.

Launch IQ Bot.

Upgrading system from IQ Bot 5.0.x to 5.1.x
Find out how to upgrade your system from IQ Bot 5.0.x to 5.1.x
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• Perform the following tasks on a machine that has MS SQL database installed.
• The MS SQL server database must belong to the same version on the source and destination database

servers.
• Before restoring the database, stop all IQ Bot services and ensure none of the services are running.
• Have the migration utility available for use, consisting of the following batch files required for upgrade:

• Backup_DB.BAT
• Restor_DB.BAT

Note:  The migration utility script supports migration of learning instances and bots from one IQ Bot
v5.1.x installation instance to another IQ Bot v5.1.x installation instance. It does not work for migration
from IQ Bot 5.0.x to IQ Bot 5.1.x.

This task walks you through the steps to upgrade your IQ Bot system from version 5.0.x to 5.1.x.
1. Back up the database using the Backup_DB.BAT file. The file contains the following:@ECHO

 OFFSETLOCALREM Build a list of databases to backupFOR %%G IN
 (ClassifierData,FileManager,MLData) DO ( ECHO %%G.BAK SqlCmd -S
 ec5-55-555-555-555.ap-south-1.compute.amazonaws.com -U username -P
 password -Q "BACKUP DATABASE [%%G] TO Disk='C:\kj\%%G.bak'" )ENDLOCAL.
File objects Ссылка

(ClassifierData,FileManager,MLData) Picks one or more databases to back up. Here all
three databases are selected.

ec5-55-555-555-555.ap-
south-1.compute.amazonaws.com

This is a placeholder for the MS SQL database
server name. Replace it with your database
server name.

'C:\kj\ This is a placeholder for the output path of
the backup files. Change this based on your
requirements.

2. To restore one or more back up files, copy all the database backup files (.bak) into the database
server and run the following from the command-line: sqlcmd -S ec5-55-555-555-555.ap-
south-1.compute.amazonaws.com -U username -P password -Q "RESTORE DATABASE
 AliasData FROM Disk='C:\IQBot_DB_Backup\AliasData.bak'

File objects Ссылка

ec5-55-555-555-555.ap-
south-1.compute.amazonaws.com

This is a placeholder for the MS SQL database
server name. Replace it with the name of your
database server.

Change the backup file path depending on your requirements. Additionally, change the database user
name and password depending on the settings of your database.

Using Migration Utility to import and export learning instances
Use the IQ Bot Migration Utility feature to export and import a learning instance between different IQ Bot
installations to avoid recreating the learning instances.
Document groups, боты, and all learning associated with a learning instance are exported. Training
documents used to train the боты during staging also get exported. However, the production documents
do not get exported.
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Прим.:
• Export learning instances to create a backup.
• Back up your database before importing learning instances.
• Select the right import option to avoid losing information.
• If migration is related to a learning instance created using custom domains, contact Automation

Anywhere Enterprise support.
• Ensure that the source and destination systems are running the same IQ Bot version. Learning

instances from differentIQ Bot versions cannot be imported because their database schema will not
match.

If you have IQ Bot administrator rights, go to IQ Bot > Administrator > Migration. The Migration
Utility page displays a list of all available learning instances.
Задачи, связанные с данной
Export a learning Instance
Export a learning instance using the Migration Utility.
Import a learning instance
Import a learning instance using the Migration Utility.
Export or Import learning instances within IQ Bot 5.2 installation
Find out how to migrate learning instances within different installations of the same version of IQ Bot.
Export/Import learning instances within IQ Bot 5.3.x, and later versions
Find out how to migrate learning instances within different installations of IQ Bot 5.3, Version 6.0, and
Version 6.5.x and above.

Export a learning Instance
Export a learning instance using the Migration Utility.
Follow these steps to export a learning instance using the Migration Utility:
1. Navigate to the Administration tab > Migration from the left panel to open that page.
2. Select one or more learning instances as per your requirement and click Export.
3. Enter an appropriate name for the IQ Bot archive (IQBA) data file, and click to begin the export

process.
The name of the backup file is appended with a time stamp to make it unique.

4. Wait for the export process to complete. Once completed, the exported data file with the .iqba
extension becomes available in the BackupData folder in the IQ Bot output directory.
C:\Users\Public\Documents\Automation Anywhere IQBot Platform\Output
\BackupData

When an export process is in progress, limited user interaction is allowed with the IQ Bot Портал
because export is a CPU-intensive activity.

Прим.:  Exporting learning instances does not export production data; therefore, the Dashboard
might not be displayed.

Import a learning instance
Import a learning instance using the Migration Utility.
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Прим.:  To import learning instance backups on an IQ Bot Version 11.3.5.2 environment, the backup
(.iqba) file must be exported from an IQ Bot Version 11.3.5.2 environment only. Therefore, you must also
upgrade your source IQ Bot environment to Version 11.3.5.2. This requirement is due to changes made in
database schemas and version information in the backup (.iqba) files.

Select from the various available options. Before initiating an import, backup your IQ Bot database.
Although Role-Based Access Control (RBAC) applies to the creation of new learning instances in IQ Bot
Version 6.5, it does not apply to the following:
• Keep existing learning instances from previous IQ Bot versions.
• Import/export learning instances from one IQ Bot Version 6.5 environment to another.

As a workaround, an administrator can do the following:
• Ensure users and roles are updated in the Automation Anywhere Control Room.
• Manually insert a row in the projected and role columns in the database table [FileManager].

[dbo].[LearningInstanceRoles].

That database table is automatically created empty during IQ Bot Version 6.5 installation.
Do the following to import learning instances using the Migration Utility feature:
1. Copy the exported data file in the BackupData folder in the IQ Bot installation output directory to

import.
2. Click Import, and select the IQ Bot Archive (IQBA) backup data file to import.
3. Select the required learning instance and click Import. You are asked to select from the following

import options :

Прим.:  The Migration Utility feature in IQ Bot Version 6.5 does not work well in scenarios where
learning instances exist in both the source and target systems, and new groups were added to the
source system for migration. In these scenarios, the new groups are not migrated to the target system
for options 1, 2, and 3 of the Migration Utility feature. Customers are required to upgrade to IQ Bot
Version 11.3.3.1 and above to avail these scenarios.

Import option When to use

Вариант 1. Append imported groups
and trained ботs to duplicate existing
learning instances:

Use when you must merge new groups
and trainings (ботs) in existing learning
instances.

Прим.:
• When you import archive (.iqba) files

using append mode, a trained group
in a source environment can overwrite
an untrained group in the destination
environment.

• If a learning instance is edited (for
example, adding new fields), it cannot be
imported using the Append option.
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Import option When to use

Вариант 2. Import learning instances,
and ignore duplicate learning
instances:

Use when you must append only new
learning instances, where the learning
instance ID in the .iqba file (for example,
from the Development environment) differs
from the ID in the target environment
(for example, Production environment).
If a learning instance ID in the .iqba
file is the same as an ID in the target
environment, the .iqba learning instance is
not appended.

Вариант 3. Overwrite duplicate
existing learning instances with
imported learning instances:

All groups, trainings (bots), and machine
learning of existing learning instances on
the destination system get replaced with
the ones from source system. This does not
impact the processing (dashboard data)
done by those learning instances.
This is also the only option to update an
existing learning instance that was edited to
include additional fields or table columns.

Вариант 4. Remove all existing
learning instances and replace with
imported learning instances:

When starting fresh and it is okay to lose all
work done so far on an IQ Bot installation.

Прим.:  If you merge the iqba files, it does not merge the machine learning (ML) part from one
learning instance to another. Instead, it keeps the ML from the existing learning instance, but not the
imported learning instance.

4. Select an import option that best meets your requirement. Click Import. You are asked to confirm the
import.

5. Click Yes Import to begin the import process. When the import finishes, you are returned to the
Migration Utility home page with the list of learning instances. A successful import shows a Last
Migration status COMPLETE message with the time stamp.

The imported learning instance retains its environment and that of all associated боты.

Варианты импорта
Find out about the impact of each import option.
The table explains the impact of learning instances using the four import options mentioned in the section
before.
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System before
file import
(Destination)

Import file
(Source)

System after file import (Destination)

Option 1:
Append
imported
groups and
trained боты
to duplicate
existing
learning
instances.

Option 2:
Импортировать
обучаемые
экземпляры,
игнорируя
дубликаты
существующих
обучаемых
экземпляров

Option 3:
Перезаписать
дубликаты
существующих
обучаемых
экземпляров
импортированными
обучаемыми
экземплярами

Option 4:
Удалить все
существующие
обучаемые
экземпляры
и заменить
импортированными
обучаемыми
экземплярами

L1 L1 L1 + L1 L1 L1 + L1 L1

L2 L2 L2 + L2 L2 L2 + L2 L2

L3 L3 L3 L3

L4 L4 L4 L4 L4

L5 L5 L5 L5 L5

L1=Learning Instance L2=Learning Instance2
The following table explains the import options in detail. The impact on the learning instances, groups,
documents, and bots is explained when using the four import options.
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Learning Instance=L1 Group=G Files=F Bots=B
Задачи, связанные с данной
Export/Import learning instances within IQ Bot 5.3.x, and later versions
Find out how to migrate learning instances within different installations of IQ Bot 5.3, Version 6.0, and
Version 6.5.x and above.

Export or Import learning instances within IQ Bot 5.2
installation

Find out how to migrate learning instances within different installations of the same version of IQ Bot.
To use migration utility, log into the IQ Bot portal. The Migration Utility screen displays a list of all
learning instances available on IQ Bot.
IQ Bot supports migration of learning instances from one IQ Bot 5.2 installation to another instance of IQ
Bot 5.2 installation, using the export/import feature. Groups, bots, and learning associated with a learning
instance are exported, along with training documents, that are used to train the bots during staging.
Launch migration utility by adding /migration-utility at the end of the portal URL in the browser,
and choose Enter on the keyboard (<IQ bot portal hostname:port>/migration-utility)
1. Perform the following procedure to export learning instances using the migration utility.

a)
Select one or more learning instances as per your requirement and click .

b)
Enter an appropriate name for the backup data file, and click  to begin the
export process.
Name of the backup file is appended with timestamp to make it unique.

c) Wait for the export to complete; after which, the exported data file with .iqba extension becomes
available in the OutputBackupData folder within the IQ Bot output directory. As export is a CPU-
intensive activity, limited user interaction with IQ Bot is allowed when any export process is in
progress.

2. The following procedure walks you through the task of importing the learning instances using the
migration utility:
a) Place the exported data file in OutputBackupData folder within the output directory of the IQ Bot

installation, where you want to import the learning instances.
b) Click , and then select the backup data file to import.

Import replaces all existing learning instances with the instances that you import. Before initiating
an import, back up your existing learning instances in case you need them later.

c)
Select the required learning instance and click  to begin the import process.

d) Once the import completes, you can see the imported learning instances.
The imported learning instance retains its environment state and the state of all the associated
bots.
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Export/Import learning instances within IQ Bot 5.3.x, and later
versions

Find out how to migrate learning instances within different installations of IQ Bot 5.3, Version 6.0, and
Version 6.5.x and above.
• IQ Bot Version 6.5.x and above uses unique delimiters "-">: for group of checkboxes and ":" for linked

tables: "Gender_ID->Female" and "Patient_Table->Services.
• IQ Bot Version 5.3.1 uses non-unique delimiters: Gender_ID_Female and Patient_Table_Services, which

is harder to split.

That difference between Version 6.5.x and above and 5.3.1. will create field name conflicts, unless the
Валидатор queue in Version 5.3.1 is cleared. Version 6.5.x and above supports IQ Bot and RPA process
better.
Import learning instances using the migration utility within IQ Bot 5.3, Version 6.0, and Version 6.5.x and
above.
Control Room 11.3.1.2 supports migration of IQ Bot from 5.3.x to Version 6.5 and later.

Note:
• Role-based access control (RBAC) is not migrated when learning instances are migrated using the

migration utility. For more information on using RBAC with IQ Bot, see Define access to learning instances
using custom roles on page 141.

• The Migration utility of IQ Bot does not support any manual changes to the database and the IQBA file.
After migration, you get only staging data.

1. Copy the exported data file in the BackupData folder within the output directory of the IQ Bot
installation, where you want to import the learning instances.

2. Click Import and select the IQBA backup data file to import.
3. Select the required learning instance and click Import. Select one of the import option from the list of

import options:
Вариант Описание

Option 1: Добавить импортированные
группы и обученные боты для
дублирования существующих обучаемых
экземпляров

• Merges new groups and trainings bots in
existing learning instances.

• Appends any new learning instances found in
import data file.

• Retains validator learning of existing learning
instances.

Note:  During import with this option, an existing
group without a bot gets a bot if it is available in
the import data file.

When to use:
When you want to append newer groups and
training bots to an existing learning instance
of an IQ Bot installation, without impacting
the processing (dashboard data) done by that
learning instance.
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Вариант Описание

Option 2: Импортировать обучаемые
экземпляры, игнорируя дубликаты
существующих обучаемых экземпляров

Appends only new learning instances.
When to use:
When you want to import only new learning
instances and or bots on an IQ Bot installation
keeping the existing learning instances intact.

Option 3: Перезаписать дубликаты
существующих обучаемых экземпляров
импортированными обучаемыми
экземплярами

• Overwrites existing learning instances
including all groups and training of bots.

• Appends any new learning instances found in
import data file.

• Replaces validator learning of existing learning
instances.

• During import with this option, if any new
group is found, it is retained to preserve the
associated documents.

When to use:
• When you want to replace all groups, trainings

bots and learnings of an existing learning
instance of an IQ Bot installation without
impacting the processing (dashboard data)
done by that learning instance.

• This is also the only option to update an
existing learning instance which has been
edited to include additional fields/table
column.

Option 4: Удалить все существующие
обучаемые экземпляры и заменить
импортированными обучаемыми
экземплярами

Deletes all existing learning instances before
importing the new instances.
When to use:
When you want to start afresh and do not mind
losing all the work done so far on an IQ Bot
installation.

4. Select an import option that you need. Click Import. A confirmation is requested to confirm the
import.

5. Click on Yes, import to begin the import process.
6. Once import completes, the migration utility home page is displayed with the list of imported learning

instances.

• If import is successful, Last Migration status is shown as COMPLETE along with the timestamp.
• If the import fails, Last Migration status is shown as FAILED along with the timestamp.

The imported learning instance retains its environment state and the state of all the associated bots.

Related concepts
Варианты импорта on page 254
Find out about the impact of each import option.
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Troubleshooting IQ Bot
Use the following information to troubleshoot your IQ Bot application.

Large IQBA files failing import
Using the migration utility feature in IQ Bot you are trying to import a large IQBA file from development to
the production server.
Large IQBA files failing import IQ-bot-v6.5 (A-People login required)

Installation error in output path configuration screen
When the user clicks Next on the Destination Folders screen, an error message is displayed that the
output path does not have read, write, and delete permissions.
Troubleshoot the issue: Installation error in output path configuration screen IQ-Bot-v6.5 (A-People login
required)

No learning instance for command in Enterprise Client
No learning instance is available to select in IQ Bot command in Enterprise Client.
Troubleshoot the issue: No learning instance for command in Enterprise client IQ-Bot-v6.5 (A-People login
required)

Learning instance classification issue on restarting AWS
instance

All the documents are classified as Yet to be Classified.
Troubleshoot the issue: Learning instance classification issue on restarting AWS instance IQ-Bot-v6.5 (A-People
login required)

IQ Bot does not load after restarting AWS instance
IQ Bot does not load after stopping and starting an AWS instance.
Troubleshoot the issue: IQ Bot does not load after restarting AWS instance IQ-Bot-v6.5 (A-People login required)

Error message displays indefinitely
Updating instance and uploading files message is displayed indefinitely for an HTTPS-enabled
IQ Bot installation
Troubleshoot the issue: Unable-to-upload-files.html - Error message displays indefinitely IQ-Bot-v6.5 (A-People
login required)

© 2023 Automation Anywhere. All rights reserved.     260

https://apeople.automationanywhere.com/s/article/Large-IQBA-files-failing-import-IQBot
https://apeople.automationanywhere.com/s/article/Fit-to-window-view-Installation-error-in-output-path-configuration-screen
https://apeople.automationanywhere.com/s/article/Fit-to-window-view-Installation-error-in-output-path-configuration-screen
https://apeople.automationanywhere.com/s/article/No-learning-instance-for-command-in-Enterprise-client
https://apeople.automationanywhere.com/s/article/No-learning-instance-for-command-in-Enterprise-client
https://apeople.automationanywhere.com/s/article/Learning-instance-classification-issue-on-restarting-AWS-instance
https://apeople.automationanywhere.com/s/article/Learning-instance-classification-issue-on-restarting-AWS-instance
https://apeople.automationanywhere.com/s/article/IQ-Bot-does-not-load-after-restarting-AWS-instance
https://apeople.automationanywhere.com/s/article/Error-message-displays-indefinitely
https://apeople.automationanywhere.com/s/article/Error-message-displays-indefinitely


    Automation Anywhere - Troubleshooting IQ Bot

Related information
Intrusion detection system

IQ Bot installation fails to run in RabbitMQ cluster mode
IQ Bot installation fails to run in RabbitMQ cluster mode
Troubleshoot the issue: IQ Bot installation fails to run in RabbitMQ cluster mode IQ-Bot-v6.5 (A-People login
required)

IQ Bot HTTPS SSL certificate expiry
In your browser window, the HTTPS entry is crossed out and displays as not secure.
Troubleshoot the issue: IQ Bot HTTPS SSL certificate expiry IQ-Bot-v6.5 (A-People login required)

Automation Anywhere Control Room login error
IQ Bot login: Control Room returns the Certificate path validator signature check failed
error.
Troubleshoot the issue: Automation Anywhere Enterprise Control Room login error IQ-Bot-v6.5 (A-People login
required)

Connect ECONNREFUSED error during login
Connect ENCONNREFUSED error message is displayed during login.
Troubleshoot the issue: Connect ECONNREFUSED error during login IQ-Bot-v6.5 (A-People login required)

Unable to install IQ Bot in express mode
Unable to install IQ Bot in express mode because Control Room is not installed in express mode.
Troubleshoot the issue: Unable to install IQ Bot in express mode IQ-Bot-v6.5 (A-People login required)

Related reference
IQ Bot 11.x: IQ Bot installation prerequisites on page 99
Verify the hardware, software, and configuration required to install IQ Bot in your environment. Follow the
pre-installation checklist before installing IQ Bot.

Uninstall error
Error when uninstalling IQ Bot.
Troubleshoot the issue: Uninstall error IQ-Bot-v6.5 (A-People login required)
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Unable to view learning instance listing
IQ Bot command does not display any learning instances and does not return specific errors when Control
Room and IQ Bot are configured in cluster mode.
Troubleshoot the issue: Unable to view learning instance listing IQ-Bot-v6.5 (A-People login required)

Your connection is not private error
Your connection is not private error is displayed on IQ Bot.
Troubleshoot the issue: Your connection is not private error IQ-Bot-v6.5 (A-People login required)

Stalled Classifier
Classifier service stalls, and timer continues to spin after restarting IQ Bot services.
Troubleshoot the issue: Stalled Classifier IQ-Bot-v6.5 (A-People login required)

Unresponsive Designer while drawing a User-Defined Region
(UDR)

Designer becomes unresponsive when drawing a User-Defined Region (UDR)
Troubleshoot the issue: Unresponsive Designer while drawing a User-Defined Region (UDR) IQ-Bot-v6.5 (A-
People login required)

Installer unable to create platform database tables
The IQ Bot installer is sometimes unable to create platform database tables.
Troubleshoot the issue: Installer unable to create platform database tables IQ-Bot-v6.5 (A-People login required)

Classification stalls while training documents
Classification stalls while training documents in IQ Bot.
Troubleshoot the issue: Classification stalls while training documents IQ-Bot-v6.5 (A-People login required)

Export process hangs
Export process hangs while creating learning instances.
Troubleshoot the issue: Export process hangs IQ-Bot-v6.5 (A-People login required)

Documents not classified after migrating learning instances
Documents are not classified after migrating learning instance to a new machine with a custom domain.
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Troubleshoot the issue: Documents not classified after migrating learning instances IQ-Bot-v6.5 (A-People login
required)

Installer error 1334
IQ Bot installer error 1334, file cannot be installed.
Troubleshoot the issue: Installer error 1334 IQ-Bot-v6.5 (A-People login required)

Access Denied message
Access denied: You are not authorized to log into IQ Bot.
Troubleshoot the issue: Access Denied message IQ-Bot-v6.5 (A-People login required)

Installation fails while installing RabbitMQ
While installing RabbitMQ, users see a message that installation failed.
Troubleshoot the issue: Installation fails while installing RabbitMQ IQ-Bot-v6.5 (A-People login required)

Cannot upgrade to IQ Bot 6.0 on Control Room 11.3
Unable to upgrade from IQ Bot 5.3 on Control Room 10.7 to IQ Bot 6.0 on Control Room 11.3.
Troubleshoot the issue: Cannot upgrade to IQ Bot 6.0 on Control Room 11.3 IQ-Bot-v6.5 (A-People login
required)

IQ Bot services not getting uninstalled
IQ Bot services not getting uninstalled during an installation rollback.
Troubleshoot the issue: IQ Bot services not getting uninstalled during an installation rollback IQ-Bot-v6.5 (A-
People login required)

Output folder path change from local to shared drive
After changing the path, when user tries to save a document in Validator, an error message is displayed.
Troubleshoot the issue: Output folder path change from local to shared drive IQ-Bot-v6.5 (A-People login
required)

Windows authentication with services in local system is not
working

Windows authentication with services in local system is not working, none of the services are able to
access the database.
Troubleshoot the issue: Windows authentication with services in local system is not working IQ-Bot-v6.5 (A-People
login required)
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Database encryption errors
Sometimes IQ Bot is unable to encrypt the database causing the installation process to rollback.
Troubleshoot the issue: Database encryption errors IQ-Bot-v6.5 (A-People login required)

SIRs not getting generated consistently
Sometimes Распознавание текста (OCR) fails to extract data from the documents, and occasionally
documents with same layout get categorized into different groups.
Troubleshoot the issue: SIRs not getting generated consistently IQ-Bot-v6.5 (A-People login required)

IQ Bot installation FAQs
Find answers to the frequently asked questions related to IQ Bot.
IQ Bot installation FAQs IQ Bot-v6.5 (A-People login required)

IQ Bot user FAQs
Refer to Frequently Asked Questions (FAQs) to know more about IQ Bot.
IQ Bot user FAQs IQ Bot -V6.5 (A-People login required)

Related reference
IQ Bot validator FAQs on page 264
View FAQs related to Validator.
IQ Bot classifier FAQs on page 264
View FAQs related to the Classifier.

IQ Bot classifier FAQs
View FAQs related to the Classifier.
IQ Bot classifier FAQs IQ Bot v6.5 (A-People login required)

IQ Bot validator FAQs
View FAQs related to Validator.
IQ Bot validator FAQs IQ Bot v-6.5 (A-People login required)
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IQ Bot Community Edition quick start guide
IQ Bot processes semi-structured or unstructured information and converts it into structured data that
is used by Robotic Process Automation (RPA) bots for end-to-end automation. This lets you train the
computer system to autonomously capture and understand unstructured information within a known
domain and convert it into actual data.
We'll walk you through the entire process to show how easy it is to use cognitive automation.

Прим.:  We recommend using the Chrome browser.

Начните с IQ Bot
Register to use the IQ Bot Community Edition, then login with credentials from the welcome email you
receive.
We will walk you through the entire process of:
• creating a learning instance and uploading sample documents
• training and reviewing your learning instance
• sending your learning instance to production

Register to use the Community Edition
Sign up for Automation Anywhere Community Edition and register as a new user.
1. Click on Register to register as a new user.

You will receive an email providing you with login credentials and a link to the IQ Bot Community
Edition. The email provides other helpful information as well.

2. Check your registered email account for your credentials and use them to log into the IQ Bot
Community Edition portal.

3. On the Control Room home page, choose COGNITIVE AUTOMATION > LAUNCH IQ BOT.
4. The IQ Bot Community Edition Home page displays in a new window.

Creating a learning instance in Community Edition
IQ Bot leverages machine learning for continuous enhancement through user training. Let's begin by
creating a learning instance.
A learning instance defines the type of document you need to process, the language of documents, and a
list of data fields you want captured from each document.

Прим.:  Use documents in various formats such as: TIFF, JPEG, PNG, and PDF, to train your learning
instance.

1. On the IQ Bot Home page, click the Get started button to display the Create new learning
instance page.

2. Define a name for the new learning instance. The description field is optional.
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3. Select the domain or the document type, and the language from the drop-down list.
4. To create a custom domain, select Document type > Others. See Custom domain for details.
5. Click the Browse button and upload documents for training.
6. Download and use the sample documents as well. To use the sample documents, click the Download

sample documents button, unzip the folder, and save the sample files to your local drive. Then click
the Browse button and upload documents to train.

7. In the Fields to extract section, select fields from where the data needs to be extracted. For
additional fields, expand the Additional form fields section and select additional fields.

8. Select common table fields and additional table fields, as required.
9. Next, click the Create Learning Instance button.
10. The system analyzes and sorts the training documents into logical groups based on field identification.

Next, train the documents, and review field mappings.
Задачи, связанные с данной
Custom domain
A domain contains information about the language of the documents, and the fields which the system
would extract from the documents. Community Edition supports five domains out-of-the-box such as:
Invoices, Purchase orders, Utility Bills, Bank Statements, and Credit Memos. For any other document type,
create a custom domain.

Custom domain
A domain contains information about the language of the documents, and the fields which the system
would extract from the documents. Community Edition supports five domains out-of-the-box such as:
Invoices, Purchase orders, Utility Bills, Bank Statements, and Credit Memos. For any other document type,
create a custom domain.
1. Begin by creating a learning instance, and then select the Document type > Other option to add a

custom domain.
2. Add the Domain name and Primary language of documents.
3. Upload your sample documents to train.
4. In the Instance fields, enter the name of the label as it appears in the training documents and then

choose to Add as form or Add as table/repeated section that require extraction.
Use the same form and table/repeated section field names as it appears in the training documents.
Otherwise, the documents will remain unclassified.

Train your learning instance
IQ Bot analyzes documents, and groups them based on similar content, structure, and layout.

IQ Bot performs an initial field mapping based on existing knowledge from any pretrained document types.
When the first group is created, you can start reviewing the results of the initial mapping, and train the
learning instance by making corrections. There are three panels in the training window:
• left panel displaying a list of fields
• center panel displaying field label, value, and parameter for each selected field
• right panel displaying the document in training

1. Select each field in the left panel to verify that the label of the field in the center panel are correctly
identified, and the location of the value is correct.
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2. If the label location is incorrect, choose the correct one by clicking directly on the text in the training
document to auto populate the text in the center panel.

3. The Designer tries to find the appropriate value for the selected field label from the training document.
However, if the displayed value is incorrect, you can either choose the correct one by clicking directly
on the value in the training document, or use the Draw tool to select a bigger area for the value
directly in the training document. The selected value displays in the center panel value field.

4. In addition to individual fields, IQ Bot captures data from tables. Verify the mapping for table columns
as well.

5. Ensure each table field has a correct corresponding column name.
6. In the Table settings, select the best column for row detection, as well as an optional end of table

indicator which tells IQ Bot that anything that comes after it will not be considered as a line item. Click
on the text in the right panel or type the value manually in the End of Table Indicator field, in the
center panel.

7. Enter multiple labels in the End of Table Indicator field in this format: Subtotal | Tax (USD). The |
pipe symbol separates the labels.

Once you complete training the current document, click the See Extraction Results button to review the
extracted fields as well as the table line items on the left, and compare them to the document on the right.
You can review other documents in this group. Since IQ Bot grouped similar documents, it can train one
document and process others in the group in the same way.
The See Extraction Results menu lists all the uploaded training documents in an alpha-numeric
sequence. The files are listed in old to new sequence.
As per the file names, the training documents in a batch are listed in the following order:
• Files names starting with special characters.
• File names starting with numbers.
• File names starting with alphabets.

Export data to a CSV file
In the See Extraction Results view, you have the option to export the extracted data to a CSV file for
ease of review.
Export data to a CSV file:
1. During training when you click the See Extraction Results button, you can view the correct/

incorrect data extraction for the current training document.
2. In this view, you have the option to export the data to a CSV file for further review.
3. Click the Export to CSV option to export data and view it in a spreadsheet.

The CSV file is downloaded with the data extracted from the document.
Click the > next to the document name at the top to see other documents in the group. This allows
you to download the data extracted from other documents.

Прим.:  The sequence of fields in the .csv output is dependent on the training and configurations
applied at the bot level. You can access field data using the field names instead of the index.
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IQ Bot 11.x: Set learning instance to production
Once the training and data extraction review process is complete, set your learning instance to production.
Use this learning instance to run on documents (belonging to the same document type) hence automating
the data extraction process.

1. In the My Learning Instances window, click your learning instance. Then click the Set to
production icon.

2. Confirm the message that comes up and choose Yes, send to production button.
3. The production label displays next to the learning instance name.
4. To edit your learning instance, go to the LEARNING INSTANCES tab, select your learning instance,

and click Set to staging button to set it back to staging.
You can edit your learning instance at any time, but have to set it to staging first before you can edit.

Use IQ Bot in RPA
Use the RPA TaskBot to automate data extraction. One TaskBot uploads documents to IQ Bot as another
one downloads the results from IQ Bot to a local folder. Ensure you have trained learning instances in
production status, to complete the process.
Задачи, связанные с данной
Using Upload Document action
The Upload Document action enables you to upload a document with IQ Bot. IQ Bot extracts fields from
the document and exports them to CSV files.
Использование action «Загрузить все документы»
Используйте action Загрузить все документы для загрузки с сервера IQ Bot извлеченных
результатов, которые созданы в результате выполнения Бот при помощи action Загрузить
документ.

Using Upload Document action
The Upload Document action enables you to upload a document with IQ Bot. IQ Bot extracts fields from
the document and exports them to CSV files.
• Gain access to an Control Room.
• Ensure your local host is a registered device in the Control Room.

Прим.:  To perform these tasks using APIs, see using APIs to upload files, check file status, and download CSV
files (A-People login required).

Use the Upload Document action to upload a single document to the Control Room.

Прим.:  Azure confidential computing enables organizations to upload encrypted data to secured storage,
such as private folders on a virtual machine. If you upload documents from such secured folders to IQ Bot,
these are moved to Unclassified status as data extraction is not supported for such documents.

Follow these steps to upload a document:
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1. In the Действия palette, double-click or drag the Upload Document action from the IQ Bot пакет.

Прим.:  A file size of 50 MB is supported for the upload action.

Прим.:  The file names of the documents that you upload should not start with special characters,
such as the hyphen (-).

2. В поле Имя обучаемого экземпляра выберите имя.
3. In the File path field, specify the location or type of the file.
4. Необязательно: В поле Метка группы укажите строковую переменную, содержащую имя

папки, в которой находятся отсортированные документы.
Это необходимо для определения группы документов, созданной пользователем. .

5. Необязательно: In the Save the response to variable field, add a variable. For example: select
prompt-assignment - string from the drop-down list.
A variable value in this field provides information about the file upload process: if the upload was
successful or failed, and the reason for the failure.

6. Щелкните Применить.
7. Щелкните Сохранить.
8. Щелкните Запустить сейчас.
9. Щелкните Закрыть.

To upload multiple files, see Upload multiple files to IQ Bot using Loop action.

Upload multiple files to IQ Bot using Loop action
Automate uploading multiple files by inserting the Upload Document action into a Loop action.
Follow these steps to upload multiple documents:
1. In the Действия palette, double-click or drag the Loop action from the Loop пакет.
2. In the Loop Type field, select the Iterator option.
3. In the Iterator field, select For each file in folder from the drop-down list.
4. In the Folder path field, select the folder path.
5. In the Assign file name and extension to this variable field, create or select a dictionary variable

to store the names and extensions of the files in the selected folder path.
For this example, we will use a dictionary variable named dictFile.

6. In the Действия palette, double-click or drag the Upload Document action from the IQ Bot пакет.
7. Complete the information, except the File Path field.
8. In the File path field, enter a dynamic file path using a variable.

a) Add a file path pointing to the folder, for example C:\input\.
b) Add the dynamic file name string: $dictFile(name)$.$dictFile(extension)$.

The name and extension keys are predefined. When inserted and run in a loop, the action iterates
through the entire folder and calls all files in the folder one at a time. The File path value looks like
this: C:\input\$dictFile(name)$.$dictFile(extension)$

9. Щелкните Сохранить.

To read results from variable, use the Message box action.
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Использование action «Загрузить все документы»
Используйте action Загрузить все документы для загрузки с сервера IQ Bot извлеченных
результатов, которые созданы в результате выполнения Бот при помощи action Загрузить
документ.

Прим.:  Чтобы выполнить эту задачу с помощью API, см. использование API для загрузки файлов,
проверки статуса файлов и загрузки CSV-файлов (требуется вход на сайте A-People).

IQ Bot извлекает поля из документов и экспортирует их как файлы CSV. Это action также позволяет
загружать любые неклассифицированные, неподготовленные и недействительные документы в ваш
локальный каталог.
Выполните следующие шаги, чтобы загрузить извлеченные результаты с сервера IQ Bot.
1. На палитре Действия дважды щелкните или перетащите action Загрузить все документы из

пакет IQ Bot.
2. В поле Имя обучаемого экземпляра выберите имя.
3. В поле Статус документа выберите подходящий статус для документов.

• Успешные. Документы обработаны и представлены в формате .csv.
• Недействительные. Документы отмечены как недействительные во время процесса

проверки.
• Неклассифицированные. Не удалось классифицировать документы по группам.
• Неподготовленные. Документы классифицированы по новым группам в процессе

обработки и требуют обучения.
• Сбой. Документы, которые не удалось обработать и которые требуют повторной обработки.

Документ отражает Статус документа как Не удалось, если при извлечении данных,
проверке или сохранении конечного результата в базе данных возникает исключение.

Необработанные документы в папках Недействительные, Неклассифицированные,
Неподготовленные и Сбой доступны в исходном формате. Например, если входные
документы были в формате .pdf, то выходные файлы в указанных выше папках будут также
представлены в формате .pdf.

Прим.:  После загрузки документа с помощью action Загрузить необходимо периодически
выполнять action Загрузить для получения последних результатов с сервера. Поддерживайте
интервал от 30 секунд до 1 минуты между выполнением двух последовательных и одинаковых
action Загрузить для IQ Bot.

4. In the Local output folder field, provide the path to the file that will hold the output.
5. Для флажка Удалить файлы с сервера после загрузки выберите вариант удаления

документов.
При выборе этого варианта сжатый файл .zip, содержащий неудачные документы, будет
доступен для повторной загрузки, даже если загрузка не удалась. Поэтому следует выбрать этот
параметр.

6. Необязательно: В поле Сохранить ответ в переменную добавьте переменную. Например,
выберите в раскрывающемся списке prompt-assignment - string.
Значение переменной в этом поле предоставляет информацию о том, была ли загрузка
успешной или неудачной, а также сведения о причине сбоя.

7. Щелкните Обновить.
8. Щелкните Сохранить.
9. Щелкните Запустить сейчас.
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10. Щелкните Закрыть.

Прим.:  Если загрузка не удалась, проверьте переменную, используя Окно сообщений или
action Записать в файл. См. описание поля Сохранить ответ в переменную.

11. Перейдите в локальную папку вывода, чтобы просмотреть загруженные файлы.

FAQs for Community Edition
This topic answers frequently asked questions about the IQ Bot Community Edition.

Обзор

IQ Bot is a purpose-built cognitive automation that you can train to automate business processes to work
fast and efficiently, and also eliminate human error.
Use IQ Bot, and Automation Anywhere Enterprise in conjunction to automate your business processes that
rely on semi-structured or unstructured data hidden in electronic documents, images, emails, and other
areas. IQ Bot leverages computer vision and multiple Artificial Intelligence (AI) techniques to intelligently
digitize and extract data to make your Robotic Process Automation (RPA) and Optical Character recognition
(OCR) technology even more effective. Using this approach IQ Bot can adapt its data extraction from
specific domains or document types, and quickly learn from the environment to improve the results.
For the Community Edition, we have made five domains available for use such as: Invoices, Purchase
Orders, Bank Statements, Credit Memos, and Utility Bills. IQ Bot uses the OCR technology to extract
information from a document. Though OCR tools measure results based on accuracy, IQ Bot uses the
Straight Through Processing (STP) technique to measure how many documents can be processed end-to-
end without human intervention.

Basic Concepts

1. How does IQ Bot work?
IQ Bot leverages computer vision and multiple AI techniques to intelligently digitize and extract data to
make your RPA more effective. IQ Bot uses OCR as one of the underlying technologies used to extract
information from a document. This approach allows IQ Bot to adapt the data extraction from specific
domains and document types, and quickly learn from the environment to improve results.

2. What is a learning instance?
You would create a learning instance for a specific use case that an IQ Bot can learn from. It is
domain-specific and has the capability to learn from documents classified and processed by it, and
validation corrections performed by humans. This learning is translated to tangible benefits such as:
improved STP and accuracy figures for the instance over a period.

3. What is the difference between bots and learning instance?
A learning instance consists of training for the business process around a specific document type.
Bots contain training files that were classified by IQ Bot in different groups based on content.
You can activate or deactivate a bot in a learning instance to improve its training; as the learning
instances would process documents that match the active bots as others remain in a queue, until that
group is trained.
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4. What is the accuracy rate of IQ Bot?
The most primary metric for IQ Bot is STP. It is dependent on the accuracy of field capture. Field
accuracy impacts STP directly.
For example, if a customer captures one to two fields across a Grade A quality document, an accuracy
of 86% is achieved. A customer who captures 11 differentially weighted fields across highly-varying
document quality would see lower accuracy.

5. How does the dashboard help?
The dashboard displays all production information and results that helps us identify how we could
improve the training.

Прим.:  The production information is not available for the Community Edition.

6. What is percent (%) training?
The percent (%) training helps us estimate the STP that is calculated based on the number of bots
trained and active bots.

Using IQ Bot Community Edition

1. What are the limitations of the Community Edition?
Processing Limitations: The user can create up to five learning instances and upload up to 100
documents for each learning instance.

2. I have trained the learning instance but cannot see the output.
For each trained group, you can select See Extraction Results > Export CSV to see the output.

3. I cannot edit a group as the Edit Bot link is disabled.
The Edit Bot link appears disabled when the group is in production or when it is in training in another
tab.

4. I have completed processing and need to process files in batch mode. How can I do that?
IQ Bot can process files in batch mode when connected to RPA.

5. I have to add a new domain that is available in the Bot Store.
Importing domains is not available for the Community Edition.

6. I cannot see the results on the dashboard.
The dashboard displays information of processed files that are in production. This option is not
available in the Community Edition.

7. What is the prerequisite step to creating a learning instance in IQ Bot?
Before you start creating a new learning instance, know what information you want to extract from
the documents you would be processing.
It is best practice is to have some sample documents, which you can use as reference to decide what
you want to extract. Use them as the first set of documents to train against the new learning instance.

8. How many simultaneous documents can be loaded into IQ Bot?
In the Community Edition, IQ Bot accepts up to a limit of 100 documents for each learning instance.
The full license would support millions of documents per year that can be uploaded in a queue.

9. What is the license requirement for IQ Bot?
Community Edition includes a license for IQ Bot. No user action is required.
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10. How many tables can I configure to extract in a Bot?
You can configure unlimited number of tables for extraction.

11. Can I test a document different than that used for training?
Yes, you can. Use the Preview option to navigate to other documents to verify if training was effective.

Learning

1. Does IQ Bot learn from user inputs?
IQ Bot learns from the user inputs over time.
Пример. If a date is extracted often with an extra character such as spaces and dots between
numbers, and the user corrects it a dozen times, IQ Bot would automatically correct the error when it
encounters a similar problem the next time.

2. How does IQ Bot differ from OCR solutions?
OCR is one of the underlying technologies in IQ Bot but is used only as a first step. IQ Bot is designed
for business users, so anyone can start training an IQ Bot after a 3-hour training. The setup costs are
10x lower.
Automation Anywhere is the only vendor that combines the best of RPA solution with cognitive
automation to significantly reduce the cost and complexity in automating document-centric processes.

3. How many templates do I have to train the IQ Bots on before it is ready for use?
The training requirement has been kept to a minimum, and in most cases, you are able to get the
required value in just one pass.

Capabilities

1. What are supported file types for IQ Bot?
The following are supported file types:
• PDF (Vector PDF, Raster PDF or Hybrid PDF)
• TIF or TIFF
• JPG or JPEG
• PNG

2. Does IQ Bot support handwritten documents?
No, not yet. Processing handwritten document to achieve high STP is a challenge, but it is part of our
roadmap.

3. Does IQ Bot support tabular data extraction?
Yes, it does. IQ Bot has advanced table extraction features to support complex use cases such as:
Explanation of Benefits.
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4. What are supported languages for IQ Bots?
IQ Bot supports the following languages out of box:
• Английский
• Испанский
• Французский
• Немецкий
• Итальянский
• Additionally, it also supports over 25+ languages including all Latin scripts.

5. Does IQ Bot support documents other than invoices?
Yes, IQ Bot supports a variety of domains, and you can also easily add new domains. You can also
create a custom domain when you select the value Other from the domain drop-down list.
The following domains are available in the Community Edition:
• Invoices
• Purchase orders
• Bank statements
• Credit Memo
• Utility bills

Прим.:  You can select the required domain when you create a learning instance.

6. Does IQ Bot support documents with multiple color text?
Yes, but this is true for darker shades of color only.

7. Can I remove the default (pre-loaded) sample document for training and replace it with another from
the group in a Bot?
Да. If the default training document on the Train tab reflects all documents in that group, you can
remove that document from the Train tab and upload a different one from the same group, and train
it.

8. Can I stop document analysis or processing in between?
No, you cannot stop a document analysis or processing mid-way.

9. What is the maximum number of learning instances I can create? What is the maximum number that
can simultaneously exist in the system at once?
The Community edition is limited to five learning instances. The Automation Anywhere Enterprise
version has no such limitations.

10. Is there a restriction to the number of characters for naming a learning instance?
You cannot exceed 50 characters when naming a learning instance.

11. What is the average time to process a single page document? Is the time dependent on the
complexity of the page?
There is no fixed time for processing a single page document as this depends on the following factors:
• CPU strength and availability
• Available free RAM
• Page clarity OR noise level
• Data on page
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12. Can I process MS Excel invoices using IQ Bot?
If the invoices have a standard format, they can be processed using RPA tasks. In case the Excel
formats vary, they need to be converted to PDFs, so they can be processed in IQ Bot.
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